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About this guide 

This guide describes workflow, concepts and procedures for using the Infor Distribution FACTS 
Sales Orders Module. 

Intended audience 
This guide is for FACTS end users, managers, in-house analysts, and trainers who require an 
understanding of the product and how to use it. 

Related documents 
You can find the documents in the product documentation section of the Infor Support Portal, as 
described in "Contacting Infor" on page 14. 

Refer to the contents of the FACTS Version 9.3 & Incrementals folder located at 
https://support.infor.com/. Click Search>Browse Documentation>FACTS> Version 9.3 & 
Incrementals to view a document tree like this. 

o FACTS Version 9.3 & Incrementals 
 Installation and Administration Guides  

• Configuration Guides 
• Demo Application Installation Guide 
• Hardware Guide 
• Installation Guide 
• Online Help Installation Instructions 
• Product Compatibility Matrix 
• Technical Information 

 Integrations 
• Credit Card  
• Document Management 
• Infor Solutions 

o eCommerce  
o Storefront Integration Layer 

• WMS 
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 Release Information 
• Feature Demonstration Videos 
• Program Menu Changes 
• Release notes  

o Incremental Release Notes 
 User Guides 

• Feature Implementation Guides 
• Standard Module User Guides 

Contacting Infor 
If you have questions about Infor products, go to Infor Concierge at https://concierge.infor.com/ and 
create a support incident. 

The latest documentation is available from docs.infor.com or from the Infor Support Portal. To 
access documentation on the Infor Support Portal, select Search > Browse Documentation. We 
recommend that you check this portal periodically for updated documentation. 

If you have comments about Infor documentation, contact documentation@infor.com.
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Chapter 1 Overview 

The Infor Distribution FACTS Sales Orders Module is the backbone of the FACTS customer 
service element. It maintains file information, provides complete audit trails on all orders, 
invoices, credit memos and other transactions. The module also optionally posts to General 
Ledger according to the parameters you establish in the GL posting tables.  

The Sales Orders module is broken down into the following subsystems:  

Quotes  

MSDS 

Orders  

Inquiries 

Invoices  

Reports & Prints 

Customer Returns  

End of Period 

Shipping  

File Maintenances  

Contract Pricing  

Many of these subsystems and additional features are optional so you can effectively use the 
parts of the SO module that you need and ignore the others. 

Credit card handling  
FACTS offers two methods for processing credit card transactions: manual and automatic. 
FACTS, alone, allows you to process these transactions manually via voice authorization. 
Automatic credit card processing is possible by integrating the FACTS system with 
CenPOS software and magnetic or stripe devices, which are purchased separately from 
CenPOS. (See www.cenpos.com for more information.)  

With either method, FACTS users can perform sales, credits and voids. 
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Credit card processing with CenPOS 
The FACTS interface with CenPOS only requires Internet Explorer to be installed on the 
user’s system; no other installation is necessary. All of the CenPOS interface is managed 
through CenPOS and is displayed in an Internet Explorer window. The TCP/IP Manager is 
not used for the CenPOS integration. Refer to the Infor Distribution FACTS Electronic 
Payments Guide for CenPOS for complete information.  

Multi-merchant capabilities 
For CenPOS credit card processing, multi-merchant is available. In Credit Card Control 
(SME957), the merchant ID can be set at the company level and overridden by warehouse 
locations that have individual merchant ids for processing credit card transactions by 
warehouse. 

EMV terminal maintenance in FACTS  
Use EMV Terminal FM to set up EMV (chip reader) credit card terminals in FACTS. For each 
terminal, specify the terminal ID, description and associated IP addresses.  

Note that the IP address being requested in EMV Terminal F/M, when adding a new record, 
is the IP address of the workstation/computer that the EMV Terminal is attached to.  This is 
not the IP address of the EMV Terminal itself. 

Tokenization 
Users with proper authorization set on the Security tab of User Code F/M (SMF410), can 
access CC Token Management (SME958) to manage credit card tokens for use with 
CenPOS credit card processing. Credit card tokens can be created for the specified 
customer or by ship-to location for the customer. To access this screen, the CC Token 
Management prompt in Customer Defaults F/M (ARF840) must be set to Customer or Ship-
to and CenPOS must be selected as the credit card processor. CC Token Management 
(SME958) is accessible from the Maintenances menu in the System Management and 
Accounts Receivable modules and when using CenPOS tokens, this screen is displayed 
automatically during credit card processing. 

Turbo Tokens 

The Turbo Tokens work flow is available faster use of CenPOS tokens credit card 
processing for deposits or payments on sales order documents. 
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The Turbo Tokens drop down list is available in Order Entry, Order Confirmation, Direct 
Invoice Entry, Counter Sale Entry and Credit Memo Entry. If a Turbo Token was 
selected for the line, the token value is displayed. 

In Deposit/Payment Entry when a Turbo Token has been selected, for “C – CC PreAuth” 
transaction types with a terms code of Type 1 or for pre-authorizations, Type 2, the entire 
CenPOS interface is suppressed and a properly formed web request is executed as if the 
user had selected the token in the normal fashion. If the transaction is approved normal 
processing such as receipt printing, continues. 

If the transaction is not approved, then the Turbo Token prompt is cleared. The user is 
returned to the Deposit/Payment Entry program. When a transaction is not approved, a 
different Turbo Token can be selected. Normal payment mechanics continue. For 
example, if a PreAuth is selected and a Type 1 or Type 2 terms code is selected, clicking 
OK displays the CenPOS interface along with the CC TOKENS button at the bottom of 
the CenPOS interface panel. 

Preauthorization/ForceCapture processing 
To initiate a preauthorization, double click a preauthorization line in the Deposit/Payment 
Entry browser, the CenPOS Force Capture CC Transaction screen is displayed. The Amount 
prompt contains the value from the preauthorization line; you can change this amount. 

For CC Preauth transactions, the CenPOS interface is automatically displayed when you 
save the transaction in Deposit/Payment Entry so you can authorize the transaction. Click 
CC Tokens on the Cenpos Interface panel to use a token for the PreAuth transaction. 

If any credit card pre-authorizations exist for a document, an ‘alert’ message, Note: PreAuths 
Exist, is displayed at the bottom left corner of the Footer screens of Order Entry (SOE210), 
Direct Invoice Entry (SOE320) and Order Confirmation (SOE310). 

When running the Daily Sales Register (SOR315), if a document is converted to a back order 
in whole and none of the pre-authorization is used, then it is retained. If part of the pre-
authorization is used toward a partial shipment, then the remaining pre-authorization is 
removed. 

If a document is completed and deleted when the Daily Sales Register (SOR315) is run, any 
existing pre-authorizations for that document are voided via a Web Service call to CenPOS 
and deleted from FACTS. 

Highlight the line and click Re-Auth to manually re-authorize a pre-authorization that is about 
to expire. If pre-authorization management is implemented in your system, an alert is raised 
when a pre-auth transaction qualified for automatic re-auth based on the customer’s settings 
and the # days old setting in Credit Card Control, but the attempt to re-authorize the 
transaction fails or pre-auth transactions are expiring. From the alerts, you can access 
Deposit/Payment Entry to re-authorize the pre-auth. 
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Level III transmission data 
Level-3 processing provides more detailed information about the transaction, which is sent 
back to the buying organization via the issuing bank. By supplying this information, level-3 
processing is done at lower merchant transaction fee rates are significantly reduced. In 
addition, a special interchange category called ‘Large Ticket Interchange,” (LTI) requires 
Level-3 processing. 

Level-3 payments require the most data out of the three processing levels. For comparison, 
Level 2 payments require information such as: 

Transaction amount 

Customer code 

Sales tax 

Level-3 payments require all the data for Level 2 payments, but also must include more 
detailed information, such as: 

Quantity 

Item ID or SKU 

Item description 

Unit price 

Extended price 

Unit of measure (each) 

Commodity code 

Line discount 

As you notice, Level-3 transactions require much more information. 

Level-3 transactions are “cheaper” for the merchant than Level 1 and Level 2 ones because 
of the lowered interchange rates they can yield. Plus, with all the transaction details required, 
merchants can better track and monitor purchases, which increases efficiency and reporting 
power. 

Setting up credit card handling for manual processing  
• Set up a cash type terms code in the Accounts Receivable Terms Code F/M program. 

Credit cards must be cash type payments, not an A/R type. The General Ledger Number 
you choose must be a cash G/L account number. 

• Navigate to the Company Control F/M in System Management File Maintenances. 
Choose "Manual do not collect information". 
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Manual processing  
If you chose "Manual do not collect information" in Company Control F/M, credit card 
payment types will not display a window to collect the credit card information. 

Working with automatic credit card transactions 
After entering the terms code and the purchase amount, you can choose F1 to swipe the 
card or enter the card information manually. 

Choose Process when you are ready to process the sale.  

A mini dialog box is displayed, indicating the system is waiting for recognition and then a 
response.  

If the credit card processing company does not answer or respond within the time set in the 
Credit Card Control F/M, the system gives you either a recognition timeout (if the card 
processing card cannot connect to the provider’s system) or a response timeout (if the 
provider’s system answers but does not approve or decline within the established response 
time). 

Recognition timeouts.  You can wait again or cancel the transaction. Canceling a document 
after a recognition timeout creates no problems because the processing company is not 
aware of the transaction.    

Response timeouts.  You have the option to wait or hold the document. If you choose to 
hold, you must call the processing company to determine whether the transaction has been 
approved or declined. 

If for some reason the swipe device is not working or the credit card processor is offline, 
the person entering the credit card transaction will need to call the processing company 
and specify the provided authorization code. 

At the end of the transaction, FACTS checks to see if you are signed on to a cash 
drawer. If not a message indicates for you to do so.  

The Process Pending Transactions (SOU610) program does not process transactions for 
CenPOS. 

Refer to the Electronic Payments for CenPOS Guide for more information about the FACTS 
setup and use for credit card processors.  Refer to www.cenpos.com for more information 
about credit card processing. 

Order Entry Management Suite  
This is a group of programs comprised of  

Order Entry  

Service Order Entry  
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Order Confirmation  

Direct Invoice Entry  

Credit Memo Entry  

Counter Sale Entry  

All of the programs in the suite use a similar layout and share many of the same functions. 
You can access any of the programs in the suite from the Go To menu.  

Use the SO Entry Options F/M to customize the header, line-item entry and footer sections of 
these programs. 

Header Processing 
The upper portion of the screen is called the header portion where you enter the customer 
placing the order, the customer’s ship-to address, and other general information required to 
process the order. Refer to the following procedures for more information about Order Entry 
header processing: 

Enter a new document 

Delete a document 

Open an existing document 

Create a document number 

Line item processing 
The lower portion is called the line item portion where you add items, quantity and pricing 
information to the sales order. The program automatically switches to add mode once you 
complete the header. This means the cursor appears in the Item Number field after you exit 
the last header field. You can use the line item browser to view items that you have already 
entered, select items so you can edit them and organize items so they appear in a certain 
order on the pick ticket. Use the mouse or arrow keys to choose add from the item browser, 
or select Edit>Add Line from the menu. Refer to the following procedures for more 
information about Order Entry item processing: 

Add a line 

Edit a line item 

Delete a line item 

Insert a line item 
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Footer processing 
The ending routine consists of final fields prior to completion of the sales order. The ending 
routine is not accessible if you have not entered line items for the order. At the end of the 
footer routine, the new total represents the total amount of the order. Refer to the Order 
Entry Footer Information topic in the online help for field descriptions. 

Ship complete feature  
Ship Complete is a warehouse- and line-level designation that has one of three values: 

Yes: The shipped quantity must equal (or be greater than) the ordered quantity. No partial 
shipment is allowed. Ship complete for the warehouse designation means all lines must ship 
complete, and the line level ship complete is not considered. Ship complete for the line 
means that the quantity ordered must be the same as the quantity shipped on that line. 

No: The shipped quantity may be less than the ordered quantity. 

Balance Complete: The initial shipped quantity may be less than the ordered quantity, but 
the backordered quantities must be shipped complete. Balance complete for the warehouse 
designation means all lines can ship partial on the first shipment, and the line level ship 
complete is not considered. Once a warehouse is processed through the DSR, it is changed 
to ship complete. Balance complete for the line means that the quantity shipped may be less 
than the quantity ordered on the first shipment. Once the line is processed through the DSR, 
it is changed to ship complete.               

Selecting companion items or importing items  
During line-item entry, the Companion Item Selection/Import Item Selection dialog box is 
displayed for selecting companions or importing items from other documents when you add 
an item that has companion items associated with it in Companion Item Entry (SOE150).  

The Companion Item Selection dialog box displays from the Order Entry Programs: Quote 
Entry, Order Entry, Confirmation, Invoice Entry, Counter Sale Entry.  

The system displays the Import Item Selection dialog box when during line-item entry when 
you import items via the policy flags established in Document Import Control F/M. The Import 
Item Selection dialog box displays from Quotes, Order Entry, Direct Invoice Entry, and 
Counter Sale Entry, click Options>Import Items from the menu.  
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Companion Item Selection Processing Notes  
When a line item is created, a check is performed to determine whether companion items or 
companion memos exist for the newly-added item. If no companions exist or if all 
companions are flagged as Not Applicable to the current entry program, the program will 
continue without interruption.  

The Companion Item Entry (SOE150) program allows you to select whether the import of 
items/memos is automatic, prompted, or not applicable to the entry program. If any 
companion items/memos are flagged as "Y-Default to Y" or "N-Default to N," you have the 
option to select any of the companion items/memos available. If any companion 
items/memos are flagged as "A – Automatic Add" then if any additional companion 
items/memos are flagged as Y or N, then all items/memos that are A, Y and N will be 
displayed in the Companion Item Selection (SOE151) dialog box. Items designated A for 
Automatic Add will always be added automatically to the document. If all companions 
applicable for this order type are flagged as A and there are no Y or N flagged items/memos, 
then no dialog is displayed and those items/memos will be automatically imported into the 
document (unless there is an exception that requires user attention, such as the item not 
being setup in a warehouse). If any companion items/memos are flagged as "X – Not 
Applicable" then they are not displayed in this dialog and are not allowed for import into the 
actual document. Once the companion items/memos are selected, the items are imported 
into the document.  

Importing item selection processing notes  
As you enter documents in Quotes, Order Entry, Direct Invoice Entry, and Counter Sale 
Entry, click Options>Import Items from the menu.  

The system displays a dialog box where you can select the document type and document 
number to import. If your system is set to allow you to change the default pricing option 
(based on Document Import Control F/M), you can also select from two options, "Current 
Default Prices" and "Source Document Prices".  

Then in the Import Item Selection dialog box, the system displays the items from the selected 
document, including memo lines, where you can choose which items to import and update 
quantities and pricing, and so on. Once you have completed your selections, the system 
adds all selected items to the end of the new document.  

You can view each line’s source document from line detail in the entry program and/or 
Document Inquiry.  

The system determines which items to import using this process.  

Quote – Pulls all lines from the quote selected, regardless of status, except for deleted lines.  

Open Order – Pulls all lines that are not flagged as Complete, Deleted or Voided. The 
quantity used will be the current order quantity, not the original order quantity.  

Past Document – Pulls all lines as they appeared on the first shipment we have on file, 
regardless of line status. The quantity used will be the order quantity, not the original order 
quantity.  
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Past Invoice – Pulls all lines that appeared on that invoice that had a positive shipped 
quantity. The quantity used will be the quantity shipped.  

The import procedure calculates price, discount, shipping warehouse, and the direct ship 
status based on the settings from Document Import Control F/M. The order quantity is set to 
the order quantity from the source document. The item descriptions are set to those from the 
source document.  

The system considers two shipping warehouses: the source document’s shipping warehouse 
and the new document’s initiating warehouse. If the warehouse selected based on the 
Document Import Control F/M isn’t valid (either the item isn’t on file there or warehouse 
security fails), the system attempts to use the other one. If both fail the processing criteria, 
the system leaves the warehouse blank so you can manually select it.  

If the warehouse/direct ship status determined by the Document Import Control F/M isn’t 
valid for the new document, the system uses the setting that’s valid for the new document.  

If a BOM item is encountered that doesn’t have stored component history, the system 
prompts you to select whether to "Skip importing the item" or "Use the component 
information from MC". If the item is no longer a BOM item in MC, the system skips the items 
and notifies the user.  

Commissions percentages are never be pulled from the source document. The system uses 
the current commission percentage as the default.  

If a past document contains an item that is no longer on file, or any of the information on the 
line (including UMs, item class, etc) are no longer valid, the system skips the item and 
displays a message indicating that the item is skipped.  

The system applies the SO Static Control flag for recalculating user override prices to 
importing quotes only. The flag is considered when importing a quote onto a quote, importing 
a quote onto an order/invoice, and when performing quote conversion. All other type of 
documents being converted work off the current cost.  

Screen information  
In the browser in the lower portion of the screen, the system displays all companion/import 
items/memo lines defined for the original item entered. You can select the companion items 
or import items to include on the order. The browser also contains a quantity field and UM 
field, which will default to the original item qty per UM times the default qty for the companion 
from the Companion Item Entry program. Press Enter or double-click on a browser line to 
edit the warehouse, quantity and UM of the companion item.  

If valid companions are found, they are written to the Companion Item on Document file. As 
they are added, the system calculates the default quantities and the various flags in this file 
are set as follows:  

Direct Ship defaults according to the ship type of the item just added; memo print and export 
flags will default from the Companion Item Line File.  

The Vendor is the primary vendor for the companion item as defined in Item F/M.  
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The shipping warehouse will default to the initiating warehouse for the document, regardless 
of the shipping warehouse of the item just added.  

For this last condition, if the companion item does not exist in the initiating warehouse, then 
** (asterisks) are displayed in the WH column. If you do not select that companion for editing 
and change the warehouse to a valid warehouse or direct ship, then you will not be allowed 
to exit the dialog (you can press the Toggle button to set the companion item to Not Import 
and exit the dialog box ). If the available quantity of the companion is less than the ordered 
quantity, then the system displays an ! (exclamation point) in the 2nd column of the dialog 
box.  

Shipping eligibility of an order  
If an order or line is "eligible to ship", that means the order has met the requirements to ship 
according to the ship complete setting and the amount of committed stock on the order. 
Balance complete on both the warehouse and line level will behave like a partial shipment 
when considering if the order is eligible to ship. If items are shipping from a warehouse that 
is set to require approval, those items must have an approved status in addition to being fully 
committed in order to be considered eligible to ship. 

Ship Complete in a Multiple Warehouse Environment:  In a multiple warehouse environment, 
warehouse-level ship complete applies to each warehouse individually. However, if the 
initiating warehouse is set to print consolidated pick ticket only, all warehouses will be 
evaluated together to determine if the order is eligible to ship. 

The Ship Complete setting on SO Entry Options F/M (SOF915) determines which Order 
Entry programs use the Ship Complete feature. Based on your systems settings in SO Entry 
Options F/M, all of the Sales Order entry programs (except Credit Memo Entry (SOE330)) 
contain a Ship Complete field on the detail screens but only the pick ticket is affected by this 
setting. It is available through other Sales Order Entry programs because order processing 
from them can in certain instances create a pick ticket. For example when you backorder a 
direct invoice you can create a pick ticket. Blanket orders and recurring documents also 
ultimately create a pick ticket. The Ship Complete setting from Blanket Sales Order Entry 
(SOE710), Quote Entry (SOE110), and Recurring Document Entry (SOE350) default to the 
order and is for all warehouses. Once the order is created this setting is modifiable like any 
other order. 

The Ship Complete field also resides in Customer F/M (ARF910) on the Invoicing tab. It is 
used as the initial default when orders or quotes are created for a customer. When a new 
customer is added by using the F1-Add feature in the Sales Order entry programs, the ship 
complete setting is loaded with the default values used when adding a new customer in 
Customer F/M. If the fields need to be changed, it must be done in Customer F/M.  

The Additional Info tab of Ship-To F/M (ARF920) also contains a Ship Complete field. When 
a new ship-to record is added, these value defaults from the customer record. 



Overview  

Infor Distribution FACTS Sales Orders User Guide  | 25 

Order processing  
When lines are added to an order, the line ship complete value always default to "N". 

If a warehouse ship complete setting is changed and there are lines on the order shipping 
from that warehouse, changes will take place as follows: 

If you change the ship complete setting from "N" to "Y" or "B" 

The system displays the message "The Ship complete setting for all lines shipping from 
warehouse XX will be cleared. OK / Cancel".   

If you select Cancels, no change is made and the system returns you to the Ship Complete 
field. 

If you select OK, the ship complete setting on all lines for the selected warehouse is changed 
to "N". Since the line ship complete flag is not considered when a "header or warehouse" is 
ship complete or balance complete, changing the flags to "N" sets them to the proper default 
value. 

If all lines were already set to "N", no prompting nor changes are done to the lines. 

If you change the ship-to value: 

If there are no lines on the order shipping from the initiating warehouse, the warehouse ship 
complete flag is changed to the ship-to’s ship complete flag. No user prompt occurs. 

If the ship-to’s ship complete setting is different from the initiating warehouse’s ship complete 
setting, the system displays the message "Change the initiating warehouse ship complete of 
XXX to the ship-to ship complete of XXX? Yes/No". 

If you select "No", the initiating warehouse ship complete remains unchanged. 

If you select "Yes", the system performs the same steps as above that deal with the change 
to ship complete. The only difference is that if you received the message that the line setting 
will be cleared, you will not have the Cancel option. The system will have already displayed 
messages that allow you to cancel from this process. The system displays informational 
messages only and changes the ship complete settings as necessary. 

If you change the ship-to value to "SAME" or "TEMP" all of the above processing still applies, 
but the values come from the customer record instead of the ship-to record. 

If the ship complete is changed for the initiating warehouse, the system determines if the 
warehouse pick ticket has already been printed but is not in the reprint file already and 
prompts you to add changed warehouse to the reprint file (similar to when a line is edited). 

Creating suggested transfers/purchase orders from 
Sales Order Entry programs 
Use the Creating Planned Special Order Transactions (SOE511) window to create planned 
special order purchase orders and transfer for backorders. When creating planned special 
order transfers, the program checks for surplus stock the shipping warehouse and then 
checks for surplus in other warehouses and recommend a transfer location of the warehouse 
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with the most surplus stock. You can use the Warehouse Lookup button to see the 
warehouses available and the amount of surplus in each of the available warehouses. When 
creating planned special order transfers, the Warehouse/Item Search (SOC070) program 
checks for surplus stock the shipping warehouse and then checks for surplus in other 
warehouses and recommend a transfer location of the warehouse with the most surplus 
stock. You can use the Warehouse Lookup button to see the warehouses available and the 
amount of surplus in each of the available warehouses. 

When you create/edit a sales order line and it has a back-ordered quantity greater than zero, 
you can create a planned special order purchase order for the primary vendor, a planned 
special order purchase order for another vendor, a planned special order transfer from the 
item’s restocking warehouse or a planned special order transfer from another warehouse 
depending on the item type. The Sales Order Entry programs can also be set to 
automatically create/update the planned special order PO or transfer as necessary. The 
system bases planned special order document creation on the prompt in the Sugg PO/TR by 
Type section of the Line Options tab of SO Entry Options F/M (SOF915). When the Sales 
Order Entry programs are evaluating a line item with a back-ordered quantity to determine 
whether to prompt you to create a planned special order transaction, the system looks at the 
item type and uses the SO Entry Option prompt associated with that type. Use these settings 
to indicate whether you want to have the system ask to create planned special order 
purchase orders or planned special order transfers during Order Entry line processing, 
automatically create planned special order purchase orders or planned special order 
transfers during Order Entry line processing or never create planned special order 
documents. When the items are received, you can run the Transfer Fill Report prior to the 
Receiving Register to advise warehouse personnel of what back-orders are to be filled with 
the incoming merchandise.  

Create Planned Special Order Transaction window 

If the Stocked and Nonstocked prompts in the Sugg PO/TR by Type section on the Line 
Options tab of SO Entry Options F/M (SOF915) are set to R Always Ask Defaulting to a 
Planned Special Order PO or A Always Ask Defaulting to Restocking Path, the system 
displays the Create Planned Special Order Transaction Window when you create/edit a 
sales order line and it has a back ordered quantity of greater than zero.  

Processing Details 
If you are creating a planned special order PO, the system writes the selected vendor back 
to the sales order line vendor prompt.  

When you edit a sales order line, the program checks to determine if a planned special order 
PO or a planned special order transfer already exists for this line. If a planned special order 
document exists, it is deleted and the quantity is saved. For a planned special order PO, the 
warehouse and vendor are also saved. For a planned special order transfer, the "from" 
warehouse is saved. If no change was made to the line, the system displays a message that 
contains the saved information prompting you to keep the existing planned special order 
transfer or PO.  

If a backorder quantity remains when the line edit is completed, the system displays a 
message prompting you to update the existing PO or transfer with the current back-ordered 
quantity. You can select from the following options: Y-Update the planned special order PO 
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or transfer with the current back-ordered quantity, N-Keep the existing planned special order 
PO or transfer with the original quantity, or D-Delete the planned special order PO or 
transfer. 

If you elect not to keep the planned special order PO or transfer (the D-Delete option), the 
program returns to the Create Planned Special Order window. This allows you to change a 
line from having a planned special order PO to having a planned special order transfer all in 
one step rather than having to delete the first and then edit the line again to create the other. 
If you do not want to create a planned special order document at all, select N-neither to not 
create a planned special order document. 

If you modify the ship warehouse or vendor (in the case of a planned special order PO) on a 
sales order line that already has existing planned special order documents, the system 
deletes the planned special order document and displays the Create Planned Special Order 
Transaction window with the a message indicating that the original planned special order 
document was deleted. You can use the Create Planned Special Order Transaction window 
to create a new planned special order transaction document.  

Validation Processing for Special Order ties  
When creating a planned special order PO line (via the F1 key) for a specific special 
order/line, the system also checks the Buyers Control Center (BCC).  

If the line is already in the BCC, you cannot add the special order and a message is 
displayed indicting that the line was found in the BCC. Additionally if the PO line created for a 
specific special order removed an existing POSUGG record, then a delete of the PO line 
processing changes will now restore the POSUGG record.  

You cannot change the shipping warehouse or selling UM for special order lines that are in 
the BCC. A message is displayed indicating there is a conflict with line in the BCC. 

Special order back-order quantities for purchase orders and transfers (PO/TR) are also 
checked in the BCC. If the back-order quantity is changed from the amount in the BCC, the 
change is not allowed and a message is displayed. 

Deleting a special order line (PO/TR) is also checked. When that line is in the BCC, the 
delete is not allowed and a message indicating the record is in BCC and must be managed 
from that program. 

An alert is displayed when editing a line with a special order that is already in the BCC. This 
alert is only displayed if the Planned Special Order prompt is set to 'Ask' in Line Options tab 
of SO Entry Options F/M (SOF915). 

Note: The vendor value in the sales order receipt line defaults from the item’s primary vendor 
when a line is created and then is updated with the vendor of any PO transaction associated 
with it. If the PO transaction is deleted, the vendor value will be restored to the item’s primary 
vendor (except temporary items). This includes deleting a planned special order PO, deleting 
a regular PO and SO entry deleting a planned special order PO and then creating a planned 
special order transfer or not creating any document at all. 



Overview  

28 | Infor Distribution FACTS Sales Orders User Guide 

Entering serial/lot items 
Serial/lot entry is only available if the OE Serial/Lot Entry control in SO Static Control F/M is 
set to either M-Assign Number in either Entry or Confirmation or Y-Assign Number in SO 
Entry. 

Use the Serial/Lot Entry window to assign serial numbers or lot numbers for items you are 
entering.  

Serial/Lot costing options 
You have the ability to cost serial and lot items by the system cost (costing method for the 
module). The feature provides for GAAP compliance. For the FACTS SO, IC and MC 
modules, you can decide if the cost for serial and lot items will be averaged actual (as it has 
always operated in the past) or system cost (costing method for the module). The default 
setting for each Static Control F/M is A-Averaged Actual (same behavior as they have before 
the monthly is applied). Users who want to take advantage of this change will need to 
change the option to S-System Cost for each of the applicable modules. The net result of 
selecting S-System Cost is that serial/lot items will be costed like non-serial/lot items. 

The window is displayed automatically when you enter item numbers flagged as serial or lot 
(see Item F/M, Main tab). 

Serial and lot processing shows and restricts serial lot selection for special orders.   

Over-commitment of serial/lot items 
The over-commitment of serial/lot items is not allowed in Order Entry and Confirmation Entry. 
If the OE Serial/Lot# Entry flag in SO Static Control is set to "M" or "N" then you can under 
commit serial/lot items.  

The system recalculates quantities if: 

• The Serial/Lot shipped amount does not equal the order's shipped amount,  

• The OE Serial/Lot# Entry flag is set to "Y" and the Serial/Lot committed quantity does 
not equal the order's committed,  

-OR- 

• The OE Serial/Lot# Entry flag in SO Static Control flag is not "Y" and the Serial/Lot 
committed quantity is greater that the order's committed amount.  

• The system displays the message "Improper ser/lot assignment. Quantities changed 
for line XXX" then recalculates as follows:  

• The order's shipped amount is set to the Serial/Lot shipped amount.  

• The committed amount is set to the Serial/Lot committed amount.  

If the "new" sum of the shipped and committed amounts is greater than the ordered amount, 
the system sets the ordered amount to the sum of the shipped and committed amounts. The 
system recalculates the order's back-ordered amount with the new quantities to equal the 
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ordered amount minus the shipped amount minus the committed amount. You cannot 
change the ordered amount for special orders.  

In the Daily Sales Register, if the Serial/Lot shipped amount doesn't match the order's 
shipped amount the system displays a message and returns to the menu. The system also 
displays a message if the Serial/Lot committed amount is greater than the order's committed 
amount and returns to the menu.  

When the system displays the Serial/Lot Entry (SOC145) window, the item number 
automatically displays in the Item field and the document number displays in the Document 
field. The system line and the document line are also displayed. For special orders, only that 
line’s special order serial/lot receipts are initially displayed. For non-special order lines, only 
non-special-order line receipts are initially displayed. A special order line may only commit 
and or ship the receipts designated for that line, and no other line may commit and or ship a 
line that is so designated. 

 

Checking customer credit  
The Customer Credit Check Processing program performs all the calculations and gives the 
appropriate messages for customer credit check. This routine is called from various entry 
programs and only the results are returned. 

The system performs a customer credit check for each customer during Sales Order entry 
programs based on the Credit Limit value and the number of Credit Check Days entered on 
the Accounting tab of Customer F/M.  If the customer fails the credit check a message 
appears. No action is taken by the system unless a password is required. The system rejects 
the customer if a valid password is not supplied. 

The credit hold option for a customer is based on the Credit Check prompt on the Accounting 
view of Customer F/M.  If the Credit Check prompt is set to "Message", "Refuse", "Hold", or 
"Password", a message displays if the customer fails the credit check.  The current balance 
figure used for processing comes from the customer’s existing balance in AR Customer F/M. 
The password for the credit check override resides in the AR Static Control F/M. 

Adding Customers On-the-Fly 
To add a new customer during order entry, you can access the Quick Customer Add dialog 
box. When a new customer is added by using this feature in the order entry programs, the 
customer credit check field value is loaded from the default in the AR Static Control record. 
You cannot enter credit check information this screen. If you need to modify the customer 
credit information, access AR Customer F/M. 
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Disputed invoice details 
For Quote Entry, Sales Order Entry, Direct Invoice Entry, Counter Sale Entry, Credit Memo 
Entry, Customer Returns Entry and Blanket Sales Order Release Register and Post 
Recurring Documents, the credit check routine also checks the Disputed Invoice setting in 
AR Document Change F/M for each open AR document record. If it finds a disputed invoice 
record, the credit check processing checks the invoice’s Exclude from Credit Check setting in 
AR Document Change F/M to determine if the disputed invoice is to be considered in the 
credit check past due processing. Documents marked as excluded from credit checking are 
skipped from the total amount past due. All invoices total into the customer’s balance and 
aging figures. Any disputed invoices that are excluded from the credit check are accumulated 
into a new total. The check for over credit limit is calculated as the customer’s balance minus 
disputed invoices not to be included plus document totals. Then, if the customer is past due, 
the excluded total displays on the optional Customer Aging window that displays in AR 
Invoice Entry and Sales Orders Entry programs: Quote Entry, Sales Order Entry, Direct 
Invoice Entry, Counter Sale Entry, Credit Memo Entry, Customer Returns Entry, and Blanket 
Sales Order Release Register and Post Recurring Documents. 

Customer Aging window 
The optional Customer Aging window displays in AR Invoice Entry and Sales Orders Entry 
programs: Quote Entry, Sales Order Entry, Direct Invoice Entry, Counter Sale Entry, Credit 
Memo Entry, Customer Returns Entry, and Blanket Sales Order Release Register and Post 
Recurring Documents   

Customer aging information includes the customer number, credit limit, aging as of date, 
balances for aging columns set in AR Aging Control F/M, balance, aging open documents 
totals, amount excluded from credit check processing and a "Disputed Invoices’ indicator 
(based on the Disputed Invoice setting in AR Document Change F/M. 

Automatic and quoted freight processing  
In Order Entry, Confirmation Entry and Direct Invoice Entry, FACTS provides automatic 
freight calculations using freight schedules or quoted freight, based on control settings in 
Ship Via F/M, AR Customer Maintenance and SO Static Control F/M (SOF980). Blanket 
sales orders allow for multiple shipping warehouses but have no freight amount field. When 
blanket sales orders are released, the system sets the document freight method from the 
customer record. 

The document freight method cannot be changed once the document has been run through 
the Daily Sales Register. 

Note: Quoted freight is on the header of the order not on the warehouse level. If not all of the 
items from an order ship, the backorder’s quoted freight will reflect the amount of the freight 
originally quoted minus the amount that was billed on the first invoice. 
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Freight method 
If freight method is quoted 

• If "Default Quoted Freight with Calculated Freight in Order Entry" is set to "No" on the 
SO Static Control F/M Freight tab, then FACTS sets the order quoted freight field to 
zero. 

• If "Default Quoted Freight with Calculated Freight in Order Entry" on the SO Static 
Control F/M Freight tab, is to "Yes", then freight is calculated for each shipping 
warehouse and displayed in the quoted freight field. 

• The system adds Invoice Billed Freight Amount adds into Previously Billed Freight 
Amount and the Invoice Calculated Freight Amount into Previously Calculated 
Freight Amount in the SORSOH record. 

• Then, the Order Quoted Freight Amount is reduced by the Invoice Billed Amount and 
the Order Calculated Freight Amount is recalculated based on new order quantity. 

• If the SO to GL Posting F/M has freight set to post by ship via, the ship via of the 
initiating warehouse is used to get the GL number. If post by branch is set, this would 
be the branch of the initiating warehouse. Quoted freight does not post by shipping 
warehouse like calculated freight. 

If freight method is calculated 

• If "Default Quoted Freight with Calculated Freight in Order Entry" on the SO Static 
Control F/M Freight tab, is to "Yes", the freight will be calculated for each shipping 
warehouse and stored in the SOFRWH records. 

• If "Default Quoted Freight with Calculated Freight in Order Entry" on the SO Static 
Control F/M Freight tab, is to "No", then the freight in each SOFRWH record is set to 
zero. 

• The system adds the Invoice Calculated Freight Amount into the Previously 
Calculated Freight Amount in the SORSOH record and recalculates the Order 
Calculated Freight Amount gets recalculated based on new order quantity if the 
Default Freight flag is Sales Order Static F/M is set to "yes". 

• The new fields will move into the past invoice header file. 

Entering lost sales 
Use the Lost Sales Entry (SOC320) program to track lost sales on items and update usage. 
Lost Sales functionality is only available if the Lost Sales checkbox is selected on the Use 
Features tab of SO Static Control F/M (SOF930). 

Long- and short-term surplus availability 
In the Order Entry Suite programs, the availability of long- and short-term surplus in 
warehouse(s) other than the current line’s shipping warehouse is displayed at the time you 
are prompted to create a purchase order or transfer during Order Entry (SOE210), Direct 
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Invoice Entry (SOE510), Confirmation Entry (SOE320), or Counter Sale Entry (SOE340), 
and during conversion of a quote to a sales order. 

Long term and short term surplus quantities are viewable in the Sale Orders module in these 
programs: 

• Side Bar-Warehouse Quantities view 
• Direct Invoice Entry, Confirmation Entry, or Counter Sale Entry-View menu>Warehouse 

Quantities Display 
• Line Detail screens for Direct Invoice Entry, Confirmation Entry, Counter Sale Entry, 

Rejected lines Inquiry (SOI650), SO Document Inquiry (SOI620) 
• Warehouse/Item Search (SOC070)-This search program is displayed from the Whse 

Qtys button or Warehouse lookup in these programs: Customer Inquiry (SOI615) - Price 
view, Price Search (SOC022), Companion Item Entry (SOE151), Remote Order Entry 
(SOE611), Blanket Order Entry (SOE710), Verify New Shipping Warehouse (SOC510), 
and Quote Item Warehouse Lookup (SOC113) 

• Creating Planned Special Order Transactions window (for transfers for backorders) 
• Order Status Report (SOR720)- shows quantities for short-term surplus, long-term 

surplus or both. 

Side Bar feature 
Use the Side Bar to display additional ordering information while in the Sales Order Entry 
program suite for quick selection and viewing. This provides information about ordering 
habits for the specified customer and information about items in the line item section of 
Quote Entry, Order Entry, Confirmation Entry, Direct Invoice Entry, Credit Memo Entry and 
Counter Sales Entry to facilitate efficient ordering choices. 

Click Show/Hide to toggle the Side Bar display off and on. Select a view from the drop box. 
For views with drag and drop functionality, click and drag one or multiple lines at a time to 
the line item section of Order Entry (SOE210), Quote Entry (SEO110), Confirmation Entry 
(SOE310), Direct Invoice Entry (SOE320), Credit Memo Entry (SOE330) and Counter Sales 
Entry (SOE510). Click Reload to refresh the contents displayed in the Side Bar area list box. 
Scrolling and go to page options are available in the lower right corner of the list box. 

You can use the Side Bar for research and review after you specify an item. Limiting, 
scrolling and double click actions, when available, are also enabled during line entry. Drag 
and Drop during line entry is not allowed. 

To drag and drop items in Credit Memo line entry, the return code is determined is this 
manner. The system reads the list of items already being returned (from selected line, 
upwards) and retrieves the return code from a prior item with a matching return or allowance 
value. If this fails, the system reads the Return Codes file for a matching return or allowance 
value and return the code for the first found code. If this fails, you are prompted to enter a 
valid return code. 
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Refer to this table for the available Side Bar views: 

View Description  
Drag / Drop 
available Functionality 

P-Prior 
Purchases 

Displays past invoices. 
This is customer-
specific and does not 
change with item 
selection. 

X Double click a line to 
launch Past Invoice 
Inquiry (SOI620) for 
the selected invoice.  

p-Item 
Purchases 

Displays the selected 
item’s current open 
purchase orders for that 
single item. This is item-
specific and contents 
change with item 
selection. 

 Double click a line to 
launch the PO 
Document Inquiry 
(POI620) for the line 
selected.  

SO-
companion 
items  

Displays all top-level 
companion items for all 
items currently on the 
order. Parent items are 
also listed. This is 
item-specific and 
contents change with 
items ordered. 

X Double click a line to 
launch the Item 
Inquiry (ICI610) 
Warehouse view for 
the item selected.  

L-Long Term 
Surplus 

Displays items with long 
term surplus in the 
Initiating Warehouse. 
Additional warehouses 
with long term surplus 
are included if the 
Multiple Warehouses 
check box is selected in 
SO Static Control F/M 
and are valid for SO in 
Warehouse F/M 
(ICF970). If the 
customer has 
purchased this item in 
the past, the indicator 
column displays “Y” and 
the quantity. Negative 
values (returns) are 
changed to positive. 
This is customer-
specific and does not 
change with item 
selection. 

X Double click a line to 
display the Change 
Long Term Surplus 
Quantity window to 
change the order 
quantity. Click Refresh 
to reset all quantities 
and values to their 
initial amounts.   



Overview  

34 | Infor Distribution FACTS Sales Orders User Guide 

View Description  
Drag / Drop 
available Functionality 

S-standard 
orders  

Displays the standard 
order lines for the 
customer. This is 
customer-specific and 
does not change with 
item selection. 

X 
Note that when 
you drag and 
drop a standard 
order in the 
Side Bar, the 
memo lines are 
not pulled into 
the order. To 
include memo 
lines from a 
standard order, 
click Import Std 
Ord to add the 
standard order 
in Order Entry. 
This dual 
functionality 
provides for a 
case where the 
standard order 
memo is really 
a note to the 
FACTS user 
entering the 
order and 
should not be 
included on the 
order. For 
example, the 
memo might 
about the 
customer and 
not for the 
customer. 

Double click a line to 
launch Standard 
Order Entry 
(SOE250). The side 
bar list box is updated 
and redisplayed when 
you exit Standard 
Order Entry.  

R-Price 
Contracts 

Displays price contracts 
for the customer or 
customer price class, as 
well as any contract for 
all customers. The 
displayed contracts are 
not item specific and 
can include items, 
classes and other 

 Double click a line to 
launch the Contract 
Price Entry (SOE560) 
(as inquiry only).  
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View Description  
Drag / Drop 
available Functionality 

information, which is not 
specific to this order. 

Q-Quotes Displays unexpired 
quotes for the customer. 
This is customer-
specific and does not 
change with item 
selection. 

X Double click a line to 
launch Quote Inquiry 
(SOI620) window for 
the selected quote.  

C-Customer 
Items 

Displays customer 
items for the Customer. 
This is customer-
specific and does not 
change with item 
selection. 

 Double click a line to 
launch the 
Customer/Item F/M 
(SOF545). 

N-Notes Displays notes based 
on customer and item. 
The contents related to 
the customer will not 
change, but content 
may change with item 
selection in Order entry. 

 Select a note and 
double-click to launch 
the Note Entry 
(SME710) for the line 
and type (Customer or 
Document (header); 
Line or Item (line). 

W-
Warehouse 
quantities 

Displays the warehouse 
quantities for that 
selected line. All 
warehouse’s quantities 
for a selected item on 
the order are displayed. 
This is item-specific and 
contents change with 
items ordered in Order 
Entry. 

 There is no further 
action in this view. 

P-Price 
Options 

Displays the selected 
item’s current price 
options. Temporary 
items are omitted. This 
is item-specific and 
contents change with 
items ordered. 

 There is no further 
action in this view. 

D-On Order Displays the selected 
item’s current open 
orders for this customer 
(for a single item). 
Deleted, voided, in-

 There is no further 
action in this view. 
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View Description  
Drag / Drop 
available Functionality 

register, confirmed, and 
Service and Repair 
documents are skipped. 
This is item-specific and 
contents change with 
items ordered. 

o-open 
orders  

Displays open orders 
for the customer for the 
selected item. This is 
item-specific and 
contents change with 
items ordered.   

 Double click a line to 
launch the Document 
Inquiry (SOI620) for 
open sales orders.  

t-Timeline Displays the selected 
item’s current timeline 
for that single item (and 
its shipping warehouse). 
Temporary items are 
omitted. This is item-
specific and contents 
change with items 
ordered.   

 Double click a line to 
launch the inquiry 
corresponding to the 
selected line type (if 
the document is 
available). 

T-Contacts Displays contacts 
corresponding to the 
customer and ship-to of 
this order. The Type 
column indicates if the 
contact is “C” a 
customer contact or “S” 
a ship to contact. This is 
customer-specific and 
does not change with 
item selection. 

 There is no further 
action in this view. 

r-Resources Displays resources for 
the customer, item and 
item class and the 
item’s primary vendor. 
Customer-specific as 
well as item-specific. 
The contents related to 
the customer will not 
change, but content 
may change with item 
selection.  

 Double click a line to 
launch the 
Supplemental 
Resource Manager 
(SMC910).  
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Chapter 2 Work flow and program concepts 

 

Quotes  
Use this subsystem to enter, correct, print and remove quotes in the system. You can also 
automatically convert a quote into a sale (work order). 

Program concepts 
You can access the following programs from the Quote Entry menu: 

Quote Entry is used to enter and modify quotes. This program is similar to other entry 
programs in the Sales Orders module, but it is not part of the Sales Order Entry Suite. 

Quote Print is used to print or reprint quotes. If you need to modify or correct a quote, return 
to the Quote Entry program. 

Quote Removal is used to remove sold and expired quotes. 

Operating tips and suggestions 
When you enter quotes, you enter a customer number, and the system assigns the quote 
date (usually the system date) and expiration date, both of which can be changed later if 
necessary. The entry screen provides fields in which you can enter a quote title, the name of 
the person who gave the quote and the person who is receiving the quote. 

The system also allows you to create quotes for companies or individuals that are not 
existing customers. Before you convert these quotes to a sales order, you must create a 
temporary customer in Customer F/M. 

Items entered on quotes are not committed in the warehouse, but the Quote Entry program 
lets you see the availability of those items. 
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Quote Entry also supports the FACTS multiple warehouse feature. If your company has 
several locations with their own inventory, this feature allows you to enter items from other 
warehouses if your default warehouse is out of stock. 

The system also allows you to create quotes for companies or individuals that are not 
existing customers. Before you convert these quotes to sales orders, you must create a 
temporary customer in Customer F/M. 

Quote status is also available to track Win/Loss information. Quotes status options are: 
Accepted/Declined/Partially Converted/Expired/Open. The date the quote was accepted or 
declined, and the reason declined also display on the Header screen. The Reason Declined 
field is validated against standard Lost Sale Reason Codes in FACTS. 

As with the other Sales Order Entry programs, Quote Entry displays all pricing but allows you 
to override that pricing if necessary. If multiple units of measure for pricing or selling are 
available for an item, you can also change the unit of measure while entering a quote. 
Quotes may also include discounts, tax and freight. 

You can send/receive quotes from Infor Distribution Storefront. When processing quotes 
from Storefront to FACTS both Require Effective Date and Require Effective Date check 
boxes on the Use Features view of Sales Order Static Control F/M (SOF980) must be 
unchecked. 

Work flow 
Once you finish entering a quote, the program gives you several options: print the quote 
immediately, save it for batch printing or convert it to a sale (providing that the customer, or 
at least a temporary customer, is valid in the system). 

At that time of entry the quote is assigned an order request date and order number in the 
Sales Orders Document File. If you use the Job Cost subsystem, the system enters a job 
number for the order at this time. Through Order Entry, you can open the document to review 
or change it. 

Quotes can be printed or reprinted through the Quote Print program. If you need to modify or 
correct a quote, return to the Quote Entry program. Quote print parameters are determined in 
the SO Document Print Control F/M. These parameters include the depth of the quote, 
whether the form is preprinted, and the standard memo. 

The system also prints any notes flagged during Quote Entry to print on the quote. Urgent 
document notes print before normal document notes. Memos print before any line notes, and 
line notes print in the order of entry with no special dispensation for urgent notes. 

A quote may be corrected and reprinted as often as needed up until the time it is converted 
to an order. If the quote is not converted at the time of entry, it may be converted at a later 
date through the same ending routine at the end of the entry program (if the customer is 
valid). 

When a quote is converted to a sale, it stays in the Quote File as a sold quote. They may be 
left on file so they can be printed through the Quote Listing. Since this file eventually fills up, 
make sure you run Quote Removal periodically to remove the quotes that you no longer 
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need to keep on file. Sold and expired quotes may be removed by their type (expired, sold) 
and the expiration date (cutoff date). 

Orders  
Programs on the Orders menu enable you to enter, correct, place on hold and print orders in 
the system. 

Program concepts 
The Orders menu contains these programs. 

Use Order Entry to enter new sales orders, or review and edit existing sales orders. A sales 
order effectively commits quantities of items for a customer and produces a pick ticket, which 
warehouse personnel use to fill the order. The Order Entry screen is divided into three 
sections: the header portion where you enter the customer placing the order and other 
general information required to process the order, the line item portion where you add items, 
quantity and pricing information, and the footer window where you enter final fields prior to 
completion of the sales order. In the footer window, if any credit card pre-authorizations exist 
an ‘alert’ message, Note: PreAuths Exist, is displayed at the bottom/left of the Footer screen. 

Pick Ticket Print is used to print and reprint orders through in this program. You can correct 
and reprint pick tickets (or printed orders) as often as needed until you confirm the order and 
convert it to an invoice. If an order includes shipments from multiple warehouses, you can 
set the system to print pick tickets in the initiating, shipping or both warehouses. Packing 
slips are also printed through Pick Ticket Print. You can access this program from the Order 
Entry footer when you complete an order. From there, you can print pick tickets, packing 
slips, and acknowledgments on an order-by-order basis. 

The pick ticket includes all pertinent header and line item information, total package weight 
and a quantity shipped column. If the Use routes flag is selected in SO Static Control, the 
route will print on the pick ticket under the date. If the pick ticket was created from a Blanket 
Sales Order, the Blanket Sales Order document number will print in the description column 
before the line item or items. 

Acknowledgment Print is used to print acknowledgments on-demand. Acknowledgment print 
properties are determined in the SO Document Print Control F/M, including whether the form 
is pre-printed, and whether to print item pricing. 

Bill of Lading Print is used to print bills of lading for orders (BOLs) on demand, past invoices 
or warehouse transfer tickets. The BOL must comply with the rules determined by the DOT 
for transporting hazardous materials. For more information on hazardous materials and 
regulations, please refer to the DOT’s Hazardous Materials Guide. 

BOL print properties are determined in the SO Document Print Control F/M, including 
whether the form is preprinted, whether to print hazardous materials only, and whether to 
print item weights. If you are printing BOLs for sales orders, transfer tickets or current 
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invoices, all BOLs that are ready to print will do so through this program. If you are printing 
BOLs for past invoices, you have to specify which past invoice that you want to print. 

Use Order Review to display, place or release documents from credit or service hold. 
Documents may be displayed by warehouse, order type, order status, origin, priority, request 
date and outside salesperson. If an order is placed on hold, it cannot be confirmed, and 
therefore will not be updated by the Daily Sales Register (DSR). However, if an invoice is 
placed on hold, it will be updated by the DSR and the resulting backorder document, if any, 
will be placed on hold. 

Documents can be placed on hold through this program or during entry if the Credit Check 
flag in the Accounts Receivable Static Control is set to H-hold. The Order Review program 
displays the document number, origin, on hold status, customer number and name, 
warehouse, date entered, total of the document and the terms code. 

The Commit Backordered Quantities program is used to update non-special-ordered back-
ordered quantities, which now have available stock, on sales orders and warehouse 
transfers and to provide a report of what is updated. The report prints as the update occurs. 
You can select whether to include sales orders only, transfers only or both when the report is 
run. You also have the option to print packing slips and the transfer tickets for the documents 
that had back-ordered quantities committed. Special orders that use planned special order 
purchase orders and transfers are not processed through the Commit Backordered 
Quantities program. 

Commit Backordered Quantities processing also checks for conflicts with the Buyers Control 
Center (BCC). If tied orders exist in the BCC or the Override check box is selected for the 
BCC line, the commit quantity will not be committed by running this report. At the end of the 
report, a section lists all orders which would have been committed but had a conflict with the 
BCC. Detail information is provided so that the conflicting line(s) in the BCC can be 
addressed as needed. 

As orders and invoices are entered, some line-items have backordered amounts, usually 
because a customer ordered an amount greater than the quantity available. In time, another 
shipment of the backordered item arrives at the user’s company. Some of this new stock 
may be partially committed from special orders that were imported to create purchase 
orders; however, the rest of the quantity is available. Since the quantity is available, it can 
once again be committed by new orders and invoices, leaving none left over to fill 
backorders. 

To avoid leaving backordered quantities on permanent backorder, the system allows the 
user to run this program. This program checks orders and backorders for backordered 
amounts. The program does not check invoices, printed or confirmed orders, quotes, counter 
sales, etc. Sales orders and backorders for customers on hold are not checked for 
backordered amounts. If the program finds backordered amounts, it then looks to see if the 
item has any quantity that is available. If there is enough of the item available to fill the entire 
backorder quantity and leave at least one in stock, the system automatically commits the 
quantity and sets the backordered amount to zero. For serial or lot number items, the system 
does not commit the backordered amounts if the OE Serial/Lot Number Entry flag in the 
Sales Orders Static Control Record is set to Y. Report information includes order number, 
order type and status, requested date, warehouse code, customer number and name, item 
number and description, and the amount committed and its corresponding unit of measure. 
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Infor® recommends that you run this program after running the Purchase Order Receipt 
Register, after entering adjustments in inventory control, or after a large amount of line-items 
have been deleted or voided. If there are a large number of orders and invoices in the 
system, this program may take some time to run. 

Item Shipment Approval is used to release lines that are on-hold because the order take did 
not have security rights to the initiating and/or shipping warehouse, on multiple warehouse 
orders. Items can be viewed in item or document order. A password is required for entry. 
However, if the user is the approved user for this shipping warehouse, the password is not 
required. The approval user code and password are set up in Warehouse F/M. This program 
is only accessible if multiple warehouses are used on an order. 

How sales orders affect inventory 
As you enter items on an order, FACTS automatically commits those items in the selected 
warehouse. That means that the items are now committed to the customer indicated on the 
sales order. For tighter inventory control, however, you can override the committed amount 
and set the ordered quantity to backordered until the order is confirmed in the warehouse. 

As you enter items, FACTS displays item availability in the selected warehouse. If the items 
are not available at the time they are being ordered, you can tell FACTS to backorder them if 
allowed, and you can tell FACTS to automatically create a planned special order purchase 
order or a planned special order transfer for the item. If multiple warehouses on an order are 
allowed, the user may be able to order items from another warehouse. If a user does not 
have rights to order items from the initiating or shipping warehouses, FACTS places the line-
items on hold. Authorized users set in Warehouse Code F/M can release the items with the 
Item Shipment Approval program. 

Pricing flexibility 
FACTS displays all prices available for an item — and the customer — in the Price Options 
window while you are in the Price field during order entry. From the Price field, you can also 
perform a Price Search or you can manually override the price options by simply entering a 
price in the price field. The Order Entry program enables you to select a different pricing unit 
of measure than the ordered unit of measure. 

Printing from Order Entry 
At the end of the entry program the order, packing slip, and acknowledgment can be printed 
immediately or saved in a file for batch printing. A printed order is referred to as a print ticket. 

A bill of lading (BOL) for the order can be added and printed later. If the order sends the 
customer over their credit limit, a message may flash on the screen indicating this to the 
user. If the user has set the system to place orders on hold if the customers are over their 
credit limits, the order does not print until the document has been taken off hold. 
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Order Entry Features 

Standard orders feature 
Item standard orders are available for customers and ship-to locations. In Order Entry you 
can create standard orders on-the-fly or import them.  

When you import a standard order, it is added the end of the current order. When you make 
a standard order, the current order becomes the customer’s standard order. If a standard 
order already exists it will be replaced. Temporary items are not added to standard orders. 
Negative quantities are converted to positive amounts. Only the item and the quantity and 
the selling um are transferred to the standard order. When you edit a standard order, the 
order is displayed in Standard Order F/M. Standards orders are also available from the Side 
Bar. 

You can perform these tasks: 

• view, edit, delete, or create item standard orders 
• add standard order memos 

Negative item quantities and temporary items are not allowed. Prices and Costs are factored 
when the standard order items or entire standard orders are added to sales orders. 

The Customer Standard Order Listing (ARR765) prints a report of customer standard orders, 
including ship-to information. Information in this report is originally entered through the 
Standard Order Entry (SOE250) program. 

EWMS processing 
The Order Entry (SOE120) program checks to determine if the order you are modifying has 
been sent to Radio Beacon. If it has, and it has already been waved, you will not be able to 
change the order. If the order has not been waved, the Order Entry program sends a ‘nuke’ 
record to Radio Beacon. This record deletes the order from Radio Beacon. You must reprint 
the order before it can be picked. This program also allows you to reprint sales orders right 
from Order Entry. Select the Hot Ship checkbox to control picking priority in Radio Beacon. 

The Pick Ticket Print (SOP210) program creates flat files that are sent to Radio Beacon. 
Select the EWMS checkbox to control whether a flat file needs to be created. 

The Daily Sales Register (SOR310) program removes records from the sales order 
companion file and write them to the past invoice companion file. It also clears the ledger 
files that hold the "XC" records sent back from Radio Beacon. 
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FACTS/eStorefront integration  
The eStorefront B2C feature allows users who are unknown to FACTS to place new orders 
and check on the status of open orders. Because these users are not individually in the 
customer master file, the system uses the email address to distinguish users. When orders 
are sent from eStorefront to FACTS Order Entry, there is no indication in the record that this 
order is for a B2C customer. FACTS processing cannot check that the order has credit card 
terms instead of AR terms. It is very important that the eStorefront administrator set up the 
guest account to only allow credit card terms. 

Because the current FACTS/eStorefront integration only supports a single warehouse on an 
order, all B2C orders are processed through one warehouse. The customer record that is set 
up in FACTS to be the B2C customer has an eStorefront warehouse assigned to it. All B2C 
orders then use that customer number and subsequently that warehouse. 

The Daily Sales Register (SOR310) program removes records from the sales order 
companion file and write them to the past invoice companion file. It also clears the ledger 
files that hold the "XC" records sent back from Radio Beacon. 

When the invoice information is being written to SOPINA, for web orders the customer name 
and address will come from SORSOA instead of ARCUST. The email address will also be 
written to SOPINA data table. 

Note that document and line notes for orders entered in eStorefront do not display in FACTS 
Order Entry. 

Additional features 
The Order Entry program supports the following features.  Refer to the FACTS online help 
for details. 

Designating items for direct ship 

Using the Order Entry Menu options 

Using the Price Search 

Using the Past Sales Search 

Changing ship via 

Entering serial/lot items 

Creating BOM items (kitting, on-the-fly) 

Using the Job Costing Entry 

Customizing the main order entry screen 
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Pick Ticket Print (SOP210) processing  
As document numbers are entered, the system performs processing checks for service hold, 
type, and priority. Orders on service hold do not print a pick. If the order does not match what 
is selected, the system displays a message and removes the document number. 

A pick ticket will not print if there is nothing committed to the order and the SO Static Control 
record parameter for Pick Ticket Quantity is set to C--print committed quantity and 
backordered quantity. 

Templates that store "system date" resolve to the "current system date at the time the report 
is run" rather than what the "current system date" was at the time the template was created. 
For example: If you save a template for the Pick Ticket Print and select "Current Date" for the 
Cutoff Date field, when that template is selected to run again (either manually or via Job 
Stream) the cutoff date is determined using the current date in the Company Periods & 
Ending Dates F/M (GLF970) when the print is run not the current date when the template 
was created. 

Formatting print tickets 
Some pick ticket print properties are determined in the SO Document Print Control F/M, 
including depth of the pick ticket, whether the form is preprinted and the standard memo. 

Printing packing slips 
You can print packing slips at the time you print pick tickets, if the Use Packing List check 
box is selected in Document Print Control F/M (SOF950). Note this setting is disabled for 
Preprinted Pick Tickets. You can exclude items with zero prices from the packing list, based 
on the Print Memo setting in SO Entry Options F/M, and will not print BOM components. To 
print packing slips, you must be printing non-printed pick tickets to have the packing list 
option. The packing list always prints on the same printer as the pick tickets. 

Printing BOM items 
If an item is a bill of material item and the BOM on Pick Ticket flag is selected in SO Static 
Control, the component items used to produce the BOM item will print on the pick ticket. Pick 
tickets will be printed by all (consolidated) warehouses or by the shipping warehouse, 
depending on what the Pick Ticket Print flag is set to in the IC Warehouse F/M. 

Printing MSDS information 
If FACTS is set up to use the Material Safety Data Sheet (MSDS) System, the message 
entered in the MSDS Message on Pick Ticket field in the MSDS Control F/M will print below 
the item description for the appropriate MSDS items. If literature locations are used to 
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process MSDS sheets, the MSDS Processing flag is set to L and the MSDS by Pick 
Ticket/Invoice flag is set to P, the literature location will print before the MSDS message on 
the same line. 

Printing multiple bin locations  
If the Print Alternate Locations on Pick Ticket setting on the SO Static Control F/M is set to 
yes, the Print Pick Ticket program prints a new line after the main item line that includes all 
alternate locations set up for the warehouse/item. If the Print Alternate Locations on Pick 
Ticket setting on the SO Static Control F/M is set to no or there are no alternate locations set 
up, no additional line prints on the pick ticket. 

Direct shipment documents 
Note that pick tickets do not print for exclusively direct ship documents. The presence of a 
direct ship line on a sales order will not cause a pick ticket to print that otherwise would not. 
Meaning, if the Direct Ship on Pick setting on the Main view of Warehouse F/M (ICF970) is 
turned off and the pick does not print then it will not print with the setting on. Direct ship lines 
can print as additional lines on a pick ticket but are not considered by the system when 
determining if there is a pick to print. You can add a leading memo to the order to cause the 
pick ticket to print. 

Print notes 
The system also prints any notes flagged during SO Entry to print on the pick ticket. Urgent 
document notes print before normal document notes. Memos print before any line notes, and 
line notes print in the order of entry with no special dispensation for urgent notes. 

Ordered By information 
Based on the value of Print Ordered By prompt on the Pick Ticket tab of Document Print 
Control F/M (SOF950) and if the ordered by field is not blank, the pick ticket includes 
"Ordered by xxxxx" in the line region on the first page only after the order priority and ship 
complete information but before the blanket order or CRS information. 

Blanket Sales Orders  
The Blanket Sales Orders Subsystem (BSO) is an optional feature of the FACTS system. It’s 
located on the Orders menu (Sales Orders>Blanket Sales Orders). Blanket Sales Orders 
provides you with a method of delivering future order merchandise on time to the customer. 
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The objective of the BSO sub-module is to provide timely response to customers while 
minimizing internal costs and maximizing internal controls on orders with multiple shipments. 
This flexible module allows unlimited future shipments based on customer needs. 

Blanket Sales Orders provides the ability to accept and handle orders where the customer 
requires fulfillment with multiple shipments at specified future ship dates. For example, a 
customer wants to receive 1,000 gallons of paint over the next five months, in five equal 
shipments, with delivery guaranteed on the first of each month. Simply create the blanket 
sales order, answer a few questions about the release dates and quantities, and the releases 
of all five shipments will be calculated. Individual sales orders will be created for each 
release at the appropriate time based on the customer request dates and the item’s lead-
time. The sales orders generated are then subject to the normal sales order processing. 

Work flow 
The Blanket Order Entry program creates an order similar to an order created through Sales 
Order Entry. However, it also allows release dates to be scheduled per line-item. Since 
releases are by item, the releases of a given blanket order may be set up to release all line-
items together, or some items on the blanket order may ship at different time from other 
items. The system allows great flexibility when scheduling releases. Optionally, an order 
acknowledgment may be printed. 

The Blanket Order Release Register is run on a regular schedule, perhaps daily. This 
program determines, for each blanket order, whether the next release of each item is called 
for based on the release basis, the current date, and the customer request date of the next 
release. If the next scheduled release meets all the criteria, it will appear on the release 
register. When the release register is updated, this release is created as a sales order. 

As the created sales orders are processed, the original blanket sales order is updated so that 
all release history on the blanket sales order is available. The Daily Sales Register updates 
blanket sales order information as blanket-generated sales orders are updated. Blanket 
order processing is complete when the last release of the order is processed. 

Program concepts 
You can access the following programs from the Blanket Sales Orders menu: 

Blanket Order Entry is used to create a blanket order that allows release dates to be 
scheduled per line-item. Since releases are by item, the releases of a given blanket order 
may be set up to release all line-items together, or some items on the blanket order may ship 
at different time from other items. 

A blanket order entry consists of three sections: the header, where you enter the customer 
number, expiration date, etc.; the line-item entry, where you enter each item, price, quantity, 
and so on; the requested release dates entry; and the ending routine, also known as the 
footer, in which and the customer’s credit limit can be checked. During entry of a BSO, you 
can change, add, insert, or delete line items at any time, or delete entire unreleased or 
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incomplete BSO documents. Temporary items and catalog items are among the additional 
features available in the Blanket SO Entry Program. 

Inquiries include Interchange, Catalog, Customer Item, and Past Sales. Release requests 
may be made for an individual line item or all line items on a document. A BSO 
Acknowledgment may be printed. 

Blanket Order Acknowledgment (SOP710) is used to print and reprint the blanket order 
acknowledgment, which can be given to the customer as an order confirmation. Blanket 
Order Acknowledgment information includes item number, item descriptions, request dates, 
request status, total order quantity, order quantity per release request, and blanket order 
expiration date. This program uses the invoice parameters in SO Document Print Control 
F/M to control the print formats. 

Blanket Order Inquiry (SOI710) is used to inquire into the status of any open or completed 
blanket order. The inquiry is especially useful for locating orders for a given warehouse, 
customer, or item. The actual document may be displayed in detail through this program. 
The Blanket Order Inquiry program is the Document Inquiry in Blanket Order view. 

You can inquire by document number. Displayed information includes document number, 
type, status, and entry date, customer number and name, ship-to number, document total, 
and designated warehouse salesperson, and order priority. If the View Description 1 option is 
"off", a memo will now display in the Full Description column (at the end of the browser). If 
the View Description 1 option is "on", the memo will now display in the Description column. 

For open blanket orders, document and line notes are available to view or edit, based on 
your user security access. For past documents, notes are only available to view/edit (, based 
on your user security access) from the Invoice view (accessed by the Invoice button) of 
Document Inquiry. 

Documents that are archived in UnForm are available for viewing from literally hundreds of 
programs throughout FACTS. Throughout the Document Inquiry view, look for buttons or 
hyperlinks that refer to Archived Doc, Archived Pick, Archived Inv, Archived BSO to view the 
archived document that contains a line in the inquiry browser. 

Blanket Order Report is used to list release requests on open blanket orders and determine if 
any releases need to be processed. This program provides a report of all orders currently on 
file in the BSO subsystem. This report is designed to track the status of the entire blanket 
document as well as the status of each individual request on the order document. It provides 
the user with information from the blanket document, as well as, information from any related 
sales order document when applicable. 

Report information includes the following: document number, return entry date, customer 
number, return warehouse, header ship complete, order priority, document line number, item 
and description, reason code, return quantity, unit of measure, price and pricing unit of 
measure, price extension, line status, document total, and credit memo or sales order 
document number (when applicable), or vendor number, name, vendor return document, line 
number and status (when applicable). This report differs from the Returns Analysis Report in 
that it includes pricing information. 

Blanket Order Removal is used to remove completed BSO documents that do not need to 
remain on the system. This program automatically removes completed BSO documents, 
including notes, based on your entries. This program skips any BSO document tied to an 
active SO document. This program is especially useful for removing large numbers of 
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documents, e.g., all documents for a specific customer, or particular warehouse based upon 
document completion date. 

Blanket Order Release Register is used to determine, for each blanket order, whether the 
next release of each item is called for based on the release basis, the current date, and the 
customer request date of the next release. If the next scheduled release meets all the 
criteria, it will appear on the release register. This program automatically generates sales 
orders and/or purchase orders based on the BSO document release request dates. The 
program cannot process expired documents, documents on hold and locked documents. The 
Blanket Order Release Register processes rush orders before BSO documents with a 
normal or service hold order status. The program steps through the next scheduled request 
for each document line-item, taking the request date, subtracting any additional days 
padding from the line entry and from the header, and subtract either the lead time for the 
item or the number of days from the Sales Order Static Control F/M. For lines flagged for 
immediate release, the system will not release all other requests with the same request date. 

Operating tips and suggestions 

Release basis 
The release basis determines when the next release must take place, based on the request 
date. Regardless of the release basis selected, when the system calculates that a release 
should take place, the system will release all items that have the same request date as one 
sales order. 

Longest lead time 
Longest lead-time is the longest average lead-time of all the items on the blanket order, 
which have the same request date. To ensure that inventory is available for a requested 
shipment, the system must attempt to commit merchandise based on the longest average 
lead-time for those items. 

Fixed days 
When fixed number of days is used for the release calculation, sales orders will be created 
this number of days prior to the request date. For example, in order to maintain customer 
service levels, you may always commit goods two weeks prior to the request date. The two 
weeks allows time to special order, restock or transfer goods into the warehouse. In this 
example, fixed days would be set to 14 days. 

Greater of longest lead time and fixed number of days 

The system looks at the longest lead-time and the fixed number of days, and selects the 
greater of the two to determine when to release the sales order. This is the most common 
method for calculating the release basis. 
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Initial setup  
The setup required to begin using the Blanket Sales Order program is minimal; however, 
there are several questions that you should consider prior to set up. Your answers to these 
questions will determine how you set up your system controls, in accordance with your 
company’s policies and procedures. 

• Do you want item usage figures to be updated by the BSO subsystem? 

• How do you determine on what date a sales order should be created to ensure that items 
are shipped in a timely fashion? Do you calculate release dates based on item lead-time, by 
a fixed number of days, or by the greater of the two? 

• What is the normal lead-time for the most commonly ordered non-stock items? 

Invoices  
The Sales Orders Invoices system allows you to confirm orders, enter direct invoices (which 
do not create work orders), enter credit memos, print invoices and credit memos, and update 
the documents to all the appropriate files in the system through the Daily Sales Register. 

Two additional subsystems are accessible from this menu: Counter Sales and Recurring 
Invoices. 

Program concepts 
The Invoices menu contains these programs: 

Order Confirmation (SOE310), is used to tell the rest of the FACTS system what was pulled 
from inventory, what was shipped, what was backordered, what the final freight and handling 
charges were, the amount discounted from the order and how much tax was charged for 
each order. Once you complete the confirmation process, this program converts the order to 
an invoice. The Order Confirmation (SOE310) program does not allow confirming of orders 
that have been sent to Radio Beacon. The upload stock picks program does that for you. 

Direct Invoice Entry (SOE510) is used to correct confirmed orders that have been converted 
to invoices. You can also use it to enter invoices directly in situations where the order has 
already been processed and shipped and needs to be invoiced. The Direct Invoice Entry 
(SOE510) program does not allow changing of shipped quantities on Radio Beacon 
controlled lines. You will be allowed to change pricing and other non-Radio Beacon 
controlled fields. 

In the footer window of Order Confirmation and Direct Invoice Entry, if any credit card pre-
authorizations exist an ‘alert’ message, Note: PreAuths Exist, is displayed at the bottom/left 
of the Footer screen. 

Credit Memo Entry (SOE330) is used to enter customer credit memos, into the sales orders 
processing cycle edit and delete existing credit memos and refund Counter Sales. 
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Invoice & Credit Memo Print (SOP310) is used to print and reprint invoices, as well as and 
credit memos. The printed invoice or credit memo includes all pertinent header and line-item 
information, addresses and totals. Order Confirmation, Direct Invoice Entry, and Credit 
Memo Entry programs also print through this program when you indicate that you want to 
print individual documents. Invoice numbers (not to be confused with document numbers) 
are assigned just before each document is printed. Invoice numbers are not affected by 
reprinting. If the invoice was created from a Blanket Sales Order, the Blanket Sales Order 
document number will print in the description column before the line-item(s). Use the SO Bill 
of Lading Print program to print a bill of lading for an invoice. 

Route Release (SOU310) is used to release invoices tied to specific routes so that the 
invoices print on the Daily Sales Register. This program is not available if the Use Routes 
flag in the SO Static Control F/M is not selected. 

Daily Sales Register (SOR310) is used to Print a daily sales register of all confirmed orders, 
invoices, credit memos and counter sale slips, build and print a general ledger distribution, if 
needed, post to accounts receivable and if the GL distribution is built, to general ledger 
according to the sales information, and update inventory, sales orders, and the Sales 
Analysis Holding File according to the sales information. 

Order confirmation 
Orders entered through the Order Entry Program are confirmed (or invoiced) through the 
Order Confirmation Program. In other words when the order is shipped, and ready to be 
billed, the order may be converted into an invoice. In the Order Confirmation program, the 
user enters the order number and the order is displayed in its entirety. If multiple warehouses 
are on the order, the user has the choice of which warehouse(s) to confirm. The program 
asks what to do with the committed quantities on the order (backorder, confirm shipment, 
etc.). The user then has to confirm the invoice date, ship date, etc. At the end of the 
program, the user may enter the off invoice discount, tax and freight (if applicable). Once the 
order is confirmed it is now considered an invoice and may be corrected through the Direct 
Invoice Entry Program. The invoice may be printed at the time of confirmation or printed 
through the Invoice and Credit Memo Print Program. 

A sales order can be confirmed even if it has not yet been printed from either the Order Entry 
or Pick Ticket Print programs. 

You can open a partially confirmed order to complete the confirmation process as long as 
you did not print an invoice. If you print an invoice before the whole document is confirmed, 
you must confirm the rest of the document after the next Daily Sales Register run. 

The program only accepts sales order type document numbers. If you enter a document 
number related to blanket sales order, direct or recurring invoice, service order or counter 
sale, the system prompts you to select a document to confirm. 

You cannot confirm an order that is already fully confirmed, nor can you confirm an order that 
has been deleted. 

You cannot confirm an order that is on service hold. 
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Order Confirmation checks to determine if the order is ready to be shipped. If it is not, the 
system displays a message indicating this and prompts you to confirm the sales order 
anyway. If you select not to confirm, the system returns you to document number prompt. 
Refer to the Ship Complete Feature Overview topic for details. 

Once a document is fully confirmed, changes must be made through the Direct Invoice Entry 
program (Sales Orders>Invoices>Direct Invoice Entry). 

Over Commitment of serial/lot items: If the OE Serial/Lot# Entry flag in SO Static Control is 
set to "M" or "N" then you can under commit serial/lot items. Refer to the Over Commitment 
of Serial/Lot Items topic. 

Confirming orders with multiple warehouses 
If the document has lines shipping from multiple warehouses, the system prompts you to 
select which warehouses to confirm. After you select warehouses, the system checks for 
shipment eligibility for each of the selected warehouses individually. If any warehouse does 
not meet requirements for shipping, the system displays one message listing all ineligible 
warehouses with the option to confirm anyway. If the pick ticket prints consolidated and all 
warehouses are selected, the system evaluates all warehouses individually and all 
warehouses are ineligible to ship, the system displays a message indicating all warehouses 
are ineligible. If you select individual warehouses to confirm, each will be evaluated 
separately and any that are not eligible to ship display in one message listing all the 
warehouses. 

Access this program by choosing Sales Orders>Invoices>Order Confirmation. 

Entering direct invoices and credit memos  
To enter invoices directly into the system (i.e., without processing an order), use the Direct 
Invoice Program. This program is similar to Order Confirmation except that the invoice must 
be entered in its entirety, indicating that the items ordered were shipped or backordered; on 
hand quantities are reduced immediately by the quantity shipped. If multiple warehouses on 
an order are allowed, the user may enter items from different warehouses on the same 
invoice. At the end of the program, the user may enter the discount, tax and freight, (if 
applicable). The invoice may be printed at the time of entry or added to the Reprint File for 
batch printing. 

Credit memos are entered through the Credit Memo Entry Program. Because it is a credit 
memo program, there is no need to enter negative (-) numbers. The system automatically 
inserts negative signs. At each line-item the user must indicate whether the credit is a return 
or allowance. A return indicates to the system that the item has been returned and inventory 
has increased immediately. An allowance indicates the credit memo is issued but no items 
are returned. If multiple warehouses on an order are allowed, the user may enter line-items 
from different warehouses on the same credit memo. The discount, tax and freight may also 
be credited (if applicable). The credit memo may be printed at the time of entry or added to 
the Reprint File for batch printing. 
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Printing MSDS information 

If the Print MSDS Literature Location flag in the MSDS Control F/M (SOF985) is set to I, this 
program will print the MSDS literature locations or print the message "MSDS included" on 
the invoice for items that require an MSDS. 

Be sure to include partially completed orders that have been zeroed out and orders with only 
backordered amounts. Even though the system does not print invoices for these orders 
(since there is no amount due), they must be run through this program so that the Daily 
Sales Register can process them. 

Setting invoice and credit memo print parameters 

Some invoice and credit memo parameters are determined in the Sales Orders Document 
Print Control Record including depth of the invoice/credit memo, whether the form is 
preprinted, and the standard memo. 

Printing ordered-by information 

Based on the value of Print Ordered By prompt on the Invoices or Credit Memo tabs of 
Document Print Control F/M (SOF950) and if and the ordered by field is not blank, the 
invoice or credit memo includes "Ordered by xxxxx" in the line region on the first page only. 

Printing BOM items on invoices and credit memos 

Make sure the BOM on Invoice flag is set to Y in the Static Control F/M. The component 
items used to produce the BOM item print on the invoices and credit memos when this flag is 
selected. 

Notes 

The system also prints any notes flagged during Direct Invoice Entry or Credit Memo Entry to 
print on invoices and credit memos. Urgent document notes print before normal document 
notes. Memos print before any line notes, and line notes print in the order of entry with no 
special dispensation for urgent notes. 

Freight 

When you sort the invoices by shipping warehouse, a line prints with warehouse, ship via 
and freight charges before the line’s shipping for each warehouse. If the document freight 
method is quoted, the freight charges do not print on this line. The total freight charges 
continue to print at the bottom of the invoice. 

Route release 

If routes are used, each customer may be assigned to a route. The route is then entered for 
each quote, order or invoice entered, defaulting to the route assigned to the customer. 
Orders and invoices can be printed according to specific routes. These orders or invoices are 
then usually sent out on the delivery truck by route when the goods are being delivered. 
These invoices are not printed on the Daily Sales Register (i.e., posted to the Accounts 
Receivable Open Receivables File) until the route has been approved and subsequently 
released. 

For example, on Tuesday a truck goes out with TUE route invoices. When the Daily Sales 
Register is printed on Tuesday, TUE invoices do not appear because the Route Release 
Program has not been run for route TUE. This is because the TUE invoices are still on the 
delivery truck and some merchandise might have been refused, i.e., some corrections may 
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have to be made to the TUE invoices before updating them to accounts receivable. Only 
after the truck has returned with the invoice slips and the corrections have been made to 
these invoices should the TUE route be released. After the route has been released, the 
Tuesday invoices will print on the next Daily Sales Register to post to accounts receivable. 

Daily Sales Register 
Use the Daily Sales Register to print a report of all confirmed orders, invoices, credit memos 
and counter sale slips. You can also print a general ledger distribution and update the 
system with the transactions that appear on the report. 

Use the Daily Sales Register (DSR) program to: 

• Print a daily sales register of all confirmed orders, invoices, credit memos and 
counter sale slips. 

• Build and print a general ledger distribution, if needed. 
• Post to accounts receivable and if the GL distribution is built, to general ledger 

according to the sales information. 
• Update inventory, sales orders, and the Sales Analysis Holding File according to the 

sales information. 
• Update warehouse and order line Balance Complete status to Ship Complete. 
• Print summary or detail information. 
• Copy document notes to past invoice notes and delete notes when documents are 

deleted or lines are complete. 

Summary information includes invoice number, date, terms code, initiating warehouse, 
salesperson/territory, department, document number, customer number and name, sales 
cost, margin, tax, freight, discount and total. 

Detail information includes summary information plus, for each line-item, line number, item 
number, description, quantity, selling unit of measure, shipping warehouse, cost, costing unit 
of measure, price, pricing unit of measure, extension, margin, item class, taxable flag, 
miscellaneous sales flag, Temporary flag, return or allowance flag, GL table flag and 
commission percent. 

Usage: The Daily Sales Register Update assigns usage to the ship warehouse only if the 
Replenish flag on the Main view of Warehouse/Item F/M (ICF920) is set to Y. If this 
Replenish setting is not Y, then program does not update the ship warehouse’s usage. As 
the program reads each line item, the update ship usage flag is set to true. Then, if the ship 
warehouse and initiating warehouse are not the same, the system reads the ICWHSE record 
for the initiating warehouse. If there is no record or the replenishment flag is not Yes, the 
update ship usage flag will remain unchanged. If the Replenish flag on the Main view of 
Warehouse/Item F/M (ICF920) is Yes, then the update ship usage flag will be changed to No 
indicating that the initiating warehouse usage is to be updated and not the ship warehouse 
usage. If the update ship usage flag remains unchanged (true) or Yes, then the program 
checks the Replenish flag for the shipping warehouse. If it is Yes, the usage is updated. If it 
is not Yes, then the ship warehouse usage is not updated. 
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Subtotals are included for cash and AR totals. Register totals include the total number of 
invoices and the average invoice amount along with the total sales, cost, margin, tax, freight 
and overall total. 

The DSR prints recaps by terminal, warehouse, salesperson and terms code if configured to 
do so in the SO Static Control F/M. If the DSR Recap MTD flag is set to Y in the SO Static 
Control Record, information in the Sales Register Recap F/M program is used to print the 
Period Sales Register and the period-to-date information on the Daily Sales Register. For 
remote orders (R-Origin), the DSR shows a section for "Origin" with breakouts for "Remote", 
"Non-Remote", and "Web" order details. 

The DSR prints an asterisk beside the document number (as indicated in the legend) if the 
document was edited after the invoice was printed. If printing the DSR in summary, no 
additional information will be printed. If printing in detail, each individual occurrence of a 
change will be printed, including the user code, terminal ID, date and time. 

Additionally, the DSR also indicates the user code, terminal ID, date and time for each 
deleted document. 

You can elect to build a general ledger distribution, according to one of three formats, or skip 
the distribution altogether. The GL distribution information includes GL account number, 
description, customer number, name, ship-to number, invoice number and the amount to be 
debited or credited. 

The Daily Sales Register updates these modules. 

• Accounts Receivable - Customer Balances, Sales History, Open Receivables File and 
Sales Tax File. 

• Sales Analysis - uses the API toolkit to publish the invoices via XML. If multiple 
warehouses are being used, credit for sales for shipping warehouses will be based on 
the Shipping Warehouse Sale Percent flag in the IC Warehouse F/M. 

• Sales Orders - Monthly (period) Sales Register, Past Sales History File and past invoice 
information. Backorders are also updated for any orders that were not shipped in full. 

• Inventory Control - sales history (in the Item File and also in the Warehouse File). 
• General Ledger - journal entry. 
• System Management - Bank Transaction system for cash type terms codes (C,1-4) that 

have the cash GL# set to "BANK". 

Over-commitment of serial/lot items 

The over-commitment of serial/lot items is not allowed in Order Entry and Confirmation Entry. 
If the OE Serial/Lot# Entry flag in SO Static Control is set to "M" or "N" then you can under 
commit serial/lot items. In the Daily Sales Register, if the Serial/Lot shipped amount doesn't 
match the order's shipped amount the system now displays a message and return to the 
menu and no longer displays an error 40. The system also displays a message if the 
Serial/Lot committed amount is greater than the order's committed amount and returns to the 
menu. Refer to the Over Commitment of Serial/Lot Items topic for more information. 

Overpayments or remaining deposits 

You cannot exit an invoice without indicating what is to be done with any overpayment 
or remaining deposit. Overpayments or remaining deposits can be applied on 
account, refunded, transfer If for some reason the swipe device is not working or the 
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credit card processor is offline, the person entering the credit card transaction will 
need to call the processing company and specify the provided authorization code. 

At the end of the transaction, FACTS checks to see if you are signed on to a cash 
drawer. If not a message indicates for you to do so. Press F2 to search.red to another 
document, and so forth. If the invoice print process detects an overpayment remaining on an 
invoice, "deposit held" or "applied on account "prints on the invoice, based on processing in 
the Daily Sales Register (SOR310) program. If the Daily Sales Register (SOR310) 
processing detects an overpayment, it will determine whether there will be a backorder 
generated for this document. If there is a backorder, the overpayment will be converted to a 
deposit on the document. If no backorder will be created, the overpayment will be applied on 
account. If the Daily Sales Register (SOR310) detects a deposit remaining on a completed 
document, the deposit will be applied on account. Payments applied on account from Sales 
Orders, via the Daily Sales Register (SOR310), now update the last payment date in the 
customer master record. 

Counter Sales  
Counter Sales acts as a point-of-sale system, providing capabilities such as deposit 
handling, multiple payments, cash drawer and tray handling, credit limit checks, credit card 
handling (with CenPOS integration) and register balancing with Z-out reports. It also allows 
you to backorder items and drop ship them, check warehouse quantities, search for items, 
customers and documents, and review past sales and quotes. 

Program concepts 
The Counter Sales menu contains these programs: 

Counter Sale Entry (SOE510) is used to create point of sale documents. 

Counter Sale Print (SOP320), which prints counter sale documents in batch or documents 
not printed on the end of a sale entry. Counter Sale Print can also be used to batch print 
(and reprint) groups receipts. Printed counter sales receipts include all pertinent header and 
line-item information, addresses and totals. Use the Sales Orders Document Print Control 
F/M to change the depth of the counter sales receipt, indicate that the form is preprinted, 
enter the standard memo, etc. This also enables you to use the same format — and 
preprinted forms — for counter sales receipts, invoices and credit memos. 

You can also print sales receipts from the Counter Sale Entry program. Invoice numbers (not 
to be confused with document numbers) are assigned just before each document is printed. 
Invoice numbers are not affected by reprinting. 

Cash Drawer F/M (SOF610) is used to set up cash drawers in FACTS. It also allows you to 
see which terminals are signed in to which drawers. 

Cash Tray F/M (SOF620) is used to create, or if necessary, delete cash trays, which are 
assigned to cash drawers in the Update Shift program. 
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Cash Drawer Sign On (SOE650) is used to sign onto a drawer in this program; the system 
ask them to sign on when they enter a cash-type payment in Counter Sale Entry or 
Payment/Deposit Entry. If the system does not require you to sign on in those programs, 
check that the SO Static Control Use Cash Drawer Handling flag is selected. 

Cash Drawer Sign On also serves as inquiry since it allows you to review which cash 
drawers are in use and which terminal, or user, is signed on to it. 

Balance Cash Tray (SOR840) is used to ensure that trays balance at the end of each shift 
(after the Update Shift program). currency calculator is built into this program to help you 
count the amount of currency, coins, checks, credit card slips and other legal tender taken 
into the drawer during the shift. 

If there is a discrepancy in a tray, you can assign it to a specific branch or let the program 
distribute it proportionately among the branches. Any discrepancies will post to the DSR. 

After you finish counting a tray, you can print a Z-out report, which lists the tray’s activities for 
the shift. Once balanced, the tray can be assigned to another drawer. You cannot access 
this program if the DSR is in the middle of an update. 

Update Shift (SOU840) is used to place trays in drawers and to assign starting amounts to 
trays and remove trays from cash drawers so they can be balanced in the Balance Cash 
Trays program. If you use cash drawer handling, use this program before Cash Drawer Sign 
On at the beginning of each shift and before Balance Cash Trays at the end of each shift. 
Update Shift is the program enables you to place trays in drawers and to assign starting 
amounts to trays. It also allows you to remove trays from cash drawers so they can be 
balanced in the Balance Cash Trays program. 

Assigned trays are removed by assigning a new tray to a drawer in this program’s Cash Tray 
ID field (see below). For example, if you want to remove tray dd1 from drawer ssi, enter 
another tray ID, say dd2. Once you specify another tray, it is ready to be balanced in the 
Balance Cash Trays program. 

Operating tips and suggestions 
Counter Sales is effectively the entire sales order process rolled into one program; it is 
structured so that you can service walk-in and established customers alike as quickly as 
possible and still tie into FACTS.  

Distributors that don’t need the cash drawer handling features available in this system can 
still benefit from the Counter Sale Entry program. This program can be used to process 
orders quickly without requiring users to run through each of the programs normally involved 
in the sales order process. Counter Sales documents, also called sales receipts, can be 
printed in batches to further speed the order entry process. Small staffs with generalized 
responsibilities that process large volumes of orders may find this entry program useful. 
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Setting up the Counter Sale system 
To use the complete Counter Sales system with cash drawer and tray handling, several 
programs in the Counter Sale menu will need to be set up and a few file maintenances will 
need to be edited. 

Terms codes 
If you have not already done so, you will need to establish the payment types that will appear 
in the Counter Sale Entry footer. This step may be unnecessary since several order entry 
programs, as well as Payment/Deposit Entry, also use this information. If this program has 
not been set up, FACTS reminds you to do so when you try to open Counter Sale Entry.      

From the Counter Sale Menu, enter the access code navigate to the SO Infrequent File 
Maintenances menu and select Terms Code Order Setup from the Infrequent File 
Maintenances menu.     

Begin by entering a cash-type terms code (set in Accounts Receivable Terms Code F/M). 
Press F2 to search the available codes, then enter a user-defined description. FACTS only 
accepts cash-type terms codes in this F/M, which are those that are designated as type 1 
through 4.    

Use the up and down arrow keys to select, move, insert, edit or delete the six terms codes so 
they are in the order in which they need to appear in the ending routine.  

Cash drawers and trays 
Cash drawers can be simple shoe boxes or sophisticated peripheral devices. Either way, 
setup procedures are essentially the same.   To enable cash drawer and tray handling in 
FACTS, set the Use Cash Drawer Handling flag located on the Use tab of SO Static Control. 
Then refer to the Cash Drawer F/M and Cash Tray F/M sections.     If you use cash drawers 
that interface with your terminals or PCs, your Affiliate will need to create link files and install 
device drivers. In addition, a hotkey that automatically opens the drawer should be set up in 
Terminal F/M. 

Work flow 
At the beginning of a shift, open Update Shift to open a drawer, assign a tray to it and place 
an opening amount in the tray.   

Have your sales clerks sign on to cash drawers in Cash Drawer Sign On. This program 
shows you which drawers are already in use and tells you which terminals (users) are signed 
on to them. If someone forgets to sign on in this program, the system will prompt them to do 
so when they enter a cash-type payment in Counter Sale Entry or Payment/Deposit Entry. 

Begin entering sales in the Counter Sale Entry. 
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At the end of the shift, open Update Shift to remove trays from their respective drawers. 
Trays are actually removed by assigning another balanced tray to the same drawer. Once 
another tray is assigned, the first tray is automatically removed and ready to be balanced. 

Open Balance Cash Trays to count out the trays and run Z-out reports, which are printouts of 
the transactions run through those trays. A currency calculator is available to help you keep 
an accurate count of currency, checks, credit card slips, etc. 

Once a tray is balanced it can be assigned to another drawer. 

At the close of a day, make sure all drawers are signed off by entering Cash Drawer Sign On 
and setting each drawer to NONE. 

Counter Sale Entry Processing Details 

The Counter Sale Entry screen is divided into three sections: the header portion where you 
enter the customer placing the counter sale and other general information required to 
process the counter sale, the line item portion where you add items, quantity and pricing 
information, and the footer window where you enter final fields prior to completion of the 
counter sale. 

Counter Sale Print (SOP320) Notes 
The system also prints any notes flagged during Counter Sale Entry to print on receipts. 
Urgent document notes print before normal document notes. Memos print before any line 
notes, and line notes print in the order of entry with no special dispensation for urgent notes. 

To use the invoice format on counter sale documents: 

1. Click Sales Orders>File Maintenances>Infrequent File Maintenances>SO Document Print 
Control F/M. 

2. Click Counter Sales, and set the Print Format option to Use Invoice Format. 

3. Save and exit. 

Printing BOM item components on counter sale receipts 

If an item is a bill of material item and the BOM on Invoice flag is set to Y in SO Static 
Control (Inventory tab), the component items used to produce the BOM item print on the 
counter sale receipt. 

To print an alignment, select Printer Options>Print Alignment. 

Recurring Invoices  
You can use the Recurring Invoices subsystem to generate any invoices that need to be sent 
on a recurring basis (e.g., service contracts or blanket orders). It enables you to set up the 
document one time and to have the system automatically post it to the Sales Orders 
Document File for each month designated. It also makes it possible for you to set up a cutoff 
so that the monthly posting stops at a predetermined time. 
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As with regular invoicing all recurring documents are entered using the customer number 
and item number, etc. 

Program concepts 
The Recurring Invoices menu contains these programs: 

Use the Recurring Document Entry program to enter recurring customer invoices to post into 
the sales orders processing cycle. 

The Recurring Document Entry screen consists of three sections. The upper portion of the 
screen is called the header portion where the customer number, ship date, etc. are entered. 
The middle portion is called the line-item portion where each item, price, quantity, etc. is 
entered. The lower portion, which shows up after line items are entered, is called the ending 
routine and consists of the final inputs prior to completion of the document. The screen is 
designed to look like a printed invoice. You have the option of changing, adding to, removing 
line items from or deleting the recurring invoice at any time. 

Use the Recurring Document Listing program to obtain a listing of all recurring documents on 
file. An optional update allows removal of expired documents. If only expired documents are 
selected, an optional update which follows the following printing of the listing, allows the 
removal of all expired documents just printed. Report information includes the following: 
customer number, name, sequence number, ship-to number, warehouse to be shipped from, 
salesperson/territory, terms code, tax code, whether to print the document as a work order 
and/or an invoice, day of month to post, months to post, total document amount, total 
number of documents and dollars posted, memo and status. 

Use the Post Recurring Documents program to post recurring documents into the Sales 
Order processing cycle based upon the post month and day for the current period. The 
program recalculates all commission percentages on lines not flagged as commission user 
override as the SO document is created. The Post Recurring Documents processes any 
Rush orders before any normal or service hold. 

Start by selecting the day through which recurring documents are to post. 

This program must be run in order to bill customers. 

Recurring Document Entry does not allow for multiple shipping warehouses. When recurring 
documents are being posted, the system sets the document freight method from the 
customer record. If the Freight Method is quoted, the system uses the freight in the recurring 
document header in the quoted freight amount field. 

If the Freight Method is calculated: 

• Because recurring documents are a contracted with the customer, even if the freight 
method for the customer is calculated, the system uses the freight from the recurring 
document header. 

• if the freight amount in the header record is not zero, the freight amount is used in 
the SOFRWH record of the initiating warehouse and the user-override flag is set to 
"Y" (selected). 
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• if the freight amount in the header record is zero, a zero freight amount is used in the 
SOFRWH record of the initiating warehouse and the user-override flag will be set to 
"N" (unselected). 

Shipping  
The Shipping Subsystem is a manifest system that handles multiple carriers but is geared 
mainly toward UPS. 

UPS requires that companies use a UPS approved shipping package. Contact your FACTS 
affiliate if you have questions about which shipping software system you should use. 

Program concepts 
The Shipping menu contains these programs: 

Freight Entry Program, is used to enter orders into the freight manifest system. Each order 
you enter appears on the manifest when you print it. You should enter orders by sales order 
number or consignee and ship via. In other words, enter all the packages to the same 
address using the same ship via on the same freight entry (this saves time and reduces 
errors in entering header information). 

Freight orders can be entered for any warehouse. Keep in mind that the shipper number is 
determined by the warehouse (stored in the Warehouse File), and the charges are based on 
the zone, which for ground service, is also warehouse dependent. 

The system stores default zones in both the Customer File and the Ship-To File. During 
header entry the program displays the latest default zone, the entered zone if any, and the 
zone calculated by the zip code. You must select the correct zone. NOTE: UPS has different 
zones for rural and urban Alaska. 

The Freight Entry Screen consists of two sections. The upper portion of the screen is called 
the header portion where the customer number, ship via, and department are entered. The 
lower portion is called the line-item portion where each package, weight, value, etc. is 
entered. During the entry of an order, the user has the option of changing, adding to, 
removing line items from, or deleting the order at any time. 

Shipping Label Print outputs UPS-style labels for sales and freight orders. The Shipping 
Label Print Program is identical to the UPS Shipping Label Print Program in the way each 
works. The difference between the two is the output. This program prints a label 4 1/8 x 2 
15/16 inches. The UPS shipping label is 2 15/16 x 5 3/4 and subscribes to UPS regulations. 
This program is also called by the Freight Entry Program when printing freight orders with a 
ship via other than UPS. Print up to 99 labels for each document entered. Also print shipping 
labels for freight and sales orders by warehouse. 

Use the UPS Shipping Label Print program to print UPS-style shipping labels for sales orders 
and freight orders. The UPS Shipping Label Print Program is identical to the Shipping Label 
Print Program in the way each works. The difference between the two is the output: This 
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program prints shipping labels that measure 2 15/16 x 5 3/4 inches. The Shipping Label Print 
Program prints a general mailing label 4 1/8 x 2 15/16 inches. Print up to 99 labels for each 
document entered. Also print shipping labels for freight and sales orders by warehouse. 

Use the UPS C.O.D. Label Print program to print regulation UPS C.O.D. labels for sales 
orders and freight orders. Even if you are not using a computerized manifest system, this 
program can be run to print multiple C.O.D. labels. Enter the information in Freight Entry or 
pull over the sales order, and enter the C.O.D. amount for each package. Then, run this 
program to print labels for each individual package. You can also enter the invoice number 
and C.O.D. amount through this program. The UPS C.O.D. Label Print program prints all the 
required data on the preprinted UPS C.O.D. label. According to the Use Alt Ctl # flag in the 
Shipping Control Record, the system prints the invoice or freight order number on the label 
as well as the preprinted UPS number. If the alternate control number is used, UPS tracks 
the C.O.D. package through the number; it does not track it by the preprinted UPS number. 
You can also print C.O.D. labels for freight and sales orders by warehouse. 

The labels created by these 3 programs are not approved by the carrier. 

Freight Manifest Print program prints the manifest that is required by the carrier. It can print 
all the manifest orders for UPS 1st Day Air, 2nd Day Air, all UPS manifest orders, or orders 
for another carrier. This program prints separate manifests by ship via code to accommodate 
multi-carrier functionality. Note: The manifests created from this program are not UPS-
approved. This program prints a summary of all line-items (packages) in the Sales Orders 
Freight Order File that possess the required criteria. Print manifests on 8 1/2 x 11-inch paper 
and in compressed print, so the manifest will fit in 132-column format. Manifest information 
includes the following: manifest date, shipper’s address and number, invoice number, 
consignee and the consignee’s address, UPS zone, package weight, freight charge, C.O.D. 
amount, declared value, and if the package uses the GroundTrac service, if it is oversized or 
if a call tag has been issued. The manifest also sub-totals every one hundred packages. A 
summary is printed for each zone, including the number of letters, number of packages, total 
weight, total freight charge, number of C.O.D. packages, total C.O.D. charges, total 
insurance charge, and total number of call tags. The summary concludes with the total 
number of GroundTrac packages on the manifest, total number of C.O.D. packages, total 
C.O.D. charges, and total UPS revenue. You have the option of printing manifests by 
warehouse and multiple warehouses. If printing by multiple warehouses, the program uses 
the shipper number from the first warehouse code entered. 

The Freight Inquiry program allows you to view any shipment in process or any past 
shipment. Open freight orders (in process) can be viewed by a warehouse, or customer. Past 
freight orders are also customer and warehouse specific, as well as date sensitive. The 
inquiry displays the documents as they appeared in Freight Entry, with two exceptions: when 
the current warehouse is set to ALL, the warehouse for the freight order is displayed, and if 
viewing the past freight orders, the date of shipment appears. The Freight Inquiry is helpful in 
tracking shipments for customers and/or warehouses. It also enables you to find out exactly 
what date a sales order or package was shipped. 

Use the Freight History Report program to print a history of the manifests that have been 
shipped. The report shows the manifest as it appeared the day the carrier picked up the 
shipment. This is helpful in finding out when an order was shipped, what day it went out, etc. 
Report information includes the following: manifest date; shipper’s address and number; 
invoice number; consignee and the consignee’s city, state, and zip code; UPS zone; 
package weight; freight charge; C.O.D. charge and amount; declared value; insurance 
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charge; the total charge; whether the order uses the GroundTrac service; and whether the 
package is oversize or a call tag has been issued. This also provides a hard copy of past 
manifests (which UPS requires to be on file for one year). 

Use the UPS Chart Print program to print a zip code to zone conversion chart or a rate chart 
based on weight and zone. Both of these charts are required by UPS, when using their 
computerized manifest system. The Zone Chart prints a listing of each warehouse’s zip-zone 
conversion. It shows the zip code prefix and the zone for that prefix. The Weight Chart prints 
the rates for one pound to seventy pounds for the zones selected. Printed are the zone, the 
pounds, and the rate. 

Work flow 
The Shipping Subsystem integrates sales orders shipments as well as the occasional non-
invoiced shipment. The Freight Entry Program prompts you for an invoice number, if you 
enter an invoice number, the system automatically pulls over the customer, address and ship 
via. If the invoice changes, the Freight Entry Program makes the necessary adjustments 
when you enter the invoice number after the changes have been made. It is not necessary to 
delete and reenter the freight information for changes to the header on the invoice. 

If the entry on the manifest does not stem from an invoice, you can enter an order number 
that is not on file. The program perceives this entry to be a non-invoiced entry, and it appears 
on the same manifest as the sales orders shipments. This allows shipments from 
departments other than sales. 

Contract pricing  
The Contract Pricing Subsystem is an optional feature of the FACTS System. The Contract 
Pricing subsystem allows you to enter, maintain, list, and remove existing contract prices. 

Program concepts 
These programs are available in this subsystem. 

Contract Entry (SOE560) is used to enter and/or maintain contract prices. You can also 
access a delete option for active contracts. The entry screen consists of four sections: 

• header, where you can specify that the contract is for all customers and/or items, the 
contract type, the effective and expiration dates and whether the contract is for all 
direct ships or all warehouse ships . 

• standard pricing, where you enter contract standard pricing and commission 
information for the customer/item scope selected. 
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• price level pricing information, where you enter contract price level and commission 
information for the customer/item scope selected. 

• quantity break pricing information, where you enter contract quantity breaks, prices 
and commission information for the customer/item scope selected. 

Contract Listing (SOR510) is used to obtain a listing of selected existing contracts entered 
through the Contract Entry program. You can specify: whether to print based on contract 
status--current, future and/or expired contracts, print based on the ‘approved or not 
approved’ setting, contract type, contract selection method, units of measure, whether to 
print standard price and price levels and/or quantity break prices, and whether to print actual 
prices along with planned special order/existing contracts. 

Expired Contract Removal (SOU520) is used to automatically remove expired contracts 
entered through the Contract Entry program. You can delete individual active contracts within 
the Contract Entry program. However, you can use this to remove batches of related expired 
contracts — for example, all contracts for a specific customer, a specific item, etc. You can 
specify: to remove based on an expiration date, customer scope for remove by criteria, item 
scope for remove by criteria and beginning and ending scope choice to remove. It may be 
helpful to first run the Contract Listing program to generate the list of contracts to delete. 

The Contract Hierarchy F/M is an optional program that allows you to set the hierarchy for 
contract prices. This hierarchy provides the order in which contract prices are searched 
during the Sales Order Entry programs. In the SO Static Control F/M, the Default Price 
control determines what priority the order entry programs give contract prices in relation to 
other types of prices set up in the system. Contract prices will not appear in Sales Order 
Entry programs if the Use Contract Pricing flag in SO Static Control F/M is not selected, or is 
set to N. The contract pricing matrix that you create in this program is based on the customer 
(who is placing the order) and the item (what merchandise is being purchased). You must 
determine the priority by customer of which price the system should select as well as the 
priority by item of which price the system should select. The choices of the hierarchy are as 
follows: Item Scope Priority (Individual Item, Item Price Class, Vendor, and All Items) and 
Customer Scope Priority (Individual Customer, Customer Price Class, and All Customers). 
Based on how you set the priorities of customer and item, the system sets the priorities of all 
contracts from highest priority to lowest automatically. 

Use Contract Maintenance to quickly add/copy/create/chain/delete/list/modify a contract or 
group of contracts. You may also save “Collections” of contracts, or manage/modify a 
collection of contracts. The term collection, from here forward, refers to contracts displayed 
in the list browser (whether one contract or many contracts is displayed). In Contract 
Maintenance, you can use the available menu options to aggregate/compile/build a collection 
that you want to work with or modify in some way. Once you have assembled a collection 
(even if the collection has only one contract), you can save that collection and give it a name 
for later use, i.e. collections can be saved and retrieved. A saved collection is visible upon 
‘look-up’ only to the user who created it. Once a collection is saved, it can be modified using 
the menu options displayed under “Collection”, or, the individual contracts that make up the 
collection can be modified using the menu options displayed under “Contract”. Creating a 
saved collection is not required. You can use Contract Maintenance without ever saving that 
collection. Without saving a collection, the user can simply use the menu options each time 
they come into Contract Maintenance. Saved collections do not ‘update-automatically’ with 
contracts that have been added/changed since the date the collection was last saved – e.g. if 
you create a collection for “all contracts that have not yet been approved”, and save it, and 
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then a week later open that collection, all the contracts since created in that week (that are 
not as yet reviewed) will have to be added/merged to that collection (through using the ‘Filter’ 
menu option or adding those contracts specifically through the collection menu option ‘Add 
Contract’). In the list browser, the system displays the contracts comprising the collection 
and includes the following information: contract number, type, description, effective date, 
expiration date, chain from, chain to, approve, priority, customer, item, last Daily Sales 
Register, and Quote number, the contract was generated from. The Customer column 
displays ‘All’ if the ‘all customers’ check box is selected for the contract. If customers are 
listed, then up to 2 customers (separated by a comma) will be listed; if there are more than 2 
customers then after the second customer will be .... If there are no customers listed in the 
contract, instead the contract has only customer price classes, and then the display of two 
classes, as above, applies for customer price class listing in this column. If customers exist in 
the contract (even if only one) then no customer price class entries will display in this 
column, only customers. The Item column works identically to Customer column but for 
Items. First for items; if no items are listed in the contract then the display is for item price 
class; if no item price classes listed either, then the display is for primary vendors. 

Contracts are written with a contract number and description. After entering pricing 
calculations, effective and expiration dates, and so on, then you enter the "scope" of the 
contract by specifying the Customer Scope ("who the contract is for"), the Item Scope ("what 
it applies to"), and the Shipment Scope ("where it comes from"). 

When FACTS calculates contract pricing and multiple contracts with the same scope apply, 
the system selects the contract with the lowest price. 

You can mark contracts as "Awaiting Review". If the flag is set, the contract will not be used 
even if the dates indicate it should be effective. 

Contract scope 
Under the Customer Scope, you can enter any number of individual customers (with or 
without ship-to’s) and any number of customer classes. Alternatively, you can specify that 
the contract applies to all customers. 

Under the Item Scope, you can enter any number of specific items, any number of item 
classes, and any number of primary vendors. You can enter UM specifications for any of the 
three Item Scopes: Specific Item, Primary Vendor and Item Price Class. You can enter 
specific UM scopes for any of the three Item Scopes (Specific Item, Primary Vendor and Item 
Price Class). Alternatively, you can specify that the UM applies to all items. 

Under the Shipment Scope, you can specify whether the contract is valid for drop ship lines. 
The Shipment Scope options are Y (for the Vendors entered), N (doesn’t apply to drop ship 
lines) and A (applies to all drop ship lines, regardless of vendor). If you select Y (for the 
Vendors entered), you can enter any number of drop ship vendors. You can also specify 
whether the contract is valid for warehouse ship lines, with the options being Y (for the 
warehouses entered), N (doesn’t apply to warehouse ship lines) and A (applies to all 
warehouse ship lines, regardless of shipping warehouse). If you select Y (for the warehouses 
entered), you can enter any number of shipping warehouse. 

Contract Pricing 
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You can setup contract prices for a customer, customer price class, or all customers by an 
item, item price class, vendor or all items by pricing unit of measure. For example, you may 
give a specific customer a special price on an item or class of items, or may give all 
wholesale customers (one customer price class) a discount off the standard price on a 
specific item or a class of items. You can set up any one of the combinations. 

Once the combination of the contract is determined, the contract may have the following 
price types defined: 

• Standard Price - The standard price of the contract as determined by the user. Standard 
contract price may be entered as a dollar amount, a percent (%) change of the actual 
standard price or may be entered using a basis (list price, manual cost, sales order cost, 
standard price or any price level) and multiplier. 

• Level Price - Up to 6 contract level prices per item can be entered. The level price used 
when the item is sold is based on the price level assigned to the customer. For example, 
if a customer is assigned price level 4, the level 4 price is used when selling an item to 
that customer. Contract level prices can be entered as a dollar amount, a percent (%) 
change of the actual level price or may be entered using a basis (list price, manual cost, 
sales order cost, standard price, or any price level) and multiplier. 

• Quantity Break Price - Up to 6 contract quantity break prices per item may be entered. 
The quantity break price allows the user to enter a minimum quantity of the item to sell 
along with the price per UM for that item. For example, if three quantity breaks are set up 
as follows: 

Qty Break 1 10 ea. for $2.75 ea. 

Qty Break 2 15 ea. for $2.50 ea. 

Qty Break 3 20 ea. for $2.25 ea. 

The quantity sold is 12, the default price would be $2.75. Contract quantity break prices 
may be entered as a dollar amount, a percent (%) change of the current quantity break 
price or may be entered using a basis (list price, manual cost, standard price or quantity 
break) and multiplier. 

Commission percentages may also be set by price level or quantity break. 

Contracts are set up with an effective and expiration date. Contract prices are only used 
when the sell date is between the effective and expiration date. Once a contract has expired, 
it remains in the system. It can be deleted through the Contract Entry Program or removed 
by date through the Expired Contract Removal Program. 

Contracts under review 
In Contract Entry you can enter contracts with an effective date. If you want to ensure that 
the contract does not take effect until it’s been reviewed even after the effective date, select 
the Awaiting Review prompt to prevent the contract from taking effect. To review a contract, 
select the Review option in Contract Entry to access the Price Contract Review screen. On 
the Price Contract Review when you select the Contract Inactive; Awaiting Review field, the 
system records the user id and date in the Review By and Review On fields. You can toggle 
the Contract Inactive; Awaiting Review setting on and off. 
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How FACTS determines when to use contract prices 
When entering contracts prices, there may be an actual price for a level and a contract price 
for a level. If the level is then used as the basis the system must determine whether the 
actual level price or contract level price is used. The rules are as follows: 

• If the basis price level is lower than the entered level, the contract price is used. 
• If the basis price level is equal to or higher than the entered level, the actual price is 

used. This is because there is no contract price yet for a higher level. 

For example, below are the bases, multipliers and which prices are used in calculating 
contract prices when setting up contract price levels for an item: 

Level Actual Price Basis/Multiplier Which price used / How calculated 

$25.00 Level 3/ 1.1000 Level 3 actual is basis - calculated price is 23.00 x 1.1 = 25.30 

$24.00 Level 2/ 1.1000 Level 2 actual is basis - calculated price is 24.00 x 1.1 = 26.40 

$23.00 Level 1/ .9500 Level 1 contract is basis - calculated price is 25.30 x .9500 = 24.04 

$22.00 Level 3/ 1.0500 Level 1 contract is basis - calculated price is 24.04 x 1.0500 = 25.24 

$21.00 Level 2/ 1.0500 Level 2 contract is basis - calculated price is 26.40 x 1.0500 = 27.72 

$20.00 Level 6/ 1.000 Level 6 actual is basis - calculated price is 20.00 x 1.000 = 20.00 

The Contract Entry programs allow you to set up the contract standard price, level prices and 
quantity break prices three different ways. The following three set up options are the basis 
for the entry of all prices throughout these Contract Entry programs: 

1. Using a basis and multiplier 

Contract prices can be entered by setting a basis and multiplier. This means that to set up a 
contract price, another existing cost or price is the basis of the new contract price and a 
multiplier is applied against it. If for example, the basis price was $100.00 and the multiplier 
was .9400, the new calculated price would be $94.00 ($100.00 x .9400). Taking this example 
further, in setting up level prices, you can determine that each one is based on some % 
(percentage) of the list price. If the list price is $100.00 and the levels are 1) $95.00, 2) 
$94.00, 3) $93.00, 4) $92.00, 5) $91.00 and 6) $90.00 the level prices may be set up using a 
basis, list price, and multipliers: 1) .9500, 2) .9400, 3) .9300, 4) .9200, 5) .9100, 6) .9000. 

When entering contract prices using a basis and multiplier, the actual price is not calculated 
and stored in the pricing files. Rather, the basis and multiplier is stored in the contract pricing 
files and the basis amount and multiplier calculation is performed at the time the item is sold 
in the sales order entry programs. The purpose of entering contract prices using a basis and 
multiplier is that if the basis amount changes, no new contract prices will then be required to 
be entered. For example, if the standard price is always a multiplier of manual cost, then the 
standard price will automatically be changed if the manual cost is changed. 

2. Using a dollar amount 

Contract prices may be entered by entering the actual dollar ($) amount. No calculations are 
then necessary. The price entered is the price that is stored in the pricing files and is what is 
used when the item is sold in the sales order entry programs. 



Work flow and program concepts  

Infor Distribution FACTS Sales Orders User Guide  | 67 

3. Using a change % (percent) 

Contract prices may be entered by entering a change % (percent) from the actual price. For 
example, if a standard price of $100.00 is increasing by 3% then a change % may be 
entered of 3.000. The system will then calculate and display the new calculated price of 
$103.00. When entering a change %, the actual dollar amount is calculated and stored in the 
contract pricing files. In this example, $103.00 is stored in the files and is what is used during 
the sales order entry programs. 

Commission Percentages 

In addition to the three set up options for the standard price, price levels and quantity breaks, 
you can also enter a commission %. 

The Use Commission Percent Levels flag in Inventory Control Static Control F/M determines 
whether this commission flag is used throughout the costing/pricing subsystem. If the flag is 
turned off, the option to enter the commission % is never available. If the flag is turned on, 
each contract price that is set up will require the entry of a commission %. When entering the 
commission %, you can set the commission % to "no priority" (blank) indicating that 
commission is not generated based on the price being set up. (If the item is set to "no 
priority", any commission % entered in the contract pricing system will be ignored). (For more 
information on commissions, refer to the commission basis flag set in the Company Control 
F/M program in the System Management Manual.) 

Contract hierarchy 
You can set the contract hierarchy through the Contract Hierarchy F/M program. The 
contract pricing matrix is based on the customer (who is placing the order) and the item 
(what merchandise is being purchased). You must determine the priority by customer of 
which price the system should select as well as the priority by item of which price the system 
should select. The choices of the hierarchy are as follows: 

Customer Scope Priority (Individual Customer, Customer Price Class, All Customers) 

Item Scope Priority (Individual Item, Item Price Class, Vendor, All Items) 

Based on how the priorities of customer and item are set, the system sets the priorities of all 
contracts from highest priority to lowest automatically. 

For example, if you set the Customer Scope Priority to ICA, and the Item Scope Priority to 
IVCA, then the system would display the following hierarchy for the contract pricing: 

The above priority list represents the order that contract prices are used when selling items 
through the sales order entry programs. In the above example, a contract price for a specific 
customer and specific item would take precedence over all other contracts. For example, 
there is a contract price set up for item I100 and customer C100 for $45.00. There is also a 
contract price set up for customer C100 and item price class, widgets for a 10% discount off 
the list price. Item I100 is a widget and is assigned to item price class, widgets. Therefore, 
when item I100 is sold to customer C100, there are two eligible contract prices: one for the 
specific customer and specific item and one for the specific customer and item price class. 
By looking at the hierarchy set above, the system will select the $45.00 price from the 
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specific customer/specific item contract since it is higher in the priority than the specific 
customer/item price class contract price. 

If the system should use the lowest contract price available regardless of the hierarchy, there 
is an option to have the system always select the lowest price. 

Contract Entry (SOE560) functionality 
The following functionality is available: 

• Contract Price by Ship-To: You can specify that a contract is valid for all customer 
ship-to addresses or for only designated ship-to addresses. 

• Copy Contract: Any new contract can be copied from an existing contract. 
• Contract Price by Warehouse: Any contract can be valid for all shipping warehouses 

or only the warehouses you specify. 
• Shipment Type Designation: For each contract, you can specify whether the pricing 

is valid for warehouse shipments, direct shipments or both. 
• Multiple Scopes for One Contract: Instead of creating the same contract more than 

once for a few customers or items, you can simply create the contract and then 
assign which customers/ship-tos, items, warehouses, and vendors the contract 
applies to. 

• "Approval" Flag: You can enter contracts in Contract Entry with an effective date. A 
contract is not active until it’s been approved, even after the effective date. Select the 
Approve button to set this flag (check the box to approve the contract, uncheck the 
box to set the contract as ‘not approved’ and thus inactive, even if the effective date 
has passed). Fields for Approved Date and Approved Reviewer are also available. 

• Rounding Codes: Each contract can be assigned a flexible rounding code, which can 
round prices up or down to a specified cents (i.e., to .99) and/or dollar increment (i.e., 
the nearest $5.00). The rounding codes are completely user-defined. 

Customer Returns 
The Customer Returns Subsystem (CRS) is an optional feature of the FACTS Sales Orders 
system. The CRS subsystem provides you with the ability to enter and track customer 
merchandise returns while improving customer service. The objective of the CRS module is 
to provide immediate response to customers who return merchandise for any reason while 
minimizing internal costs and maximizing internal controls over returned goods. 

EWMS (Accellos) / FACTS CRS Integration 
Only lines in CRS that are Accellos warehouse integrated (meaning the warehouse is 
enabled/interacting with Accellos) will be sent to Accellos when a CRS document 
authorization is printed.  However, if any line is sent and is at Accellos, the user will be 
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denied entry into that document.  This is consistent with processing in Order Entry for orders 
sent to Accellos.  When the CRS document is received back from Accellos and any needed 
sales order and/or credit memo documents are created, the user will be able to access the 
document again in FACTS.  The lines that are already processed will have fields disabled at 
the line level. 

Program concepts 
You can access the following programs from the Customer Returns menu: 

Customer Returns Entry (SOE810) is used to create and edit customer return authorizations 
and customer return documents. Customer return authorization processing is an optional 
feature. The entry screen consists of three sections: the header, where the customer 
number, ship date are entered; line-item entry, where each item, price, quantity, and so on is 
entered; and the ending routine, also called the footer, which consists of the final fields prior 
to completion of the customer returns document. The screen is designed to look like a 
printed invoice. During entry of a Customer Returns document, you can change, add, or 
delete line items at any time, or delete entire Customer Returns documents. 

Returns Authorization (SOP820) is used to print and reprint the returns authorization. An 
authorization is provided to the customer when the customer calls to indicate that a return is 
to be made. The returns authorization can also be used as a returns packing slip. This 
program prints the authorization based on the information in the text file.  

You have the option to: 

• Enter CRS authorization number to print 
• Perform a search of CRS documents 

The Returns Authorization includes information as set in the text file. The default text file’s 
information includes: Date of issue, Customer name, Contact name, Returns Authorization 
number, Authorization date, Reference #, Company and address of where to return 
merchandise, Item number and description of each item to return, Quantity and unit of 
measure of each item to return, and Disposition description of each item to return. 

Returns Acknowledgment Print (SOP810) is used to print and reprint the returns 
acknowledgment. An acknowledgment is given to the customer and can be used as a returns 
packing slip or repair ticket. This program uses the invoice parameters in SO Document Print 
Control F/M to control the print formats. 

You can: 

• Print an alignment 
• Select acknowledgments by warehouse 
• Select acknowledgments by type (acknowledgment, repair ticket, or both 
• Batch print all acknowledgments or print specific documents 

Returns Acknowledgment information includes: Item Number, Item Descriptions, Returned 
Quantity, Price and Unit of Measure, Extension, and Return disposition category. 
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Customer Returns Inquiry (SOI810) is used to inquire into the status of any return document. 
The inquiry is especially useful for locating orders for a given warehouse, customer, or item. 
The actual document may be displayed in detail through this program. 

The Customer Returns Inquiry is a display-only version of the Customer Returns Entry 
program. 

CRS Status Report (SOR820) is used to track returns currently on file in the CRS 
subsystem. It provides you with information from the return document, as well as, information 
from any related sales order document, credit memo, and/or vendor return when applicable. 

You specify: 

• print order by document, by customer or by item 
• beginning and ending order 
• returns by warehouse, reason, disposition, and status 
• Include price, memo, and VRS information 
• range of return dates 

Report information includes the following: document number, return entry date, customer 
number, return warehouse, document line number, item and description, reason code, return 
quantity, unit of measure, price and pricing unit of measure, price extension, line status, 
document total, and credit memo or sales order document number when applicable, or 
vendor number, name, vendor return document, line number and status when applicable. 
This report differs from the Returns Analysis Report in that it includes pricing information. 

You can indicate whether to include all CRS documents or only those CRS documents with 
lines that are ready to create sales order or credit memos. 

Returns Analysis Report (SOR830) is used to obtain a report of all orders currently on file in 
the CRS subsystem. This report is designed to track returns. It provides you with both 
information from the return document and information from the sales order, credit memo, 
and/or vendor return when these entries are generated. 

You can specify: 

• print order by customer or by item 
• beginning and ending order 
• returns by warehouse, reason and disposition 
• range of return dates 

Report information includes the following: document number, return entry date, customer 
number, return warehouse, document line number, item and description, reason code, return 
quantity, unit of measure, line status, and credit memo or sales order document number 
when applicable. 

Returns Reason Code F/M (SOF820) is used to create and maintain the reason codes for 
the CRS subsystem. The reason code is used to classify why merchandise is to be returned 
and to determine whether to charge a restocking fee based on that return. 

CRS Control F/M (SOF890) is used to provide you with static and non-static controls for the 
Customer Return Subsystem. The static controls are flags and default entries that affect 
certain fields in CRS Entry and Authorization print. The flags you set in this F/M should 
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reflect your company’s return policy. FACTS updates the non-static data on a continual 
basis. 

Work flow 
Return documents are created in Customer Returns Entry using the Quick Entry screen and 
the Past Invoice Search or with the Customer Returns Line Entry screen. 

You can create the following types of documents: 

1. Returned Goods Document 

2. Return to Vendor PO 

3. Vendor Replacement PO 

4. Customer Replacement Order 

When you exit from Return Entry, the Return Authorization is printed. 

When the goods are received, you can access the Order Entry suite of programs and select 
the menu option “RMA” and enter the return document number to go to Returns Entry with 
the return document information loaded. 

In Returns Entry, enter the quantity that was received back from the customer for each item. 

When done, the return goods credit memo and customer replacement sales order are 
created and status flags for the vendor return and vendor replacement is set. 

As the return goods credit memo is processed through the Daily Sales Register, the status 
flags change for the vendor returns so the Buyer’s Control Center can then process the 
returns to the vendor and create the negative PO. The Buyer’s Control Center will also be 
aware of any vendor replacements that are indicated by a customer return and create the 
replacement PO. These will update back to the Customer Returns System files. 

As the return and replacement POs are processed through the Receipt Register, the status 
flags on the CRS lines are again updated. If the customer credit and customer replacement 
were waiting on vendor action, the credit memo and sales order will be created. The DSR 
updating these documents will again update back to the CRS line. 

You can create the return document manually, by directly entering lines in Customer Returns 
Line Entry (SOE710), or using the Quick Entry process and the Past Invoice Search. During 
entry of a Customer Returns document, you can change, add, or delete line items at any 
time, or delete entire Customer Returns documents.  When all lines on the return document 
are complete the document will be marked complete. 

The Auto Create Docs During setting in CRS Control F/M (SOF890) determines whether 
credit memos and/or sales orders are created during the PO Receipt Register update or the 
AP Entry Register update.  The auto-creation of return documents is an “All or nothing” 
setting. Either the returns are auto-created or users, after processing the PO Receipt and AP 
Entry registers, must access CRS Entry and click Create Docs to manually create customer 
returns. Use the CRS Status Report, (SOR820) output to determine which CRS docs to go 
into CRS entry for, and from there click ‘Create Docs’). 
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The Customer Returns Entry program allows you to create either a return authorization or a 
return document. Use a return authorization document when the distributor insists that all 
returns be approved in advance (perhaps requiring an authorization number) or when a 
customer gives advance notification of returns (perhaps inquiring as to the amount of the 
credit). When the returned goods arrive, the authorization document is converted by the user 
to a return document. A return document is created when the goods are returned and no 
authorization has been previously created or when goods are returned without any 
notification from the customer.  

The Customer Returns Entry program is similar to other FACTS order entry programs, but 
requires some additional information to complete the document: a return reason code (why 
are the goods to be returned) and how is the return going to be processed are required 
during document entry. Depending on the nature of the return, credit memos (for returns for 
credit) and/or sales orders (for returns for replacement or repair) can be generated. For 
returns to stock, the system adjusts inventory. For returns to vendor, the system generates 
vendor return information so that the original return document can be associated with any 
credit issued by the vendor when appropriate. Optionally, you can print an order 
authorization or order acknowledgment for the customer to use as a packing slip or receipt. 

Commission % Note: For credit memos (for returns for credit) and/or sales orders (for returns 
for replacement or repair), the system recalculates the commission % as the lines are being 
created, except the restocking fee, which has 0% commission. 

Initial setup  
The setup required to begin using the Customer Returns System is minimal; however, there 
are several questions that you should consider prior to setup. The answers to these 
questions will determine how you set up the system controls, in accordance with your 
company’s policies and procedures. 

• Do you allow the return of temporary items? 

• Will you require all returns to be tied to a specific past invoice? 

• Do you want to store customer returns history information? 

• Do you want to charge a standard restocking fee? If so, is the fee a flat dollar amount or 
percent based fee? 

• Do you want to track returns using separate GL accounts? 

• How many different ways does your business handle returns? 

Customer Returns Entry (SOE810) additional features  
A number of additional features are available in the Customer Returns Entry Program: 

• Memo lines can be entered 
• Temporary items can be entered 
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• Catalog items can be entered 
• Inquiries include Interchange, Catalog, Customer Item, and Past Sales 
• A Returns Authorization can be printed 
• A Returns Acknowledgment can be printed 
• Lost sales can be entered 
• Items can be added on the fly during line-item entry 
• During processing, the system automatically displays urgent notes for customers and 

items based on your settings on the Notes tab of SO Entry Options F/M. Refer to the 
Viewing/Entering Notes from Sales Order Programs topic for additional details. When 
the Customer Returns Entry program automatically creates purchase order such as 
for a direct ship sales order, FACTS determines if Vendor and Item notes should 
import into the PO, based on the export options setup on the note, and the Notes pop 
up functionality is disabled. If a note is set to export or required, then FACTS 
automatically imports the note onto the PO. 

Returns processing and replenishment 
The Return document is created in Customer Returns Entry using the Quick Entry screen 
and the Invoice Search or with the regular line entry screen. 

When you exit from Returns Entry the Return Authorization is printed. 

When the goods are received, you can access the Order Entry suite of programs and select 
the menu option “CRS Entry” and enter the return document number. This will take the user 
to Returns Entry with the return document loaded. 

In Returns Entry, enter the quantity that was received back from the customer for each item. 

When done, the return goods credit memo and customer replacement sales order will be 
created and status flags for the vendor return and vendor replacement will be set. 

As the return goods credit memo is processed through the Daily Sales Register (DSR), the 
status flags for the vendor returns are updated so the Buyer’s Control Center can then 
process the returns to the vendor and create the negative PO. The Buyer’s Control Center 
also tracks any vendor replacements that are indicated by a customer return and creates the 
replacement PO. These purchase orders update back to the CRS files. 

As the return and replacement POs are processed through the PO Receipt Register, the 
status flags on the CRS lines will again be updated. If the customer credit and customer 
replacement were waiting on vendor action, the credit memo and sales order will be created. 
The DSR updating these documents will again update back to the CRS line. 

The Auto Create Docs During setting in CRS Control F/M (SOF890) determines whether 
credit memos and/or sales orders are created during the PO Receipt Register update or the 
AP Entry Register update.  The auto-creation of return documents is an “All or nothing” 
setting. Either the returns are auto-created or users, after processing the PO Receipt and AP 
Entry registers, must access CRS Entry and click Create Docs to manually create customer 
returns. Use the CRS Status Report, (SOR820) output to determine which CRS docs to go 
into CRS entry for, and from there click ‘Create Docs’). 
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In Returns Entry, you can also create the credit dollars CM and customer replacement SO 
before the items are actually returned, when the received quantity is zero. This is not the 
standard so it can only be done on a line by line basis using the Create Documents button in 
line entry. The wait vendor action flag must be No. 

Temporary items  
The Customer Returns Entry (SOE810) program also allows returns processing for 
temporary items.   

In Customer Returns Entry, you can enter temporary items for returns processing for the 
following return options:  

• Return to Warehouse 
• CRS temporary item returns may not have a consolidation warehouse that is different 

from the return warehouse. 
• Return to Vendor for Credit 
• Return to Vendor for Replacement 

• Note that the customer replacement option “Direct from vendor” is not allowed for 
temporary items. 

• Scrap 
• Repair 

Temporary items created in CRS and passed through are not editable in the Buyers Control 
Center or the PO Entry Suite, but the temporary item flag is set to Y for them.  Temporary 
items created in SO, which are imported into PO from a planned special order PO or by F1 
entry in PO Entry or PO Receipt Entry do not have the temporary item flag set to Y in PO. 

The CRS Quick Entry program does not allow entry of Temporary Items. 

PO returns processing for temporary items 
You can process returns for temporary items in the Buyers Control Center (POE400), 
Purchase Order Entry (POE120), Receipt Entry (POE210) and Non-PO Receipt (POE220) 
programs.  You can enter a temporary item having a negative quantity with no tie to any 
document. 

In the PO Entry Program Suite the entry of purchase orders for >0 quantities is not allowed 
for temporary items.  All quantities entered for temporary items must be negative quantities. 

PO document lines tied to CRS cannot be edited; this includes lines for temporary items tied 
to CRS as well. 

When processing a CRS temporary item that is a return action of “Repair” it is possible to 
enter a Unit of Measure that does not exist for the CRS Repair Item.  When that repair is 
processed from the BCC (creating a PO), if the Unit of Measure entered in CRS is not a valid 
Unit of Measure for the CRS repair item, you will be prompted in the PO Entry Program 
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Suite, to enter that missing unit of measure in UM Code F/M (ICF910) and then in Item UM 
F/M for the CRS repair before being allowed to continue with the PO. 

Vendor return type (V-Type) records 
Entry of a temporary item in the Buyers Control Center (POE400) program creates a CRS 
Vendor Return (“V”) type document/line record just like for IC Master table (ICMAST) items.  
Entering a temporary item in the Customer Returns System in the Sales Order module also 
creates CRS Vendor Return (“V”) type document/line records. 

However, temporary item entry in the PO Entry, Receipt Entry and Non-PO Receipt 
programs does not create V-type document/line records.  In order to track a temporary item 
return, it is necessary to create the return in Customer Returns Entry (SOE810) or via the 
Buyers Control Center (POE400). 

PO to GL posting  
The Nonstocked field in the PO line files refers to the item being a temporary item tied to a 
sales order, and not that the item is in the ICMAST (IC Master) table as a non-stock item.  
This is so the PO to GL posting table uses the Temporary/Nonstocked GL # selection.  Truly 
temporary items entered in the PO Entry suite have the new Temporary_Item flag set to “Y” 
and use the Temporary/Nonstocked GL # selection too. 

Returned goods credit memo processing 
As the return goods credit memo is processed through the Daily Sales Register it will change 
the status flags for the vendor returns so the Buyer’s Control Center can then process the 
returns to the vendor and create the negative PO. The Buyer’s Control Center will also be 
aware of any vendor replacements that are indicated by a customer return and create the 
replacement PO. These will update back to the CRS files. 

As the return goods credit memo is processed through the DSR it will change the status flags 
for the vendor returns so the Buyer’s Control Center can then process the returns to the 
vendor and create the negative PO. The Buyer’s Control Center will also be aware of any 
vendor replacements that are indicated by a customer return and create the replacement 
PO. These will update back to the CRS files. 

For Returned Goods Credit Memo (allowance for credit dollars) there is no updating to 
inventory quantities. For a Returned Goods Credit Memo (return), the inventory quantities for 
return warehouse will be updated and usage for the credit warehouse will be updated. The 
returned goods status is updated to complete. 

If the vendor return status is N/A the and the return action is return to vendor for credit 
(dollars) or item return and the return warehouse is same as consolidation warehouse, 
change vendor return status to Ready for return to vendor (Transfer has been updated 
through the Receiving Register or return warehouse is same as consolidation warehouse) 
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If the vendor return status is N/A and the return action is return to vendor for credit (dollars) 
or item return and the return warehouse different from consolidation warehouse, the DSR will 
create a planned special order transfer to the consolidation warehouse and change vendor 
return status to N/A. If this is also the Returned (for Credit) Credit Memo, the DSR also 
changes the returned credit status to complete and the Customer Replacement SO is 
changed to a customer replacement status of complete. 

Usage updates from the Daily Sales Register 
If the Update Usage field in Customer Returns Entry (SOE810) is set to No (unchecked) then 
usage will not be updated. If Update Usage is Yes (selected) and the Usage Period is blank 
then the current period usage will be updated and set to the current period. If Update Usage 
is Yes and the Usage Period is not blank then the usage for the indicated period will be 
updated. 

Manually advancing CRS line status 
The Manual Status Advance for CRS (SOC860) window allows you to advance a customer 
return line's statuses independent of processing that CRS line through standard FACTS CRS 
steps. This window is accessed from the Edit menu of CRS Entry (SOE810). This screen 
also available, as inquiry only, from the selection grid by clicking the CRS line number. 

MSDS 
The Material Safety Data Sheet (MSDS) System allows you to maintain MSDS sheet 
information for hazardous items and to track which customers have received MSDS sheets 
and when the sheets were sent. 

The Occupational Safety and Health Administration (OSHA) of the U.S. Department of Labor 
stipulates that distributors must provide an MSDS sheet for hazardous items. Therefore, 
distributors of hazardous items must be able to do the following: 

• Keep track of MSDS sheets for hazardous items 
• Send MSDS sheets to customers when they purchase hazardous items for the first time 
• Send updated MSDS sheets when appropriate 
• Maintain records of customers who have received an MSDS sheet and dates. 

Program concepts 
The MSDS subsystem contains the following programs: 
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MSDS On-Line Print (SOP350), which is used to print on-line MSDS sheets, summary 
sheets and optional cover letters. Use it to print on-line MSDS sheets, summary sheets and 
optional cover letters. 

A summary sheet contains: 

• customer number 

• ship-to or order number 

• MSDS IDs of sheets that were printed 

• MSDS IDs of sheets that did not print due to an error 

• general description of any errors that occurred. 

The cover letter is maintained in the MSDS Cover Letter F/M Program (SOF986). 

NOTE: This program is set to print in the following order: 1) cover letter, 2) MSDS sheet and 
3) summary sheet. However, due to third-party software print queuing, it is not guaranteed 
that the documents will come out in this order. 

A temporary file of MSDS sheets to print is generated during the SO Invoice Print program or 
the SO Pick Ticket program (whichever is defined in the MSDS Control F/M) and this 
program can be run after the appropriate SO print program. 

You can print all MSDS sheets that have not previously been printed and reprint any sheets 
that have been printed but have not been updated during DSR to the MSDS History File. 

MSDS On-Demand Print (SOP360), which is used to print MSDS sheets, cover letters and 
summary sheets on demand. You have three options for printing documents: by open Sales 
Order documents, by customer ship-to, by MSDS ID. If MSDS sheets for open SO 
documents or for a customer’s ship-to print, an optional cover letter will accompany the 
MSDS sheets. If MSDS sheets for open SO documents print, an MSDS sheet will print for 
every line item on the SO document that requires an MSDS sheet. 

MSDS ID Listing (SOR705), which is used to print a list of MSDS IDs with MSDS information 
and an optional list of items using each MSDS ID. The report may be run for any range of 
MSDS IDs. 

For each MSDS ID, the report lists this information. 

• MSDS ID number and description 
• MSDS sheet literature location (if applicable) 
• electronic MSDS file name 
• MSDS print macro code 
• MSDS revision date 
• whether an MSDS sheet is required 
• items with this MSDS ID (optional). 

MSDS History Report/Reprint (SOR785), which is used to print a history report of MSDS 
sheets that have been sent to customers and reprint MSDS sheets previously sent (if the 
MSDS on-line print process is used). You can run the history report in either customer or 
MSDS ID order. If the report is run in customer order and the same customer number is 
entered for the beginning and ending customer, the prompts for beginning and ending ship-to 
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will be displayed. Also, if the user is printing MSDS sheets on-line, this report will ask the 
user whether to reprint MSDS sheets already sent. Summary sheets and cover letters (if 
used) will also print at this time. 

MSDS ID F/M (SOF905), which is used to maintain information for each MSDS ID. An MSDS 
ID must be assigned to each item in the IC Item F/M that requires an MSDS sheet as 
stipulated by OSHA standards. 

MSDS History F/M (SOF987), which is used to maintain the historical information for MSDS 
sheets sent. 

MSDS Cover Letter F/M (SOF986), which is used to enter and maintain an optional standard 
cover letter to be printed with a group of MSDS sheets. This program allows you to enter and 
maintain an optional standard cover letter to be printed with a group of MSDS sheets. Only 
one cover letter may be created. The printed cover letter includes the text entered through 
this program, with the customer and MSDS ID information needed to match the cover letter 
with the order/invoice and the MSDS sheets printed. 

MSDS Print Code F/M (SOF988), which is used to maintain the MSDS print codes. Print 
codes are only used if the method for printing MSDS sheets is on-line printing. Use the 
MSDS Print Code F/M program to maintain the MSDS print codes. Print codes are used 
during on-line printing to print sheets that are stored on the disk and were either typed or 
scanned into third-party software such as an imaging package or a word processor, e.g., 
WordPerfect. Print codes are established with a default directory path where the MSDS 
sheets are stored. Print commands (see the section on the MSDS Print Command F/M 
Program) are then assigned to each print code by warehouse to instruct the system how to 
print the MSDS sheets through the third-party software. These print codes are then assigned 
to MSDS IDs in the MSDS ID F/M to direct the system on print instructions for the MSDS 
sheets, summary sheets and cover letters (if used). These instructions are used by the 
MSDS On-line Print and On-demand Print Programs. 

MSDS Print Command F/M (SOF989), which is used to maintain the MSDS print commands 
for individual warehouses. Print commands are only used if the on-line print process is used 
for printing MSDS sheets. Use the MSDS Print Command F/M program to maintain the 
MSDS print commands for individual warehouses. Print commands are assigned to print 
codes by warehouse. Basically, a print command is a macro that initiates the third-party 
software and tells it which printer to use. 

MSDS Control F/M (SOF985), which is used to control records, by warehouse, for the MSDS 
System. These records contain information and flag settings that the MSDS programs 
reference to perform various operations. For example, when printing MSDS sheets, the 
system checks the MSDS On-line Cover Letter flag before printing the cover letter. One 
record is required for each warehouse. These records contain information and flag settings 
that the MSDS programs reference to perform various operations. For example, when 
printing MSDS sheets, the system checks the MSDS On-line Cover Letter flag before printing 
the cover letter. One record is required for each warehouse. 

MSDS History Removal (SOU930), which is used to delete MSDS history records for a 
specified range of customers and cut-off dates. 
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Inquiries  
The Sales Order Inquiry Menu allows you to view sales order information by customer, item 
and document. 

You can select the records for inquiry by using a filter in combination with an inquiry. The 
system then searches for records that match the conditions described by the filter settings 
and displays them for you to view. For example, you may want to view the records for 
customers that have made purchases from you after a specified date. For detailed 
instructions on setting up filters, see the FACTS Help file. 

Information for each record you select is displayed in multiple views. Each view is grouped to 
provide detailed information on a particular topic or type of information. For example, 
Customer Inquiry includes the following views: Quotes, Ship-to Addresses, Open Sales 
Orders, Blanket Sales Orders, Past Invoices, MSDS, Past Sales, Customer Notes, and 
Customer Pricing. 

Program concepts 
The programs are selections from the Inquiries menu. 

Use Customer Inquiry to view sales order information by the customer selected. Available 
screens include: 

Blanket Orders, which displays information on blanket sales orders including document 
number, hold status, warehouse, entry date, expiration date, completion date, ship-to 
number and reference number. 

MSDS, which displays information on Material Safety Data Sheets (MSDS) that were sent to 
this customer. The information in the view consists of the MSDS ID and ID description, ship-
to, date last sent, MSDS revision date and the invoice numbers with which the MSDS sheets 
were sent. 

Orders, which displays open sales order information including document number, document 
type (work order, invoice, credit memo, counter sale, etc.), document status (work order 
entered but not printed, work order printed, confirmed invoice, receipted invoice, deleted 
sales order, voided invoice), document origin, order priority, ship-complete status, invoice 
date, warehouse, amount, ship-to and reference number. 

Past Invoices, which displays past invoices including SO document number, AR invoice 
number, order priority, ship-complete status, document type (work order, invoice, credit 
memo, counter sale, etc.), invoice date, warehouse, amount, ship-to and reference number. 
In the view area, select the line and click Line Detail. On the Line Detail screen for Past 
Invoices view of Customer Inquiry, there are 2 special buttons available above the line item 
browser. The GL Posting button is enabled when the transaction highlighted in the browser 
is one that allows for drill back from the source document to the GL posting that was created 
by the register. If the GL posting records can be found, then Journal Inquiry will display 
defaulting to showing transactions for this document only. Click AR Detail to view the AR 
document associated with the invoice if it is still on file. 
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Past Sales, which displays past sales information for each item number and description. 
Listed information consists of invoice number and date, quantity sold and the corresponding 
unit of measure, price and the pricing unit of measure. 

Customer Returns, which displays information on the returns documents for the selected 
customer. 

Credit History, which displays tabs for Aging, Payment history and Sales history. 

• Payment history includes last payment date and grace period. Information also 
includes both invoices and weighted dollars. Invoice Payment Statistics include the 
total number of invoices paid, the average number of days to pay, the dollars paid, 
and the weighted average days to pay are also displayed in accumulated periods. 
The accumulation of data into periods displays the “Last 03 Periods” , the “Last 06 
Periods” and “Last 12 Periods” as the accumulation of data from the current period 
through the specified periods back from the current period.  
Click Payment Detail to access the Payment History Details for the customer. The 
screen displays a listing showing each period and the totals for that period and a 
running accumulation is also shown. The periods listed will be those periods entered 
in the GL NonStatic Control FM. 

• Sales history includes the account opening date, last sale date, highest balance date 
and highest balance. Information also includes sales, cost and gross margin 
percentage for month-to-date, year-to-date, and prior year. 

• Aging displays credit history in three categories: Current date for balances due, Total 
aging and Disputed. 

Check History, which displays accounts receivable document information by check number. 
The number of periods check history is kept is dependent on the Check History setting on in 
AR Static F/M. 

The Check History view displays check numbers for the highlighted customer along with the 
check date, check amount, and check memo. You can sort the information by descending 
check number, ascending check number, or by check date (newest to oldest), with 
descending check number being the default sort order. Since duplicate check numbers can 
appear, lines appear first in check number order then date order or by date order then 
descending check number order depending on the sort order selected. 

You can also click Line Detail to access the Check History - Line Detail window on each 
check line to display the payments and transactions made under that check entry. Lines are 
displayed in document and document continuation order. For payments on an invoice, the 
document number is the invoice number. In AR, the OA number preceded by "OA" acts as 
the document number. Miscellaneous cash lines are displayed with "MISC CSH" as the 
document number. 

From the Check History - Line Detail window, if the highlighted document has not been 
deleted (through Document Removal Register or End of Period Update), indicated with a 
"Delete" status, click Doc Detail to see the AR transactions for that document or SO Doc Inq 
to display the Past Invoice window of SO Doc Inquiry. With regard to the AR transaction 
option, if the line has an "Open" status, the AR transactions display from the open and 
transaction tables (as seen in the line detail window of the Open Docs view of Customer 
Inquiry). If the line has a "Past" status, the AR transactions display from the paid document 
tables (as seen in the line detail window of Paid Doc History view). This option is not 
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available for OA or misc cash lines. You only have the option to pull up SO Doc Inquiry if the 
document highlighted was created in SO rather than in AR Invoice Entry. 

Pricing, which displays customer pricing information on items. This information is available: 
item number, item description, quantity break information, the customer’s default price, 
pricing unit of measure and item type. Warehouse availability in all warehouses, and 
purchase order, manufacturing ticket and transfer information, as well as lead time details 
are also displayed. Highlight a line and click: 

Orders to display the On Order Purchase Order/Transfer/Manufacturing Information 
(POC085) window, which contains on order information for existing purchase orders, 
warehouse transfers or manufacturing tickets for the selected customer and item. 
Specify the display code: S-sales orders, T-warehouse transfers, M-manufacturing 
tickets. The display for each document includes: order number, type, status, ordered 
quantity, received quantity, back-ordered quantity, unit of measure for the quantities, 
cost and its corresponding unit of measure, the promised date and vendor number 
for all warehouses. 

Whse Qtys to display the Warehouse/Item window (SOC070), which to view 
quantities and the average lead time, in each warehouse. 

Line Detail to access level pricing, contracts, and past sales information for the 
customer/item combination. 

Quotes, which displays quote information including quote number, quote date, expiration 
date, warehouse, sales order number (if converted to a sale), the customer for whom the 
quote was made, who gave the quote and the quote total. 

Ledgercards includes all ledgercard information for the selected customer from newest to 
oldest by default. To view ledgercards oldest to newest, click the Date column header. (You 
can also click on any other column header to resort ledgercards.) 

In either order, select the beginning date to view. Information displayed includes entry date, 
debit amount, credit amount, balance, transaction (register) type, document number and 
register number of each ledgercard on file for this customer. Click View Doc at the bottom of 
the screen to display additional document detail information. The system checks to see if 
detail info exists for currently highlighted ledgercard line for its transaction type. For AR 
ledgercards there are 10 transaction types: B – Begin Balance, C – Cash Receipts, A – AR 
Sales Reg, O – SO Sales Reg, T – TS Invoice Reg, M – Credit Memo, S – Svc Charge Reg, 
R – Returned Check, X – Cust Balancing, s – SR Contract. Four of these types display 
additional document detail information. When you click View Doc, type C– Cash Receipts 
displays the Check History view line detail (ARI650) screen, type A– AR Sales Register 
displays the Open or Paid Doc view line detail (ARI614/ARI691) screen, and transaction 
types O--SO Sales Register, and M– Credit Memo display SO Doc Inquiry (SOI620) in view-
only Past Invoice mode. 

Ship-to, which displays alternate ship-to information from the created in the Ship-To F/M for 
this customer. This view lists the alternate ship-to numbers, location names, contact 1, and 
phone number 1. 

Notes, which displays customer note information. 

General, which displays general customer information: name, address, customer’s price 
class, customer’s price level, commission %, off-invoice discount, ship via, UPS zone, 
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contact information, and Sales Order processing options for such as payments, ledgercards, 
past sales and invoices, back orders, required POs for sales orders, and credit information. 
This information display here is entered in Customer F/M (ARF910). 

Open docs displays the open documents for the customer including the document number, 
type, ship-to number, register number, entry period, date entered, due date, the original 
amount and the current amount. If the open document was created from SO, the SO 
document number that the open document applies to is also displayed. Search open 
documents by document order and by reference number order. The view defaults to 
document number order. 

Paid Doc History, includes document number, reference number, ship-to number, 
original amount, original discount amount, entry period, entry register number and 
removal register number. The documents initially appear in document number order. 
User-Defined, which displays data that appears on the User-Defined view Customer 
F/M (ARF910). 
Doc Routing, which displays the document routing information, Listed information 
includes the account, document type and description, routes, fax number and email 
address. 
Lost Sales, which displays lost sales information for each item for the specified 
customer. 
Contracts, which displays service contracts entered in the Service and Repair module 
for the specified customer. Information in the browser includes the contract number, 
effective and expiration dates, contact, total amount and reference information. 
Proposals, which displays service proposals entered in the Service & Repair module 
for the specified customer. Information in the browser includes the proposal number, 
effective and expiration dates, contact, total amount and reference information. The 
Line Detail button displays the Service Proposal Inquiry with details for the highlighted 
line item. 
Standard Order, which displays ship-to locations that have standard orders for the 
specified customer. Highlight a line and click Line Detail to access standard order lines 
for the specified ship-to/customer combination.  

The SO Document Inquiry program allows you to view quotes and sales order documents in 
detail by the type and status selected. The type options are: open work orders, backorders, 
invoices, credit memos, and counter sales. The various status codes include: work orders 
entered, but not printed, pick ticket printed, confirmed invoice, invoice printed, invoice 
released, deleted sales order, voided invoice. Inquiry information includes an overview of the 
document’s current status, the actual document as it appeared at time of entry (with updated 
amounts and units) and as sales orders are line-item salable, each sale per line may also be 
displayed. You can inquire by document number. Displayed information includes document 
number, type, status, and entry date, customer number and name, ship-to number, 
document total, and designated warehouse salesperson, and order priority. In Past Invoice 
mode, the AR Disputed indicator and memo also display on the main screen. In Quote mode, 
there are also a few slight differences in the screen display. 

The SO Items-in-Process Inquiry program allows you to inquire about the status of a sales 
order item. This inquiry displays in item order all the sales orders that contain the selected 
item. You choose the beginning item to view. Information includes item, document number, 
type, status, order amount, ship amount, backorder amount, unit of measure, cost and 
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warehouse Inquiry information is displayed in item order and includes: item and description, 
document number, document type, status, entry date, customer number and name, 
warehouse, order quantity, shipped quantity, backordered quantity, inventory unit of 
measure, price and pricing unit of measure. 

This inquiry has a multitude of uses, but is especially useful for determining all orders and 
invoices containing a given item. By selecting the correct document types and status codes 
to display, this inquiry provides information similar to the Order Status Report by item. Of 
course, if more detailed document information is desired the actual document may be 
displayed through the appropriate order entry program or through the Document Inquiry 
program. 

You can specify: 

• SO (sale order) or PO (purchase order) items in process for the inquiry. 

• document type(s) to display: -open orders, direct entries or confirmed orders, credit 
memos, backorders, counter sale invoices for SO documents and open purchase orders, 
backorders, and non-PO receipts for PO documents. 

• document status code(s) to display (stage in the sales orders or purchase order processing 
cycle). 

• beginning item to display. 

The SO Item Inquiry program allows you to display specific information for items in the 
Inventory File. Items may be displayed individually or sequentially. You have the option to 
display general information, packaging information, warehouse information, open purchase 
order information, , blanket sales order information, costing information, pricing information, 
interchange items, ledgercards, turn information for the past 12 periods, item notes, 
restocking, usage, receipt information, production, warehouse transfers, serial/lot 
information, vendor information, sales history information, item activity information, MSDS 
and DOT information. This inquiry is also found on the Inventory Control Inquiries Menu. 

The Rejected Lines Inquiry is only accessible if the multiple warehouses on an order feature 
is being used. This program allows you, from the initiating warehouse, to view information 
about all items on hold or rejected for shipment by the shipping warehouse. It also provides 
quick access to the document in Order Entry to change/delete the line on the order. This 
program provides information about all items on hold or rejected for shipment by the shipping 
warehouse. It also gives you quick access to the document in Order Entry to change/delete 
the line on the order. 

Use Catalog Item Inquiry to review information for catalog items within inventory. When you 
first access Catalog Item Inquiry, the upper portion of the screen contains a Go to field, 
which is used locate specific items. The Go to field is case sensitive. This means that if you 
enter i100 to lookup an item number when someone entered it as I100, the item record you 
are looking for will not appear in the browser. 

There are two views available in the lower portion of the screen: 

General-Displays the following information from the item’s master file: item class; item price 
class; vendor; vendor item; interchange item number, weight, model number and standard 
package size associated with this catalog item and the date the item was established 
(entered) in the system. 
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Pricing-Displays pricing information including current and planned special order list price and 
manual cost, the pricing unit of measure, the current and planned special order standard 
price, current and planned special order pricing for levels used by the system (1-6 as set in 
the IC Static Control F/M), and quantity break prices in both the default Pricing and Quantity 
Break UM (if available). 

Disputed document indicator 

The SO Doc Inquiry in view-only Past Invoice mode provides an indicator for disputed 
documents. If any of the corresponding open invoice records in AROPEN are disputed, the 
text "*Disputed Invoice*" and memo are displayed in the upper portion of the SO Doc Inquiry 
screen.. For example, if you have an open invoice with split terms and only one of the terms 
is in dispute, the drill to SO Doc Inquiry will display the disputed indicator for both 
continuation lines. The disputed memo (50 characters) is the first encountered memo for that 
invoice (first disputed continuation). 

The AR Disputed indicator only appears in Past Invoice mode. 

Price level information for line details 

SO Doc Inquiry line detail contains a field labeled Price Origin. If Price Type is "P", the field 
contains the standard price description from the IC Static Control record. If Price Type is "L", 
the field contains the level price description from IC Static that corresponds to D3$(12,1) - 
Level field. 

Ordered amount column 

The Ordered amount column header displays as "Orig Ord" in Overview mode for Open 
Docs and Past Docs and displays the original ordered amount. In Current mode, the column 
displays as "Ordered’ and displays the current ordered amount. 

Source CRS/BSO number information 

The source CRS/BSO number appears above the Customer number on the main screen and 
in the title bar of Line Detail for Open Docs, Past Docs, and Past Invoices. The Last CRS 
appears to the right of Invoice number in Line Detail of Past Docs and Past Invoices. 

Searches 

You can search open sales order documents, past sales order documents, blanket sales 
orders, quotes or past invoices. 

Search quotes according to quote number. 

When searching sales order documents: 

• Search open or past documents by document number. 
• Display documents in current or overview mode. 
• Search open documents by type(s) (open work orders, invoices, credit memos, 

backorders or counter sale invoices). 
• Search open documents by status code (stage in the sales orders processing cycle). 
• Search in document number or in customer number order and determine beginning 

order choice to display. 

When searching blanket sales order documents: 



Work flow and program concepts  

Infor Distribution FACTS Sales Orders User Guide  | 85 

• Search blanket order by document number. 
• Display documents in current or overview mode. 
• Search in document number or in customer number order and determine beginning 

order choice to display 

Note: In Blanket Orders mode only the Current view is available. 

When searching past invoices: 

• Search past documents by invoice number. 
• Display documents in actual or overview mode. 
• Search in document number or in customer number order and determine beginning 

order choice to display. 

Note: In Past Invoices mode only the Current view is available. 

UnForm archiving functionality 

Documents that are archived in UnForm are available for viewing from literally hundreds of 
programs throughout FACTS. Throughout the Document Inquiry view, look for buttons or 
hyperlinks that refer to Archived Doc, Archived Pick, Archived Inv, and Archived BSO to view 
the archived document that contains a line in the inquiry browser. 

Use Past Order Status Change Inquiry to view to log status changes by date and time when 
the status of sales order and past order changes. Specify a document number to review the 
log. In the lower portion of the screen, filtering options are available for code type, user code, 
document number and invoice number. The document number, invoice number filters have 
no mask and when entered, lines matching the exact typed value are displayed. Whenever 
the status code changes for the SORSOH file, a record will be written to the status code 
changes file. The sales order status code, description, date, time and user code are 
displayed for order status change history. 

These Sales Order Status codes are available. 

Sales Order Status Code Definition 

E Created or Entered 

W Pick Ticket Printed 

P Partial Confirmed 

C Confirmed 

I Invoiced 

R Register Ready 

D Deleted 

V Voided 
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Reports and prints  
Most sales orders reports can be printed in different orders (depending on the information on 
the report). In addition to the order, you can choose the range to be printed. For example, on 
the Order Status Report, you may print in order number, item or customer order. If the order 
chosen is by item number, the beginning and ending item number is asked for. 

Program concepts 
The programs available in this subsystem are: 

Quote Listing, which provides a report of quotes in quote, customer, or customer alpha order. 
You have the option to select: print order - quote number, customer number or alpha sort, 
beginning and ending order choice, beginning and ending quote date to print, warehouse(s) 
of quotes to print, route(s) of quotes to print. Information on this report is entered through the 
Quote Entry Program and can be removed through the Quote Removal Program. 

Report totals include the total number of quotes on the report and the total dollar amount of 
quotes listed. 

The report includes these formats. 

• Summary: quote number, quote date, expiration date, customer number, customer 
name, ship-to name, quoted to, initiating warehouse code, total quote amount, and 
order number (if applicable). 

• Detail: summary plus the reference number, line-item number, item number and 
description, selling quantity and selling unit of measure, shipping warehouse, price 
and pricing unit of measure, and the line extension. 

• Detail with bill-of-material components: detail plus the items that make up each 
finished item on the quote, including the quantity per stocking unit of measure and 
any memo lines. 

Order Status Report, which provides a report of orders in order number, item number or 
customer number order. You can select a specific warehouse to print for, the types of orders 
to print (open, backorders or all) and whether to include quantities for short-term surplus, 
long-term surplus or both. This report is especially useful in spotting inventory shortages and 
potential shortages, as well as allocating available stock. 

You can specify: print order - order number, customer number or item number, beginning 
and ending order choice and dates, item description(s) and warehouses to print, whether to 
print price information. You can print various order priorities, selecting any combination of 
normal, rush and service hold order priorities, print only open orders, back orders, or all 
orders, print the component items of bill-of-material (BOM) finished items, and print the 
report for a salesperson or all salespeople. 

The report includes the following: document number, requested date, customer number, 
customer name, item number, item description, available quantity, on order quantity, 
backordered quantity, sales order quantities, amount ordered, committed, shipped, and 
backordered, selling and pricing units of measure, price, shipping and initiating warehouse, 
order type, long- and short-term surplus, and an extension of the total dollar amount ordered. 
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If the item is a special order then the PO/transfer information and status is printed. If you are 
printing component items for BOM finished items, they are denoted by an asterisk by the 
item number and include any memos. The order the information prints depends on the print 
order. 

Daily Shipping Report, which prints a list of backorders and work orders that have the 
requested ship date on or between the dates specified. This report should be run daily after 
the Daily Sales Register has been run. It is run prior to confirming orders for a new day to 
inform the user what should be shipped for the next day. Orders which contain no line-items 
that are available for shipment do not print. 

Important Note: In the Daily Shipping Report, even if a sales order line is tied to an open PO 
or transfer, if there is a quantity committed and the line is not ship complete, the sales order 
line prints on the report. The line is not excluded from the Daily Shipping Report if a PO or 
transfer is still open. 

You can select these options. 

• beginning and ending order numbers. 
• shipping warehouse(s) to print. 
• route(s) to print. 
• item description(s) to print. 
• beginning and ending dates. 

Report information includes the following: document number, document type, initiating and 
shipping warehouse, requested date, customer name and number, routing (if the user utilizes 
routing), whether the order is on hold, item and selected description, the document quantities 
(ordered, committed, and backordered) and the selling unit of measure, the inventory 
quantities (on hand, on order, committed, backordered) and the inventory unit of measure 
and purchase order or warehouse transfer information. The total number of documents listed 
is also included. 

Lost Sales Report, which lists lost sales by item. A lost sale is recorded when the ordered 
number is greater than the shipped number plus the backordered number; e.g., the sale was 
lost because the merchandise was not available. Lost sales are recorded when the 
backordered quantity was zero but the user did not ship all the items ordered. 

The Lost Sales Report is only available if the Use Lost Sales flag is set to Y in the SO Static 
Control Record. 

Report information includes the following: item number, item description, number of times the 
item was a lost sale (number of requests), the reason code for the lost sale, total lost quantity 
of sales, selling unit of measure, total dollar value of lost sales, and whether usage is 
updated from the lost sale for the item. Report totals include total dollar value of lost sales for 
all items in the selected warehouse and printed on the report. The total number of items 
listed is also included. 

Returns Report, which provides a listing of merchandise returns. The report prints the invoice 
number, returns code, items and cost of the items returned. This report is designed to track 
returns. It provides the user with the document information from the return, the item 
information and the return type. It also provides an optional removal. 
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You can specify: order to print — item or item class, beginning and ending order choice and 
date, warehouse(s) and return code(s) to print. 

Report information includes the following: customer number and name, item number and 
description, shipping and initiating warehouse (item was returned to), returning document 
type, returns code, returning document number, return date, quantity returned and the 
corresponding unit of measure, the extended cost of the item(s) returned and whether the 
return was an allowance or return. If the return type and returns code is blank, this indicates 
the return was entered in an entry program other than the Credit Memo Entry, (i.e., Direct 
Invoice Entry, etc.). 

Outstanding Deposits report, which provides a list of documents with deposits that have not 
been applied on account or earned. An outstanding deposit is one that has not been applied 
to an account, transferred to another order, earned by your company or refunded to the 
customer. 

You can print a detailed report to see a breakdown of all the deposits customer orders or 
print a summary report if you just want know many deposits are outstanding on which 
documents and the value of those deposits. 

After reviewing the report, you can determine whether you need to apply, transfer or earn the 
deposits so they can post to the Daily Sales Register. 

The Sales Order Item Report program allows you to print a report of documents in the sales 
orders processing cycle that contain direct shipments or non-stocked items. Report 
information includes the following: the document number, document type, date entered, date 
requested, warehouse code, order type (direct or warehouse), customer number, customer 
name, item number, description, committed, shipped and back-ordered quantities, unit of 
measure, and ordered quantity, line discount amount, total cost (based on selected quantity, 
and subject to cost security), total price (based on selected quantity), Gross Margin (subject 
to cost security) and Gross Margin % (subject to cost security). The vendor, transfer or PO 
number, Line number and status, and the ship-to information are available in the order tier if 
you want to add that data to the report using Custom Report Layout. 

Route Recap Report, which lists all the documents sold for the route, in route number order. 
This may be instrumental in approving routes so that they may be released. This report is 
only available if the Use Routes flag is set to Y in the Sales Orders Static Control Record. 

You can specify: route(s) and document type(s) to print - open orders, direct entries or 
confirmed orders, credit memos and/or backorders, and status codes to print - order entered 
not printed, work order printed, order confirmed or invoice/credit memo entered not printed, 
invoice/credit memo printed and/or invoice/credit memo released. Report information 
includes route number, route description, invoice number, type, status, customer number, 
customer name and cash and credit amounts. Report totals include cash and credit amounts 
for each route. The total number of documents listed is also included. 

Customer Price List, which prints a list of the least expensive prices of each item for the 
selected customer. The user may elect to print contract pricing only. You can specify: the 
order to print - item, alpha, vendor or item class, beginning and ending order choice, pricing 
unit of measure, customer, and whether to print contract prices only. Report information 
includes the following: the customer name, item number, item description, price, pricing unit 
of measure and basis (if selected). (If Q appears beside the price, it indicates that if pricing is 
set up by quantity breaks, the price is the best quantity break price.) 
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Unbilled Freight Report, which provides a list of all invoices billed with the freight flag set to B 
for bill later. The listing displays the ship via, invoice number, and weight for each document. 
Unbilled freight is recorded during the Daily Sales Register update when the freight code is 
set to Bill later on an invoice. An optional update following printing of the report allows 
removal of all records just printed. Report information includes the following: the ship via, 
invoice number, invoice date, customer number, ship-to name and weight. 

Service Fill Report, which is used to measure your company’s level of service by evaluating 
what percentage of line items are completely filled on the first shipment to a customer or 
transfer to another warehouse. Use the Service Level Report to measure your company’s 
level of service by evaluating what percentage of line items are completely filled on the first 
shipment to a customer or transfer to another warehouse. Backorders are not considered by 
this report. 

The report can be run for one or all warehouses with a range of ship dates. It can be printed 
as warehouse totals only, in summary, or with order and transfer ticket detail. The user can 
select to include orders, counter sales, transfers, or a combination orders and counter sales. 

You also can select to print the documents by customer, customer class, salesperson or ship 
date and include a beginning and ending range. For warehouse transfers, since customer, 
customer class, and salesperson do not apply, transfer tickets print in ticket number order 
unless you select to print in ship date order. For service level processing, the system 
measures the request date against the shipping date entered in Order Confirmation to 
determine if the line item will fail for the report. This report is valid for item type S—stocking 
items only. 

Use the Past Invoice Report to retrieve sales information for as long as invoices are stored. 
You can sort invoices by Invoice, Document, Customer, Customer Class or 
Salesperson/Territory and narrow your selection with by a beginning and ending range, and 
date range. You can select an Item, Vendor, Item Class or any combination of the above to 
print only the information you desire. You can also include Ship-to-information for past 
invoices. 

Past Invoice Report limitations/exclusions:  

Only lines that have non-zero shipped quantities print on the report. Additionally, the 
"Restrict By" settings only apply to lines with non-zero shipped quantities. 

For this report to be useful, your system must store past invoices. Also, if past invoices were 
not stored previously but are turned on at a certain point in time, this report only displays 
information back to that point in time. 

Printing ordered-by information on past invoices 

Based on the value of Print Ordered By prompt on the Invoices tab of Document Print 
Control F/M (SOF950) and if and the ordered by field is not blank, the past invoice includes 
"Ordered by xxxxx" in the line region on the first page only. 

DOT Code Listing, which provides a list of all DOT Codes in the system. The listing contains 
the following information: DOT Code, whether the material is hazardous, hazardous material 
entry, hazardous class, UN/NA identification number, packing group, freight class, shipping 
name and optionally additional descriptions. You can specify: beginning and ending DOT 
Codes to print, whether to print only those DOT Codes that are hazardous and any additional 
descriptions of the material.  
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The listing contains this information about DOT Codes. 

DOT Code  Packing group 

Whether the material is hazardous  Freight class 

Hazardous material entry (hazardous 
or reportable quantities)  

Shipping name 

Hazard class  Additional descriptions of the material 
(optional) 

UN/NA identification number   

SO Code List, which prints a listing of the various 50 codes including route and returns code. 
Each code above is entered into its own F/M program. Routes are assigned to each 
document in sales orders (if used). Returns codes are assigned to items when the 
merchandise is returned and defines why the merchandise is being returned. Return reason 
codes are assigned to items on a CR (Customer Return document) when the merchandise is 
returned and defines why the merchandise is being returned. Report information includes 
each code and the information stored with the code. The total number of codes listed is also 
included. 

Ship Via Listing, which lists ship via codes, which are set up in the Ship Via F/M. The report 
consists of codes that meet the criteria entered in the program (see fields below), including 
whether the codes are active or inactive, and whether they are commercial or residential. 
The report also shows the freight GL number associated with the code and the handling 
charge amount, if any. All of the information provided in this list is derived from the Ship Via 
F/M. 

Order Activity Cost Code Listing, which lists all the different types of order cost activities. The 
report lists the cost code, the cost type, the document type, the warehouses the cost applies 
to, the cost dollars, and whether it applies to direct ships, if applicable. 

Customer Order Profitability Analysis Report, which applies the costs recorded in Order Cost 
Activity F/M to the customers by the volume of their orders. For backorders, the order level 
cost will not be applied. Backordered counter sales will be treated the same as backordered 
sales orders for calculating costs. 

Customer Order Profitability Analysis Report Details 

BOM items are treated as a single item if it updated the finished item, and will be treated as 
multiple items if it the components were entered/updated on the Sales Order. 

Calculations for the report will include: gross profit, cost to serve (all document costs based 
on the cost codes defined above), and net profit contribution (gross profit less cost to serve). 
It is the net profit contribution that will be used to sort in descending order if selected. 

Gross Profit will be calculated by taking price minus cost times quantity on each line that 
qualifies to be included in the report. Then order costs will be applied. Order type costs will 
only be applied if the initiating warehouse is included in the warehouses list. Warehouse and 
line type costs will only be applied if the shipping warehouse is included in the warehouses 
list. All flags in the cost type file will be considered before applying the cost. 
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Order Booking Report, which is used to review booked orders and print them for tracking 
purposes of tracking. You must set the Order Booking flag on the Use tab of SO Static 
Control F/M to indicate how many months to store order booking information. To ensure 
additional accuracy, the Order Booking Report is based on the system date (not the FACTS 
date). The End-Of-Period Update (SOU890) program also uses the system date for Order 
Booking processing. 

Order booking work flow 
The system books orders in these ways: 

• Orders are booked through SO Order Entry. 
• In Quote Entry, quotes can be converted to orders by setting the Conv Stat flag to "Y" for 

a line(s) and enter "Y" at the Convert quote to sales order prompt in the Order Entry 
footer. 

• Recurring documents are entered in Recurring Document Entry with posting dates. 
When you run the Post Recurring Documents program, it creates orders for those source 
documents that are within the posting range. 

• Blanket orders are entered in Blanket Order Entry. When you run the Blanket Order 
Release Register, it creates orders for the source documents that meet the 
specifications. 

The system considers an order as edited if the initiating warehouse, document total, total 
cost, or primary/secondary/inside salesperson contains a net change. If you change an order 
and then change the order again in manner that does results not result in a net change of 
information, the system does not consider the edit for order booking tracking. For example if 
modify the document total, total cost, or primary/secondary/inside salesperson and then 
change the information back, the system does not record the change.. 

However, if an order is changed then deleted in the same session, the system tracks only the 
deletion. 

The program provides many report criteria options to allow for tailoring the report. You can 
print booked orders, orders that have been entered through various methods in the SO 
module (excluding direct invoices, credit memos, and counter sales) and edited orders, 
orders that have been changed and/or deleted. 

The information and report selection available pertaining to Salesperson is determined by the 
Inside/2nd Slsp flag set in SO Static Control F/M. Information prints for the inside 
salesperson only if the Inside/2nd Slsp flag in SO Static Control F/M is set to "I" or "B". 
Information on second salesperson prints on the report if the Inside/2nd Slsp flag is set to "2" 
or "B". In addition, the report selection based on a salesperson only applies to the current 
salesperson at the time the report is printed. 

Limitations/Exclusions 
• The Order Booking Report does not report on direct invoices, credit memos, or counter 
sales where items can be committed and not shipped. 
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• The report does not reflect anything that takes place during or after confirmation of the 
original order. 

• Once an order is confirmed, order booking no longer tracks the order, so changes to or 
deletions of backordered documents are not tracked. 

• CRS-generated orders will not be included since they usually contain replacements and not 
new sales. 

• The system does not track the original (source) entry of blanket orders and recurring 
orders. However, each order created by a source blanket or recurring order is included in the 
report. 

• The report information is displayed by order, not by line-item. 

• If the LIFO/FIFO costing method is used, the cost and GM at the time of the original entry 
prints on the report. The report is not updated by final cost. 

• Order booking records will only be created for new documents. Changes made to orders 
that already existed before order booking was turned on will not be tracked. 

End of Period  
The End-of-Period Menu contains programs that should be run at the end of each Sales 
Orders period in order to close it correctly. 

Program concepts 
These programs are on the SO End of Period menu: 

The Period Sales Register prints a recap of all the Daily Sales Registers run for the period 
listing a total for the period at the bottom. If used, the Daily Sales Registers recaps are also 
listed by salesperson, terminal, terms code, warehouse and/or department. The optional 
removal should be run to remove all registers for the start of the next period. An optional 
update following register the register print allows removal of all records just printed. The data 
for this program is the Daily Sales Register totals since the last Period Sales Register update 
was run. This data is stored in the Sales Orders Period Sales File. 

This program is only used if the Use pd sales register flag is set to Y in the Sales Orders 
Static Control F/M. 

Period sales register information by Daily Sales Register includes register date, register 
number, number of invoices, merchandise amount, miscellaneous amount, discount amount, 
cost, margin, tax, freight, cash sales and total register amount. Totals are included for all 
fields for all Daily Sales Registers appearing on the report. 

The End-of-Period Update zeros out the monthly recap figures and increments the current 
sales orders period by one. Use the End-Of-Period Update program to close the current 
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sales orders period by resetting the current period and removing Daily Sales Register recap 
period-to-date information. 

Order booking processing 

When determining if a document’s order booking records should be removed, the system 
only considers the document’s create date. In other words, if the create date is within the 
date range, the system removes all of that document’s order booking records–-even if the 
edit dates are not within the date range. However, the system first checks to see if the sales 
order is still open. If the order type is "O" or the status is "E" or "W", then the system does 
not remove the document’s order booking records 

If the Order Booking flag is set to "Not used" in SO Static Control F/M, the next time the end 
of period update is run, the system purges all order booking records for the current company. 

File maintenances and infrequent file 
maintenances 
The File Maintenance programs allow you to enter, change and delete data. These programs 
are used to enter the initial data required to set up the system. You can also add, change 
and delete the records in a file. 

File maintenance programs create the foundation of the FACTS system. They enable users 
to enter file information (such as customer, item and vendor files) and control how the 
system processes information, as in SO Static Control. 

File Maintenance programs are also referred to as F/Ms for short, these programs often 
function the same way. 

You will use some file maintenance programs, such as Vendor/Item F/M, more often than 
you use others. In fact, some file maintenance programs, such as SO Static Control F/M, are 
only used during installation. These programs are accessible from the Infrequent File 
Maintenances menu. 

Infrequent file maintenance programs are used most often during initial system installation 
and setup; they primarily allow you to control overall operation of other programs in the Sales 
Orders Modules. Once set up, these programs are often maintained by the system and rarely 
require editing. However, if you are not getting the desired results from entry programs, 
reports or inquiries, certain file maintenance programs may need to be modified. 

Program concepts (file maintenances) 
The following file maintenances can be accessed from this menu: 

Past Sales F/M (SOF910), which is used to maintain records in the Past Sales History File 
during initial installation and setup. If past sales history is stored, three records are stored for 
each customer/item combination. 
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You should enter data manually in this program only when setting up the original customer 
and item information. Thereafter, it is updated by the Daily Sales Register update. Any 
changes you make via this program after the system is operational may compromise data. 

NOTE: Entering original information into this file is optional. Past sales information may be 
displayed using the sales orders Customer Inquiry Program. Records may be removed from 
the Past Sale File using the Past Sales Removal Program. 

Before using this program, the Use Past Sales flag the SO Static Control Record must be set 
to Y. The Store SO Sales history flag in the Customer File must also be set to Y for the 
customer selected. 

Sales Register Recap F/M (SOF920), which is used to create and maintain records in the 
Sales Register Recap File. Initially, the system does not use this program, and the file is 
empty. Records are created depending on the recap settings in the SO Static Control 
Record. If the DSR Recap MTD flag is set to Y in the SO Static Control Record, information 
in this file is used to print the Period Sales Register and the period-to-date information on the 
Daily Sales Register. 

Lost Sales F/M (SOF930), which is used to enter lost sales information during initial 
installation and setup. Thereafter, it is updated by the Daily Sales Register update. Any 
changes you make via this program after the system is operational may compromise data. 

NOTE: Entering original information into this file is optional. 

Lost sales are recorded during the Daily Sales Register update when the backordered 
quantity was 0, but you did not ship all the items ordered. For example, if the customer 
ordered 5 and the shipped quantity was 3 and the backordered quantity was 0, then the lost 
sales would record 2. 

Lost sales information may be displayed by printing the Lost Sales Report. Records may be 
removed from the Lost Sales File using the optional removal at the end of the Lost Sales 
Report or through the delete option in this file maintenance. 

Before using this program, make sure the Use Lost Sales tracking flag is selected or set to Y 
in the SO Static Control F/M. 

Unbilled Freight F/M (SOF940), which is used to create records in the Unbilled Freight File 
during initial installation and setup. The program should only be used once to enter original 
start-up information. Thereafter, the Daily Sales Register updates this information. Any 
changes made to this program after live processing begins may compromise data. 

NOTE: Entering original information into this file is optional. 

Unbilled freight is recorded during the Daily Sales Register update when the freight code is 
set to B-bill later on an invoice. 

Unbilled freight information may be displayed by printing the Unbilled Freight Report. 
Records may be removed from the Unbilled Freight File using the optional removal at the 
end of the Unbilled Freight Report or through the delete option in this file maintenance. 

DOT Code F/M (SOF530), which is used to create and maintain Department of 
Transportation (DOT) Codes for hazardous materials. All materials that the DOT deems 
hazardous must have a DOT Code assigned to it. For more information on hazardous 
materials and regulations, please refer to the DOT’s Hazardous Materials Guide. 
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Each DOT Code can be assigned to an unlimited number of items in Item F/M. 

Remote Customer/User F/M (SOF540), which is used to maintain information of customers 
who use the Remote Order Entry System. This program provides crucial data identifying the 
remote user as a customer instead of a standard user as well as other information on the 
user. Enter all data relevant to your requirements for security and controlled access. 

Note: It is not the responsibility of Infor to support, maintain or recommend any software or 
hardware to be used to maintain the connection between you (the distributor) and your 
remote customer's computer. Please consult with your hardware/software supplier for 
specific recommendations for your installation. 

If you are inquiring on an existing remote customer, enter the customer’s number and select 
the Customer Activity tab to view thisinformation: 

• Month-to-date sales 
• Year-to-date sales 
• PYR sales 
• Last sign-on date 
• Last date an order was entered 

Resetting Failed Logins:  Remote user login attempts are tracked and processed using 
settings from System Control F/M just like all other user accounts. Select the Security tab of 
System Control F/M and set the Invalid Login Attempts field 0. Then select the General tab 
and deselect the Disable Login flag for this user. 

Customer Item F/M (SOF545), which is used to set up cross-references for the item numbers 
that customers use to ID items and the item codes used in FACTS. Both the customer item 
descriptions and the standard FACTS item descriptions print on pick tickets and invoices. 

eCatalog Note: When a customer item is added or the description is changed, the system 
adds a record to the eCatalog log file for the next update to the eCatalog database. There is 
currently no way to remove a Customer item record from eCatalog. However, when a 
Customer item record is deleted, any unprocessed records for this transaction will be 
removed from the log file. The system sends All customer items to eCatalog. 

Companion Item Entry (SOE150), which is used to designate item to import when a specified 
item is entered in Order Entry, Quotes, Confirmation, Direct Invoices or Counter Sales. You 
can indicate whether the import of items/memos is automatic or prompted for each Order 
Entry program type. 

Use Standard Order F/M (SOE250) to manage item standard orders for a customer and 
ship-to location. The Copy To feature allows you to create standard order lines within the 
standard order file, based on the lines shown by customer and ship-to. You can copy 
standard order lines to another standard order. See Copying standard orders. The Remove 
From feature allows you to delete standard order lines within the standard order file, based 
on the lines shown by customer and ship-to. You can delete standard order lines from other 
standard orders by customer, ship-to or all ship-tos. You can broaden deletion process by 
ignoring the item quantity and /or UM for the selected standard order line. For example, if 
you wanted to remove item I100 from every standard order on record, you could check the 
Ignore Quantity and Ignore UM boxes to remove all matching item number’s regardless of 
quantity and /or UM. If you only wanted to remove specific memos, specific quantities, and/or 
specific UMs, leave these check boxes unselected. By mixing and matching the check box 
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selections you can manage a vast array of values throughout the standard order files. See 
Removing standard orders. Standard orders are available from the Side Bar. You can also 
create standard orders on-the-fly in Order Entry. 

Companion item processing 
In the Order Entry program suite when a line item is originally saved, a check is performed to 
determine if there is an SO Companion Item header record for the item number.  

Use Companion Item Entry (SOE150) to select whether the import of items/memos is 
automatic, prompted, or not applicable to the entry program. If any companion items/memos 
are flagged as "Y-Default to Y" or "N-Default to N," you have the option to select any of the 
companion items/memos available. In the Auto Add section, if any companion items/memos 
are flagged as "A – Always Add" and any additional companion items/memos are flagged as 
Y or N, then all items/memos that are A, Y and N are displayed in the SO Companion Item 
Selection (SOE151) dialog box. A for Automatic Add always adds automatically to the 
document. If all companions applicable for this order type are flagged as A and there are no 
Y or N flagged items/memos, then no dialog is displayed and those items/memos are 
automatically imported into the document (unless there’s an exception that requires user 
attention, like the item not being setup in a warehouse). If any companion items/memos are 
flagged as "X – Not Applicable" then they are not displayed in this dialog and are not 
imported into the actual document. Once the companion items/memos are selected the items 
are imported into the document.  

eCatalog note: When a companion item is added and the Companions to eCatalog check 
box on Company Control F/M is selected, the system adds a record to the eCatalog log file 
for the next update to the eCatalog database. There is currently no way to remove a 
companion item record from eCatalog. However, when a companion item record is deleted, 
any unprocessed records for this transaction will be removed from the log file. Companion 
memo lines do not upload to eCatalog.  

Displaying companion usage  
Optionally click Companion Usage Display to view usage for parent companion items. In the 
grid, optionally click Companion Line Usage Display for companion line items.  

Indicate what to display: 

The modules that use the companion item: IC, SO, PO or all. 

How the companion item is used: as a Parent item and/or companion line item. 

Click OK to display the Companion Items File Overview screen with the item usage. To print 
this overview, check the Print Usage Info box and specify a print option. Click OK. 

In the grid in the lower portion of the screen, the system displays any companion items 
previously associated with this item. 
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Limitations and exclusions 
These limitations apply. 

• Companion items are not searched for bill of material components.  
• Companion items are only searched from Quote Entry, Sales Order Entry, 

Confirmation Entry, Direct Invoice Entry, and Counter Sales Entry.  
• In the event of a substitution, the companion items for the substituted item are used, 

not the originally entered item.  
• Companion items are not searched when negative quantities are entered on the 

document.  
• If companion items were selected on the save of a line item and the original line item 

is subsequently deleted, the companion items selected are not automatically deleted.  
• Companion items are only searched when initially adding or inserting a line.  
• Companion items or memos are not able to be setup for memo lines.  
• Temporary items cannot be setup as companions.  

Use Freight Schedule Entry to set up various freight rate schedules that can be used in 
FACTS to calculate the freight charges on an order. The freight rates can be calculated by 
total order weight, total order value or total item value 

Use the Ship Via F/M program to create and maintain ship via codes. Ship via codes are 
used throughout the system to indicate which carrier will ship an order. 

The codes are created according to warehouse to allow for these: 

• different warehouses posting freight to different General Ledger numbers 
• different warehouses charging different handling fees or not charging them at all 

Program concepts (infrequent file maintenances) 
You can access the following file maintenance programs from the Sales Orders Infrequent 
F/M subsystem: 

The Document Print Control F/M program allows you to set up and maintain the print 
parameters for quotes, pick tickets, packing slips, invoices, counter sale slips and bills of 
lading. It should be set up prior to using the Sales Orders system. Defaults in this program 
are set to accommodate the preprinted FACTS forms, which users can purchase separately 
from Infor Forms division. (Sample forms were included with the FACTS New User Packet.) 
If your company uses its own preprinted forms, modifications may need to be made to the 
various programs that affect quote, pick ticket, invoice and counter sales printing. If this is the 
case, contact your Affiliate. Preprinted forms are not necessary, however. Samples of non-
preprinted outputs are included in the PDF Documentation Library. Also, contact your 
Affiliate to see if UnForm software meets your needs. 

Route F/M, which is used to maintain delivery route information for use in various order and 
invoice headers. This feature is helpful to users who offer delivery services. If you offer 
delivery services, the Route F/M program enables you to create and maintain delivery route 
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codes and corresponding descriptions. If routing is not used, (the Use Routes flag in the SO 
Static Control F/M is set to unselected), this program may be skipped. 

If your system is set up for routing, each customer is assigned a default route based on the 
information set up in this file maintenance. That customer’s default route appears on all 
quotes, orders and invoices created for that customer. Orders and invoices may then be 
printed according to routes. These orders or invoices are usually sent out with the 
merchandise on delivery trucks. 

NOTE: Invoices sent out with deliveries do not print on the Daily Sales Register (that is, post 
to the Accounts Receivable File) until the route has been released (or approved) in the Route 
Release program (SOU310) under the Invoices menu. For example, on Tuesday, a truck 
goes out with TUE route invoices. When the Daily Sales Register is printed on Tuesday, TUE 
invoices do not appear because the Route Release Program has not been run for route TUE. 
This is because the TUE invoices are still on the delivery truck and some merchandise might 
be refused; some corrections may have to be made to the TUE invoices before updating 
them to Accounts Receivable. Only after the truck has returned with the invoice slips and the 
corrections have been made to these invoices should the TUE route be released. Once 
released, the Tuesday invoices will print on the next Daily Sales Register and post to AR. 

Use the Deposit Earned Reason Code FM program to set up one or more two-character 
reason codes, their descriptions and corresponding General Ledger numbers to handle 
instances in which deposits are earned (e.g., a customer cancels a special order after the 
order arrives). Reason codes work something like terms codes in that they provide a 
description of the transaction and indicate to which GL account the transaction should be 
posted. Deposit Earned Reason Codes are used in SO deposit entries, which can be 
accessed from several of SO entry programs. 

Returns Code F/M, which is used to manage codes used in Credit Memo entries that 
determine whether goods sent back by the customer, should be entered as returns or 
allowances. Use the Returns Code F/M program to create and maintain a list of returns 
codes that the systems uses to determine if goods returned should be categorized as returns 
or allowances. Returns codes are entered in the Credit Memo Entry program. 

If the goods are a return, then on-hand quantities are updated in the Credit Memo Entry 
program. If the goods are an allowance, no inventory quantities are updated. Both returns 
and allowances are posted to the General Ledger based on the GL numbers assigned to 
them in the SO to GL Posting F/M. 

Package F/M, which is used to calculate and maintain dimensional measurements of 
shipping containers, based on UPS definitions. Use the Package F/M program to calculate 
and maintain dimensional measurements of shipping containers. The dimensional weight, as 
defined by UPS, is used when shipping packages measuring more one cubic foot via UPS 
Next Day Air or 2nd Day Air. If the dimensional weight is greater than the actual weight, the 
dimensional weight is used to calculate shipping charges. 

The calculation used to determine dimensional weight is: 

length x width x height 

194 (dimensional weight factor) 

NOTE: If a package is a non-rectangular shape (such as a drum or sphere), use the 
dimensions of the smallest rectangular box in which the object can fit. 
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If calculated dimensional weight applies, it displays on screen. 

Shipping Control F/M, which is used to set up the defaults used in Freight Entry and contains 
flags that affect C.O.D. label printing and UPS Weight F/M. The Shipping Control F/M 
program allows you to create and maintain the Shipping Control Record, which consists of 
UPS rates and weight limits.  

The Shipping Control Record stores the defaults used in Freight Entry, the flags for the 
C.O.D. label printing and the UPS Weight F/M. 

As UPS changes its rates and weight limits, use this enter the new amounts in this program. 

If you have a package configuration (weight and value) that is used often, its information can 
be set up in this program as the defaults for weight and declared value in the Freight Entry. 

NOTE: The Freight Subsystem has been approved by UPS as a host computerized manifest 
system. However, each user will have to contact the appropriate UPS representatives and 
get their approval as well. Also, FACTS can use other carriers/freight companies; just enter 
their information instead of the information from UPS. 

UPS Weight F/M, which is used to store UPS weight tables for users who wish to add UPS 
charges into freight. Use this program to create, maintain and view the UPS weight tables (if 
applicable). If UPS charges are not to be implemented into the freight, then this program may 
be skipped. 

The weights table chart is given to the user by UPS. The user is responsible for creating and 
maintaining the UPS weight tables with this program by entering the charge assigned by 
UPS for the selected zone and displayed weight. The weight tables should be entered 
directly from the UPS weights table. Charges for air letters are also entered in this program. 

FACTS ships with the weights and zones for the 48 contiguous states. Users outside the 48 
contiguous states must enter the rates that apply to them. 

UPS Zone F/M , which is used to set up UPS zones by warehouse for users who wish to add 
UPS charges into freight. The UPS Zone F/M program allows you to create and maintain the 
UPS zones (if applicable) by warehouse location. The UPS zone determines the cost of 
shipping a package from the warehouse to the desired location. You can skip this program if 
you do not include UPS charges in the freight. 

To create zones in this program, enter the beginning and ending zip code (first three 
characters) and the zone for the codes as assigned by UPS. The zones should be entered 
directly from the zone chart provided by UPS. 

Entries are only applicable for ground and 2nd day air zones in the domestic United States 
(2-8, 12, 14, 15, and 16). A note displays at the bottom of the screen indicating the proper 
setup for Alaska, rural Alaska, Hawaii and Puerto Rico. 

Lost Sales Reasons Code F/M, which is used to manage user-defined reason codes used in 
order entry to track lost sales. Use the Lost Sales Reason Codes F/M program to enter, 
change, and delete lost sales reason codes. A Lost Sales Reason Code is a three-character 
code that indicates why merchandise was not sold (e.g., out of stock, extended lead time, 
found better price, etc.). The purpose of this code is mostly informational. It does not affect 
the General Ledger. 

Warehouse Code F/M, which is used to indicate which users can access the initiating or 
shipping warehouse in the Order Entry Program. The Warehouse Code F/M is a security 
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program that gives warehouse managers control over who has access to their warehouse 
stock. It is one of several programs used to set up multi-warehousing capabilities and 
controls. See also Warehouse F/M and Warehouse/Item F/M. 

By default, the approval process for releasing an item so that it can be shipped from a 
warehouse is enabled for all users, unless the option to allow items shipped from other 
warehouses is set to unselected or the SO Static F/M flag Use Multiple Warehouses in SO is 
set to unselected. 

Users can be authorized to initiate orders from a warehouse, and they can be given rights to 
ship from warehouses. Users without initiating rights in a warehouse will not be able to 
create orders, invoices or perform counter sales from that warehouse. Users without 
shipping rights in a warehouse will not be able to confirm orders in that warehouse. 

Once line items have been entered in a sales order, the initiating warehouse may not be 
changed regardless of authorization level. You can access this program from the Users 
button in Warehouse F/M (ICF970) or from SO Infrequent File Maintenances menu. 

Terms Code Order Setup, which is used to manage the display of multiple terms codes in the 
ending routines of direct invoice and counter sale entries. Many of the SO Entry programs 
allow you to enter multiple payments. The Terms Code Order Setup program allows you to 
create and organize the list of terms that you want to appear in the footer of invoice, counter 
sale, order confirmation, service order and credit memo documents. 

The six two-character terms codes must already be set up in the Accounts Receivable Terms 
Code F/M program (Accounts Receivable > Infrequent F/M > Terms Code F/M). The 
descriptions that follow the codes are user defined (up to 10 characters). Once entered, 
terms codes and their descriptions can be inserted, moved or deleted. Press F3 to save 
changes and exit, or press F4 to abandon changes before you exit the program. 

Order Activity Cost Code Entry (SOE620) is used to enter cost codes. You can use cost 
codes to associate cost activities with orders, shipping warehouses, or order lines, as well as 
set the document origin. This allows for different costing to be applied to orders that originate 
from the API, remote order entry or EDI, processes that may carry a lower cost. A cost 
activity is an activity that requires the resources of the company and is not included in the 
cost of goods. Examples of cost activities are picking orders, expediting orders, collection 
calls, and so on. 

After you enter cost code, use the Order Cost Activity Report to list all the different types of 
order cost activities and the Customer Order Profitability Analysis report to identify and rank 
customers by cost activities to examine the net profit contribution each customer is 
associated with. 

SO Entry Options F/M, which is used to define which header prompts users can edit in SO 
Order, Credit Memo, Invoice and Confirmation Entry programs. This file maintenance builds 
on flags formerly available in the SO Static Control F/M in FACTS 6.06 and earlier. SO Entry 
Option settings are not user-specific; they affect all SO Order Management Suite users. 

In this program, you define whether header, line item entry and footer inputs are: 

• required to complete a document and whether they should appear on the main screen. 
• not required. 
• can be initially skipped, but can be edited later if necessary. 
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You can also select which totals appear on the entry screen, set item browser flags to 
indicate backordered items, temporary items, non-stock items, as well as direct ships and 
items shipping from alternate warehouses, and set the notes pop-up display for item and 
customer notes. 

Programs that can be modified through this file maintenance are 

• Quote Entry 
• Order Entry (also modifies Service Order Entry) 
• Credit Memo Entry 
• Order Confirmation 
• Direct Invoice Entry 
• Counter Sales 

The Quote Entry option to recalculate user-overridden costs for items when a quote is 
imported to another quote or converted to a sale order is controlled through the SO Static 
Control F/M 

Ship Via F/M, which is used to create and maintain ship via codes. 

Document Import Control F/M program, which is used to set up and maintain a record for 
each importable document type, including Quote, Open Order, and Past Documents. 

SO to GL Posting F/M, which is used to determine how the Daily Sales Register posts to the 
General Ledger? The SO to GL Posting F/M program enables you to determine how sales 
orders, via the Daily Sales Register (DSR), post to general ledger (GL), if at all. It contains 
information (such as journal and account numbers) that the system references in performing 
the automatic posting of SO Daily Sales Register data to the General Ledger during the Daily 
Sales Register Update. This program only allows you to use General Ledger numbers that 
are already set up in the General Ledger Account F/M program. Do not make changes to this 
program without the approval of your company’s Accounting Manager or Controller. 

Static Control F/M, which is used to control how Sales Order programs process information 
for you. For example, you can set up or disable the system’s ability to use contract pricing, 
invoice history or line discounts, or allow backorders in order entry programs. The 
information in the Static Control F/M stays the same. The Static Control F/M consists of 
many flags and entries that activate or deactivate many of the features available in the Sales 
Order module. For instance, from this program you can determine whether or not to use job 
costing, past sales, cash drawer handling and quick customer creation, just to name a few of 
the possibilities. This program also enables you to show or hide certain header and line-item 
entry prompts for during entry in Blanket Sales Orders, Recurring Invoices, and the 
Customer Returns System. 

CAUTION! It is strongly advised that a password be employed on the Nonstatic Control F/M 
and Static Control F/M programs. Changes should be made only with extreme 
caution and under the supervision of your Affiliate. 

Nonstatic Control F/M, which is used to maintain flags that the system updates periodically, 
such as the current Sales Order period, last quote number and date of last release register. 
The SO Nonstatic Control Record is critical to the proper functioning of the SO System. The 
record contains information that the SO System references in performing various functions. 



Work flow and program concepts  

102 | Infor Distribution FACTS Sales Orders User Guide 

Remote orders 
The Remote Order Entry (ROE) subsystem is an optional feature of the FACTS system. The 
ROE subsystem provides a way to allow customers to log onto the system and enter their 
own orders directly, using their own item numbers. Remote users can also inquire upon the 
status of their quotes, open orders, past invoices, and other historical sales information when 
applicable. 

Program concepts 
You can access the following programs from the Remote Order Entry menu: 

Remote Order Entry, which is used to enter new sales orders and edit pending orders. Note: 
Orders that have been accessed by the distributor cannot be changed or deleted. You must 
call your distributor (system administrator) to have these orders changed or deleted. 

The Remote Order Entry screen consists of three sections: 

• header, containing order number, request date, etc. 
• line-item detail, containing the items, quantities, etc. 
• footer, which consists of the final fields prior to completion of the order. 

Remote Customer/Item File Maintenance., which is used to create and maintain item 
numbers to be used in the Remote Order System. Use the Remote Customer/Item File 
Maintenance program to create and maintain links between the standard system item 
numbers and the item numbers to be used in Remote Order Entry. Linking the customer item 
numbers to a standard system number makes it easier to search for items by using item 
numbers that are easily recognizable versus item numbers that the distributor uses. 

Customer Inquiry, which is used to perform system inquiries for quotes, open sales orders, 
past invoices, past purchases, pricing, ship-to’s, notes, and MSDS information (when 
applicable). 

Sales Analysis Customer Inquiry, which is used to perform system inquires into sales 
analysis information for customer/item numbers month-to-date and year-to-date activity. 

General Message Entry, which is used to send messages to your distributor’s contact. 
Remote users can use the General Message Entry program to communicate to with the 
distributor via the mail message system. Accessibility to this system may be restricted 
depending on how your distributor set up its system. 

Note: It is not the responsibility of Infor to support, maintain or recommend any software or 
hardware to be used to maintain the connection between the host system (the distributor’s 
computer) and the remote user. 
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Chapter 3 Sales Orders Transaction 
Procedures 

Standard Sales Orders Procedures 
This section covers standard procedures to be followed for Sales Orders. These procedures 
may vary depending on how the company’s business is conducted. The following three 
sections of standard procedures are provided as a guideline: 

Recommended Operating Procedures for Sales Orders 
An outline is provided of routine procedures on a daily, weekly, period (month, if 12 periods 
are used) and yearly basis. 

* indicates the procedure is required and must be performed in the time period designated 

Daily Procedures (or as needed) 

1. Print Daily Shipping Report 

2. Run Commit Backordered Quantities Program or run whenever new inventory is received 
into the system. 

3.  Enter/print quotes 

4.  Enter/print blanket sales orders 

5.  Print/update BSO Release Register 

6.  Enter/print work orders (picking tickets, packing lists) 

7.  Confirm orders 

8.  Enter/print invoices, credit memos 

9.  Enter/print counter sales 

10. Enter shipping information through Freight Entry/Print necessary shipping labels/ Print/ 
Manifest update after packages have been shipped. 

11. Run Route Release Program 

12. Maintain contract prices 

13. Run Post Recurring Documents Program 
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14. Print/update Daily Sales Register. 

  

Weekly Procedures (or as needed) 

1. Print Unbilled Freight Report 

2. Print Order Status Report 

 

Period Procedures (or as needed) 

1. *Post Recurring Documents through last day of period (if applicable) 

2. *Print/update last Daily Sales Register 

3. Print/update Period Sales Register 

4. *Run End-of-Period Update 

 

Yearly Procedures 

1. *Run the End-of-Period Update (already covered in period procedures - do NOT run twice 

General Procedures  

Creating document numbers 
The system automatically creates a document number once you complete the header. At 
that point, the document number appears in the title bar along with the customer’s name. 
You can also assign a document number manually if you prefer. 

To assign document numbers manually: 
1  Open the Sales Order Entry program. 

2  Click File>New Document Number from the menu.  

3  Specify up to six characters to create a document number. Click OK. 

4  Begin entering the order, starting with the Customer Number. 

Opening existing documents 
Access an existing document before you begin entering a new one. Once you begin entering 
header information, the system does not allow to you open a document in the same window. 



Sales Orders Transaction Procedures  

Infor Distribution FACTS Sales Orders User Guide  | 105 

You can also start another session of FACTS if you need to open a document while you are 
in the middle of entering one. 

To open an existing order: 
1 Specify the document number in the Customer Number field and press Enter. If the 

document number is on file, the customer number appears in the field and the document 
number appears in the title bar. 

OR 

1 Click File>Open Existing Document.  

2 Use the Document Search window to find the document you want to edit or review. 

3 Click OK in the search window to select the document and return to the main entry 
window. 

Deleting an order 
When you delete a sales order document, the document is not technically deleted from the 
system until the next Daily Sales Register Update. Until then, the header status changes to 
Deleted and the system removes all line items. This procedure enables the system to keep 
an audit trail of all the order numbers used.  

To delete an order before the header is complete: 
Press F4 to back up to the Customer Field. 

To delete an order after the header is complete: 
With the document open on screen, 

Click File>Delete Document from the menu. 

To edit an existing line item 
Use your mouse or arrow keys to highlight the line in the item browser and press Enter.  

OR 

Highlight the line and click Line Detail to access fields that do not appear in the line-item 
entry section.  
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To delete a line 
Use the mouse or arrow keys to highlight the line in the item browser.  

Press the Delete key on the keyboard;  
or 
click Delete  
or  
click Edit>Delete Item from the menu. 

At the prompt “Delete this line?” click “YES – Delete”. 

If the Lost Sales is selected on the Use Features tab of SO Static Control F/M (SOF980), you 
have the opportunity to post to lost sales if the item is inactive and the quantity is greater 
than the available amount. 

Select from the following options to indicate how to record and process the lost sale: 
N-No to indicate that you do not want to record the lost sale, R-Review to display the Lost 
Sales Entry (SOC420) screen and modify the lost date, update usage, quantity, price, cost, 
reason, and/or notes, Y-Yes to record the lost sale using the default lost sale reason code 
entered SO static Control F/M, the quote date as the lost sale date and usage defaulting to 
“no update”. You can also specify a different lost sale reason code.  
Click OK to delete the line or Cancel to exit without deleting. 

Inserting a line item or memo line 
Use the mouse or arrow keys to highlight a line. The program inserts the new line item above 
the selected one. 

Click Insert 
or 
click Edit >Insert Line from the menu. 

The program stays in Insert mode until you press F4 from the Item Number field or click 
Cancel. 

Finding an item in the item browser 
This feature may be helpful when you need to find an item you entered on a long order. It 
eliminates the need to scroll up and down in the list browser. 

Click Edit>Find Line Item from the menu.  

Enter the item number you want to locate. Press Enter to go to the first occurrence of that 
item in the item browser on the main screen. Press F2 to find a different item or F4 to exit the 
Find Item window. 
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Adding line items (Using the Line-Item Entry fields) 
1 Click Add. 

2 The program automatically switches to add mode once you complete the header. This 
means the cursor appears in the Item Number field after you exit the last header field. 

(The program stays in add mode until you press F4 to back out of the line-item entry 
section or click Cancel.) 

Quick entry tip: Specify the item number, the ordered quantity and then press the down 
arrow key. The program inserts the default information in the rest of the line-item entry 
fields and returns to the Item Number field. 

Complete this information. 

Field Options 

Item number Enter an item number manually or press F2 to select one from the 
Item Search.  
When you enter an item number, the system displays the Gross 
Margin for the item in the GM% field. If you modify the pricing and 
unit cost for the item, the system updates this value. 
Enter M to enter a memo line. 
Choose the Options menu to access Catalog Item Search, 
Customer Item Search, Past Sales Search, and several other 
searches. 
Choose the View menu to access Item Interchanges. 

Exceptional Sales Select the Exceptional Sales check box to indicate that this line 
item should not be included usage for replenishment calculations. 

Usage Date For line items that should have their usage included in 
replenishment calculations, enter the date to use or press F1 to 
enter the system date in the Usage field. 

Ship Direct or DS Select the Ship Direct or DS check box or press F3 to indicate, 
that this item is shipped directly to the from the vendor. 

Ordered Enter the customer's requested quantity.  
Press F2 to change the unit of measure on the ordered quantity. 
Press F3 to indicate this item is a direct ship. Enter or search for 
a vendor code. Later in the order you can press F3 again to 
toggle back to a warehouse ship. 
If the quantity entered exceeds the available inventory in the 
selected warehouse, the program gives you the option to accept 
the quantity anyway or press F2 to search other warehouses. 
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The Search Warehouses window displays the warehouses that 
have the item, along with the available, on hand, committed, on 
order, backordered and surplus quantities for the unit of measure 
selected.  
Select a warehouse. This creates a planned special order 
warehouse transfer. Make sure you backorder the item. 

Shipped Enter the quantity shipped to the customer. 

Committed Enter a quantity to commit in the warehouse or accept the default. 
This field defaults to the quantity ordered, if that quantity is 
available in the selected warehouse.  

Backordered Enter a backordered quantity if the quantity ordered is greater 
than the available quantity in the selected warehouse.  
When you enter a backordered quantity, Sales Order Entry 
programs base planned special order document creation on the 
Stock, NonStocked, Uninventoried, and Temporary prompts in 
Sugg PO/TR by Type section on the Line Prompt tab of SO Entry 
Options F/M (SOF915). Use these settings to indicate whether 
you want to have the system ask to create planned special order 
purchase orders or planned special order transfers by item type 
during Order Entry line processing. Refer to the Creating planned 
special order transfers/purchase orders from Sales Order Entry 
programs topic for detailed information about creating planned 
special order warehouse transfer or purchase orders for 
backordered quantities. 
The program skips this field if: 
The customer does not allow backorders (Allow backorders flag 
not selected in AR Customer F/M). 
Your company does not allow backorders (Allow backorders flag 
not selected in SO Static Control F/M). 
The item is a direct ship. 
The selected warehouse has enough inventory to fill the order. 
If the backordered and committed quantities do not add up to the 
ordered quantity, the entry program resets the ordered quantity to 
the sum of the committed plus backordered. 

Price Enter a price or press F3 to select one from the Price Search 
window.  
A letter appears after the pricing UM to indicate which pricing 
option you selected. Press F2 to change the pricing unit of 
measure. 
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If the Price Options window is open enter once of the following in 
the Price field to import the corresponding price: 
S-Standard, C-Contract, D-Default, T-List, L-Last, L#-Price level, 
Q#-Quantity break, U-user override – you keyed in a price. 
 
The T column in the browser refers to the price type for the item. 
The values in this column represent the following price types: 
List Price: T, 
Level Price: L#, 
Qty Break Price: Q#, 
Standard Price: S, 
Contract Price: C, 
User Override Price: U,  
where # gets replaced by the level number or the quantity break 
level number.  
To access the Price Options window, select View and make sure 
a check appears next to Price Options. 

If the item is designated as having companion items, the system displays the Companion 
Item Selection (SOE151) screen. Refer to the Companion Item Selection (SOE151) topic for 
details.  

3 Click Save. 

 

Accessing Lost Sale Entry (SOC320) 
1 You can access the Lost Sale Entry (SOC320) program three ways.  

From Order Entry Quote Entry, Direct Invoice Entry, Counter Sale Entry, Confirmation 
Entry, Purchase Order Entry, and Contract Item Entry you can select Options>Lost Sales 
Entry, if the Lost Sales checkbox is selected on the Use Features tab of SO Static 
Control F/M (SOF930). 
-OR- 

You can right-click to access Lost Sale Entry from the same entry screens listed above 
except, providing you have the proper security and the system has Lost Sale ability 
enables in SO Static Control F/M. 
-OR-    

The Lost Sale Entry option can be triggered automatically. If you reset the ordered 
quantity from the original order quantity entered, but the shipped, backordered and 
committed quantities do not equal the new order quantity. The program prompts you to 
indicate whether to post the difference (original order quantity minus new reset order 
quantity) to lost sales. Select R-Review to display the Lost Sales Entry (SOC320) screen 
and modify the lost date, update usage, quantity, price, cost, reason, and/or notes. Note 
that you must have the proper security code clearance as entered for SO Static Control 
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F/M (SOF930) to select the R-Review option and display this program. If a password is 
required for SO Static Control F/M (SOF930) then the password prompt will display 
before allowing you to continue. If you select Cancel on the Password prompt, a lost sale 
will automatically be recorded. 

Posting lost sales 
1 Access Lost Sale Entry (SOC320) using one of the methods listed in Accessing Lost 

Sale Entry (SOC320). 

2 (Optional) In the Customer, Ship-To, and Slsp/Terr fields enter the information.  Default 
values are available when Lost Sale Entry is called from SO Entry programs. 

3 Enter the item, quantity, price, and cost values in the Quantity, Price, and Cost (if cost 
is shown) field.  Default values are available when Lost Sale Entry is called from SO 
Entry programs. Note: The Cost field does not display if you do not have the cost security 
code, and the Cost column in the list box will also be hidden. Items not on file can be 
entered. 

4 The Warehouse field value defaults from the user profile. 

5 (Optional) In the Description 1 and 2 fields, enter the description for only items not on 
file.  (Only items-not-on-file can have their description entered/changed.) 

6 After you enter information in the above fields, matching or near matching records 
already on file are displayed in the lower list box. 

7 Update the Reason Code as needed.  The Reason Code will default to the SO Static 
value entered for default reason code.  

8 Specify whether to Update Usage. The default setting is based on the value for the 
Reason Code in Lost Sale Reason Code F/M.  

9 (Optional) In the Notes field, specify any notes for the lost sale entry. 

10  Click Save to record the lost sale. 

11 (Optional) Click Reset Filter to clear the list box of any values and reset the header field 
values on the screen to enter more lost sales information.  

12 Click Done to exit the program.   

Processing deposits or payments 
Use Deposit/Payment Entry (SOC718) to enter customer deposits or payments on SO 
documents. You can access this feature from any of the SO Order Management programs 
(Order Entry, Service Order Entry, Confirmation, Direct Invoice Entry, Credit Memo or 
Counter Sale Entry) by clicking Deposits/CC Preauth or Payments (from the Footer 
screen). 
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Turbo Tokens 
The Turbo Tokens workflow is available faster use of CenPOS tokens credit card processing 
for deposits or payments on sales order documents.  

The Turbo Tokens drop down list is available in Order Entry, Order Confirmation, Direct 
Invoice Entry, Counter Sale Entry and Credit Memo Entry. If a Turbo Token was selected for 
the line, the token value is displayed. 

In Deposit/Payment Entry when a Turbo Token has been selected, for “C – CC PreAuth” 
transaction types with a terms code of Type 1 or for pre-authorizations, Type 2, the entire 
CenPOS interface is suppressed and a properly formed web request is executed as if the 
user had selected the token in the normal fashion. If the transaction is approved normal 
processing such as receipt printing, continues. 

If the transaction is not approved, then the Turbo Token prompt is cleared. The user is 
returned to the Deposit/Payment Entry program. When a transaction is not approved, a 
different Turbo Token can be selected. Normal payment mechanics continue. For example, if 
a PreAuth is selected and a Type 1 or Type 2 terms code is selected, clicking OK displays 
the CenPOS interface along with the CC TOKENS button at the bottom of the CenPOS 
interface panel. 

Tips: 

If an invoice contains a zero balance payment or deposit with a transaction (i.e., transfers, 
apply on account, refund, etc.) against it and you attempt to delete the document, the system 
displays a message indicating that the financial transaction will remain in effect. You can 
delete this document, or, you can back up to the Payment dialog box and delete the 
transaction if necessary.  

When a deposit is transferred to another order, the system applies the same deposit settings 
from the Daily Sales Register to the order that receives the deposit.  

Creating deposits, preauths and payments 
1 Click Deposits/ CC Preauths or from the main screen of the entry program or 

Payments from the footer window. This opens the Deposit/Payment Entry window. 

2 In the browser, click Add. 

3 At the Add prompt click CC Preauth or Deposit for orders (Deposit or Payment for 
invoicing programs) from the drop down list. 
In Order Entry, CC Preauth or Deposit are the only options. Payments cannot be entered 
on sales orders until they are converted to invoices. CC Preauth is only available if the 
Credit Card Processor is set to “C” (Cenpos) in Company Control F/M (SMF920). 
In Credit Memo Entry, Payment is the only option.  

4 Specify the cash type terms code.  
Deposits and payments must use AR terms codes types 1, 2, 3 or 4. These should be 
set up in the AR Terms Code F/M. Press F2 to search terms codes. Tip: Refer to the 
Type column to see which codes are type 1, 2, 3 or 4. 
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5 Specify the amount of the deposit, credit card pre-authorization, or payment.  
Credit Card processing users: If you entered a credit card terms code, the credit card 
transaction pop-up window is displayed after you click Save.  
Deposits and payments cannot exceed their document totals. If FACTS detects an 
overage, it asks to either refund the overage or apply it to the customer’s account before 
it lets you complete the document. 

6 If applicable, specify the check number or credit card number.  

7 (Optional) Add any notes about the payment or deposit.  

8 Click Save. 
 
Cash drawer users: When you complete the deposit or payment entry, the system 
checks to see if you are signed into a cash draw. If you did not sign in through the 
Update Shift program, the system prompts you for a drawer ID. Press F2 to search for 
available cash draws. 

9 For credit card pre-authorization transactions, the Cenpos POS interface is automatically 
displayed so you can authorize the transaction. 

10 (Optional) Click CC Tokens on the Cenpos Interface panel to use a token for this 
preauth transaction. 

Initiating pre-authorizations (forced capture) 
1 Access the Deposit/Payment Entry window from an entry program. 

2 Double-click a pre-authorization line (type “C” payment line ) in the browser. 

3 The ForceCapture CC Transaction window is displayed and a CenPOS ForceCapture 
(web service) transaction is automatically started using the selected pre-authorization 
line. 

4 (Optional) The amount from the pre-auth line is displayed for the CC Charge Amount. 
You can specify a different amount as needed. 

5 Click OK to complete the processing and send the CenPOS 
ProcessCreditCard/ForceCapture Transact Web Service call. 

6 The CenPOS interface is automatically displayed when you save the transaction in 
Deposit/Payment Entry so you can authorize the transaction.  

7 (Optional) Click CC Tokens on the Cenpos Interface panel to use a token for the 
PreAuth transaction. 

8 When you complete the CenPOS processing the original entry program is re-displayed. 

Editing deposits, pre-authorizations, and payments 
1 Access the Deposit/Payment Entry window from an entry program. 

2 Click the payment, pre-authorization, or deposit line in the browser. 
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3 Click Edit. You can make changes to terms codes, amounts, notes.  

Credit card transactions that have been forced or have been approved by the processing 
company cannot be changed. You must void the credit card transaction or perform a 
refund back to the credit card and then enter a new deposit or payment.  
 
Transferred deposits cannot be modified. Cash payments, meaning payments made with 
a type C cash terms code from the footer window, cannot be edited in the 
Deposit/Payment Entry window. If you need to make a change to a cash payment, delete 
it or refund it first and then add another payment. 

4 Click Save to return to the Deposit/Payment Entry window. 

Deleting deposits, pre-authorizations, and payments 
1 Access the Deposit/Payment Entry window from an entry program. 

2 Click the deposit, pre-authorization, or payment line in the browser. 

3 Click Delete.  

If the deposit or payment has been acted on — applied, earned, transferred, etc. — you 
must delete the transaction first and then delete the original deposit or payment.  

Pre-authorizations are first voided via a Web Service Call to Cenpos and then removed 
the FACTS sales order processing files. 

Transferred deposits cannot be deleted.  

If a deposit or payment was made by a credit card, you cannot delete it. You must void 
the transaction or refund the payment. 

4 Click OK to confirm. 

Clearing outstanding deposits from SO documents 
You cannot complete a Confirmation, Direct Invoice or Counter Sale document with an 
outstanding deposit. A deposit entered on a document is considered an outstanding deposit 
until you perform one of the following actions: 

Earn the deposit (in the event that a customer forfeits the deposit) 

Refund the deposit to the customer 

Apply the deposit to the customer’s account 

Transfer the deposit to another of the customer’s documents 

Deposits cannot be applied to a sales order document until the document is converted to an 
invoice. 

Use the Outstanding Deposits Report (Sales Orders>Reports>Outstanding Deposits Report) 
to generate a list of outstanding deposits. You can run this report at any time during the 
Sales Order process. It does not affect the DSR. 
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To apply a deposit to a customer’s account: 
1 Access the Deposit/Payment Entry window from an entry program. 

2 Click the deposit line in the browser. Click Apply Trx button. 

3 In the popup window, select O-On Account in the Transaction Type dropdown list. 

4 Click Balance to apply the total amount of the deposit to the customer’s account. Apply 
part of the deposit by manually entering an amount. If you enter a partial amount, you 
must clear the remainder of the deposit before you complete the order, invoice, counter 
sale or credit memo. 

5 Click Save to return to the Deposit/Payment entry window. 

To earn a deposit: 
1 Before you can earn deposits, reason codes must be set up in the Deposit Earned 

Reason Code F/M (Sales Orders>File Maintenances>Infrequent File 
Maintenances>Deposit Earned Reason Code F/M). 

2 Access the Deposit/Payment Entry window from an entry program. 

3 Click the deposit line in the browser and click Apply Trx. 

4 In the popup window, choose E-Earn from the Transaction Type dropdown list.  

5 Specify the reason code. Press F2 to find a reason code. The reason codes enable you 
to track why the customer forfeited the deposit and indicate to which GL number the 
earned deposit should post.  

6 Specify the amount being earned. Click Balance to enter the entire amount. 

7 Click Save to return to the Deposit/Payment entry window. 

To refund a deposit: 
1 Access the Deposit/Payment Entry window from an entry program. 

2 Click the deposit line in the browser and click Apply Trx. 

3 In the popup window, choose R-Refund from the Transaction Type dropdown list. 

4 In the Terms Code field, indicate how the payment is being refunded – cash, check, 
credit card, etc. The terms code must be a cash type 1-4. Press F2 to search terms 
codes.  

Check refunds must be processed through the AP Manual Check Entry program. A note 
to this effect appears in the Daily Sale Register, but the amount does not affect the 
register totals. 

5 Specify the amount of the refund. Click Balance to refund the entire amount. 

6 If applicable, specify the AP check number, if you are refunding the payment by check, 
or specify the customer’s credit card number.  
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7 Click Save to return to the Deposit/Payment Entry window. 

To apply a deposit to the same document (create a payment): 
1 Access the Deposit/Payment Entry window from an entry program. 

2 Click the deposit line in the browser and click Apply Trx. 

3 In the popup window, choose A-Apply from the Transaction Type dropdown list. This 
option is not available if you’re in Order Entry. Applied deposits are the same as 
payments, which can only be made on invoices, counter sales and credit memos.  

4 Specify the amount to apply on the customer’s account. Click Balance to apply the entire 
amount.  

5 Click Save to return to the Deposit/Payment Entry window. 

To transfer a deposit to another document for the same customer: 
1 Access the Deposit/Payment Entry window from an entry program. 

2 Click the deposit line in the browser and click Apply Trx. 

3 In the popup window, choose T-Transfer from the Transaction Type dropdown list.  

4 Specify the document to which you want to transfer. Press F2 to find the document. It 
must belong to the same customer. The document number appears under the Notes 
column header in the browser on the main Deposit/Payment Entry screen. 

5 Specify the amount to apply on the customer’s account. Click Balance to apply the entire 
amount. 

6 Click Save to return to the Deposit/Payment Entry window. 

Using payment options 
Payments made on a document are automatically applied against the document’s total 
unless you apply the payment to the customer’s account or refund the payment back to the 
customer. 

To apply a payment to a customer’s account:  
1 Access the Deposit/Payment Entry window from an entry program. 

2 Click the payment line in the browser and click Apply Trx. 

3 In the popup window, choose O-Apply on Account from the Transaction Type dropdown 
list. 

4 Specify the amount to apply on the customer’s account. Click Balance to apply the entire 
amount. 
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Check refunds must be processed through the AP Manual Check Entry program. A note 
to this effect appears in the Daily Sale Register, but the amount does not affect the 
register totals. 

5 Click Save to return to the Deposit/Payment Entry window. 

To refund a payment to the customer: 
1 Access the Deposit/Payment Entry window from an entry program. 

2 Click the payment line in the browser and choose Apply Trx. 

3 In the popup window, choose R-Refund from the Transaction Type dropdown list. 

4 In the Terms Code field, indicate how the payment is being refunded – cash, check, 
credit card, etc. The terms code must be a cash type currency (type 1-4) or cash. Press 
F2 to search terms codes.  

5 Specify the amount to refund. Click Balance to apply the entire amount. 

If applicable, enter the AP check number, if you are refunding the payment by check, or 
enter the customer’s credit card number. 

6 Click Save to return to the Deposit/Payment Entry window. 

Using the multiple payments section (Sales Orders) 
The multiple payments section is part of the SO Entry document footer and enables you to 
enter more than one type of payment on a document, if for example, a customer wants to 
pay for part of the order by credit card and part of it by check.  

It also serves as a shortcut since it enables you to set up the six most frequently used cash-
type payments on SO Entry footers so you don’t have to access the Deposit/Payment Entry 
window. 

Order Confirmation, Direct Invoice Entry and Counter Sales Entry each provides a multiple 
payment section. You can define up to six payment options and determine the order in which 
they appear. 

Defining the multiple payment options 
1 Use the Terms Code Order Setup program (Sales Orders>File Maintenance>Infrequent 

File Maintenance>Terms Code Order Setup) to determine which payment types appear 
and in which order they appear.  

2 Terms codes must be defined in this program before you can use Order Confirmation, 
Direct Invoice Entry or Counter Sale Entry. 
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Entering a payment through the multiple payments section 
1 Specify that payment on the appropriate line or lines. If you click Balance, the program 

automatically enters the document balance.  

2 Use the Notes field to specify check numbers, notes, etc. In credit card transactions, the 
last four digits of the credit card number appear in the Notes field. 

3 Click OK when the document balance is zero. 

4 Choose whether to print the invoice now or print it later. 

Entering payments with payment options that don’t appear in 
multiple payments section 
1 Click Payment while the cursor is in any of the payment lines to access the 

Deposits/Payment Entry program.  
Payments and deposits can only be made with cash type terms codes 1-4, such as credit 
cards, checks, debit cards, etc. Press F2 to search the available terms codes and look 
for those with Type 1, 2, 3 or 4. Type C terms codes cannot be used in the 
Deposits/Payment Entry window. 

2 The payment amount that you specify in the Deposits/Payment Entry window appears on 
the OTHER PAYMENTS line when you exit the payment entry program.  F4-Backup 
takes you back to the Tax $ field after you exit the Deposits/Payment Entry window. You 
cannot edit entries in the multiple payments section.  

Editing payments from the multiple payments section 
Once you specify payments, … 

1 Click Payments to return to the Deposit/Payment Entry window. 

2 Using your mouse or the arrow keys, highlight the line you want to edit and click Edit to 
the right of the screen. 

You cannot change the terms code while you are in edit mode. Instead, delete the 
transaction and start over. 

Deleting payments from the multiple payments section 
1 Click Payments to return to the Deposit/Payment Entry window. 

2 Use the mouse or the arrow keys to select the payment you want delete. 

3 Click Delete. 
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Credit card handling procedures 

Setting up credit card handling for manual processing  
1 Set up a cash type terms code in the Accounts Receivable Terms Code F/M program. 

Credit cards must be cash type payments, not an A/R type. The General Ledger Number 
you choose must be a cash G/L account number. 

2 Navigate to the Company Control F/M in System Management File Maintenances. Click 
"Manual do not collect information". 

Processing credit cards manually  
• If you chose "Manual do not collect information" in Company Control F/M, credit card 

payment types will not display a window to collect the credit card information. 

Configuring FACTS to use CenPOS 
1 Navigate to System Management>File Maintenances>Company Control F/M. 

2 Choose CenPOS in the Credit Card Processor field. 

3 Set up a credit card terms code in the Accounts Receivable Terms Code F/M (Accounts 
Receivable>File Maintenances>Infrequent File Maintenances>Terms Code F/M) if you 
have not already done so. Credit cards must be set up as a cash type —that is, Type 1-4 
— so the General Ledger number you choose must be a cash G/L account number. 

4 Click System Management>File Maintenances>Infrequent File Maintenances>Credit 
Card Control (SME957). 

5 Specify the URL for the CenPOS interface as the Base URL. The default is 
https://www.cenpos.net/posintegration/inforintegration/default.aspx. When you have 
completed this screen, click Save then click Test to perform a 1-cent test transaction with 
CenPOS. 

6 Specify the Merchant account ID for CenPOS and the CenPOS password.  

7 Specify the User ID to store in the cache to allow processing without logging in each 
time. 

8 (Optional) Check the EMV Terminals check box to indicate you use chip reader (EMV) 
terminals. 

9 Specify the number of columns over which you want the credit card receipts to print in 
Columns for Receipt. The available range is between 30 to 80 (30 columns will give 
you a 2½-inch wide receipt). This sets the width of your credit card receipts, which can 
range from 30 to 80 columns wide. Specify 0 if you do not want a receipt to print. 
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10 Check the Transmit to CenPOS check box to indicate you are ready to activate 
CenPOS and transmit transactions. 

11 (Optional) In the Lines section, specify override merchant id and CenPOS settings for 
warehouses that need multi-merchant capability. Click Add and specify the information in 
steps 12-17. 

12 Specify the Warehouse for the override settings. 

13 Specify the Merchant account ID for CenPOS and the CenPOS password. 

14 Specify the User ID to store in the cache to allow processing without logging in each 
time. 

15 Check the EMV Terminals check box to indicate you use chip reader (EMV) terminals. 

16 Check the Transmit to CenPOS check box to indicate you are ready to activate 
CenPOS and transmit transactions. 

17 Click Save. 

18 Repeat steps 12-17 for any additional warehouses. 

19 Click Cancel to end line entry.  

20 Click Done. 

21 (Optional) To print credit card receipts, set up SOP610 in Program F/M. Then select the 
printer usage and normal printer for each terminal (the entries for fields 2-8 are arbitrary) 
so credit card receipts will print. This allows you to have one credit card receipt printer for 
all terminals, or a different printer for some terminals, as necessary. 

Managing CenPOS tokens 
1 Click System Management>File Maintenance> CenPOS CC Token Management. 

2 Specify the customer and, if used, ship-to location. 

3 In the browser, you can complete these tasks: 

• To remove a token, highlight the line and click Delete. At the delete message, click 
Yes and then click OK. 

• To edit a token, highlight the line and click Edit. The CenPOS token management url 
is displayed so you can update tokens in the CenPOS vault. You can modify this 
information: expiration date, name of card, zip, email address, tax exempt status, and 
address. Click Submit. 

• To add a token, click Add. The CenPOS token management url is displayed so you 
can update tokens in the CenPOS vault. You can specify this information: card 
number, expiration, name on card, zip, email address, and billing address 

4 (Optional) Check the Positive Card Verification check box to add the CVV code.  

5 Click Submit. 

6 When you are finishing managing tokens, click Done. 
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7 To exit, click Done again. 

Implementing level III payment processing 
To implement level III payment processing for CenPOS complete this information: 

1 Access Unit of Measure Code F/M (ICF965) and specify the Alternate Unit of Measure 
Code. It is an option in Credit Card Control F/M for Level III summary data processing. 

2 In Credit Card Control, ensure the Transmit Level II Data check box is selected and the 
Level III UOM, AR and SO Level III Summary descriptions are completed. 

Creating EMV terminals 
1 Click System Management>File Maintenances>EMV Terminal Maintenance. 
2 Specify the EMV terminal id and description. 
3 Specify the IP address (in IVP4 or IVP6 format) of the workstation/computer that the 

EMV Terminal is attached to. 
4 Click Save. 
5 (Optional) Click Test Connection to determine if the ip address is correct. 
6 (Optional) Modify the value if needed and save your changes. 
7 Click Exit. 

Using CenPOS tokens 
1 The CenPOS CC Token Management screen is automatically displayed for credit card 

processing if tokens are enabled for CenPOS. 

2 Specify the customer and, if used, ship-to location. 

3 In the browser, you can complete these tasks: 

• To remove a token, modify or add a token, refer to Managing CenPOS tokens, step 
3. 

• To use a token, highlight the line and click Use Selected Token. 

4 When you are finishing managing tokens, click Done. 

3 To exit, click Done again. 

Processing credit cards with FACTS and CenPOS 
After entering the credit card amount, the CenPOS Credit Card Entry pop-up window 
appears with the Amount from FACTS: 

Note: The required fields on the screen are marked with an asterisk *and highlighted in red.  
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1 Enter the credit card number or swipe the card through the reader. 

2 Enter the expiration date. If you swiped the card, the system automatically enters this 
data. 

3 Enter additional information as needed, based on your settings in CenPOS.  

4 Click Submit to process the transaction. 
 
A mini dialog box is displayed, indicating the system is waiting for a response.  
 
If there is no internet connection, the system will give a recognition timeout. If the card 
processing company does not answer or respond within the time set in CenPOS, the 
system gives you a response timeout. In both cases, the transaction is cancelled and 
nothing will have been charged on the user’s credit card.  
 
Voice Authorization is not supported at this time.  

5 At the end of the transaction, FACTS checks to see if you are signed on to a cash 
drawer. If not it asks you to do so. Press F2 to search. 

Importing notes 
The system displays the Importing Notes screen when SO document header or line notes 
are available for addition to the sales order, purchase order or item transfer document. SO, 
PO and TR Document and line notes are available to view/edit (according to the user’s 
security) for all open documents.  

You also have the option to print the note on the sales order (for order or backorder type 
documents only), credit memo, counter sale or invoice, purchase order or transfer. When you 
run the Daily Sales Register, the system copies SO document notes to the past invoice.  

You can export sales order line notes to associated purchase orders or inventory transfers 
and print the exported sales order line notes on the PO or transfer ticket. When an Order 
Entry program automatically creates purchase order such as for a direct ship sales order, 
FACTS determines if Vendor and Item notes should import into the PO, based on the export 
options setup on the note. If a note is set to export or required, then FACTS automatically 
imports the note onto the PO. 

1 At the top of the screen, the system displays the Note Type, document number, and 
Note Category for the note displayed for import.  

2 You can modify the following fields: 

Subject  

Enter or modify the subject for the note.  

Urgent 

Indicates the note should be classed as urgent. Notes marked urgent automatically 
display in Sales Order Entry programs for customers, document header records, 
document line records, and items.  
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Note 

Enter or modify the text for the note.  

Print on [PO/SO Document] 

This field depends on the document type being entered or edited. 

Print on Pick Ticket 

For sales orders, indicate whether to print this note on the pick ticket.  

Print on Purchase Order? 

For purchase orders, indicate whether to print this note on the PO.  

Print on quote? 

For quotes, indicate whether to print this note on the quote.  

Print on pick ticket when quote is converted? 

During quote entry, indicate whether this note should print on the pick ticket.  

Print on invoice when quote is converted? 

For invoices, indicate whether to print this note on the invoice when the quote 
converted to a sales order is confirmed.  

 Print on PO/transfer when quote is converted? 

For sales orders, indicate whether to print this note on the PO or warehouse transfer 
when the quote is converted to a sales order.  

3 You can: 

Click OK to import the note to the current sales document or Skip to stop the note 
import. You can click Export to export the SO document note to the purchase order 
to which it is tied.  

Designating items for direct ship 
Direct ships, or drop ships, are items that are sent directly to the customer from the 
manufacturer. You may need to flag an item as a direct ship if the item is:  currently out of 
stock, a temporary item, which is an item you don’t normally stock but are willing to order for 
the customer, or a catalog item  

To flag an item as a direct ship: 
1 Check the DS box in the line item entry section.  

2 Specify the vendor from which this item should ship in the popup box. F2 allows a 
search. 

Direct ships automatically set the ordered quantity to backordered. 
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Entering freight and handling (Sales Orders) 
1 To enter freight and handling charges in the document footer, click Done in the main 

Order Confirmation screen. 

2 Select the Freight $ field in the document footer to enter or update freight and handling 
charges for the selected order. Press F2 to access the Freight Totals Display window. 

3 You can enter freight and handling manually in the Freight $ field or you can import 
freight and handling charges from another shipping software system, such as UPS 
software.  

Automatic Freight Calculations and Quoted Freight: In Order Entry, Confirmation 
Entry and Direct Invoice Entry, FACTS provides automatic freight calculations using 
freight schedules or quoted freight, based on control settings in Ship Via F/M, AR 
Customer Maintenance and SO Static Control F/M (SOF980). Refer to the Automatic 
Freight Calculations and Quoted topic for details. 

To charge freight in SO entry programs, the Charge Freight flag in the Sales Order 
Static Control F/M (Sales Orders>File Maintenances>Infrequent File Maintenances>SO 
Static Control F/M) must be selected (set to Y).  

4 If the system does not allow manual entry in this prompt, the Allow Manual Freight flag 
in IC Warehouse F/M may be deselected (set to N). 

Quoted freight processing 
1 Press F2 in the Freight $ field to open the Quoted Freight Entry Dialog box.  

2 During Confirmation Entry and Direct Invoice Entry, you can modify the Quoted Freight 
Amount and the Invoice Billed Freight Amount. The system also displays the 
Calculated Order Freight Amount and the Calculated Invoice Freight Amount in the 
Quoted Freight Entry Dialog box. When a new invoice is added in Direct Invoice Entry 
and the customer is set to use Quoted freight and the Quoted Freight is not set to be 
automatically filled with the calculated freight and the Billed Freight is set to default to the 
Order Quoted Freight in SO Static Control F/M, then when the Quoted Freight Entry 
(SOC504) window is opened and an amount is entered in the Order Quoted Freight field, 
this amount will then also default into the Invoice Billed Freight field. 

3 Click Freight at the Quoted Freight Amount field to access the Freight Totals Display 
window to review and calculate freight. 

Reviewing and calculating freight 
1 Press F2 in the Freight $ field to open the Freight Totals Display window. 

2 In the browser the system displays the warehouse code and name, ship via and freight 
and handing charges.  

3 Highlight a warehouse line and select Process Frt and the system calculates freight per 
warehouse based on the shipped quantity on the order document lines. 
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Automatic Freight Calculation Details: 
Freight will be calculated per warehouse based on the shipped quantity on the lines. This 
value is accumulated and stored in the Invoice Calculated Freight Amount field of the 
header. The system sets the Invoice Billed Freight Amount based on the "How to Default 
Billed Freight in Confirmation" setting in SO Static Control F/M. It will either be the Order 
Quoted Freight Amount (charge all on first shipment) or the Invoice Calculated Freight 
Amount (recalculate for every invoice). This is calculated when you click Done to 
advance to the footer in Confirmation. If you back up to the document lines and then 
return to the footer the field will again be set based on the How to Default Billed Freight 
in Confirmation" setting in SO Static Control F/M. If you changed the invoice billed freight 
amount manually when you first accessed on the footer you must re-enter the value. The 
Invoice Billed Amount cannot be greater than the Order Quoted Freight Amount. You 
must also change the Order Quoted Freight Amount you add document lines and then 
return to the footer in order to bill for those lines.   

4 Click Chg Frt/Hdlg to modify freight and handling charges. 

 Changing freight and handling:  
1 Click Chg Freight. 

2 Specify the freight amount, and if applicable the handling amount, and click OK to return 
to the document footer. 

 The program skips directly to the handling field if the Allow Manual Freight flag is not 
selected (set to N) on the Main tab of Warehouse F/M  (Inventory Control>File 
Maintenances>Infrequent File Maintenances>Warehouse F/M). 

3 Using default handling charges: To import a default handling charge from SO Ship Via 
F/M, click Import. 

4 Complete the footer and click OK. 

5 Indicate whether you want to print an invoice at this time or batch print it from the Invoice 
& Credit Memo Print program later. 

Assigning freight with the FACTS shipping system 
If you use the FACTS Shipping System (Sales Orders>Shipping) you can get freight totals 
based on the information entered in the UPS Weight Table F/M, UPS Zone F/M and 
Package F/M. 

These totals are only as accurate as the annual February UPS rate updates. 

For carriers other than UPS, enter freight totals manually. The FACTS Shipping System is 
based on UPS rates. 

The FACTS Shipping System is not UPS approved. This means the manifests and labels 
cannot be used.  
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To assign freight totals from the FACTS Shipping System: 
1 Access the footer and tab to the Freight $ field. 

2 Press F2 to access the Freight Totals Display.  

3 Press F3 and enter the following information: 

 UPS Zone. UPS Zone codes, which are related to zip codes, are maintained in the UPS 
Zone F/M. The program defaults to the zone entered in the Accounts Receivable Ship-To 
profile for this customer. 

 Com/Res. If the UPS Zone entered in the previous field is greater than 8, this field is not 
accessible and defaults to NA. Enter whether this delivery is a C - commercial or R - 
residential UPS ground delivery. UPS charges different rates for commercial and 
residential deliveries. Press Enter to accept the default value for this ship-to address. 

 Weight: The program defaults to the next highest whole pound from the weight entered 
in the Inventory Control Item F/M for this item. A different weight can be entered if 
necessary. 

 Freight: The program defaults to the freight calculation derived from the information 
entered in the previous three prompts. You may enter a number (+/-9999.99) if you need 
to override the system’s calculation. 

If the item is designated as having companion items, the system displays the Companion 
Item Selection (SOE151) screen. Refer to the Companion Item Selection (SOE151) topic for 
details.  

4 Click Save. 

Using standard orders 

Manage standard orders 
1 Select Sales Orders>File Maintenances> Standard Order F/M (SOE250). 

2 Specify the customer number. 

3 You have these options: 

• Click Add and specify the item, quantity, unit of measure, and optional note. Click 
OK. 

• Highlight a standard order and click Edit to modify the quantity, unit of measure, and 
optional note. 

• Highlight a standard order and click Delete to remove it. 

4 Click Save. 
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Copying standard orders 
1 Access Standard Order Entry (SOE250).  

2 Use the Customer and Ship-to prompts to display the standard order and click Copy 
To.  

3 The Copy To window displays the customer, ship-to, and the lines that are currently on 
file for this selection.  

4 Specify the customer in the Copy To Customer prompt and (optionally) the ship-to 
location in the Copy To Ship-to prompt. 

5 You have these options: 

• Check the Copy to All Ship-to box to copy the selected lines in the grid to all ship-to 
locations for the Copy-to Customer. 

• Check the Create Standard Order box to create a standard order for the copy, if 
none exists. 

• In the grid check the Copy box for the lines you want to include in another standard 
order. Optionally click the All or None buttons to select/deselect all lines.  

6 Click OK to copy the lines and return to Standard Order Entry. 

Removing standard orders 
1 Access Standard Order Entry (SOE250).  

2 Use the Customer and Ship-to prompts to display the standard order and click Remove 
From.  

3 The Remove From window displays the customer, ship-to, and the lines that are 
currently on file for this selection.  

4 Specify the customer in the Remove From Customer prompt and (optionally) the ship-to 
location in the Remove From Ship-to prompt. 

5 You have these options: 

• Check the Remove From All Ship-to box to copy the selected lines in the grid to all 
ship-to locations for the Remove From Customer. 

• Check the Ignore Memo/Note Text box to retain any standard order memo and note 
lines, but remove the item lines. 

• In the grid check the Copy box for the lines you want to include in another standard 
order.  

• Check the Ignore Quantity box to broaden the deletion process to include all 
standard order lines for the selected item, regardless of the quantity specified. 

• Check the Ignore UM box to broaden the deletion process to include all standard 
order lines for the selected item, regardless of the unit of measure specified.  

6 In the grid check the Remove box for the lines you want to remove from the standard 
order file. Optionally click the All or None buttons to select/deselect all lines. 

7 Click OK to remove the lines and return to Standard Order Entry. 
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Manage standard order memos 
1 Select Sales Orders>File Maintenances>Standard Order F/M (SOE250). 

2 Specify the customer number. 

3 You have these options: 

• Click Add and specify M in the Item field. Specify the memo in the Note/Memo field. 
Click OK. 

• Highlight a standard order memo and click Edit to modify the memo. 
• Highlight a standard order memo and click Delete to remove it. 

4 Click Save. 

Using the Job Costing Entry window 
1 If there is a job number in the header, the Job Posting Entry window appears after you 

finish editing or adding a line to a document. 

2 Complete the following: 

Price 
message 

If the job is a fixed contract or time and materials contract, this field 
is skipped. If the job is a cost plus (+) contract or a no charge 
contract, a message is displayed indicating the price that must be 
billed for the item on this job.  

Press Enter to continue. Then press F4 to backup to the price field 
to enter the correct price. 

Cost code Enter a valid cost code (up to 4 characters). Entering a valid cost 
code displays the cost code description and the cost type. F2 
enables to search for a cost code. 

Memo Enter the memo to post to job cost (not used for printing purposes). 
The memo can contain up to 30 characters. The program initially 
defaults to blanks. 

Print Memo This field is skipped in Sales Orders. (When billing through Sales 
Orders the billing, i.e., invoices printed, does not take place in Job 
Cost.) 

Using the price search feature 
Use the price search program to find an item’s default price as well as alternate prices, which 
may include customer contract prices, pricing levels, quantity breaks and prices from past 
sales. The price search is available in Order Entry, Order Confirmation, Direct Invoice Entry, 
Credit Memo Entry, Counter Sale Entry and Service Order Entry. 
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Administrators can turn off the price search feature in the SO Entry Options F/M (on the Line 
Prompts tab). 

Access the price search in one of the following ways: 
Press F3 while the cursor is in the Price field. 
Click Price Search next to the Price field. 
Select View>Price Search from the menu bar. 

The Price Search window displays available pricing information for the selected item, 
quantity and customer, if a customer is selected. An asterisk denotes the default price for a 
select item and customer. 

When you select a price for a line item, the system returns the pricing UM to line item price in 
Order Entry. 

Price Search options 
In the main search window, you have these options.  

Item/Qty to view prices on another item. This option is available if you access Price Search 
from the View menu in one of the SO Order Management programs. 

Whse Qtys to view item availability in the warehouse the selected item is set to ship from. If 
you do not have an order open, the system uses the default warehouse for this terminal. This 
option is disabled when you access Price Search from the Price field. 

Contracts to view the Contract Entry (SOE560) program in view-only mode. The contract 
price details are available for the selected item and customer. 

GM Entry to calculate a new price based on the GM percent you enter. To use this feature, 
first select a price in the browser. The gross margin percentage is based on the cost of the 
item selected and the price you selected. Change the GM % to create a new price. If you 
accessed Price Search from the Price field, choose OK to select the new price you created. 

Change UM to see prices based on a different unit of measure. 

To search on a price from the View menu: 

1 Click View>Price Search from the menu bar in any of the SO Order Management Suite 
programs. 

2 Click Item/Qty. 

3 In the Item/Quantity window, choose the item and the quantity on which you want to find 
price information. Press F2 in the Item field to find an item.  

4 Click OK to continue to the main Price Search window. 

Factors that affect default pricing in the Price Search feature 
These factors are included in determine the default price feature. 

ordered quantity (for quantity breaks),  

selling and pricing units of measure on the sales order line item,  
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types of prices available for the item being sold, and  

status of the Default Price control (SO Static Control F/M; Inventory tab) and Use Default 
Prices flag (IC Item F/M; Sales tab. 

Setting the Default Price control in SO Static Control F/M 
Use this control to define which prices FACTS should default to when it is searching for 
prices. The default price appears in the price field once you select an item. 

The price options are: 

S-Standard 

L-Level Pricing 

Q-Quantity Breaks 

C-Contract Price 

X-Lowest Price 

For example, if you want the system to default to contract prices when they exist, enter C 
first. If FACTS cannot find a contract price for the item and customer selected, it looks for the 
next price set.  

Use Default Price flag 

FACTS also looks at the use default prices flag defined in the Item F/M.  

This flag may be used for items that have multiple pricing units of measure that, when 
converted to the default pricing unit of measure, convert to the same price.  

If this flag is set to Y, then you only have to set up prices for the default pricing UM. Pricing 
for other units of measure for the item may be calculated by the system.  

Entering serial/lot items 
Serial/lot entry is only available if the OE Serial/Lot Entry control in SO Static Control F/M is 
set to either M-Assign Number in either Entry or Confirmation or Y-Assign Number in SO 
Entry. 

Use the Serial/Lot Entry window to assign serial numbers or lot numbers for items you are 
entering.  

Serial/Lot costing options 
You have the ability to cost serial and lot items by the system cost (costing method for the 
module). The feature provides for GAAP compliance. For the FACTS SO, IC and MC 
modules, you can decide if the cost for serial and lot items will be averaged actual (as it has 
always operated in the past) or system cost (costing method for the module). The default 
setting for each Static Control F/M is A-Averaged Actual (same behavior as they have before 
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the monthly is applied). Users who want to take advantage of this change will need to 
change the option to S-System Cost for each of the applicable modules. The net result of 
selecting S-System Cost is that serial/lot items will be costed like non-serial/lot items. 

The window appears automatically when you enter item numbers flagged as serial or lot (see 
Item F/M, Main tab). 

Over-commitment of serial/lot items 
The over-commitment of serial/lot items is not allowed in Order Entry and Confirmation Entry. 
If the OE Serial/Lot# Entry flag in SO Static Control is set to "M" or "N" then you can under 
commit serial/lot items.  

The system recalculates quantities if: 

• The Serial/Lot shipped amount does not equal the order's shipped amount,  

• The OE Serial/Lot# Entry flag is set to "Y" and the Serial/Lot committed quantity does 
not equal the order's committed,  

-OR- 

• The OE Serial/Lot# Entry flag in SO Static Control flag is not "Y" and the Serial/Lot 
committed quantity is greater that the order's committed amount.  

• The system displays the message "Improper ser/lot assignment. Quantities changed 
for line XXX" then recalculates as follows:  

• The order's shipped amount is set to the Serial/Lot shipped amount.  

• The committed amount is set to the Serial/Lot committed amount.  

If the "new" sum of the shipped and committed amounts is greater than the ordered amount, 
the system sets the ordered amount to the sum of the shipped and committed amounts. The 
system recalculates the order's backordered amount with the new quantities to equal the 
ordered amount minus the shipped amount minus the committed amount.  

In the Daily Sales Register, if the Serial/Lot shipped amount doesn't match the order's 
shipped amount the system now displays a message and return to the menu and no longer 
displays an error 40. The system also displays a message if the Serial/Lot committed amount 
is greater than the order's committed amount and returns to the menu.  

When the system displays the Serial/Lot Entry (SOC145) window, the item number 
automatically displays in the Item field and the document number displays in the Document 
field. 

Calculating commissions 
Use Company Control F/M to setup the proper prioritization of the contract price’s 
commission % and to set the commission flag for use highest/lowest/priority commission. 
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As a line is being entered/edited in the Sales Order module, the default commission % 
values for customer, salesperson, item, and price are saved and used in the commission 
calculation processing detailed below. 

Processing details 

Throughout FACTS, commission percentage processing is as follows when the price 
selected has a commission % assigned: 

There are five commission percent sources: customer, salesperson, item, price and current 
line commission. The system maintains a user override flag and a price type to designate if 
the user overrode the line’s commission during order entry.  
 
When calculating commissions, the system first checks the value of the Commission Flag. If 
the Commission Flag is set to H- always choose the Highest commission in the hierarchy, 
the system returns the highest commission %, excluding the line’s commission %, after 
replacing the item’s commission with the price’s commission if necessary. If the Commission 
flag is set to "L- always choose the Lowest commission in the hierarchy", it returns the 
lowest, non-blank, commission %, excluding the line’s commission %, after replacing the 
item’s commission with the price’s commission if necessary. 

If the value of the Commission Flag is set to X-calculate (always choose the commission that 
the hierarchy determines), the system checks the Commission Basis for the first priority to 
determine which commission percentage to use. As the system navigates the priority string, 
it returns the first entry that has a commission other than "No Priority" (or blank) as the 
correct commission %.  

For example: If the commission hierarchy is set to SCIP the system would calculate the 
commission using the percentage assigned to the salesman who sold the merchandise. If no 
priority is assigned to the salesman, the second priority is checked. The system would then 
calculate the commission using the percentage assigned to the customer the merchandise 
was sold to. If no priority is assigned to the customer, the third priority is checked. The 
system would then calculate the commission using the percentage assigned to the item that 
was sold. 

If the price type is not a contract price, the position of the Price’s Commission % in the 
hierarchy will be ignored, and if a Price Commission is present, it will replace the Item’s 
Commission % (regardless of whether the Item’s Commission was "No Priority").  

If the user override flag is set for the line-item during order entry processing, the system 
returns the Line’s Commission as the correct commission %.  

Using the Past Sales Search feature 
Use the Past Sales program to lookup all items sold to this customer in the past. When you 
select an item from this search, the system sets quantity ordered to what the customer 
ordered in the past sale.  

This option is available at the item prompt and only if the Use Past Sales flag is selected in 
SO Static Control. 
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The past sales search is available in Order Entry, Order Confirmation, Direct Invoice Entry, 
Credit Memo Entry, and Counter Sale Entry. 

For details about using the Go to and filters options, refer to the Search Features topic in 
FACTS Basics. 

From the Past Sales Search screen, click Temp Items to display the Temporary Past Sales 
Search window, which contains a list of temporary items for the specified customer. If an 
item is selected from this window, the system closes both search windows populates the 
following fields in the Order Entry Line item section of the screen: Item number, Description 
1, Description 2, Vendor, Class, Weight, selling Unit of Measure, Cost, cost Unit of Measure, 
Price, and price Unit of Measure. 

Creating planned special order transfer/purchase order 
records from Sales Order entry programs 
Use the Creating Planned Special Order Transactions (SOE511) window to create planned 
special order purchase or transfer records when the ordered quantity equals the back-
ordered quantity. Sales Order documents that are tied to planned special order purchase 
orders or transfer records are always special orders. Special orders contain an S setting in 
the Flags column in the line item grid of these Sales Order entry programs: Sales Order 
Entry (SOE210), Direct Invoice Entry (SOE320), Counter Sales Entry (SOE510) and 
Confirmation Entry (SOE310). 

Planned Special Order transactions and planned special order orders are always special 
orders. 

When you create/edit an order line that has a back-ordered quantity that is equal to the 
ordered quantity, you can create a planned special order purchase order record for the 
primary vendor, a planned special order purchase order record for another vendor, a planned 
special order transfer record from the item’s restocking warehouse or a planned special 
order transfer record from another warehouse depending on the item type. When creating 
planned special order transfer records, the program checks for surplus stock in the shipping 
warehouse and then checks for surplus in other warehouses and recommends the transfer 
location of the warehouse having the most surplus stock. You can use the Warehouse 
Lookup button to see the warehouses available and the amount of surplus in each of the 
available warehouses.  

Sales Order entry programs can also be set to automatically create/update planned special 
order PO or transfer records. The system bases planned special order record creation on the 
prompt in the Sugg PO/TR by Type section of the Line Options tab of SO Entry Options F/M 
(SOF915). When the Sales Order entry programs are evaluating a line item with a back-
ordered quantity to determine whether to prompt you to create a planned special order 
transaction, the system looks at the item type and uses the SO Entry Option prompt 
associated with that type. Use these settings to indicate whether you want to have the 
system ask to create planned special order purchase orders or planned special order 
transfers during Sales Order entry line processing, automatically create planned special 
order purchase orders or planned special order transfers during Sales Order entry line 
processing or never create planned special order records. 
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Run the Document Fill Report prior to the PO Receipt Register and IC Receiving Register. 
Set the Document Fill Report parameters to preview quantities ready to be filled by 
outstanding purchase order and transfer documents. Use the results from the Document Fill 
Report to prepare warehouse and purchasing personnel for action on back-ordered and 
special order quantities. 

Backorders vs. special orders 

If a back-ordered line item can be fulfilled by using any item quantity when it becomes 
available in the warehouse then that line is not a special order line. Normal AIM processes 
through the BCC automatically pulls in back-ordered quantities when warehouse stock is 
insufficient to fulfill that order. For back-ordered quantities, normal AIM replenishment 
procedures take care of back-ordered/stock-out quantities on document lines.  

A special order line is a specific request, regardless of current, or upcoming, on hand 
quantities, with special consideration for the document/line which placed it. The quantity is 
specific to this and is not generally available to fulfill any other document/line for that item. 
Special order lines are specific and unique requests that drive specific actions related to the 
specific quantities involved. Special orders do not follow ‘normal replenishment’ actions. 
Special order lines override and ignore normal stock in favor of the specially received 
quantities specific to the single line’s request.  

Serial and lot processing shows and restricts serial lot selection for special orders.   

Special order lines cannot have quantity changes once the special order PO or transfer 
receipt document is created. If changes are needed then the originating special order line in 
the originating Sales Order entry program is the place to modify or delete that special order, 
accordingly. When a received special order quantity greater than one in Order Entry, and 
there is a need to return a portion of that receipt, you must delete the originating special 
order line in Order Entry. The non-damaged items would be re-entered in Order Entry 
immediately and the damaged items would be returned. For example, if you received 5 but 2 
of them were broken and need to be returned, you would delete the special order, freeing up 
the quantity of 5 that has to be “split” by making all 5 items generally available. The quantity 
is no longer special order specific. The 3 non-damaged received items would be re-entered 
in Order Entry immediately. The other 2 damaged received items would be returned 
immediately. 

Create Planned Special Order Transaction window 

If the Stocked and Nonstocked prompts in the Sugg PO/TR by Type section on the Line 
Options tab of SO Entry Options F/M (SOF915) are set to R Always Ask Defaulting to a 
Planned Special Order PO or A Always Ask Defaulting to Restocking Path, the system 
displays the Create Planned Special Order Transaction Window when you create/edit an 
Sales Order entry document line and it has a matching ordered and back ordered quantity 
greater than zero.  

Processing Details 
If you are creating a planned special order PO record, the system writes the selected vendor 
back to the Sales Order entry program document line vendor.  
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When you edit a Sales Order entry program document line, the program checks to determine 
if a planned special order PO record or a planned special order transfer record already exists 
for this Sales Order entry program document/line. For a planned special order PO record, the 
warehouse and vendor are saved. For a planned special order transfer record, the "from" 
warehouse is saved. Upon Sales Order entry program document line completion, when a 
planned special order PO record or a planned special order transfer record already exists, 
the system displays a message prompting you to update or delete the existing planned 
special order transfer or PO record.  

If a back-ordered quantity matching the ordered quantity remains when the document line 
edit is completed and a planned special order PO or transfer record exists, the system 
displays a message prompting you to update the existing planned special order PO or 
transfer record with the current back-ordered quantity. You can select from the following 
options: Y-Update the planned special order PO or transfer with the current back-ordered 
quantity, or D-Delete the planned special order PO or transfer. If the special order is in 
process you cannot update the back-ordered quantity. If you need to change the ordered 
quantity and the back-ordered quantity field is available to edit, increase or decrease the 
back-ordered quantity. Then confirm the change and update the ordered quantity to match 
the back-ordered quantity or cancel the change. 

If you elect not to keep the planned special order PO or transfer record (the D-Delete option), 
the program returns to the Create Planned Special Order window. This allows you to change 
a line from having a planned special order PO record to having a planned special order 
transfer record all in one step rather than having to delete the first and then edit the line 
again to create the other. If you do not want to create a planned special order record at all, 
select N-neither to not create a planned special order record. 

Special order overrides 

Special order overrides allow authorized users to manage special order quantities outside of 
normal FACTS processing. Override quantity changes are at the users own risk. The 
override ability applies to quantity and unit changes only. Override ability does not affect 
system behavior for non-special-order quantities and units from stock. Special-order stock 
still cannot be used on non-special-orders. Non-special-orders still cannot use special-order 
stock.  

Special order override privileges and messaging display are set in User Code F/M 
(SMF950). Overrides provide the ability to create situations where special-order receipt 
records are over- or under-received. This creates OS type receipt records, even when the 
special-order receipt remains under- or not utilized. Use the Item Balancing Register to clean 
up OS type records for over and under situations. 

Messages can be displayed to users with override ability to special order quantity changes. 
This provides knowledge of potential issues. Messages can be turned off, per user with 
override ability. Users without override ability will also see the relevant messages when 
changing quantity if that quantity changes falls outside allowed ranges.  

Infor recommends that the override messages are left on for all users with override ability. 
This allows users to be forewarned that their changes should be carefully considered. 
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Validation processing for special order ties  
When creating a planned special order PO line (via the F1 key) for a specific back-ordered 
sales document line the ordered quantity must match the back-ordered quantity. If a planned 
special order PO record exists and it was not imported upon PO document creation, use the 
Options>Import Planned Special Order PO menu option for importing.  

The system also checks the Buyers Control Center (BCC) for the line. If the line is already in 
the BCC, you cannot create the new PO line via the F1 key and a message is displayed 
indicting that the line was found in the BCC. If the PO line created for a specific back-ordered 
sales document line removed an existing planned special order PO record, then deleting the 
PO line from the PO document restores the planned special order PO record.  

You cannot change the shipping warehouse or selling UM for special order lines that are in 
the BCC. A message is displayed indicating there is a conflict with line in the BCC. 

Special order back-order quantities for purchase orders and transfers (PO/TR) are also 
checked in the BCC. If the back-order quantity is changed from the amount in the BCC, the 
change is not allowed and a message is displayed. 

Deleting a special order line (PO/TR) is also checked. When that line is in the BCC, the 
delete is not allowed and a message indicating the record is in BCC and must be managed 
from that program first. 

An alert is displayed when editing a line with a special order that is already in the BCC. This 
alert is only displayed if the Planned Special Order prompt is set to 'Ask' in Line Options tab 
of SO Entry Options F/M (SOF915). 

Note: The vendor value in the sales order receipt line defaults from the item’s primary vendor 
when a line is created and then is updated with the vendor of any PO transaction associated 
with it. If the PO transaction is deleted, the vendor value will be restored to the item’s primary 
vendor (except temporary items). This includes deleting a planned special order PO record, 
deleting a regular PO and SO entry deleting a planned special order PO record and then 
creating a planned special order transfer record or not creating any document at all. 

Use these fields to create a planned special order transaction. 
1 Create  

Select the type of planned special order transaction to create: P-Create a planned special 
order PO, T-Create a planned special order transfer or N-neither.  

If the ship warehouse is not the same as the initiating warehouse, the T-transfer option is not 
available. If only one type of planned special order document is valid on the sales order line, 
the Create prompt only allows you to create the valid document type or to not create any 
planned special order document. For example, if the item is temporary and so a planned 
special order transfer is invalid, then the Create prompt would display the option to P-Create 
a planned special order PO or N-neither. 

2 Vendor  

Specify the vendor for the planned special order transaction. Press F1 to use the primary 
vendor, press F2 to search or F4 to backup to the Create prompt. 
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This field is disabled if the Create field is not set to "P"-Create a planned special order PO. 

3 Warehouse  

Specify the warehouse for the planned special order transfer. Press F1 to use the restocking 
warehouse, F2 to search or F4 to backup to the Create field. This prompt is disabled if the 
Create field is not "T"-Create a planned special order transfer. 

If you press F2-warehouse search, the system displays the Warehouse/Item window 
(SOC070), which displays all warehouses (other than the shipping warehouse) and the 
warehouse quantities. You can select a warehouse from the search and the "Select Wh" 
option is available to return the warehouse number to create planned special order 
document. 

Managing standard orders and memos 
1 Select Sales Orders>File Maintenances> Standard Order F/M (SOE250). 

2 Specify the customer number. 

3 You have these options: 

Click Add and specify the item, quantity, unit of measure, and optional note. 
Click OK. 

For standard memos, click Add and specify M in the Item field.  
Specify the memo in the Note/Memo field. 
Click OK. 

Highlight a standard order and click Edit to modify the quantity, unit of measure, and 
optional note. For a standard order memo, highlight and click Edit to modify the memo. 

Highlight a standard order or memo and click Delete to remove it. 

4 Click Save. 

Quotes procedures 

Converting a quote to sale or service order 
1 From the Quote Header section of quote entry, click the Bring in Another Quote 

checkbox to bring in another quote, then enter the quote number. Press F2 to search. 
You can establish some standard quotes so that there is no need to enter them each 
time. By using the Bring in Another Quote function, the line-items automatically transfer 
from the quote selected to the quote being entered. The quote selected to be brought in 
is not affected by the transfer. It stays in its original form. If you enter No, the system 
continues without additional quote information.  
 
 When you import a quote into a new quote, the system recalculates the cost of each 
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item to the current cost. For items that contain a user-overridden cost, the system 
recalculates the cost based on a setting on the Quotes tab of the SO Static Control F/M. 
The setting allows you to indicate whether you want the system to recalculate a user-
entered item cost when the quote is imported to a new quote or converted to a sales 
order.  

2 When you convert a quote to a sale when using source document pricing all prices come 
in as user override prices. The system sets the price’s commission % to "No Priority" and 
calculates the default commission. Refer to the Calculating Commissions topic for 
processing details about commission percentages. 

3 If multiple warehouses on an order are being used: 
If the initiating warehouse of the line-item being transferred is different than that of the 
quote, the line-item’s initiating warehouse is automatically changed to match that of the 
quote’s. 
The system verifies the security on the shipping warehouse and if you do not have 
security, the system displays the message: "QUOTE LINES SKIPPED BECAUSE USER 
CANNOT SHIP FROM WAREHOUSE XX" where "XX" is the shipping warehouse. 

Creating BOM items (Kitting, On-the-fly) for Quotes 
You can create Bill of Material (BOM) items in Quote Entry if: 

• You purchased and activated the Manufacturing Control module. 
• You set the Update in SO option in the Manufacturing Control BOM Entry program 

to C, A or O. 

Creating finished items 
1 At the Bill of Material (BOM) field that appears when you enter a BOM item, select from 

the following options: Y-Update and Change Components, A - Update Components 
automatically and initially skip change, or F- Update the finished item. The options Y-
Update and Change Components and A - Update Components automatically and initially 
skip change, available if the Update in SO option for this BOM item is set to C (Update 
Components, Entry and Change of Components Allowed) or A - Update Components 
automatically and initially skip change) in the BOM Entry program. To simply update the 
finished item and not modify or update its components, select F- Update the finished 
item. 

2 The Y-Update and Change Components option provides access to the Component 
Entry window, which displays the component items and descriptions and asks for the 
number of units needed to complete one finished item.   

3 The Create/Review component lines one at a time option provides access to the BOM 
Component Entry window, which displays the components and asks for the number of 
units needed to complete one finished item. 

4 In the Units/ea field, enter the number of units — in stocking units of measure — 
required to make the one finished item. You can accept the default from the BOM Entry 
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program by clicking OK. Click Skip to skip the item. Click Accept All to accept the 
default entries for the remaining components on this BOM item.  

5 The program uses the number of units needed to build one finished item and determines 
the quantity that should be shipped or backordered.  
 For example, a customer orders 5 units of BOM Item 1, which requires two units of 
Component A and 1 unit of Component B to make one finished unit.  

When you choose to create component lines automatically, the system "ships" 10 units 
of Component A and 5 units of Component B (assuming all quantities are available). 
 
If you changed the ordered quantity for the finished item in the main window, the system 
automatically updates the quantities of components needed. 

6 The program defaults to the component descriptions entered in the BOM Entry 
program. 

7 Enter the number of units — in stocking units of measure — required to make one 
finished item. You can accept the default from the BOM Entry program by pressing 
Enter. Press F2 or Skip to skip the item. Press F3 or Accept All to accept the default 
entries for the remaining components on this BOM item.  
 
The program uses the number of units needed to build one finished item and determines 
the quantity that should be shipped or backordered. For example, a customer orders 5 
units of BOM Item 1, which requires two units of Component A and 1 unit of Component 
B to make one finished unit. When you choose to create component lines automatically, 
the system "ships" 10 units of Component A and 5 units of Component B (assuming all 
quantities are available). 
 
If you change ordered quantity for the finished item in the main window, the system 
automatically updates the quantities of components needed. 

8 The program defaults to the component descriptions entered in the BOM Entry 
program. 

9  Click OK to accept the line. 

10 When the system displays the Memo screen for the component, edit memo lines 
associated with the component item, if necessary and select the Print on Invoice 
checkbox to indicate you want to include the memo on the invoice. You can select Skip 
to not add a memo, Acpt Memos to select and include memos for all components, or 
OK to accept the memo for the current component only.   

11 Repeat these steps for each component line. 

12 When the system displays the message, Create component lines automatically, FACTS 
looks at the stocking units required to make one finished item (defined in the BOM Entry 
program) and multiplies that number by the quantity ordered. Note that the Component 
Entry for Quote (SOE113) screen does not automatically appear when you select this 
option. 

13 When all component lines are created, the system displays the Component Entry for 
Quote (SOE113) screen, where you can change components, as long as the BOM item 
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allows editing. The Component Entry for Quote (SOE113) screen also displays if you 
choose to edit the components after the line item has been saved. 

14 You have these options. 
Edit - to make changes for the highlighted component item and modify the Description 
or Units fields.  
Add a component line. Then enter the item number and units for the component. 
Delete the highlighted component line.  

15 Save your changes (when editing a line).  
 
Click Stop to stop working with component lines. 

16 Click Done when you are ready to return to Quote Entry. 

Creating or changing quotes information 
1 Click Sales Orders>Quote Entry. 

Complete steps 2 and 3 to enter quote header information. 

2 In the Doc/Cust field, specify the quote number or specify the customer number and 
press Enter to automatically assign the quote number when you complete your header 
information. 

3 Specify this information. 

Ship-to 

(Optional) Modify the ship-to code (this code displays from the customer’s default 
information) where the order should be shipped. 

Quote Date 

(Optional)The system displays the current date as the default; you can modify this field. 

Effective Date 

Specify the date the quote is effective. This field is available based on the Eff Date field 
setting on SO Entry Options (SOF915), Header view. 

Expiration Date 

Specify the date this quote expires or press Enter to default to the value already 
displayed. 

Title 

(Optional) Specify a title for the quote. Note: This field is intended to be used for internal 
descriptions of the quote that may help when searching for or identifying a quote.  It 
allows a maximum of 60 characters. 

Reference # 

(Optional) Specify the reference number, if required. 

Salesperson 
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Specify the salesperson for the quote.  

TIP: More prompts may appear depending on the settings in SO Entry Options F/M. 
Once the header is complete, the program automatically goes into Add mode, which 
means the cursor moves to the Item Number prompt in the line entry section where you 
can begin entering line-item information. Use the line entry section to specify the item 
numbers, the quantities ordered, committed and/or back ordered; the price; and the 
extension (prices multiplied by the quantity ordered). More prompts may appear 
depending on the settings in SO Entry Options F/M. 

Complete Steps 4-11 to specify line items on a quote. 

4 In the Item field, specify the item number for the quote line. Press F2 to search for items. 
For Catalog or temporary items numbers refer to the Fields For Temporary and Catalog 
Item Entry section. You can also specify service and equipment on quotes. Service items 
can be imported and converted to service orders. 

5 After you specify an item, the item class, package size, item weight and its unit of 
measure, available quantity, on hand quantity, on-order quantity, and bin location are 
displayed. 

6 (Optional) Select the Ship Direct check box to indicate, that this item is shipped directly 
to the customer ship-to address.  

7 (Optional) In the Whse field, the system displays the default warehouse for the item. You 
can modify this value or search for a different warehouse. 

8 In the Quantity field, specify the quantity to quote. If this is a BOM finished item that can 
be assembled in SO, you may be able to specify component items. If the item has 
multiple selling units of measure you can press F2 to change the unit of measure on the 
ordered quantity. Press F3 to change the shipping warehouse if you are using multiple 
warehouses. Specify a back-ordered quantity if the quantity ordered is greater than the 
available quantity in the selected warehouse.  

9 (Optional) The Cost field is available if the Change by Ln Cost flag in the SO Static 
Control Record is set to Y or B. If the Change by Ln Cost flag is set to B, you can press 
F4 to back up to this field. This field is also available if the item is temporary. Specify the 
cost per displayed costing unit of measure.  

10  In the Price field, specify the price per displayed pricing unit of measure. Specify L and 
a level number for a price level if applicable. Press F2 to change the unit of measure for 
pricing if more than one is set up for this item. Press F3 to select another price. This field 
defaults to the pricing default UM for this item. 

Repeat steps 4-9 to add additional items.  

11 To end line entry, click Cancel. 

Complete steps 12-13 to enter footer information for a quote 

12 Click Done to display Footer for Document dialog box; specify this information. 

Disc % 
Specify the discount percent (maximum of 100) or dollar discount (maximum equals 
merchandise total) of the merchandise total for the document. This field only appears if 
% or $ was entered at the Use Invoice Discounts flag in the SO Static Control Record. 
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Freight $ 

Specify the freight amount (+/-9999.99). Press Enter to default to 0 or, if this ship via is 
UPS, to the freight calculated for the UPS zone.  

If the Ship Via code is UPS, refer to the UPS Ship Via Information topic for additional 
fields. 

Tax Code 

Specify the tax code for this ship-to customer. The entry must be a valid tax code. This 
field is not available if the Charge Tax flag in the SO Static Control Record is set to N. 
Press Enter to default to the currently displayed value (initially the customer's ship-to tax 
code). Press F2 to search. 

NOTE: If you back up to this prompt and do not press F1 - skip after changing the tax 
rate or the tax amount, the system recalculates the charges to reflect the tax code and 
the changes to the Tax Rate and Amount fields are lost. 

Tax $ (Amount) 

This field is only available if the Charge Tax flag in the SO Static Control Record is set to 
O. Specify tax amount. 

The system displays the total amount for the quote that is taxable, quote subtotal, 
discount amount, freight, tax and document totals. 

Memo 

Specify the memo to print on the quote. Press Enter to default to the displayed value, 
initially the standard memo set up in the Document Print Control Record. If no memo is 
needed, you can press the space bar before pressing Enter.  

13 Click OK.  

14 The system displays the message: Print Quote Now? 

If the quote has been printed once, this field is skipped. Check the Print Quote Now? 
check box to indicate to print the quote immediately. If do not select the check box or if 
the quote has already been printed, you can print/reprint the quote through the Quote 
Print program. Click OK. 

The system still prompts you to print quotes even if the customer fails the credit check 
and your system is set in AR Static Control to place the document to Hold status. The 
system uses the credit check to determine whether the quote will be converted into a 
sales order. 

If the Lost Sales is selected on the Use Features tab of SO Static Control F/M (SOF980), 
you have the opportunity to post to lost sales if the item is inactive and the quantity is 
greater than the available amount. 

15 The system displays the message: Convert quote to a sale? 

16 Click N - do not convert and skip to the end of the ending routine, A - convert all 
line-items to a sale or contract, or F - convert the flagged line-items to a sale or 
contract. Press Enter to default to N. 
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17 (Optional) If you selected A or F for the Convert quote to a sale? option, complete the 
Convert Quote Lines screen. 

18 The system returns you to the Doc/Cust field, where you can specify another quote or 
select Done to exit the program. 

Orders procedures 

Importing quote lines to sales, service, or counter sale 
orders 
1 Access Order Entry or Counter Sale Entry.  

2 Complete the header information. 

3 Add an item, equipment or service to the sales, service or counter sale order. 

4 If there are quote lines for the same customer/ship-to/item you are entering on a sales, 
service or counter sale order, the Import Quote window displays the quote lines. 

5 Select the quote line you want to import and click Import. 

6 When you import a quote line, the required line fields are displayed with default 
information from the quote. 

7 You can modify information as needed. 

8 Complete the header information. (For service and equipment the Service Order Entry 
screen is displayed.) 

9 Click OK. 

10 The import of the quote line is completed and you are returned to Order Entry or Counter 
Sale Entry. 

Creating sales order headers 
1 Click Sales Orders>Order Entry. 

2 In the Doc/Cust field, specify the sales order number to assign to this document or the 
customer for the sales order.  

3 (Optional) In the Ship-to field, modify the ship-to code (this code displays from the 
customer’s default information) where the order should be shipped. The system displays 
the full ship-to address. If a customer requests to have an order shipped to an address 
other than its usual shipping address, use the Temporary Ship-to feature to facilitate this 
request. 

4 (Optional) In the Ordered field, the system displays the current date as the default for the 
date on which the order was placed; you can modify this field.  



Sales Orders Transaction Procedures  

Infor Distribution FACTS Sales Orders User Guide  | 143 

5 (Optional) In the Requested field, the system displays ASAP as the default for the date 
on which the customer wants the order to arrive. You can change the value in this field to 
ASAP.  

6 The Turbo Tokens drop down list is available for faster use of CenPOS tokens 
credit card processing for deposits or payments on sales order documents. It is 
automatically populated with all available tokens for the specified customer and ship-
to combination if the CCToken Usage in Ship-to F/M (ARF920) is set to “S – Ship To” 
or the specified customer if CCToken Usage in Ship-to F/M (ARF920) is set to “C – 
Customer”.  

7 (Optional) The system displays a dialog box of additional fields. You can update the 
following information: 
Ship Via-The ship via code indicating the method of shipment the customer requested.  
Click Edit to modify warehouse to change the ship vias for all existing lines for a 
particular warehouse.  
Click Ship Complete to enter a new ship complete status for the specified warehouse.  

Ordered By-The name of the person who placed the order. 
Terms-The code representing the payment terms extended to this customer. 
Freight code-Indicate how the customer will pay for freight on this order. The options are 
P-Prepaid, C-Collect freight, B-Bill later, or A Prepay/Add.  
Salesperson-The salesperson code assigned to this customer.  
Inside Salesperson-The salesperson code to indicate who is entering the order on the 
primary salesperson’s behalf. To access this field, the Inside/2nd slsp flag in SO Static 
Control must be set to I-Inside Salesperson or B-Both. Commission cannot be split with 
an inside salesperson in FACTS. 

8 Click OK.  

9 If this customer requires a reference number for the sales order, the system displays a 
message: Reference # required for this customer. Click OK to display the Header Detail 
screen to enter the reference number. At this time you can also modify values for many 
of the available fields. Refer to the Header Detail topic for field description information.  

10 Once the header is complete, use the line entry section to enter the item numbers, the 
quantities ordered, committed and/or back-ordered; the price; and the extension (prices 
multiplied by the quantity ordered). More prompts may appear depending on the settings 
in SO Entry Options F/M. Refer to the Adding items to sales orders for step-by-step 
instructions. 

Converting quote lines 
1 Use the Convert Quote Lines program to convert a quote to a contract or sales order.  

Processing Notes  

For Contracts: If all lines on the contract have been converted to a sales order or to a 
contract then that option (either sales order or contract) will not be available in the drop 
down box. If all lines have been converted to both, then the conversion window will not 
display. If the SO Static Use Contracts check box is not selected then the conversion 
window will remain unchanged. If a contract has been created from a line on the quote 
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and there are no conflicts with other lines and no conflicts with the contract's settings 
since the contract was created (for example the contract is still active and not expired) 
then a prompt will appear allowing the user to merge any quotes lines being converted 
now to that existing contract. Selecting the check box will add the new line (or lines) to 
the existing contract, otherwise the quote lines will create a new contract. If the merge 
check box is selected all other field for contract conversion are disabled and ignored 
during the conversion. If you do not have the ability to review contracts then the check 
box for creating the contract as approved will not be available and you will also not be 
presented the option to copy a quote line to a contract that has already been reviewed. 
Any contract will be created as not-approved. The description will default to the customer 
number, name, and the quote number. This can be changed.  

2 Click OK to process the request. If a contract is created then that contract number will 
display. If merging lines to a contract then this alert will not show. A tally of lines that 
were converted will display. If no lines were created then the following will tell the user: 
(This can happen when selecting to convert only flagged quote lines and no quote lines 
in fact were flagged.) 

Adding items to sales orders  
1 Click Sales Orders>Order Entry.  

2 Access the sales order document or complete the Creating sales order headers 
procedure. 

3 Specify the item number for the sales order line. 

Item Entry Notes:  

If the Display Quotes check box on the Use Features tab of SO Control F/M (SOF980) is 
selected, the Quote Import screen is displayed with any active (not expired) quotes on 
file for the specified Customer, Ship-to, Item, and Warehouse are displayed during item 
entry. Select the quotes you want to include and click Import to add the quote line to line 
entry in during sales order or counter sale entry. 

If you enter a temporary item or a catalog item, the system displays additional field fields. 
Refer to the Temporary and Catalog Item Entry topic for field details. 
For detailed information about entering serial/lot items refer to the Entering serial/lot 
items topic. 
Over Commitment of serial/lot items: The over-commitment of serial/lot items is not 
allowed in Order Entry and Confirmation Entry. If the OE Serial/Lot# Entry flag in SO 
Static Control is set to "M" or "N" then you can under commit serial/lot items. Refer to the 
Over Commitment of Serial/Lot Items topic for more information.  

4 Check the Ship Direct check box to indicate that this item is shipped directly to the 
customer ship-to address. Then specify the Vendor and click OK.  

5 In the Wh field, the system displays the default warehouse for the item. You can modify 
this value or search for a different warehouse.   

6 In the Ordered field, specify the customer's requested quantity. You can change the unit 
of measure on the ordered quantity.  
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TIP: If the quantity entered exceeds the available inventory in the selected warehouse, 
the program gives you the option to accept the quantity anyway or to search other 
warehouses. The Search Warehouses window displays the warehouses that have the 
item, along with the available, on hand, committed, on order, back ordered and surplus 
quantities for the unit of measure selected. Select a warehouse. This creates a planned 
special order warehouse transfer. Make sure you back order the item. 

7 In the Committed field, enter a quantity to commit in the warehouse or accept the 
default. This field defaults to the quantity ordered, if that quantity is available in the 
selected warehouse. 

8 In the Backordered field, enter a back ordered quantity if the quantity ordered is greater 
than the available quantity in the selected warehouse. The program skips this field if the 
customer or your company does not allow back orders (Allow back orders flag not 
selected in AR Customer F/M and SO Static Control F/M), the item is a direct ship, or the 
selected warehouse has enough inventory to fill the order. When you enter a back-
ordered quantity, Sales Order Entry programs base planned special order document 
creation on the Stock, NonStocked, Uninventoried, and Temporary prompts in Sugg 
PO/TR by Type section on the Line Options tab of SO Entry Options F/M (SOF915). Use 
these settings to indicate whether you want to have the system ask to create planned 
special order purchase orders or planned special order transfers by item type during 
Order Entry line processing. Refer to the Creating planned special order 
transfers/purchase orders from Sales Order Entry programs topic for detailed information 
about creating planned special order warehouse transfer or purchase orders for 
backordered quantities. 

9 You can add additional line items or click Cancel to exit out of Add mode. 

If the item is designated as having companion items, the system displays the Companion 
Item Selection (SOE151) screen. Refer to the Companion Item Selection (SOE151) topic 
for details.  

10 You have these options. 

Edit - to make changes for the highlighted line item.  

Add a line. 

Delete the highlighted line.  

Insert a line item above the highlighted item in the browser. 

Save your changes 

Header-to access the Header Detail for Documents screen, which is used to view 
(inquiry-mode) and/or modify warehouse, shipping information, request and order dates, 
and salesperson, freight, terms and ship via codes.  

Deposits/CC Preauths-to access to the Deposit/Payment Entry window. 

Import Standard Order - to display standard orders if available or quotes on file for the 
customer to import as a standard customer order.  

Make Standard Order - to make the items on this order the customer's standard order. 
This action also replaces any previous standard order for the customer.  
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Highlight a line item and click Line Detail to access the Line Detail for Documents 
screen, which is used to view and/or modify item descriptions, quantity and shipping 
information, costing, and PO information 

Access Note Entry (SME710) for the customer, item, header or line record specified in 
the program.  

11 Click Done to display Footer for Document dialog box. Refer to Completing sales order 
footers for step-by-step instructions.  

Creating planned special order transactions 
If the Stocked and Nonstocked prompts in the Sugg PO/TR by Type section on the Line 
Options tab of SO Entry Options F/M (SOF915) are set to R Always Ask Defaulting to a 
Planned Special Order PO or A Always Ask Defaulting to Restocking Path, the system 
displays the Create Planned Special Order Transaction Window when you create/edit an 
Sales Order entry document line and it has a matching ordered and back ordered quantity 
greater than zero. 

1 Select the type of planned special order transaction to Create. You can select from: P-
Create a planned special order PO, T-Create a planned special order transfer or N-
neither.  

If the ship warehouse is not the same as the initiating warehouse, the T-transfer option is 
not available. If only one type of planned special order document is valid on the sales 
order line, the Create prompt only allows you to create the valid document type or to not 
create any planned special order document. For example, if the item is temporary and so 
a planned special order transfer is invalid, then the Create prompt would display the 
option to P-Create a planned special order PO or N-neither. 

2 Specify the Vendor for the planned special order transaction. Press F1 to use the 
primary vendor, press F2 to search or F4 to backup to the Create prompt. This prompt is 
disabled if the Create prompt is not set to "P"-Create a planned special order PO. 

3 Specify the Warehouse for the planned special order transfer. Press F1 to use the 
restocking warehouse, F2 to search or F4 to backup to the Create prompt. This prompt is 
disabled if the create field is not "T"-Create a planned special order transfer. 

4 (Optional) For searches, the system displays the Warehouse/Item window (SOC070), 
showing all warehouses (other than the shipping warehouse) and the warehouse 
quantities. You can select a warehouse from the search and the "Select Wh" option is 
available to return the warehouse number to create planned special order document. 

Completing sales orders footers  
1 Click Sales Orders>Order Entry.  

2 Specify the order number and click Done to display Footer for Document dialog box. 
Refer to Creating sales order headers and Adding items to sales orders for step-by-step 
instructions. 
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3 (Optional) In the Memo field, enter the memo line that prints on the pick ticket.  

4 (Optional) Click Backup if you need to change any items or header information or 
Deposits/CC Preauths to access to the Deposit/Payment Entry window.  

5 Choose OK in the Footer window to finish the order.  

6 In the Frt Method field, the system displays the Document Freight Method (Q/C) for this 
customer– this value defaults from AR Customer Maintenance and is modifiable based 
on the Allow Method Change check box on the Invoicing tab of AR Customer 
Maintenance. Based on the setting, you can select from: Quoted Freight or Calculated 
Freight.   

7 In the Freight $ field, the freight value can be entered freight, quoted freight or 
automatically-calculated freight, based on control settings in Ship Via F/M, AR Customer 
Maintenance and SO Static Control F/M (SOF980). You can modify the entered freight, 
quoted freight amount but the calculated freight is determined by the system. You cannot 
modify this value from within Sales Order Entry. The Discount Percentage, Tax Code 
and Rate display and are not modifiable. 

8 Click OK to access the Print Ticket Window.  

9 Complete this information. 

Print Pick Ticket – You have these options. N-Do not print pick ticket now. , Y-Print 
pick ticket now. , P-Print pick ticket and pack list now. or, H-Place document on 
hold, which may be necessary if the order put the selected customer over its credit limit. 
Documents put on hold can be released in the SO Hold Selection program (Sales 
Orders>Orders>Hold Selection).  Click Save to make your Print Pick Ticket response the 
default answer for the next pick ticket you create.  
 Multiple warehouse users: If you select Y-Print pick ticket now and no print ticket exists 
for the initiating warehouse, a message appears to the effect. Items shipping from other 
warehouses are added to the Item Ship Approval File for those shipping 
warehouses.    You must approve the items in Item Shipment Approval before the ticket 
can print. 
 Orders with direct ships: The program asks you if you create or update a purchase order 
if the Create POs for Direct Ships control in SO Static Control F/M is set to Y-Create POs 
or M-Operator Selection of PO Creation. 
(Optional) Bill of Lading – Check the box to print the bill of lading now also. Click Save 
to make your selection the default. 
Print Acknowledgment– Check the box to print the acknowledgment as well. Click 
Save to make your selection the default. 

Print Prices-– Check the box to print the item pricing information on the 
acknowledgment. Click Save to make your selection the default. 
Click OK.  

10 The system returns you to the Doc/Cust field, where you can enter another sales order 
or click Done exit the program. 
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Creating BOM items (Kitting, On-the-fly) 
You can create Bill of Material (BOM) items in Order Entry (SOE210) if: 

You purchased and activated the Manufacturing Control module. 

You set the Update in SO option in the Manufacturing Control BOM Entry program to C, A or 
O. 

1 To create finished items, click Sales Orders>Order Entry. 

2 Specify the order header information and specify a component item that composes the 
BOM item. (Refer to Creating sales order headers and Adding items to sales orders for 
instructions.) 

3 At the Bill of Material (BOM) field that appears when you enter a BOM item, select F- 
Update the finished item to simply update the finished item and not modify or update its 
components. 

4 In the Units/ea field, specify the number of units — in stocking units of measure — 
required to make the one finished item. You can accept the default from the BOM Entry 
program by clicking OK. Click Skip to skip the item. Click Accept All to accept the 
default entries for the remaining components on this BOM item. The program uses the 
number of units needed to build one finished item and determines the quantity that 
should be shipped or back ordered. For example, a customer orders 5 units of BOM Item 
1, which requires two units of Component A and 1 unit of Component B to make one 
finished unit. When you choose to create component lines automatically, the system 
"ships" 10 units of Component A and 5 units of Component B (assuming all quantities 
are available). 

5 If you changed the ordered quantity for the finished item in the main window, the system 
automatically updates the quantities of components needed. 

6 The program defaults to the component descriptions entered in the BOM Entry program. 

7 Click OK to accept the line. 

8 When the system displays the Memo screen for the component, edit memo lines 
associated with the component item, if necessary and check the Print on Invoice check 
box to indicate you want to include the memo on the invoice. Click Skip to not add a 
memo, Acpt Memos to select and include memos for all components, or OK to accept 
the memo for the current component only. 

9 Repeat these steps for each component line. 

10 When all component lines are created, click OK to return to the main Order Entry window 
to continue with the order. Using the A- Create component lines automatically option, the 
system looks at the stocking units required to make one finished item (defined in the 
BOM Entry program) and multiplies that number by the quantity ordered. 

Approving shipments of on-hold document lines 
1 Click Sales Orders>Orders>Item Shipment Approval. 
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2 Specify the shipping warehouse.  

3 In the Enter Password field, specify the password, as necessary.  

4 Specify the initiating warehouse.  

5 In the Display By drop down, specify whether to display by D - Document or I - Item.  

6 (Optional) If displaying by document, information about each document is displayed 
including number, type, status code, date created, initiating warehouse, customer 
number and name, salesperson, number of lines rejected and number of lines on hold. 
Highlight a line then click Show Items for this Document to display document line items. If 
there are no rejected or on-hold line for a document, the system displays a message.  

7 You have these options. 

Hold-Places all items on hold for the selected document. Once a line is placed on hold, 
the shipment status displays 'On Hold'. 

Approve-Approves lines on the highlighted document. Once a line is approved, the 
shipment status displays 'APPROVED' and the line cannot be placed on hold or rejected.  

Reject-Rejects lines on the highlighted document. Once a line is rejected, the shipment 
status displays 'REJECTED'.  

Done-Ends processing  

Doc Inquiry-Displays line details Information, including item number, descriptions 1 and 
2, shipping warehouse, ship via, shipment status, original order amount, invoiced 
ordered, committed, shipped and back-ordered amounts, total amount shipped, selling 
unit of measure (UM), picking status, price, pricing UM, cost, costing UM, discount, 
location, commission percentage, whether the item is taxed, GL department number, 
weight and vendor.  

8 (Optional) If displaying by item, each item is displayed with the item number, description, 
committed amount, selling UM, number of line-items rejected and number of line-items 
on hold. Also displayed are the available, on-hand, on order, back-ordered, and 
committed amounts for this item and warehouse. Use the arrow keys to highlight and 
select a line. Once a line is selected, you have these options.  

Approve-Approves all items. Once lines have been approved, the numbers in the 
rejected and/or on-hold columns become 0.  

Reject-Rejects all items  

Done-Ends processing. 

5 After you approve/reject a line on a document or view details, click Done.  

Placing/releasing document credit holds 
1 Click Sales Orders >Order Review.  

2 Specify the warehouse.   
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3 In the Hold Status drop-down list, specify whether to display documents that are H-on 
hold, N-not on hold or A-all documents. The program defaults to H. 

4 In the Type field, specify the types of orders to display. You can select from open orders, 
back-orders, invoices, credit memos and/or counter sales.  

5 In the Status drop-down list, specify the order status to display: E-Entered, W-Pick 
Printed, C-Confirmed, I-Invoice Printed, R-Register Ready, or A-All. 

6 In the Origin drop-down list, specify the origin of orders to display: N-non-remote, W-
web, R-remote or A-all documents. 

7 In the Priority drop-down list, select the orders priority to display: N-normal, R-rush or B-
both.  

8 In the Salesperson drop-down list, specify the salesperson type: salesperson; second 
salesperson or inside salesperson to display.  Once you specify the salesperson/territory 
type, specify the salesperson. 

9 In the Req. cutoff field, specify the request date to display through.   

10 You have these options. 

Svc Hold-Places the highlighted documents on service hold. The selected document is 
placed on hold until the user releases it.  

Credit Hold-Places the highlighted documents on credit hold. The selected document is 
placed on hold until the user releases it.  

Release-Releases the highlighted document. The selected document is no longer on 
hold. The system re-displays the sales order documents in the browser. 

Display Document-Accesses SO Document Inquiry (SOI620) for the selected 
document. 

Aging-Displays aging for the highlighted document ’s customer. Shown is the customer’s 
aging as of the current system date. Displayed information includes: credit limit, balance, 
and current aging for the number periods (set in Accounts Receivable Static Control 
Record).  

Payment History-Displays payment history for the selected customer’s document. 
Shown is the customer’s payment history. Displayed information includes last payment 
date, days grace and history.  

Header-Displays the Change Filters dialog box which is used to modify the selection 
criteria in the upper portion of the screen.  

Access Note Entry (SME710) for the customer or sales order header record specified in 
the program.  Tip: At the List From field, specify the beginning document number to list in 
the browser or display the first document selected or next available document. 

11 When you have managed the document holds, click Done. 

Committing back-ordered quantities 
1 Click Sales Orders> Orders>Commit Backordered Quantities.  
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2 At the Include field, indicate whether to commit stock for S-sales orders, T-transfers or 
B-both.  

3 Select the order in which to print the report.  

4 At the Beginning and Ending prompts, specify the beginning and ending orders choices 
to update.  

5 In the Properties section of the screen, complete this information: 
Warehouse-The Warehouse information varies, depending on the Include option you 
selected above: 

For S-sales orders, specify the shipping warehouse to update for. 

For T-transfer only, specify the from warehouse to update for. 

For B-both sales orders and transfers, specify the shipping warehouse or from 
warehouse to update for. 
Beginning and Ending Date-The beginning and ending dates for the update. Route-The 
three-character route codes (entered side by side) for which orders are to be updated. If 
the Include prompt is not "S" for sales orders or "B" for both, the Route prompt will be 
disabled. Of course the existing check for Use Routes from the SO Static will be 
maintained.Doc Type-Indicate whether to commit O-open orders, B-backorders or A-all 
orders. 
Priority-The priority to use when committing items: N-normal, R-rush and/or H-service 
hold orders.  
Press F3 to default to All.  
Print Status-Specify the print status to use for the commit quantities scope: Commit 
quantities on documents that have Not been printed, commit quantities on documents 
that are Ready for reprinting, commit quantities on documents that are TR-already 
printed, commit quantities on documents that are Ready for reprinting, or commit 
quantities on All order/back order documents that are ready for reprinting. The program 
defaults to N-documents that have not been printed. 

6 In the Pick Ticket section, complete this information. 
Print Pick Tickets-Indicate whether to print pick tickets for orders being committed. 
Printer-Specify the code for the printer to use. If the Print Pick Tickets prompt is set to 
"No", this prompt is disabled. A printer is the only valid option for this field; you cannot 
select viewer, fax or file for printing. 
Note: If the Print Pick Tickets prompt is "No", this prompt is disabled. If the pick ticket 
quantity is "Ordered" in the SO Static Control file, this prompt is not displayed. If the new 
"Allow Print if not Complete" field from SO Static Control file is "No", this field is set to "N" 
and disabled. 
Print if Not Ready-Indicate whether to print orders that are not yet available to ship.  
Print Packing Slips-Indicate whether to print packing lists for orders being committed. 

6 In the Transfer Ticket, section of the screen, complete this information. 
Print Transfer Tickets-Indicate whether to print pick tickets for orders being committed. 
Printer-Specify the code for the printer to use. If the Print Pick Tickets prompt is set to 
"No", this prompt is disabled. A printer is the only valid option for this field; you cannot 
select viewer, fax or file for printing. 

7 Click OK to run this program using the defaults.  
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Blanket Sales Orders procedures  

Processing Blanket Sales Orders (Overview) 
1 Create the Blanket Sales Order. Generate the blanket order document number and 

complete the customer information in the header section document entry. Add line items, 
memo lines, release request dates and complete the Blanket order by entering the 
document memo. 

2 Acknowledge the customer’s order.  From within BSO document entry or from the 
BSO menu, print the order acknowledgment for the customer to use as confirmation of 
the order. 

3 BSO Document Inquiry and/or Report Analysis: Check the status of current and 
completed BSO documents through Customer Inquiry, SO Quick-Look Inquiry, Item 
Inquiry, and Blanket Sales Order Inquiry. Use the BSO Inquiry to obtain the associated 
Sales Order Document # as releases are processed. Use the SO Inquiry to check the 
status of individual Sales Orders.  

4 Run the Blanket Order Report to list release requests on open blanket orders and 
determine if any releases need to be processed. This report can also be used to 
determine which Sales Order documents are related to BSO release requests and the 
status of those releases.  

5 Run the Blanket Order Release Register. The release register will print a list of items 
ready for processing. If you choose to update the Blanket Order Release Register, sales 
order(s) will be created for each BSO, containing all items scheduled to be released. As 
the order is shipped, the Daily Sales Register will update the BSO document.  

6 Remove the Completed Blanket Order Document. Run Blanket Order Removal as 
needed to remove completed BSO documents that do not need to remain on the system. 

Creating or updating blanket order headers 
1 Click Sales Orders>Orders >Blanket Sales Orders>Blanket Order Entry.  

2 In the Doc/Cust field, enter an existing blanket order document number (up to 6 digits) or 
press Enter to have the system assign a new document number or the customer for the 
blanket sales order. 

Tips:  

When you press Enter or Tab, the additional fields that appear, such as Ship to code, an 
inside salesperson code, etc., depend on the settings selected in SO Static Control F/M 
SOF980, the AR customer record, and the Ship Via F/M. This procedure details all 
possible entries. Most of these entries already display default information.  

3 Click Defaults to accept the default values for the remaining fields. If the program stops 
at an entry field, this means that the system could not find a valid default for the required 
field and a valid value must be entered before continuing. 
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4 Modify the ship-to code (this code displays from the customer's default information) 
where the order should be shipped. The system displays the full ship-to address. 

5 Specify the date the order expires in the Expires field. Press Enter or F1-None to default 
to NONE. 

6 In the Completion field, specify the date all releases on the order have been completed.  

Tip: When all line-items are released and shipped this field is updated by the Daily Sales 
Register. You can specify a date to manually cancel an order. All documents which 
contain a completion date are considered complete and will not be processed any 
further. 

7 (Optional) Check the Blanket Order On Hold check box to indicate you want to place 
the document on Hold status. The system does not process releases for any document 
placed on hold.  

8 In the Release Basis field, the system defaults to SO Static control value for Release 
Basis. The basis is used to determine when a sales order will be created for specific 
release requests per BSO document, by the item which has the Longest lead time, a 
Fixed number of days, or whichever represents the Greater of, longest lead time and 
fixed number of days.  

9 In the Fixed Days field, specify the predetermined number of days to be used in the 
release calculation.  

10 In the Add Days entry field, specify the number of days to allow adding pad to the 
longest lead-time for an additional margin of safety, or to cover the order processing and 
shipping time.  

11 This completes the blanket order header information. The system displays the system 
displays the line-item detail screen. Refer to Adding line items on blanket sales orders for 
step-by-step instructions. 

Adding items to blanket sales orders 
1 Click Sales Orders>Orders >Blanket Sales Orders>Blanket Order Entry. 

2 Complete the Creating or updating blanket order headers procedure or specify the 
document number.  

3 Specify the Item Number.  After entering a valid item the program displays item 
description 1 and 2, the item class, package size, item weight and its unit of measure, 
available quantity, on hand quantity, on order quantity and bin location.  

TIP: F3-Defaults Option Use this option to accept the system defaults on file for the 
remaining fields (after you enter the item number). If the program stops at an entry field, 
this means that the system could not find a valid default for the required field and a valid 
value must be entered before continuing. For example, you are entering blanket order 
detail and you choose F3 at the Add Days entry field. The system enters all default 
information until it reaches the Sugg PO entry field. At this point, you must decide 
whether or not to create planned special order PO when insufficient available to commit? 
(Y/N).  
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4 (Optional) If the system determines that the item number entered is not in standard 
inventory, it will prompt you to enter temporary and/or catalog information for the item 
number.  

5 The warehouse code for the item displays in the Wh field. 

6 (Optional) Check the Direct Ship check box to ship the item directly from the vendor. 
Then, specify the Vendor. 

7 In the Total Qty field, specify the total quantity to release over the life span of this BSO, 
up to 11 digits.  

8 Specify a cost plus percentage in the Cost + % field. Cost plus pricing allows price to be 
set as a percentage over cost. Price will then be determined from the cost at the time of 
the release register. An asterisk (*) displayed to the right of the extended amount 
denotes a line-item price that contains a cost plus percentage. Press F2-Change UM to 
change the pricing unit of measure.   

9 In the Price field, the system displays the default price from file. You can modify the 
price. 

10 The line-item extension is calculated (price less any discounts multiplied by the quantity 
ordered multiplied by the conversion factor) and displayed in the Extension field.  

11 The system displays a message asking: Specify release requests now for this item? 

12 Click Yes to access the Blanket Sales Order Entry Release Requests (SOE711) to 
release requests for an item on the blanket sales order.  Refer to Releasing blanket sales 
order requests for step-by-step instructions.  

13 Click No to enter another line item and repeat the entry steps.   

14 When you have finished adding items, click Stop. 

15 You have these options. 

Archived BSO to access to the Unform Archive window to review archived blanket sales 
order documents. 

Doc Distrib to access to the Change Document Distribution window. 

Release Req to access to the Blanket Sales Order Entry Release Requests (SOE711) to 
release blanket sales order requests for an individual line item or all line items on a 
document.  

Header to access the Header Detail for Documents screen, which is used to view and/or 
modify warehouse, shipping information, request and order dates, and salesperson, 
freight, terms and ship via codes.  

Highlight a line item and click Line Detail to access the Line Detail for Documents 
screen, which is used to view and/or modify item descriptions, quantity and shipping 
information, costing, and PO information.  

16 Click Done to access the Blanket Sales Order Footer screen. Refer to Completing 
blanket order footers for step-by-step instructions.  
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Completing blanket order footers 
Once the blanket order item information is complete and you click Done, the system displays 
the Blanket Sales Order Footer screen.  

1 In the Document Memo field, specify the memo to be added to the pick ticket and the 
sales order. 

2 This system performs an initial credit limit check. You can enter a blanket order 
document for a customer who has exceeded their credit limit, however, the system 
performs another credit limit check on the sales order document that is generated from 
the blanket order.  

3 (Optional) Check the BOL Print File check box to indicate you want to add the document 
to the Bill of Lading print file when it is released. 

4 (Optional) Check the Print Blanket Order Acknowledgment Now? check box to 
indicate you want to print the blanket order acknowledgment at this time.  

5 Click OK, and the system completes the blanket order processing and returns you to the 
Doc/Cust field. 

6 To exit the program, click Done. 

Releasing blanket sales order requests  
The system displays this dialog box when you click Yes on the asking: Specify release 
requests now for this item?, while adding items to a blanket sales order. Complete the 
Adding items to blanket sales orders procedure first.  

1 In the Request Date field, specify the date the order is requested at the ship to location. 

2 Specify the quantity to be released on the specific release date. 

3 Check the Immediate Release check box to indicate the line is flagged for immediate 
release; the system will not release all other requests with the same request date.  

4 Repeat this process for each line.  

5 When you have finished adding line items for release, click Stop.   

6 You have these options. 

Immediate Release-releases the highlighted line. 

Line Distrib-accesses the Change Document Line Distribution window for the 
highlighted line. 

SO Inquiry-accesses Sales Order Document Inquiry for the associated SO doc.  

Invoice Inq-accesses to Sales Order Document Inquiry--Past Invoices view for the 
associated sales order.   

7 To return to the Blanket Sales Orders screen, click Done. 
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Printing the Blanket Order Release Register 
1 Click Sales Orders > Orders >Blanket Sales Orders>Blanket Order Release 

Register.  

2 In the Date field, enter the date from which the system will calculate the scheduled 
releases. The date must be on or after the current system date. Press F1 to default to the 
system date.  

3 In the Scope field, select whether to process Printed documents only or All documents. 
The program defaults to Printed 

4 In the Memo field, select whether to include memo lines on the report. The program 
defaults to No.  

5 Enter Yes to print the register, or press F4 to backup. The system prints the register for 
the selected documents.  

Automatically removing completed BSO documents 
1 Click Sales Orders > Orders >Blanket Sales Orders>Blanket Order Removal.    

2 The Blanket Order Removal program displays the following default field values: 

Order-Customer 

Beginning-First 

Ending-Last 

Warehouse-The warehouse assigned to the current terminal 

Cutoff Date-The date stored in GL: Company Periods and Ending Dates F/M, Last 
Period 

3 You have these options. 

Enter to run this program using the defaults. 

F1 to access template information for this program. 

F3 to change the default field values listed in step 2. 

F4 to exit without running the removal program.   

Invoices procedures 

Confirming invoices 
1 Click Sales Orders>Invoices>Order Confirmation. 

2 In the Document field, specify the number of the order you want to confirm.  
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3 (Optional)  If multiple warehouses exist on the order, you must select the warehouse or 
warehouses to confirm before you can select a confirmation method. Select a 
warehouse to confirm if more than one warehouse appears on the order.  

4 The Assume Shipment window is displayed after you open a document in Order 
Confirmation. Select the shipping options for confirmation. Refer to the Choosing a 
confirmation method topic for details.  

Choose a confirmation method: 

Assume shipment all committed quantities 

Back order all committed quantities 

Leave all committed quantities as committed 

Confirm the order line by line. 

5 (Optional) Based on settings for Confirmation in SO Entry Options F/M, the system 
displays a window for entry of the invoice date and ship date for the order you are 
confirming.  
 
In the Invoice field specify the confirmation date. 

In the Shipped field specify the date the order ships. 

In the Ship-to field, the system displays the ship-to code entered on the sales order 
along with the full ship-to address. Edit the ship-to code, if necessary. If a customer 
requests to have an order shipped to an address other than its usual shipping address, 
use the Temporary Ship-to feature to facilitate this request. You can press F2 to search. 

6 The Turbo Tokens drop down list is available for faster use of CenPOS tokens credit 
card processing for deposits or payments on sales order documents. It is automatically 
populated with all available tokens for the specified customer and ship-to combination if 
the CCToken Usage in Ship-to F/M (ARF920) is set to “S – Ship To” or the specified 
customer if CCToken Usage in Ship-to F/M (ARF920) is set to “C – Customer”. If a Turbo 
Token was selected in Order Entry, the token is displayed in Order Confirmation. If the 
Turbo Token prompt is available in Order Confirmation, the selected token can be 
changed or removed. 

7 Based on the shipping option for confirmation, confirm the individual line items as 
necessary.  

8 You have these options.  

Change quantity information by highlighting a line item and click Edit. Refer to the 
Editing line items in entry programs topic for details.  
Edit lines on the order as necessary by highlighting them in the item browser, and 
clicking Line Detail to make changes in the Line-item Detail Entry window.  
Click Header Detail to make changes in the Header Detail Entry window.  
Add line items or insert line items above the highlighted line in the browser.  
Refer to Adding line items in Order Confirmation Entry topic for details. 
Access Note Entry (SME710) for the customer, item, sales order header or line record 
specified in the program. 
Delete a line item by highlighting it and clicking Delete.  
Click Stop Conf to perform a partial confirmation – in other words leave some items 
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unconfirmed, as in a multiple warehouse order – or to interrupt confirmation on a 
document. Refer to the Stopping confirmation topic for details.  

9 Click Done to access the footer. 

10 Complete or modify this information. 

(Optional) Memo-a memo for the credit memo. 

Ship-to-The ship-to code from the document header is displayed. You can modify this 
field. 

Freight code-Options are Prepaid, Collect, Bill Later and A Prepay/Add.  

11 In the Frt Method field, the Document Freight Method (Q/C) for this customer defaults 
from AR Customer Maintenance and is modifiable based on the Allow Method Change 
check box on the Invoicing tab of AR Customer Maintenance and is not a back order. 
Based on the setting, you can select from: Quoted Freight or Calculated Freight.  

Unless the Freight Type is prepaid, specify or update freight and handling charges in the 
Freight $ field. Refer to the Entering Freight and Handling (Sales Orders) topic for 
details 

Disc %-The discount percent (maximum of 100) or dollar discount (maximum equals 
merchandise total) of the merchandise total.   

Tax code -The tax code assigned to the customer’s ship to file. 

Tax rate-If the Charge Tax flag in the Sales Orders Static Control F/M is not set to O-
Override, you cannot override the tax code and this field is unavailable. Specify H-to use 
the high rate, L-to use the low rate, or X-to change tax status of this document to exempt.  

Check, ATM, Debit Card, V,M/C, A, D, Coupon-Use this field to pay for the order using 
a customer’s check, ATM, debit or credit cards. 

Other-Use this field to pay for the order with other cash type payment methods. 

Cash Terms-Use this field to specify a cash terms code. Specify the cash amount.  

A/R Terms-This defaults to the terms code entered in the Terms Code setting for the 
customer. 

12 (Optional) Click Payments if you need to place a deposit on the order or specify a 
payment.  

13 Click OK. 

14 Check Print Invoice now to print the invoice when you complete the footer, or batch 
print it through Invoice & Credit Memo Print program later. If you choose to print the now, 
select a printer in the dialog box.  

15 (Optional) Check the Sort by Shipping Whse check box to print invoices in groups by 
shipping warehouse. 

16 (Optional) Check the Update Now check box to create/update any purchase orders 
generated by the invoice. 

17 Click OK. 

18 Click Done. 
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Opening a document in Order Confirmation 
1 Specify the document or pick ticket number in the Document field.  
2 If you don’t know the number, click File>Open Existing Document and use the search 

tools to find the document you want to confirm. 

• You cannot create or delete documents in Order Confirmation.  
• Delete unconfirmed documents in Order Entry. 
• Delete confirmed documents in the Direct Invoice Entry. 

Opening a document with multiple warehouses 
1 Specify the document or pick ticket number. 

2 Select the warehouse or warehouses for which you are confirming. The dialog box 
displays the warehouses that have not yet been confirmed. The program defaults to ALL 
if none of the warehouses on this order has been confirmed or ALL ABOVE if you are 
working in a partially confirmed document. 

Changing header information in Order Confirmation 
The Header Detail window can be accessed after you enter a document number and 
complete the header section of the main window. The header information that appears at 
the top of the screen also appears in Header Detail.  

To access the Header Detail window: 

1 Click Header or Options>Header Detail from the menu. 

Main tab fields 

Fields Entry 

Customer This information is display only on this window. 
The customer number cannot be changed after the header is 
complete. If the customer number needs to be changed, delete 
the document and re-enter the order. 

Ship-to The ship-to code from the main screen appears along with the full 
ship-to address. Edit this entry here or on the main screen.  
If a customer requests a specific order ship-to an address other than 
the one to which you normally ship orders, you can enter a 
temporary ship-to address.  
Creating a temporary Ship-to: 
1. Press F3 or choose the Temporary button.  
2. In the Ship-to Address window, enter the new ship-to information.  
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3. Click OK to return to the main entry screen. TEMP appears in the 
Ship-to field to indicate that this address is different from the normal 
shipping address. 

Reference 
Number 

Specify up to 15 characters of customer reference information, such 
as the name of the person who placed the order or the PO number 
generated on the customer’s system.  
If the PO required flag is selected in Customer F/M. You must enter 
a reference number. 

Initiating 
Warehouse 

Specify the warehouse from which the items on this order are 
shipping. If your system uses multiple warehousing, enter the 
warehouse from which this order initiated. Press F2 or choose the 
Search button to see the list of warehouses.  

Invoice Date This is the date on which you are confirming the sales order and, in 
the process, turning it into an invoice. The program defaults to the 
system date. The system uses this date to determine payment 
schedules in Accounts Receivable. 

Choosing a confirmation method 
The Assume Shipment window is displayed after you open a document in Order 
Confirmation. If multiple warehouses exist on the order, you must select the warehouse or 
warehouses to confirm before you can select a confirmation method. 

1 Several options are available in this window: 

Y-Assume shipment of all committed quantities. This option sets all committed quantities 
to shipped. This is the default option and the most likely choice if the order was 
completely filled or almost completely filled.  

For instance, say you receive a pick ticket with 15 items listed, but one of the items could 
not be picked. You can select the Assume shipment option to auto confirm and then 
change the one line item to back ordered. 

If the program asks How should the committed quantity for this line be handled? It 
means: 

A line is on hold or is rejected 

Negative on-hand quantities are not allowed, and a BOM component in a line creates a 
negative on-hand quantity. 

 Specify B to back order the committed quantity or C to leave the quantity committed. 
The program defaults to back order. 
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 This prompt only appears if you select the Y- assume shipment of all committed 
quantities and the Commit in Confirmation flag in the SO Static Control F/M is selected 
(or set to Y).  

N - do not assume shipment of all committed quantities, instead backorder all committed 
quantities. This may be helpful for orders that may not be able to ship the same day the 
customer ordered the items. 

Back-ordered quantities must be committed through the Commit Backordered Quantities 
program. 

B - confirm shipment of committed quantities line by line. Use this option for orders that 
have a mixed bag of items that can ship or that need to be back ordered, you may want 
to confirm line by line to ensure accuracy. 

2 A dialog box asks "Confirm Shipment for this line?" for each line on the document. 
Choose one of the following options: 

Y -  Ship committed quantity for this line. This option is only available if shipment of this 
line is allowed. 

N -  Do not ship the committed quantity, backorder this line. This option is only available 
if back orders are allowed. 

C -  Do not ship, leave quantity committed for this line. This option is only available if 
commitment in confirmation is allowed. 

S -  Ship the committed quantity for this and all remaining lines. This option is only 
available if shipment of this line is allowed. 

B -  Backorder committed quantity for this and all remaining lines. This option is only 
available if back orders are allowed. 

L -  Leave this line and remaining lines committed. This option is only available if 
commitment in confirmation is allowed. 

In some cases, only one of these options is available in a confirm-line-by-line situation. If 
so, a message to this effect is displayed. 

If none of these options are allowed (i.e., cannot ship this line, cannot leave quantity 
committed and cannot back order) the system forces the quantity to remain committed 
regardless of how the Commit in Confirmation flag is set.  

C - do not assume shipment, leave all lines committed. This option only appears if the 
Commit in Confirmation flag is selected or set to Y in the SO Static Control F/M. 

Use this option to set the shipped, committed and back-ordered quantities manually by 
editing each line on the main Order Confirmation screen. With this option, the system 
assumes nothing. You specify all quantities for each line. 

Confirming serial and lot items 
1 Serial/lot entry is only available if the OE/Serial Lot Entry control is set to M-Assign in 

either Entry or Confirmation or N-Assign in Confirmation in SO Static Control F/M. 
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2 If you choose Y, B or C in the Assume Shipment window on an order with serialized or 
lot items, the Serial/Lot Entry window is displayed automatically. 

3 Use this window to assign serial numbers or lot numbers for items you are confirming.  

Serial/Lot Costing Options 
You have the ability to cost serial and lot items by the system cost (costing method for the 
module). The feature provides for GAAP compliance. For the FACTS SO, IC and MC 
modules, you can decide if the cost for serial and lot items will be averaged actual (as it has 
always operated in the past) or system cost (costing method for the module). The default 
setting for each Static Control F/M is A-Averaged Actual (same behavior as they have before 
the monthly is applied). To take advantage of this you will need to change the option to S-
System Cost for each of the applicable modules. The net result of selecting S-System Cost is 
that serial/lot items will be costed like non-serial/lot items. 

Over-Commitment of Serial/Lot Items 
The over-commitment of serial/lot items is not allowed in Order Entry and Confirmation Entry. 
If the OE Serial/Lot# Entry flag in SO Static Control is set to "M" or "N" then you can under 
commit serial/lot items.  

The system recalculates quantities if: 

The Serial/Lot shipped amount does not equal the order's shipped amount,  

The OE Serial/Lot# Entry flag is set to "Y" and the Serial/Lot committed quantity does not 
equal the order's committed,  

-OR- 

The OE Serial/Lot# Entry flag in SO Static Control flag is not "Y" and the Serial/Lot 
committed quantity is greater that the order's committed amount.  

The system displays the message "Improper ser/lot assignment. Quantities changed for line 
XXX" then recalculates as follows:  

The order's shipped amount is set to the Serial/Lot shipped amount.  

The committed amount is set to the Serial/Lot committed amount.  

If the "new" sum of the shipped and committed amounts is greater than the ordered amount, 
the system sets the ordered amount to the sum of the shipped and committed amounts. The 
system recalculates the order's back-ordered amount with the new quantities to equal the 
ordered amount minus the shipped amount minus the committed amount.  

In the Daily Sales Register, if the Serial/Lot shipped amount doesn't match the order's 
shipped amount the system now displays a message and return to the menu and no longer 
displays an error 40. The system also displays a message if the Serial/Lot committed amount 
is greater than the order's committed amount and returns to the menu.  
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When the system displays the Serial/Lot Entry (SOC145) window, the item number 
automatically displays in the Item field and the document number displays in the Document 
field. 

1 You can update the following: 

1 Ship Only 

Indicate whether you want to allow the entry of shipped amounts only in the lower portion 
of the screen. 

2 Auto Accept Quantities 

Indicate whether you want to automatically accept maximum amounts for quantities.  

3 Show  

Select the serial/lot items you want to display in the browser. You can select from L-All, 
A-Available, or S-Assigned. 

In the browser in the lower portion of the screen, the system displays the serial or lot 
numbers, the available, shipped and committed quantities and the date received. Select 
the serial or lot you want to use and press Enter . 

You can use the List From field to narrow the serial/lot items displayed in the browser.   

-OR- 

Click Ship Max to use the highlighted line to sip the maximum quantity available. 

4 Shipped/Committed  

Specify the quantity to ship or commit. The amount you need to distribute —referred to 
as the undistributed shipped amount — appears at the lower portion of the screen. This 
is the amount ordered, minus any back-ordered quantity.   

7 Save your selection. 

8 Click Clear Qtys to clear the Shipped quantity.  

9 Click Return to List after Entry to return to the serial/lot browser and make further 
selections. 

10 Click Done when you have completed your selections and return to the main Order 
Confirmation screen.  

Creating BOM items in Order Confirmation (kitting, on-the 
fly) 
You can create Bill of Material (BOM) items if: 

You purchased and activated the Manufacturing Control module. 

You set the Update in SO option in the Manufacturing Control BOM Entry program to C, A or 
O. 
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To create finished items: 
1 Open the document you want to confirm and select a confirmation method in the Assume 

Shipment window. 
2 At the Bill of Material (BOM) field select from the following options: Y-Update and 

Change Components, A - Update Components automatically and initially skip change, or 
F- Update the finished item. The options Y-Update and Change Components and A - 
Update Components automatically and initially skip change, available if the Update in SO 
option for this BOM item is set to C (Update Components, Entry and Change of 
Components Allowed) or A - Update Components automatically and initially skip change) 
in the BOM Entry program. To simply update the finished item and not modify or update 
its components, select F- Update the finished item. 
The Create component lines one at a time option provides access to the BOM 
Component Entry window, which displays the components and asks for the number of 
units required to complete one finished item. 

3 In the Units/ea field specify the number of units — in stocking units of measure — 
required to make the one finished item. You can accept the default from the BOM Entry 
program by clicking OK. Press Skip to skip the item. Click Accept All to accept the 
default entries for the remaining components on this BOM item.  
The program uses the number of units needed to build one finished item and determines 
the quantity that should be shipped or backordered.  
The program defaults to the component descriptions entered in the BOM Entry program. 

4 Specify the cost associated with the component or accept the default cost. This field is 
disabled if the Change by Ln Cost flag is deselected (set to N) in the SO Entry Options 
F/M.  

5 Click OK to accept the line. 
6 In the Memo field edit or specify memo lines associated with the component item, if 

necessary. Select the Print on Invoice check box to include the memo on the invoice 
printout.  

7 Repeat these steps for each component line. 
8 When all component lines are created, click OK to return to the main Order Confirmation 

window. 
9 Using the A- Create component lines automatically option, the system looks at the 

stocking units required to make one finished item (defined in the BOM Entry program) 
and multiplies that number by the quantity ordered. 
For example, a customer orders 5 units of BOM Item 1, which requires two units of 
Component A and 1 unit of Component B to make one finished unit.  
When you choose to create component lines automatically, the system "ships" 10 units 
of Component A and 5 units of Component B (assuming all quantities are available). 
The BOM Component Entry window does not automatically appear when you select this 
option.  

To change component lines:  
1 Select the BOM item in the line item browser on the main window and Edit.  
2 The system calculated the number of items committed and displays the Over-Commit 

Warning (SOC513) screen with any over committed items, as needed. 
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3 Click Yes in the Change Bill of Material Components window to display the Component 
Entry (SOE513) program, which is used to add or modify the component items or their 
descriptions and quantities for the specified finished item. 

   If you change the ordered quantity for the finished item in the main Order Confirmation 
window, the system automatically updates the quantities of components needed. 

Opening existing invoices 
You can open an existing document as long as you don’t have another document open in 
the same window. Once you begin entering header information, the system does not 
allow to you open a document in the same window.  
You can also start another session of FACTS if you need to open an existing document 
while you are in the middle of entering one. 

To open an existing invoice: 
Enter the document number in the Customer/document number field. If the document is on 
file, the customer number appears in the customer number field and the document number 
moves to the title bar. 

OR 

1 Click File>Open Existing Document.  
2 Use the Document Search window to find the document you want to edit or review.  
3 Click OK in the search window to select the document and return to the main entry 

window. 

Printing invoices from Order Confirmation 
When you complete confirmation on a document, the system gives you the option of printing 
the invoice immediately or printing it later from the Invoice & Credit Memo Print program.  

This program enables you to batch print or reprint invoices converted from this program and 
entered through Direct Invoice Entry. 

You may want to batch print invoices at a later time if: 

1 You are partially confirming a multiple warehouse order and want to confirm additional 
warehouses. Once you print an invoice in documentation, the document is then closed 
for further confirmation. You must wait until the invoice is updated by the DSR until you 
can confirm the rest of lines for the other warehouses. Stopping confirmation 

2 Click Stop Conf to perform a partial confirmation – in other words leave some items 
unconfirmed, as in a multiple warehouse order – or to interrupt confirmation on a 
document. 

The stop confirmation feature offers two options: 
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1 Leave document as is, committing the shipped quantities. This options saves any 
changes you made to the document. 

2 Restore original document. This option erases any changes you made since you last 
opened the document. 

Direct invoice procedures 

Creating direct invoices (process overview) 
In many respects, entering a direct invoice is similar to entering a sales order; however, the 
footer of a direct invoice is the same as the one used in Order Confirmation. 

1 Click Sales Orders>Invoices>Direct Invoices. 

2 In the Ship-to field, the system displays the ship-to code from the sales order along with 
the full ship-to address or the default ship-to code for the customer. Edit the ship-to code, 
if necessary. If a customer requests to have an order shipped to an address other than 
its usual shipping address, use the Temporary Ship-to feature to facilitate this request. 

3 In the Invoice field specify the confirmation date. 

4 In the Shipped field specify the date the order ships.  

5 The Turbo Tokens drop down list is available for faster use of CenPOS tokens 
credit card processing for deposits or payments on sales order documents. It is 
automatically populated with all available tokens for the specified customer and ship-
to combination if the CCToken Usage in Ship-to F/M (ARF920) is set to “S – Ship To” 
or the specified customer if CCToken Usage in Ship-to F/M (ARF920) is set to “C – 
Customer”. 

6 (Optional) Select a warehouse to confirm if more than one warehouse appears on the 
order. 

7 The header is automatically created by the system. 

8 Specify the item. 

9 (Optional) Check the Ship Direct check box to indicate that this item is shipped directly 
to the customer ship-to address. Then specify the Vendor and click OK.  
 
(Optional) Check the Exceptional Sales check box to indicate that this line item should 
not be included usage for replenishment calculations. 

10 (Optional) For line items that should have their usage included in replenishment 
calculations, specify the usage date. 

11 In the Wh field, the system displays the default warehouse for the item. You can modify 
this value or search for a different warehouse.   

12 In the Ordered field, specify the customer's requested quantity. You can change the unit 
of measure on the ordered quantity.  
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TIP: If the quantity entered exceeds the available inventory in the selected warehouse, 
the program gives you the option to accept the quantity anyway or to search other 
warehouses. The Search Warehouses window displays the warehouses that have the 
item, along with the available, on hand, committed, on order, back ordered and surplus 
quantities for the unit of measure selected. Select a warehouse. This creates a planned 
special order warehouse transfer. Make sure you back order the item. 

13 In the Committed field, enter a quantity to commit in the warehouse or accept the 
default. This field defaults to the quantity ordered, if that quantity is available in the 
selected warehouse. 

14 In the Shipped field, enter a quantity to ship. 

15 In the Backordered field, enter a back ordered quantity if the quantity ordered is greater 
than the available quantity in the selected warehouse. The program skips this field if the 
customer or your company does not allow back orders (Allow back orders flag not 
selected in AR Customer F/M and SO Static Control F/M), the item is a direct ship, or the 
selected warehouse has enough inventory to fill the order. When you enter a back-
ordered quantity, Sales Order Entry programs base planned special order document 
creation on the Stock, NonStocked, Uninventoried, and Temporary prompts in Sugg 
PO/TR by Type section on the Line Options tab of SO Entry Options F/M (SOF915). Use 
these settings to indicate whether you want to have the system ask to create planned 
special order purchase orders or planned special order transfers by item type during 
Order Entry line processing. Refer to the Creating planned special order 
transfers/purchase orders from Sales Order Entry programs topic for detailed information 
about creating planned special order warehouse transfer or purchase orders for back-
ordered quantities. 

16 You can enter additional line items or click Cancel to exit out of Add mode. 

17 You have these options. 

Edit - to make changes for the highlighted line item.  
Add a line. 
Delete the highlighted line.  
Insert a line item above the highlighted item in the browser. 
Save your changes 

Header-to access the Header Detail for Documents screen, which is used to view 
(inquiry-mode) and/or modify warehouse, shipping information, request and order dates, 
and salesperson, freight, terms and ship via codes.  

Highlight a line item and click Line Detail to access the Line Detail for Documents 
screen, which is used to view and/or modify item descriptions, quantity and shipping 
information, costing, and PO information 

Access Note Entry (SME710) for the customer, item, header or line record specified in 
the program.  

18 Click Done to display Footer for Document dialog box.  

19 Complete or modify this information. 

(Optional) Memo-a memo for the credit memo. 
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Ship-to-The ship-to code from the document header is displayed. You can modify this 
field. 

Freight code-Options are Prepaid, Collect, Bill Later and A Prepay/Add.  

In the Frt Method field, the Document Freight Method (Q/C) for this customer defaults 
from AR Customer Maintenance and is modifiable based on the Allow Method Change 
check box on the Invoicing tab of AR Customer Maintenance and is not a back order. 
Based on the setting, you can select from: Quoted Freight or Calculated Freight.  

Unless the Freight Type is prepaid, specify or update freight and handling charges in the 
Freight $ field.  Refer to the Entering Freight and Handling (Sales Orders) topic for 
details   

Disc %-The discount percent (maximum of 100) or dollar discount (maximum equals 
merchandise total) of the merchandise total.   

Tax code -The tax code assigned to the customer’s ship to file. 

Tax rate-If the Charge Tax flag in the Sales Orders Static Control F/M is not set to O-
Override, you cannot override the tax code and this field is unavailable. Specify H-to use 
the high rate, L-to use the low rate, or X-to change tax status of this document to exempt.  

Check, ATM, Debit Card, V,M/C, A, D, Coupon-Use this field to enter payments to this 
order. 

Other-Use this field to apply this pay the order with other cash type payment methods. 

Cash Terms-Use this field to specify a cash terms code. Specify the cash amount.  

A/R Terms-This defaults to the terms code entered in the Terms Code setting for the 
customer.   

19 (Optional) Click Payments-to access to the Deposit/Payment Entry window. 

20 Click OK. 

21 Check Print Direct Invoice now to print the direct invoice when you complete the footer. 
If you choose to print the now, select a printer in the dialog box.  

8 (Optional) Check the Sort by Shipping Whse check box to print direct invoices in 
groups by shipping warehouse. 

9 (Optional) Check the Update Now check box to create/update any purchase orders 
generated by the direct invoice. 

10 Click OK. 

11 Click Done. 

Deleting an invoice 
Invoices can be deleted at any time; however, they are not technically deleted from the 
system until the next Daily Sales Register Update.  

Until then, the header status changes to Deleted and the system removes all line items. This 
procedure enables the system to keep an audit trail of all the invoice numbers used.  
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To delete an invoice before the header is complete: 

Press F4 to back up to the Customer field. 

To delete an invoice after the header is complete. 

With the document open on screen, 

1 Click File>Delete Document from the menu. 

2 At the prompt “Delete this entire document?” click “YES – Delete”. 

3 If the Lost Sales is selected on the Use Features tab of SO Static Control F/M (SOF980), 
you have the opportunity to post to lost sales if the item is inactive and the quantity is 
greater than the available amount. 

4 Select from the following options to indicate how to record and process the lost sale: 
N-No to indicate that you do not want to record the lost sale, R-Review to display the 
Lost Sales Entry (SOC420) screen and modify the lost date, update usage, quantity, 
price, cost, reason, and/or notes, Y-Yes to record the lost sale using the default lost sale 
reason code entered SO static Control F/M, the quote date as the lost sale date and 
usage defaulting to “no update”. You can also specify a different lost sale reason code.  
Click OK to delete the document or Cancel to exit without deleting. 

To delete a line 
1 Use the mouse or arrow keys to highlight the line in the item browser.  
2 Press the Delete key on the keyboard, or click Edit>Delete Item from the menu. 
3 At the prompt “Delete this line?” click “YES – Delete”. 
4 If the Lost Sales is selected on the Use Features tab of SO Static Control F/M 

(SOF980), you have the opportunity to post to lost sales if the item is inactive and the 
quantity is greater than the available amount. 

5 Select from the following options to indicate how to record and process the lost sale: 
N-No to indicate that you do not want to record the lost sale, R-Review to display the 
Lost Sales Entry (SOC420) screen and modify the lost date, update usage, quantity, 
price, cost, reason, and/or notes, Y-Yes to record the lost sale using the default lost 
sale reason code entered SO static Control F/M, the quote date as the lost sale date 
and usage defaulting to “no update”. You can also specify a different lost sale reason 
code. 

6 Click OK to delete the line or Cancel to exit without deleting. 

Creating document numbers in Direct Invoice Entry 
Invoice numbers (not to be confused with document numbers) are assigned just before each 
document is printed. Invoice numbers are not affected by reprinting. 

The system automatically creates a document number once you complete the header. At 
that point, the document number appears in the title bar along with the customer’s name. 
You can also assign a document number manually if you prefer. 
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To create document numbers manually: 
1 Click Sales Orders>Invoices>Direct Invoice. 

2 Click File>New Document Number from the menu.  

3 Enter up to six characters to create a document number. Click OK. The document 
number appears in the title bar. 

4 Begin entering the invoice, starting with the Customer Number. 

Using the Direct Invoice Header Detail window 
The Header Detail window can be accessed after you specify an existing document number 
or customer number. The header information that appears at the top of the screen also 
appears in the Header Detail window.  

To access the Header Detail window: 
1 Click Header or Options>Header Detail from the menu. 

2 The Header Detail window contains all the possible fields for the Direct Invoice header. 
Any of the fields located in this window can be configured to appear on the main 
Confirmation screen. This can be done in the SO Entry Options F/M on the SO 
Infrequent File Maintenances menu. 

Main tab fields 

Fields Entry 

Customer This information is display only on this window.  
The customer number cannot be changed after the 
header is complete. If the customer number needs to 
be changed after this point, delete and re-specify the 
document. 

Ship-to The ship-to code entered on the main screen appears 
along with the full ship-to address. Edit the ship-to 
code here or on the main screen, if necessary. 
The ship-to code from the main screen appears along 
with the full ship-to address. Edit this entry here or on 
the main screen.  
If a customer requests a specific order ship-to an 
address other than the one to which you normally ship 
orders, you can specify a temporary ship-to address.  
Creating a temporary Ship-to: 
1. Click Temporary.  
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2. In the Ship-to Address window, specify the new 
ship-to information.  
3. Click OK to return to the main Direct Invoice screen. 
TEMP appears in the Ship to field on the main screen 
to indicate a temporary address has been entered. 

Reference Number Specify up to 30 characters of customer reference 
information, such as the name of the person who 
placed the order or the PO number generated on the 
customer’s system. If the PO required flag is selected 
in Customer F/M, this field is required and you must 
specify something before you can continue. 

Initiating Warehouse Specify the warehouse from which the items on this 
order are shipping. If your system uses multiple 
warehousing, specify the warehouse from which this 
order initiated. Press F2 or choose the Search button 
to see the list of warehouses.  

Invoice Date This is the date on which you are entering the invoice 
into the system. The program defaults to the system 
date. The system uses this date to determine payment 
schedules in Accounts Receivable. 

Turbo Token The token selected for CenPOS processing. This 
token is used in Deposit/Payment Entry (SOC718). 

Using the Direct Invoice Line Detail window 
The Line Detail window provides information about the item selected in the item browser. 

To access the Line Detail window: 
1 Use the mouse or arrow keys to select an item in the browser. Click Line Detail or 

Options>Line Detail from the menu. 

2 The Line Detail window contains all possible fields available for item entry. Item number, 
description, ordered quantities, committed quantities, back-ordered quantities and price 
always appear on the main screen. Other line detail fields can be set to appear in 
secondary windows or on the menu during item entry. Use SO Entry Options F/M to 
determine which fields should appear during line item entry. Access SO Entry Options by 
selecting Sales Orders>File Maintenances>Infrequent File Maintenances>SO Entry 
Options F/M.). 
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Quantities/Shipping tab fields   

Field Entry 

Item  This information is display only in the Line Detail window. 
You can specify or change an item number in the line item 
entry section of the main Direct Invoice screen.  
Note: If an asterisk (*) appears after the item number on the 
main screen, it indicates that the line number is on hold 
because the user does not have authorization to ship items 
from the shipping warehouse. To ship the item, an authorized 
user must approve the line at the line approval dialog box that 
appears during line item entry or that user must approve the 
line in the Item Shipment Approval Program (SOE520). 

From Order # The source document type and number.  

Description Specify a new item description, if necessary.  

Customer Item Specify the customer’s description or reference number for this 
item, if applicable. 

Item notes Choose the link the view any notes entered on this item. 
(Specify notes through the Item Inquiry program, access code 
ii). 

Taxable Indicate whether this item is taxable. The program defaults to 
the Taxable setting in the item’s master file (see Item F/M).  

Print on Forms Indicate whether to print this item on acknowledgments, 
packing lists, and invoice forms. 

Ordered  Shows the quantity of the item ordered.  
Press F2 to change the unit of measure. This can be used if, 
for example, the default UM is each but the customer wants to 
order a box.  
If the quantity entered exceeds the available inventory in the 
shipping warehouse, the program gives you the option to 
accept the quantity anyway or press F2 to search other 
warehouses. 
The Search Warehouses window displays the warehouses that 
have the item, along with the available, on hand, committed, on 
order, back-ordered and surplus quantities for the unit of 
measure selected.  
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Select a warehouse. This creates a planned special order 
warehouse transfer. Make sure you back order the item. 
Press F3 to indicate this item is a direct ship from the 
manufacturer. 

UM The unit of measure field is display only. For a standard part 
number, the system uses the unit of measure (UM) from the 
Standard Part Number record as the default selling UM instead 
of the default selling UM in the Item F/M record. If you select 
not to use the standard part number UM or the standard part 
number UM is blank or not a valid selling UM for the item, then 
the system uses the standard default UM for the item. 

Creating credit memos 
Entering a credit memo is not unlike entering orders or invoices. However, the quantities 
appear and print as negative numbers and you enter returns codes to indicate why items are 
being returned.  

1 Click Sales Orders>Invoices>Credit Memo Entry. 

2 In the Doc/Cust field, specify the customer number.  

3 Specify this information. 

Ship-to-The system displays the default ship-to code for the customer. Edit the ship-to 
code, if necessary.  

(Optional) Invoice-The invoice number against which you are entering the credit memo. 

Memo Date-The date you created the credit memo. 

Invoice Date-The date you invoiced the credit memo. 

4 The Turbo Tokens drop down list is available for faster use of CenPOS tokens 
credit card processing for deposits or payments on sales order documents. It is 
automatically populated with all available tokens for the specified customer and ship-
to combination if the CCToken Usage in Ship-to F/M (ARF920) is set to “S – Ship To” 
or the specified customer if CCToken Usage in Ship-to F/M (ARF920) is set to “C – 
Customer”.  

5 The header is automatically created by the system.  

6 Specify the item and complete this information. 

Exceptional Sales-Check to indicate that this line item should not be included usage for 
replenishment calculations. 

Usage Date-For line items that should have their usage included in replenishment 
calculations, specify the date to use or press F1 to enter the system date. 

Credit Usage Warehouse-Specify the warehouse to use to credit the usage for the item 
on the credit memo. 
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Whse-The system displays the warehouse selected on the sales order. You can modify 
this value as needed. 

Unit Cost-The cost per 'each' of the item. 

Quantity-The quantity of the item the customer is returning. 

RC-The returns code for processing the return. 

Price-The return price.  

Extension-The price extension.  

7 Click Cancel to end line entry.  

8 You have these options. 

To change quantity information by highlight a line item and click Edit. Refer to the Editing 
line items in entry programs topic for details.  
To edit lines on the order highlight a line and click Line Detail to make changes in the 
Line-item Detail Entry window.  
To edit header information on the order, click Header Detail to make changes in the 
Credit Memo header detail window.  
Add or insert line items above the highlighted line in the browser. 
Refer to Adding line items in Credit Memo Entry topic for details. Delete a line item by 
highlighting it and clicking Delete.  
Access Note Entry (SME710) for the credit memo header or line record specified in the 
program or for the item highlighted in line item browser. 

9 Click Done to access the footer screen.  

10 Complete or modify this information. 

(Optional) Memo-a memo for the credit memo. 

Ship-to-The ship-to code from the document header is displayed. You can modify this 
field. 

Freight code-Options are Prepaid, Collect, Bill Later and A Prepay/Add.  

In the Frt Method field, the Document Freight Method (Q/C) for this customer defaults 
from AR Customer Maintenance and is modifiable based on the Allow Method Change 
check box on the Invoicing tab of AR Customer Maintenance and is not a back order. 
Based on the setting, you can select from: Quoted Freight or Calculated Freight.  

Unless the Freight Type is prepaid, specify or update freight and handling charges in the 
Freight $ field.   Refer to the Entering Freight and Handling (Sales Orders) topic for 
details   

Disc %-The discount percent (maximum of 100) or dollar discount (maximum equals 
merchandise total) of the merchandise total.   

Tax code -The tax code assigned to the customer’s ship to file. 

Tax rate-If the Charge Tax flag in the Sales Orders Static Control F/M is not set to O-
Override, you cannot override the tax code and this field is unavailable. Specify H-to use 
the high rate, L-to use the low rate, or X-to change tax status of this document to exempt.  
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Other-Use this field to apply this credit to a customer’s credit card or issue the credit with 
other cash type payment methods. 

Cash Terms-Use this field to issue a cash credit to the customer. Specify the cash 
amount due to the customer. If the amount you enter is not the full amount on the credit 
memo, the remainder credits the customer’s AR account, if they have one. 

A/R Terms-This defaults to the terms code entered in the CM Terms Code setting on the 
Inventory tab of the SO Static Control F/M. In  

11 (Optional) Click Payments if you need to place a deposit on the order or enter a 
payment.  

12 Click OK. 

13 Check Print Credit Memo now to print the credit memo when you complete the footer. If 
you choose to print the now, select a printer in the dialog box.  

14 (Optional) Check the Sort by Shipping Whse check box to print credit memos in groups 
by shipping warehouse. 

15 Click OK. 

16 Click Done. 

Opening an existing credit memo 
You can open an existing document as long as you don’t have another document open in the 
same window. Once you begin specifying header information, the system does not allow to 
you open a document in the same window.  

You can start another session of FACTS if you need to open an existing document while you 
are in the middle of entering one. 

To open an existing invoice: 
Specify the document number in the Customer/document number field. If the document is on 
file, the customer number appears in the customer number field and the document number 
moves to the title bar. 

OR 

1 Click File>Open Existing Document.  

2 Use the Document Search window to find the document you want to edit or review.  

3 Click OK in the search window to select the document and return to the main entry 
window. 
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Before issuing refunds with Credit Memo Entry 
Performing counter sale customer refunds with Credit Memo Entry works best when counter 
sale receipts are set up to print in the same format as invoices and credit memos. This 
eliminates the need to swap out forms in the printer; it cuts down on the number of separate 
pre-printed forms that have to be ordered. 

Check with your System Administrator or local FACTS Affiliate to make sure this printer 
configuration is in place. 

Deleting a credit memo 
Credit memos are not technically deleted from the system until the next Daily Sales Register 
Update. Until then, the header status changes to Deleted and the system removes all line 
items. This procedure enables the system to keep an audit trail of all the credit memo 
numbers used.  

To delete a credit memo before the header is complete: 
Press F4 to back up to the Customer field. 

To delete a credit memo after the header is complete: 
With the document open on screen, click File>Delete Document from the menu. 

From the Delete drop down list, click YES-Delete.  

Printing the Daily Sale Register (DSR) 
1 Click Sales Orders>Invoices>Daily Sales Register. 

2 In the Date field, specify the sales register date. 

3 In the Warehouse field, specify up to 20 two-character warehouse codes side by side to 
indicate the warehouse(s) for which register is to print.   

4 In the Department field, specify as many GL department numbers as will fit in the field 
for which the register is to print. (GL department length is user-defined in the SM 
Company Control F/M. 

5 In the Scope field, specify whether to print S-summary or D-detail information. The 
program defaults to Summary. 

6 When the system displays: Correct?, indicate whether or not this is the correct date and 
GL and SA period for the sales register to post. The Daily Sales Register prints by 
reading through the Ready-For-Register File. Information about each document prints as 
the General Ledger Distribution File is built. 
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7 If you print the GL distribution, the following field displays: Check register. OK to print GL 
distribution? 

8 After printing the Daily Sales Register, verify the printout. If there is a correction to be 
made, exit the program and make the necessary corrections. After the correction is 
made, the register can be rerun. If everything is correct, print the GL distribution. Once 
the GL distribution prints, proceed to: Check GL distribution. OK to update? 

After printing the GL distribution, verify the printout. If everything is correct, click OK to 
continue. The program proceeds with the update. If there is a correction to be made, 
click Cancel to exit the program. After the correction is made, the entire register process 
begins again. 

If you do not print the GL distribution, the following field is displayed: Check register. OK 
to update? 

After printing the Daily Sales Register, verify the printout. If there is a correction to be 
made, exit the program and make the necessary corrections. After the correction is 
made, the register can be rerun. If everything is correct, proceed with the register update. 

Click OK to print the register. The system prints the register for the selected documents.  

9 The system displays the message: Invoice Receipt Register: OK to Update? 

After printing the Daily Sales Register, verify the printout. If you need to correct the 
register data, select Cancel to exit the program. After you make the correction, you can 
rerun the Invoice Daily Sales Register. If everything is correct, click OK to continue. The 
program then prints the GL distribution.  

Counter sales procedures 

Using the Counter Sale system (Overview) 
1 At the beginning of a shift, open Update Shift to open a drawer, assign a tray to it and 

place an opening amount in the tray. 

2 Have your sales clerks sign on to cash drawers in Cash Drawer Sign On.  This program 
shows you which drawers are already in use and tells you which terminals (users) are 
signed on to them. If someone forgets to sign on in this program, the system will prompt 
them to do so when they enter a cash-type payment in Counter Sale Entry or 
Payment/Deposit Entry. 

3 Begin entering sales in the Counter Sale Entry. 

4 At the end of the shift, open Update Shift to remove trays from their respective drawers. 
Trays are actually removed by assigning another balanced tray to the same drawer. 
Once another tray is assigned, the first tray is automatically removed and ready to be 
balanced.  
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5 Open Balance Cash Trays to count out the trays and run Z-out reports, which are 
printouts of the transactions run through those trays. A currency calculator is available to 
help you keep an accurate count of currency, checks, credit card slips, etc.  

6 Once a tray is balanced it can be assigned to another drawer.  

7 At the close of a day, make sure all drawers are signed off by entering Cash Drawer 
Sign On and setting each drawer to NONE.  

Creating counter sales 
1 Click Sales Orders>Counter Sales>Counter Sale Entry. 

2 In the Doc/Cust field, specify the customer.  

3 In the Ship-to field, the system displays the ship-to code entered on the sales order 
along with the full ship-to address. Edit the ship-to code, if necessary. If a customer 
requests to have an order shipped to an address other than its usual shipping address, 
use the Temporary Ship-to feature to facilitate this request. 

4 In the Date field specify the date for the counter sale transaction.  

5 The Turbo Tokens drop down list is available for faster use of CenPOS tokens 
credit card processing for deposits or payments on sales order documents. It is 
automatically populated with all available tokens for the specified customer and ship-
to combination if the CCToken Usage in Ship-to F/M (ARF920) is set to “S – Ship To” 
or the specified customer if CCToken Usage in Ship-to F/M (ARF920) is set to “C – 
Customer”. 

6 (Optional) In the Initiating Warehouse field specify the warehouse from which the items 
on this order are shipping. If your system uses multiple warehousing, specify the 
warehouse from which this order initiated. Press F2 or click Search to see the list of 
warehouses.  

7 (Optional) The program automatically switches to add mode once you complete the 
header. Specify the Item. 

8 Check the Ship Direct check box to indicate that this item is shipped directly to the 
customer ship-to address. Then specify the Vendor and click OK.  

9 In the Wh field, the system displays the default warehouse for the item. You can modify 
this value or search for a different warehouse.   

10 In the Ordered field, specify the customer's requested quantity. You can change the unit 
of measure on the ordered quantity.  

11 In the Committed field, specify a quantity to commit in the warehouse or accept the 
default. This field defaults to the quantity ordered, if that quantity is available in the 
selected warehouse. 

12 In the Backordered field, specify a back ordered quantity if the quantity ordered is 
greater than the available quantity in the selected warehouse. The program skips this 
field if the customer or your company does not allow back orders (Allow back orders flag 
not selected in AR Customer F/M and SO Static Control F/M), the item is a direct ship, or 
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the selected warehouse has enough inventory to fill the order. When you specify a back-
ordered quantity, Sales Order Entry programs base planned special order document 
creation on the Stock, NonStocked, Uninventoried, and Temporary prompts in Sugg 
PO/TR by Type section on the Line Options tab of SO Entry Options F/M (SOF915). Use 
these settings to indicate whether you want to have the system ask to create planned 
special order purchase orders or planned special order transfers by item type during 
Order Entry line processing. Refer to the Creating planned special order 
transfers/purchase orders from Sales Order Entry programs topic for detailed information 
about creating planned special order warehouse transfer or purchase orders for 
backordered quantities. 

13 You can add additional line items or click Cancel to exit out of Add mode. 

14 You have these options. 

Edit - to make changes for the highlighted line item.  
Add a line. 
Delete the highlighted line.  
Insert a line item above the highlighted item in the browser. 
Save your changes 

Header-to access the Header Detail for Documents screen, which is used to view 
(inquiry-mode) and/or modify warehouse, shipping information, request and order dates, 
and salesperson, freight, terms and ship via codes.  

Highlight a line item and click Line Detail to access the Line Detail for Documents 
screen, which is used to view and/or modify item descriptions, quantity and shipping 
information, costing, and PO information 

Access Note Entry (SME710) for the customer, item, header or line record specified in 
the program.  

15 Click Done to display Footer for Document dialog box. 

16 Complete or modify this information. 

(Optional) Memo-a memo for the credit memo. 

Ship-to-The ship-to code from the document header is displayed. You can modify this 
field. 

Freight code-Options are Prepaid, Collect, Bill Later  and A Prepay/Add.  

In the Frt Method field, the Document Freight Method (Q/C) for this customer defaults 
from AR Customer Maintenance and is modifiable based on the Allow Method Change 
check box on the Invoicing tab of AR Customer Maintenance and is not a back order. 
Based on the setting, you can select from: Quoted Freight or Calculated Freight.  

Unless the Freight Type is prepaid, specify or update freight and handling charges in the 
Freight $ field.   Refer to the Entering Freight and Handling (Sales Orders) topic for 
details   

Disc %-The discount percent (maximum of 100) or dollar discount (maximum equals 
merchandise total) of the merchandise total.   

Tax code -The tax code assigned to the customer’s ship to file. 
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Tax rate-If the Charge Tax flag in the Sales Orders Static Control F/M is not set to O-
Override, you cannot override the tax code and this field is unavailable. Specify H-to use 
the high rate, L-to use the low rate, or X-to change tax status of this document to exempt.  

Check, ATM, Debit Card, V,M/C, A, D, Coupon-Use this field to specify payments to 
this order. 

Other-Use this field to apply this pay the order with other cash type payment methods. 

Cash Terms-Use this field to specify a cash terms code. Specify the cash amount.  

A/R Terms-This defaults to the terms code entered in the Terms Code setting for the 
customer.   

17 (Optional) Click Payments-to access to the Deposit/Payment Entry window. 

18 Click OK. 

19 Check Print Direct Invoice now to print the direct invoice when you complete the footer. 
If you choose to print the now, select a printer in the dialog box.  

20 (Optional) Check the Sort by Shipping Whse check box to print direct invoices in 
groups by shipping warehouse. 

21 (Optional) Check the Update Now check box to create/update any purchase orders 
generated by the direct invoice. 

22 Click OK. 

23 Click Done. 

Importing quote lines to sales order or counter sale orders 
1 Access Order Entry or Counter Sale Entry.  

2 Complete the header information. 

3 Add an item to the order or counter sale. 

4 If there are quote lines for the same customer/ship-to/item you are entering on a sales 
order or counter sale order, the Import Quote window displays the quote lines. 

5 Select the quote line you want to import and click Import. 

6 When you import a quote line, the required line fields are displayed with default 
information from the quote. 

7 You can modify information as needed. 

8 Click OK. 

 The import of the quote line is completed and you are returned to Order Entry or Counter 
Sale Entry. 
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Refunding Counter Sales (process overview) 
Before issuing refunds with Credit Memo Entry  

Use Credit Memo Entry to perform refunds on counter sales receipts.  

Performing a refund: 
1 If you are already in Counter Sale Entry, click Go To>Credit Memo Entry from the 

menu. Otherwise type the access code CM at a FACTS menu screen. 

2 In Credit Memo Entry, specify the document header. Use the Invoice field in the header 
to apply the credit memo to an existing invoice.  

3 When you complete the header, press Enter to add the returned item information on the 
document.  

4 Specify the item number.  

5 Specify the quantity being returned. You do not need to enter a minus; the program 
automatically inserts one. 

6 Specify a two-character reason code.  

7 Specify the price of the item being returned. Press F2 to change the pricing UM. Press 
F3 to use the Price Search feature. 

8 Add additional items if necessary. 

9 Click Done when you are finished entering items to access the credit memo footer. 

10 Select a Refund Type in the footer. 

11 To apply the refund to a customer’s account, use the A/R Terms field.  

12 Press F2 and select the CM A/R terms code in the search window. The CM, or credit 
memo, terms code uses no discounts or payment schedules. It simply tells FACTS to 
post the document to the Accounts Receivable module.  

13 You can set CM as the default A/R terms code for all Credit Memo documents on the 
Inventory tab of the SO Static Control F/M. 

14 To give the customer a cash refund, use the Cash Terms field.  

15 Press F2 and select a Type C Cash Terms code from the search window. Specify the 
amount of the refund. Make sure you enter the amount as a negative number. For 
example, enter -50.50 if you want to give the customer $50.50 back in cash.  

16 To apply the refund to the customer’s credit card, click Payments to access the 
Deposit/Payment Entry window.  

17 Press Enter in the Deposit/Payment Entry window or click Add. 

18 Specify a credit card terms code or press F2 to search for the appropriate credit card 
terms code.  

19 Specify the amount of the refund as a negative number, for instance -50.50, and press 
Enter. 
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20 Specify the credit card number and the expiration date, or swipe the card. 

21 Specify notes (optional). 

22 Click Save. 

23 If you are not already signed onto a cash drawer, press F2 and select a cash drawer with 
a tray assigned to it from the search window.  

24 Click Done to return to the Credit Memo Footer. 

25 Make sure the document is zeroed out. Click OK to print the credit memo. 

Deleting a counter sale receipt 
A counter sale receipt is not technically deleted from the system until the next Daily Sales 
Register Update. Until then, the header status changes to Deleted and the system removes 
all line items. This procedure enables the system to keep an audit trail of all the counter sale 
numbers used.  

To delete a counter sale receipt before the header is complete: 
Press F4 to back up to the Customer field. 

To delete a counter sale receipt after the header is complete: 
With the document open on screen, 

1 Click File>Delete Document from the menu. Click Yes-Delete.  

2 If the Lost Sales is selected on the Use Features tab of SO Static Control F/M (SOF980), 
you have the opportunity to post to lost sales if the item is inactive and the quantity is 
greater than the available amount. 

3 Select from the following options to indicate how to record and process the lost sale: 
N-No to indicate that you do not want to record the lost sale, R-Review to display the 
Lost Sales Entry (SOC420) screen and modify the lost date, update usage, quantity, 
price, cost, reason, and/or notes, Y-Yes to record the lost sale using the default lost sale 
reason code entered SO static Control F/M, the quote date as the lost sale date and 
usage defaulting to “no update”. 

4 Click OK. 
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Recurring invoices procedures 

Creating recurring document headers 
1 Click Sales Orders > Recurring Invoices>Recurring Document Entry.  

2 Enter the customer number for the customer receiving the invoice. Press F2 to perform 
a customer search or F3 to perform a document search for recurring documents already 
on file. The system performs a credit check on this customer once you enter the number.  

3 Enter the sequence number (0-99) for the document to be created. The sequence 
number is a counter that allows a given customer to have multiple recurring documents. 
Sequence 01 for example, can be considered the first recurring document for the 
customer. Press Enter to initially default to 01.  

4 The system populates the remaining recurring document header fields with default 
information. At any point during the header fields through Reference Number, you can 
press F3-header defaults. Pressing F3 causes the program to display the defaults on file 
from that field forward and skip to Reference Number. Refer to the Recurring Document 
Header topic for field definitions.  

NOTE: If the program does not skip to Reference Number and instead stops at an earlier 
field, the system could not find a valid default value for that field, and the user must enter 
a valid value before continuing.  

5 When you complete the recurring document invoice header information, the system 
displays the system displays the line-item detail screen. Refer to the Adding items to 
recurring document invoices for step-by-step instructions. 

Adding line items to recurring document invoices 
1 Complete the header information; refer to Creating recurring document headers for 

details. The system displays the command prompt at the bottom of the screen, you have 
these options. 

Line # Enter the line number to change.- Specify the line number to select. Specifying a 
line number sets the quantity default to the same amount sold the last time (displayed in 
the units column). Price is not affected. Press Enter displays more sales, if any. 

2 You have these options. 

L List 

A Add a line 

D Delete the highlighted line. 

F2 Change header information. 

F3  End line-item entry. 

2. Specify the Item. You also have these options. 
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I  -  To display items and their corresponding interchange. 

A  -  Search catalog items  

L  -  Allow a lost sales entry  

P  -  Display past sales of all items in the selected warehouse. Item number, date sold, 
invoice number, quantity sold, price, and unit of measure.  

C  -  Search customer/item numbers  

#  -  Specify an item number or an interchange number  

M  -  Specify a memo  

F1  -  Enables the Quick Item Add (ICF020) program.  

F2  -  Allows an item search  

F3  -  Ends line-item entries  

4 For a valid item, the item description 1 and 2, the item class, package size, item weight 
and its unit of measure, available quantity, on hand quantity, on order quantity and bin 
location are displayed. The Temporary, Vendor, Item Class, U of M, Weight, and 
Commission Percent fields are only displayed if the item is a temporary item.  

5 Specify the quantity of the item to be sold per displayed unit of measure or select a 
display code. If this is a BOM finished item that can be assembled in SO, you may be 
able to enter component items. If this item has multiple selling units of measure, press F2 
to change the unit of measure.  

6 Specify the cost per displayed costing unit of measure. The Cost field is available if the 
Change by Ln Cost flag in the SO Static Control Record is set to Y or B. If the Change by 
Ln Cost flag is set to B, press F4 to back up to this field. This field is also available if the 
item is temporary.  

7 Specify the price per displayed pricing unit of measure. Press Enter to default to the 
default price per the pricing hierarchy. Select the following (if available): S-Standard 
Price, C-Contract, T-List, L-Last, or enter L and a level number for a price level or enter 
Q and a quantity break level for a quantity break price.  

8 (Optional) The system displays the Change Selling UM To Match Pricing UM prompt only 
displays if the pricing unit of measure entered in the previous field does not match the 
selling unit of measure. Specify Y or N to change the selling UM to match the pricing UM. 
Press Enter to default to Y. If Y is entered, the value in the Quantity field may change.  

9 Headings for the line-item fields used are displayed, and if the Display g.M.% flag in the 
sales orders static control is set to A, the gross margin percentage is also displayed. The 
line-item extension is calculated (price less any discounts multiplied by the quantity 
ordered multiplied by the conversion factor) and displayed.  

10 (Optional) Specify the discount amount or percent for this line. This field is only 
available if the Use Line Discount flag in the SO Static Control Record is set to % or $.  

11 (Optional) Specify the percent of commission. Press Enter to default to 0. This field is 
only available if the Change by Ln Comm% flag in the SO Static Control Record is set to 
Y or B. Press F1 to set this field to Use Default when the user override flag is set.  
Calculating Commissions: There are five commission percent sources: customer, 
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salesperson, item, price and current line commission. The system contains a user 
override flag and a price type to designate if the user overrode the line’s commission 
during order entry. Refer to the Calculating Commissions topic for processing details. 

12 For the Taxable field, enter Y or N to indicate whether to charge tax for this line item. 
Press Enter to default to Y.  

13 Specify the general ledger posting table to use in the Daily Sales Register to post this 
line to general ledger. Press F2 to perform a search. This field is only available if the 
Change by Ln GL Table flag in the SO Static Control Record is set to Y or B. If B is 
entered at Change by Ln GL Table , press F4 to backup to this field.  

14 Specify the default ship complete status, or press F4-Backup to return to the 
preceding field. 
Note: The Ship Complete field is a warehouse- and line-level designation. Refer to the 
Ship Complete Feature Overview topic for details. You can select from the following 
options:  
N Allow Partial--Indicates you want to allow the shipped quantity to be less than the 
ordered quantity for order the order line.  
Y Ship Complete--Indicates you want to allow the quantity ordered must be the same as 
the quantity shipped on the order line item.  
B Balance Complete—Indicates you want to allow the quantity shipped to be less than 
the quantity ordered on the first shipment, but the back-ordered quantities must be 
shipped complete for the order line. Once an order line is processed through the DSR, 
the line is changed to ship complete. 

15 If the line is correct, press End to continue. If the line is not correct, select F4 to back up 
to change the field that is not correct.  

16  Repeat this process for each line item you want to add to the recurring document 
invoice, then click End Entries to end line-item entry. Refer to the procedure, 
Completing recurring document invoice footers for step-by-step instructions. 

Completing recurring document invoice footers 
1 Once the recurring document invoice line item information is complete and you press F3-

End, the system displays the footer fields. 

2 (Optional) Specify the memo to print on the recurring invoice.  

3 (Optional) Specify the discount percent (maximum of 100) or dollar discount (maximum 
equals merchandise total) of the merchandise total. This field only appears if % or $ was 
entered at the Use Invoice Discounts flag in the SO Static Control Record and is initially 
skipped if the total for the recurring invoice is zero.  

4 (Optional) If UPS was entered in the ship via field, specify the UPS zone here; otherwise, 
this field is skipped. The entry must be a valid zone as set up in the UPS Zone F/M. The 
COM/RES field is skipped if the UPS zone is greater than 8. Specify whether this 
delivery is a C-commercial or R-residential UPS ground delivery. UPS charges different 
rates for commercial and residential deliveries. 

5 Specify the weight of this package.  
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6 Specify the freight amount (+/-9999.99). 

7 Specify the tax code for this ship-to customer. This field is not available if the Charge 
Tax flag in the SO Static Control F/M is set to N. This field is initially skipped if the 
recurring invoice total is zero.  

NOTE: If you back up to this prompt after changing the tax rate or the tax amount and do 
not select F1 - skip, the system recalculates the charges to reflect the tax code and the 
changes to the Tax Rate and Amount fields are lost.  

8 (Optional) For the RT (Tax Rate) field, specify H-to use the high rate, L-to use the low 
rate, or X -to change tax status of this document to exempt. The rates are set up in the 
Accounts Receivable Tax Table F/M. Press Enter to default to the displayed value. This 
field is initially skipped. If the Charge Tax flag in the Sales Orders Static Control Record 
is not set to O, you are not able to override the tax code and this field is unavailable.  

9 (Optional) For the Taxable (Amount) field, specify the amount of sales tax to charge for 
this invoice (+/-99999.99). Press Enter to default to the displayed value. This field is 
initially skipped. If the Charge Tax flag in the Sales Orders Static Control Record is not 
set to O, you are not able to override the tax amount and this field is unavailable.  

10 Click OK. 

11 This concludes the ending routine of the Recurring Invoice Entry Program. Upon 
completion of the update, the screen is cleared of all field information and the program 
returns to the Customer Number field so you can specify more recurring documents or 
click End to exit the program.  

Posting recurring documents  
Start by selecting the day through which recurring documents are to post. 

This program must be run in order to bill customers. 

1 To post recurring documents, specify the Post Through date (date through which 
recurring documents are to be posted). The day entered must be greater than the day 
the recurring documents have already posted through; e.g., if recurring documents have 
already posted through the 10th of the month, and the 15th is entered, all recurring 
documents with post dates between the 10th and the 15th are to post. The program 
defaults to the system date.  

2 Use the Listing Run check box to indicate whether or not a recurring document list has 
been run and checked.  

3 Click OK.  
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Shipping procedures 

Adding orders into the freight manifest system 
1 Click Sales Orders>Shipping>Freight Entry. 

2 Specify the order number for this shipment.  
Tip: You can specify 3 types of documents on this screen: a valid sales order, freight 
order or new freight document that is not a sales order. Create a new order number that 
is not on file when shipping packages that do not appear on sales orders.  

3 (Optional) If this order is a multi-warehouse order, the Freight Totals Display window will 
display. This displays each warehouse that is on this order with the warehouse code, 
description, ship via and freight amount, as well as the total amount of freight for all 
warehouses on this order. Press Enter.  

4 (Optional) If you specify an existing sales order or freight document, the system displays 
the document header information, such as the customer, ship via, zone, package total, 
charge information and freight line items for each package. For new freight documents 
complete steps 5-10. For existing freight or sales order documents, go to step 11.  

5 (Optional) For new freight documents, specify the customer code. The system displays 
the customer's assigned ship-to number, the ship via in the Ship-To Record, the default 
zone from the Ship-To Record; you can modify these values.  

6 (Optional--For new freight documents) In the Com/Res field indicate whether this 
delivery is a C-commercial or R-residential UPS ground delivery. The system displays 
the default value for the ship-to address.  

7 (Optional--For new freight documents) In the Dept specify the valid general ledger 
department number that is approving this shipment as necessary. This field is initially 
skipped. Press Enter initially default to the general ledger department number assigned 
to the terminal. Press F2 to perform a search.  

8 (Optional--For new freight documents) In the line-item portion of the screen: 
 
In the WGT field, specify the weight of the package to be shipped (1-70). You can also 
specify L for letter service if the ship via is UPS RED, UPS 1ST, UPS BLU, or UPS 2ND 
or if the zone contains a Canadian air zone (87-89) or international zone (900-912, 921-
932). Press Enter to initially default to the weight set up as the Default Weight in the 
Shipping Control Record.  
 
In the Tracking/ID# field, specify the tracking/id number. Press Enter to default to 
blanks.  
 
In the DCLRD VALUE field, specify the amount (0-99999.99) the user wants to declare 
as the value for the package. This amount is used to calculate insurance charges. If the 
carrier is UPS, there is no insurance charge for any value less than $100.00.  

9 (Optional--For new freight documents) Press Enter to accept the new line on the freight 
manifest. 
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The system displays the messages: Print Shipping Label for This Line? or Print UPS 
C.O.D. label for this line? only if the Label at Each Line Item flag of the Shipping Control 
F/M is set to M (maybe). Specify Y or N to indicate whether a shipping label is to be 
immediately printed for this line-item. If you specify Y, the program prints a shipping 
label, UPS shipping label, or a UPS C.O.D. label, depending on the ship via. The printer 
is defined in the SM Program F/M for the Shipping Label Print Program (SOP410), UPS 
Shipping Label Print Program (SOP450), or UPS C.O.D. Label Print Program (SOP420).  
 
Press Enter to default to Y.  

10 (Optional--For new freight documents) You can add more lines on the freight manifest 
then press F3 to end line-item entry. 

11 You have these options. 

# - Changes a line-item  

L - Lists line-items  

A - Adds a line-item  

D - Deletes the order (if created from a sales order, the sales order is not affected)  

F2 - Changes the header  

F3 - Ends entries and proceeds to the ending routine  

12 The system displays the message: Update freight on order? if the freight entry order 
number is a current sales order. The total freight charge for the order is displayed in the 
bottom right of the header. The current freight charge for the sales order is displayed. 
Specify whether this amount should be up dated to the freight field on the actual order. 
You can specify N-no, do not update the sales order, A-add the total freight charge to the 
existing amount on the sales order, or R -replace the current freight amount on the sales 
order with the total freight charge. Press Enter to default to N.  

13 The system displays the message: Print Shipping Labels Now? Specify N or Y to indicate 
whether to print the shipping labels for this order now. If you specify a Y, the program 
prints one label for each package. If the ship via is UPS the label printed is a UPS 
shipping label otherwise it is a general mail-shipping label. Press Enter to default to N.  

14 The system returns you to the Order field so you can specify freight or press F4 to exit 
the program. 

Printing a freight manifest 
1 Click Sales Order>Shipping>Freight Manifest Print (SOP430). 

2 Specify the date of the shipment that is to print on the manifest. This is the date the 
manifest was picked up by UPS.  

3 Specify the ship via code for which the manifest is supposed to print. Ship Via codes are 
set up and maintained in the Ship Via F/M (Sales Orders>File Maintenances>Ship Via 
F/M). NOTE: The program reads through the Freight Orders File and gets the ship via 
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from the document. If any of the letters in the document ship via are in the same order as 
all the letters in the entered ship via, the manifest prints. For example, if you specify 
UPS1ST, the system prints all freight orders with UPS1ST or UPSRED in the ship via. 
Also, if you specify UPS, the system prints all freight orders with UPS in the ship via. 
Press F2 to perform a search. 

4 Specify the warehouse that shipped the freight orders. Entering a valid warehouse code 
displays the warehouse description and the UPS shipper number that prints on the 
manifest. Press Enter to default to the warehouse assigned to the terminal.   

5 Specify the Pickup Record Number (UPS-generated number that verifies that the 
carrier picked up the shipment). This can be helpful when tracking packages in the 
shipment. 

6 Click OK. 

7 (Optional) Removing the manifest from the system: 

After the freight manifest prints, the program asks whether the manifest and its packages 
should be removed from SO Freight Orders system and transferred to a history file. 
Indicate whether to remove the manifest. 
Tip: Remove the manifest after packages on that shipment have been entered. 
Otherwise, the system will continue to add freight orders to this document.  

Displaying freight document information 
1 Click Sales Orders>Shipping>Freight Inquiry (SOI410). 

2 Specify the Document Type: O-open freight orders or P-past freight orders. After you 
select a document type the appropriate display (OPEN or PAST) appears in the top 
center of the screen. Open documents are freight orders that have not been updated in 
the Manifest Print Program; past documents have been updated. Press Enter to default 
to O. 

3 For past freight orders, specify the date of shipment for the display. For example, if June 
1, 1989 were entered, only documents that were shipped on or after June 1, 1989 are 
listed for display. Press Enter to skip to field #5 (customer), and view documents for a 
selected customer. Press F1 to default to the first date on file for the company and 
warehouse and displays the warehouse, date shipped, customer number, order number, 
ship-to number, ship via and address 1. Press F3 to select another warehouse. If you 
enter O for the document type in field #1, the system skips this field.  

4 Specify the freight order number to display. Entering a valid freight order number 
displays the document. Press F2 to perform a search. Press F3 to select another 
warehouse. If you enter P for the document type in field #1, the system skips this field.  

If you press F2, the program prompts you for the beginning document number to 
search from. The system displays the warehouse, the order number, the customer 
number, the ship-to number, the ship via, address 1, and the number of packages on the 
order. Enter a freight order number that serves as a beginning point to list from, or enter 
the line number that contains the desired document to be displayed. Press Enter to 
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default to the next screen of documents. If you are at the end of the file or at the 
beginning of the file, pressing Enter lists from the first on file. 

5 The program displays the current warehouse code and its description. The current 
warehouse is the warehouse that determines which documents are displayed. If a 
document was not shipped from the current warehouse, you are only able to view the 
document after changing the current warehouse to match that of the document. Enter a 
valid warehouse code. Press F2 to perform a search. Press F3 to select ALL 
warehouses, and the system displays all documents. This field is skipped unless you 
press F3 at field #2 (Date ) or #3 (Order).  

6 Specify the customer number of the customer for which documents are to be displayed. 
Any document that was not shipped to the selected customer is not displayed. Entering a 
valid customer number displays the customer name, and prompts the user for a 
beginning document number to search from. The system displays the warehouse, the 
order number, the ship-to number, the ship via, address information, and the number of 
packages on the order. Enter a freight order number that serves as a beginning point to 
list from, or enter the line number that contains the desired document to be displayed. 
Press Enter to default to the next screen of documents. If you are at the end of the file or 
at the beginning of the file, pressing Enter lists from the first on file. 

7 After selecting a document to display, you can enter another document number to 
display or press Enter to display the next document on file meeting the selected criteria 
(open/past, warehouse, and/or customer), or enter the beginning date from which to list. 

Printing a Freight History Report 
1 Click Sales Orders>Shipping>Freight History Report (SOR410). 

2 Specify the earliest date of shipment on a manifest to be included on the report. 
Manifests that were shipped before this date do not print.   

3 Specify the last date of shipment on a manifest to be included. Manifests shipped after 
this date do not print.   

4 Specify the ship via that manifest used. Ship Via codes are set up and maintained in the 
Ship Via F/M. NOTE:  The program reads through the Freight Orders File and gets the 
ship via from the document. If any of the letters in the document ship via are in the same 
order as all the letters in the entered ship via, the manifest prints. For example, if you 
enter UPS1ST, the system prints all manifest packages with UPS1ST or UPSRED in the 
ship via. Also, if you enter UPS, the system prints all manifest packages with UPS in the 
ship via.   

5 Specify the valid warehouse code that shipped the manifests. Entering a valid 
warehouse code displays the warehouse description. The program defaults to the 
warehouse assigned to the terminal.  

6 Specify the GL department for which to print. Only manifests assigned to the GL 
department entered will print on the report. The entry must be a valid GL department.  

7 Click OK. 
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8 When the report is complete, the message, Remove documents just printed?, is 
displayed. Indicate whether to remove the documents from the sales orders freight 
history.  

NOTE: UPS requires that these records be kept on file for one year. 

Printing shipping labels 
1 Click Sales Orders>Shipping>Shipping Label Print (SOP410).  

2 Indicate whether you want to print an alignment (test print). 

3 Specify the valid warehouse code that shipped the freight orders or sold the sales orders. 

4 Specify the document number(s) for which to print labels. The entry must be a valid 
document number. If the document entered is deleted or voided, a message to this effect 
is displayed and the entry is not accepted. Press Enter to default to ALL, and prints one 
label for each package on every freight order for the selected warehouse.  

5 Specify the number of labels to print for the order number entered in document number 
field. If the order number is a valid freight order number, the program defaults to the 
number of packages entered for the order in the Freight Entry Program. If ALL is entered 
in the document number field, this field is skipped. 

6 Click OK. 

Printing C.O.D. labels 
1 Click Sales Orders>Shipping>UPS C.O.D. Label Print (SOP420). 

2 Indicate whether you want to print an alignment (test print). 

3 Specify the date of shipment that is to print on the C.O.D. label. If using the manifest 
system, this date must match the manifest date.  

4 Specify the document number(s) for which you need to print labels If the document 
entered is deleted or voided, a message appears to this effect and the entry is rejected. 
Press Enter to default to ALL, and prints one label for each package on every freight 
order for the selected warehouse. 

5 Specify the valid warehouse code that shipped the freight orders or sold the sales 
orders.  

6 If a valid freight order number is entered at field #4 this field is skipped and MANIFEST 
appears on the screen, which indicates that the amount comes from the line items on the 
order. Specify the C.O.D. dollar amount that should appear on the label; this is the 
amount the UPS delivery person needs to collect upon delivery. If the document is an 
invoice, press F1 to default to the document total. 

7 Click OK. 
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Printing a UPS chart 
1 Click Sales Orders>Freight>UPS Chart Print (SOP440). 

2 In the Chart field, specify whether to print Z -a zip to zone conversion or W-a rate chart 
for each weight in a selected zone. The program defaults to Zip to Zone. 

3 If you enter Z in the Chart field (#1), specify a valid Warehouse and Country code for 
which to print. Entering a valid warehouse code displays its description. The zones for 
different zip codes differ depending on the location of the shipping warehouse. In this 
way, UPS can publish a rate chart for each zone that is good throughout the continental 
United States.  
-OR- 
If you enter W in the Chart field (#1), specify the Beginning and Ending Zones and the 
Ground Delivery Type:  C-Commerial, R-Residential, B-Both 

4 Click OK. 

Contract pricing procedures 

Creating contract headers (customer scope, item scope, 
shipment scope, pricing UM, effective date and expiration 
date) 
1 Click Sales Orders>Contract Pricing> Contract Entry.  

2 In the Contract # field, enter the contract number to assign to this document.  
Tip: You can use the next contract number on file, search or copy a contract: The system 
displays a copy dialogue box where you can select the contract to copy, and enter a new 
description. The system loads the new contract for the user to edit. When you create a 
contract by copying it will force the Awaiting Review flag to default to Yes.  

3 In the Description field, enter the contract description. 

4 Specify the effective date of this contract price record.   

5 Specify the expiration date of this contract price. When running this Remove Contracts 
program, a cutoff date is entered and expiration dates up to that cutoff are removed. On 
any date after the expiration date, the contract price is not eligible for the price search 
program in the sales order entry programs. 

6 In the Type field, select a contract price type--Levels or Quantity Breaks. Refer to the 
Contract Pricing topic for details about contract price types. 

7 The Convert Fixed Prices and Qty Breaks field is only available if the contract is for a 
specific item and a specific UM. For all other quantity break contract types (non-specific) 
the flag is automatically set to Y and this field is skipped. Specify N or Y to indicate 
whether the quantity break prices for this item and UM should be used as the default to 
calculate prices for other quantity break UMs that do not have contract prices set up. For 
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example, a quantity break price is set up for $5.00 EA for a minimum of 10 (10 EA /BX). 
If on the sales order 1 BX is sold the system would calculate a price of $50.00 BX. Or, a 
fixed price is set for $1.00 EA , if there are 10 each per box, and a line is entered on a 
sales order with a UM of ‘boxes’ the system would calculate a price of $10.00 BX. 

8 Indicate whether this contract is for all customers by clicking All Customers. 
 
OR 
Click Customer to access Customer Scope Entry (SOE561) to define the customers for 
the contract. 
 
If the contract is marked as valid for all customers, the Customers button is disabled. If 
you enter any information on the Customer Scope screen, then the system changes the 
All Customers prompt to selected (flag to "Yes)", and the system displays a message 
prompting for whether to remove all entries from the Customer Scope screen. If you 
select to not remove the Customer Scope information, the All Customers prompt will 
remain selected.  
 
If you don’t select the All Customers prompt and do not enter any information on the 
Customer Scope screen, the system will not allow you to exit.  

9 Indicate whether this contract is for all items by clicking All Items. 
 
OR 
Click Item to access Item Scope Entry (SOE563) to define the customers for the 
contract. 
 
If the contract is marked as valid for all items, the Items button is disabled. If you enter 
any information on the Item Scope screen, then the system changes the All Items prompt 
to selected (flag to "Yes)", and the system displays a message prompting for whether to 
remove all entries from the Item Scope screen. If you select not to remove the Item 
Scope information, the All Items prompt will remain selected.  
 
If you don’t select the All Items prompt and do not enter any information on the Item 
Scope screen, the system will not allow you to exit.  

10 Indicate if the contract is valid for warehouse ships: If the Whse Ships prompt is set to 
Yes, you must enter the shipping warehouses that the contract applies to on the 
Shipment Scope screen. If it is set to No or All, individual warehouses cannot be entered 
on the Shipment Scope screen.  
 
To access the Shipment Scope Entry (SOE565) screen, click Shipment. 
 
If you enter any warehouse information on the Shipment Scope screen, then the system 
changes the Whse Ships prompt to Yes, and the system displays a message prompting 
for whether to remove all warehouses from the Shipment Scope screen. If you select not 
to remove the Shipment Scope information, the Whse Ships prompt will remain selected. 

11 Indicate if the contract is valid for direct shipments from vendors. If the Direct Ships 
prompt is set to Yes, you must enter the direct ship vendors that the contract applies to 
on the Shipment Scope screen. If it is set to No or All, individual vendors cannot be 
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entered on the Shipment Scope screen.  
 
To access the Shipment Scope Entry (SOE565) screen, click Shipment. 
 
If you enter any vendor information on the Shipment Scope screen, then the system 
changes the Direct Ships prompt to Yes, and the system displays a message prompting 
for whether to remove all vendors from the Shipment Scope screen. If you select not to 
remove the Shipment Scope information, the Direct Ships prompt will remain selected. 

12 (Optional) Specify the rounding code to establish rounding rules for contract prices.  

13 In the Excluded Items section of the screen you can select to exclude the following item 
types from the contract scope: Stocked, NonStocked, Uninventoried, and Catalog. 

14 You have these options.  

Add Choose this option to add contract pricing information for the first time to contracts. 
You must complete the contract header information before you can add pricing 
information to a contract. This option is available only if no contract pricing information is 
on file. Refer to the Adding pricing information to contracts or Adding quantity break price 
information to contracts procedure for step-by-step instructions.  

Delete Choose this option to delete the highlighted contract price line.  

Review Accesses the Price Contract Review screen where you can mark/unmark a 
contract as awaiting review. Contract awaiting review are not active. 

Customers Accesses Customer Scope Entry (SOE561) to enter any number of 
individual customers (with or without ship-to’s) and any number of customer classes.  

Items Accesses Item Scope Entry (SOE563) to enter any number of specific items (with 
or without UM specifications), any number of item classes, and any number of primary 
vendors for a contract. 

Shipping  Accesses Shipment Scope Entry (SOE565) to specify whether the contract is 
valid for drop ship lines.  

Header Accesses Price Contract Header Detail to allow you to modify contract 
information such as description, effective dates or contract scope details.  

Done Completes the contract and returns you to the Contract # field so you can enter or 
modify additional contracts. 

Editing existing contracts 
1 Click Sales Orders > Contract Pricing> Contract Entry.  

2 For existing contracts, specify the contract number in the Contract # field.   

3 When you specify the contract number, the system makes available the editable fields on 
the screen. 

4 To edit existing contract prices for this contract, select one of the options across the 
bottom of the screen. Highlight a contract price (for Q-quantity break contract types or 
L-price level contract types) in the browser in the lower portion of the screen and add 
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pricing information. For Q-quantity breaks contract types you can specify a quantity 
break price and breaks 1-6. For L-price level contract types you can specify a standard 
price and price levels 1-6.  

5 The following options are available, when a contract price record exists for the entered 
customer, item, shipping and UM scopes: 

Review Accesses the Price Contract Review screen where you can mark/unmark a 
contract as awaiting review. Contracts awaiting review are not active. 

Customers Accesses Customer Scope Entry (SOE561)  to specify any number of 
individual customers (with or without ship-to’s) and any number of customer classes.  

Items Accesses Item Scope Entry (SOE563) to specify any number of specific items 
(with or without UM specifications), any number of item classes, and any number of 
primary vendors for a contract. 

Shipping  Accesses Shipment Scope Entry (SOE565) to specify whether the contract is 
valid for drop ship lines.  

Header Accesses Price Contract Header Detail to allow you to modify contract 
information such as description, effective dates or contract scope details.  

Done Completes the contract and returns you to the Contract # field so you can create 
or modify additional contracts. 

Adding quantity break price information to contracts 
1 Click Sales Orders>Contract Pricing>Contract Entry.  

2 For new contracts, refer to the How to enter contract header information procedure for 
details. For existing contracts, specify the contract number in the Contract # field.   

3 In the browser in the lower portion of the screen, highlight a contract price (for Q-
quantity break contract types) and add pricing information. For Q-quantity breaks 
contract types you can specify a quantity break price and breaks 1-6.  

4 (Optional) To specify a quantity break price, select the Type, Break 1-6 in the line 
browser.  

5 Specify the minimum quantity that must be sold on a sales order document in order to 
utilize the price from the level. Quantity break is always defined in the selling unit of 
measure. 
 
For example, the standard price of I100 is $10.00 ea., the break 1 price is $9.75 and the 
break 2 price is $9.50. In order to receive a price of $9.75 the customer must purchase a 
minimum of 50. In order to receive a price of $9.50 the customer must purchase a 
minimum of 100. Therefore break 1’s quantity is 50 and break 2’s quantity is 100. 
 
If the contract is for a non-specific item, i.e., item price class, vendor or all items, the 
quantity break will apply to any item in that group of items regardless of UM. For 
example, if 10 is set as the quantity for quantity break 1, it would apply to 10 boxes of 
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widgets as well as 10 cases of wickets (as long as widgets and wickets were within the 
same item scope defined on the contract). 

6 If the contract is for a specific item, the quantity break price may be entered as a basis 
and multiplier, a set price or a change %. If the contract is for a non-specific item (i.e., 
item price class, vendor or all items), the quantity break price may be entered as a basis 
and multiplier. The valid options for basis for quantity break prices are as follows: list 
price, manual cost, sales order entry cost, standard price, quantity break price (up to the 
level being entered, e.g., if quantity break 3 is being entered, you may specify 1 - 3 as 
the basis for quantity break 3). 
Basis: The valid options for basis for quantity break price are list price, manual cost, 
sales order entry cost, standard price, any quantity break price or level price(up to the 
level being entered, e.g., if quantity break 3 is being entered, you may specify 1 - 3 as 
the basis for quantity break 3), entered in Costing and Pricing programs located in the 
Inventory Control module. 
 
Mult:  The multiplier for the quantity break price. 
 
-OR-  
Price: The set price for the contract quantity break price line. (If you select N/A as the 
basis you can specify a set price in this field.) 
Commission %: In addition to the three set up options for the quantity break prices, you 
can also specify a commission %. An Inventory Control static record flag determines 
whether this commission flag is used throughout the costing/pricing subsystem. If the flag 
is turned off, the option to specify the commission % is never available. If the flag is 
turned on, each contract price that is set up will require the field of a commission %. 
When entering the commission %, you can set the commission % to "no priority" (blank) 
indicating that commission is not generated based on the price being set up. (If the item 
is set to "no priority", any commission % entered in the contract pricing system will be 
ignored). (For more information on commissions, refer to the commission basis flag set in 
the Company Control F/M program in the System Management module.) 

7 Save your contract pricing line.  

8 You can highlight a pricing line and select: 

Delete. Deletes a highlighted pricing contact line 

F3 or  Stop Stops adding contract pricing lines. 

9 The following options are available; when a contract price record exists for the entered 
customer, item, shipping and UM scopes: 

Review Accesses the Price Contract Review screen where you can mark/unmark a 
contract as awaiting review. Contracts awaiting review are not active. 

Customers Accesses Customer Scope Entry (SOE561)  to specify any number of 
individual customers (with or without ship-to’s) and any number of customer classes.  

Items Accesses Item Scope Entry (SOE563) to specify any number of specific items 
(with or without UM specifications), any number of item classes, and any number of 
primary vendors for a contract. 
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Shipping Accesses Shipment Scope Entry (SOE565) to specify whether the contract is 
valid for drop ship lines.  

Header Accesses Price Contract Header Detail to allow you to modify contract 
information such as description, effective dates or contract scope details.  

Done Completes the contract and returns you to the Contract # field so you can create 
or modify additional contracts. 

Adding level pricing information to contracts 
1 Click Sales Orders>Contract Pricing>Contract Entry.  

2 For new contracts, refer to the How to enter contract header information procedure for 
details. For existing contracts, specify the contract number in the Contract # field.   

3 In the browser in the lower portion of the screen, highlight a contract price (for L-price 
level contract types) and add pricing information. For L-price level contract types you can 
specify a standard price and price levels 1-6.  

4 To specify a standard price, select the Type, STD PR line in the browser: 
 
The standard price may be entered as a basis and multiplier, a set price or a change %.  
Basis: The valid options for basis for standard price are as follows: list price, manual 
cost, sales order entry cost, standard price, any level price or quantity break price 
(entered in Costing and Pricing programs located in the Inventory Control module).  
Mult:  The multiplier for the standard price. 
 
-OR- 
Price: The set price for the contract price line. (If you select N/A as the basis you can 
specify a set price in this field.) 
Commission %: In addition to the three set up options for the standard price, you can 
also specify a commission %. The Inventory Control static record flag determines 
whether this commission flag is used throughout the costing/pricing subsystem. If the flag 
is turned off, the option to specify the commission % is never available. If the flag is 
turned on, each contract price that is set up will require the field of a commission %. 
When entering the commission %, you can set the commission % to "no priority" (blank) 
indicating that commission is not generated based on the price being set up. (If the item 
is set to "no priority", any commission % entered in the contract pricing system will be 
ignored). (For more information on commissions, refer to the commission basis flag set in 
the Company Control F/M program in the System Management module.) 

5 (Optional) To specify a level price, select the Type, Level 1-6 in the line browser.  
 
The level price may be entered as a basis and multiplier, a set price or a change %.  
Basis: The valid options for basis for level price are list price, manual cost, sales order 
entry cost, standard price, any price level.  
Mult:  The multiplier for the level price. 
 
-OR- 
Price: The set price for the contract price line. (If you select N/A as the basis you can 
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specify a set price in this field.) 
Commission %: In addition to the three set up options for the price levels, you can also 
specify a commission %. An Inventory Control static record flag determines whether this 
commission flag is used throughout the costing/pricing subsystem. If the flag is turned 
off, the option to specify the commission % is never available. If the flag is turned on, 
each contract price that is set up will require the field of a commission %. When entering 
the commission %, you can set the commission % to "no priority" (blank) indicating that 
commission is not generated based on the price being set up. (If the item is set to "no 
priority", any commission % entered in the contract pricing system will be ignored). (For 
more information on commissions, refer to the commission basis flag set in the Company 
Control F/M program in the System Management module.) 

6 Save your contract pricing line.  

7 (Optional) You can highlight a pricing line and select: 

Delete. Deletes a highlighted pricing contact line 

F3 or Stop Stops adding contract pricing lines. 

8 The following options are available; when a contract price record exists for the entered 
customer, item, shipping and UM scopes: 

Review Accesses the Price Contract Review screen where you can mark/unmark a 
contract as awaiting review. Contracts awaiting review are not active. 

Customers Accesses Customer Scope Entry (SOE561) to specify any number of 
individual customers (with or without ship-to’s) and any number of customer classes.  

Items Accesses Item Scope Entry (SOE563) to specify any number of specific items 
(with or without UM specifications), any number of item classes, and any number of 
primary vendors for a contract. 

Shipping  Accesses Shipment Scope Entry (SOE565) to specify whether the contract is 
valid for drop ship lines.  

Header Accesses Price Contract Header Detail to allow you to modify contract 
information such as description, effective dates or contract scope details.  

Done Completes the contract and returns you to the Contract # field so you can specify 
or modify additional contracts. 

Using Excel for Contract Maintenance Import/Export 
You can only edit contracts using this feature. Contracts may not be created or deleted 
by use of the Import/Export procedure. 

The Import menu option is available from the Data Menu of Contract Maintenance 
(SOE567). The Import command brings in a contract collection, which was previously 
export to Excel, from Excel into Contract Maintenance. 

The Export menu option is available from the Data Menu of Contract Maintenance 
(SOE567). It sends the displayed contract collection to Excel. Only certain fields will be 
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sent. Refer to the spreadsheet first row for descriptions of those values that are exported. 
Excel must be open before the export can succeed. 

Modifying the Spreadsheet 
• No columns may be inserted into or deleted from the spreadsheet, as that will cause the 
import into FACTS to fail. If desired, columns may be added beyond the last spreadsheet 
columns to facilitate updates. 

• No rows may be added to or deleted from the spreadsheet. 

• Rows may be resorted to facilitate editing, but prior to attempting an import the spreadsheet 
must be resorted on the first column to restore its original order. 

Spreadsheet Security 

The Excel spreadsheet is protected to help users avoid making disallowed changes. The 
spreadsheet is protected by default with the case-sensitive password “FACTSEXPORT”. 
While it is protected, you can modify only the fields that are valid to be changed (not shaded 
grey). If you want to resort the lines of the spreadsheet, add columns beyond the 
spreadsheet, etc., the spreadsheet must be unprotected. It is advisable to re-protect the 
spreadsheet after taking such actions to prevent accidental changes to cells that should not 
be changed. 

Excel Spreadsheet Details—Contents 

A Status column is included on the spreadsheet to provide additional information about the 
import process. The values for the Status can be:  
E – the contract has been exported – no import actions have taken place. 
I – the contract was successfully imported (and thus will not be imported again on a 
subsequent import.) 
F - the contract failed to import due to problems – further explanation of the problem will be 
found in the import message column. 

There are two ‘groupings’ of columns on the spreadsheet—one for quantity break information 
and one for stocking and manual cost details--that can be ‘collapsed’ if the user prefers not 
to see them. 

There are multiple UM columns listed on the spreadsheet. 
The first is the column for UMs listed in the contract (if any, or All) 
The second is the selling UM 
The third is the pricing UM 
And the fourth (if listed) is also the pricing UM. 

The costs that are optionally exported to the spreadsheet are always presented in the pricing 
UM to make their use in formulas simpler. 

Importing Rules for Data Entered in the Excel Spreadsheet 

All spreadsheet values entered in the Excel spreadsheet may only be in the ranges 
acceptable when using Contract Entry. Any values that would not be accepted through 
Contract Entry in FACTS will cause that row to fail to import.  
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No reformatting of numeric values (such as adding parentheses around numbers or adding 
dollar signs or adding percent signs) is to be done if the spreadsheet is to be imported later. 
Any such changes will cause that Excel row to fail to import. Date entry is only allowed in the 
numeric format of MM/DD/YYYY – forward-slash use separating the month, day and year is 
mandatory (do not use backslash or dashes or other characters to separate date values as 
that will cause the excel row of that invalid date value to fail to import). 

The Effective date column may also have the word “Always”. Contracts that are linked to a 
previous contract will not import the effective date. The Expiration date column may also 
have the word “Never”. Contracts that are linked to a subsequent contract will not import the 
expiration date. 

No Excel spreadsheet cells may be imported when ‘blanked’/’empty’ – Empty cells for import 
will result in the row failing to import. 

Any break quantity, if present, that is not in ascending order will result in the row failing to 
import. 

Customer returns procedures 

Processing customer returns (Overview) 

1 Create a returns authorization document (optional) and print an authorization. 

Customer Authorization document and Return Authorization 
• The Return document is created in Customer Returns Entry using the Quick Entry 

screen and the Invoice Search or with the Customer Returns Line Entry screen. 
• Since the original sale was also recorded on the system, the return can be tied to the 

past invoice. The authorization document number is given to the customer. 

2 Print a returns receipt. 

When you exit from Return Entry, the Return Authorization is printed. Provide a Returns 
Authorization or Returns Acknowledgment for the customer to use as a packing slip for the 
returned merchandise or keep as a receipt. 

3 Update the returns document. 
• When the damaged merchandise is received, you can access the Order Entry suite 

of programs and select the menu option “RMA” and enter the return document 
number to access Returns Entry with the return document information loaded. 

• In Returns Entry, enter the quantity that was received back from the customer for 
each item. When done, the return goods credit memo and customer replacement 
sales order are created and status flags for the vendor return and vendor 
replacement is set to process the return in the Buyers Control Center.  Returns to 
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stock or scrap result in a SO Credit Memo. Returns for repair or replacement result in 
a Sales Order. 

4 Check Buyers Control Center—PO. 
• As the return goods credit memo is processed through the Daily Sales Register, the 

status flags change for the vendor returns so the Buyer’s Control Center can then 
process the returns to the vendor and create the negative PO.  The Buyer’s Control 
Center will also be aware of any vendor replacements that are indicated by a 
customer return and create the replacement PO.  These will update back to the 
Customer Returns System files. 

• As the return and replacement POs are processed through the Receipt Register, the 
status flags on the CRS lines are again updated.  If the customer credit and customer 
replacement were waiting on vendor action, the credit memo and sales order will be 
created.  The DSR updating these documents will again update back to the CRS line. 

5 Returns Inquiry and/or Report Analysis 
• Use Customer Returns Inquiry (SOI810) to check the status of documents in the 

process of being returned. 
• Run the CRS Status Report (SOR820) to list open returns, and analyze what stock is 

being returned. 
• Run the Returns Analysis Report (SOR830) as needed to list past returns, and 

analyze how much inventory was returned and for what reasons. 

6 Remove Past Customer Returns History  
Run SM System Clean Up F/M as needed to remove past Customer Returns documents 
which do not need to remain on the system. 

Creating return documents 
1 Access Sales Orders>Returns>Customer Returns Entry. 

2 Select the customer return. 

3 Click Done to display a window indicating that the documents will be created for all lines 
that have a received quantity. 

4 Enter the requested information. For credit memos, you can associate an AR Invoice, 
add the credit memo to the invoice-ready-to-print file, and add a document memo. For 
sales orders, you can add the sales order to the bill-of-lading-print file, and add a 
document memo. 

5 Click OK to create the return and associated documents. Repeat step 4 as needed for 
each document created. 

6 The system will display a message indicating the document (credit memo then other 
associated sales order documents) number that was created for the line(s) specified. If 
received quantity is less than authorized quantity then a new line will be added with the 
difference being the authorized quantity. If there are received quantities entered on any 
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line that the documents have not been created for, you will not be allowed to exit the 
document. 

7 Click Done to enter another returns document; click Done again to exit the program. 

Creating customer authorization or return (Quick Entry 
Method) 
1 Click Sales Orders>Customer Returns>Customer Returns Entry. 

2 Click Quick Entry and then enter the customer number. 

3 Specify the past invoice number for the return.  
--OR-- 
Use the Inv # search to select past invoice lines to be returned, or enter an item number 
to return an item not associated with a past invoice.   

4 In the Filters section, enter any of the following to limit the invoice search: item, 
beginning and ending invoice date, serial/lot number, ship-to, or reference number. Click 
Apply Filters. 

5 Specify the authorized and received (if known) amounts to select lines and click OK. 
All selected lines will return to the Quick Entry screen. (If the goods are already at the 
distributor’s warehouse, then the received quantity can also be entered.) 

6 On the Quick Entry screen, modify the authorized or received quantity, or reason code, if 
needed, and enter the CM returns code.  

7 (Optional) You can also update the Return Actions and Replace to Customer options, as 
well as add a warehouse for processing and modify the credit cost, credit price and 
restocking fee amounts. 

8 Click OK to automatically create the lines on the CRS document. Only lines from the 
Quick Entry screen that have an authorized quantity will import into the return document. 

9 (Optional) On the Customer Returns Entry screen, you can now add return lines to this 
CRS document. 

10 Click Done to specify whether to print the returns authorization now. After you print the 
returns authorization the system also creates the associated documents for the return. 

11 Click Done again to return to the CRS main menu.  

Using Past Invoice Search for Customer Returns 
1 Click Sales Orders>Customer Returns>Customer Returns Entry.  

2 Click Quick Entry and then enter the customer number. 

3 Use the Inv # search to select past invoice lines to be returned. 
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4 In the Filters section, specify any of the following to limit the invoice search: item, 
beginning and ending invoice date, serial/lot number, ship-to, or reference number. You 
can also enter an item number to return an item not associated with any past invoice. 

5 Click Apply Filters to display past invoices in the grid. 

6 Specify the authorized and received (if known) amounts to select lines and click OK. All 
selected lines will return to the Quick Entry screen. (If the goods are already at the 
distributor’s warehouse, then the received quantity can also be entered.) 

7 (Optional) Click None beside a line to un-select it or enter 0 as the authorized quantity. 

8 Click OK to close the Past Invoice Search and any selected lines (lines with a positive 
authorized quantity) will be returned to the Quick Entry screen. 

Entering Customer Returns header details 
1 Click Sales Orders>Returns>Customer Returns Entry. 

2 Specify the customer return number. 

3 Click Header to display the Header Detail window. 

4 Update the salesperson, terms, department and contact and reference information as 
needed. 

5 Click OK to save and display Customer Returns Entry. 

Entering customer return line item information 
Whether you are creating a Returned Goods Document, Return to Vendor PO, Vendor 
Replacement PO, and/or Customer Replacement Order, the beginning process for entering 
customer return line item information is the same. 

1 Click Sales Orders>Returns>Customer Returns Entry. 

2 Create a new return or enter the return number. 

3 Click Add and enter the item number. 

4 The Customer Returns Line Entry program is displayed. 

5 Specify the past invoice number, if any, for the return. 

6 Specify the Received and Authorized quantities. 

7 Specify the Return Action: W - Return to Warehouse, R - Return to Vendor for 
Replacement, C - Return to Vendor for Credit, S – Scrap, P – Repair. 

8 Specify how Replace to Customer: W – From Warehouse (default), D – Direct Ship 
from Vendor, or N – No.  
Note that for temporary items, the D – Direct Ship from Vendor option is not available for 
the R - Return to Vendor for Replacement Return Action. 

9 Specify the Reason Code and the Returns Code. 
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10 (Optional) If Return Action you selected is R, C or P, indicate whether to Wait for 
Vendor Action/Repair. 

11 Complete the remaining fields as needed to produce the following: Returned Goods 
Document, Return to Vendor PO, Vendor Replacement PO, and/or Customer 
Replacement Order. Refer to step 6 of the step-by-step procedures below for creating 
each kind of document to complete this process. 

Entering Customer Replacement Information to create the Customer Replacement order 

Entering Vendor Replacement Information (to create the Vendor Replacement PO and 
will return the goods to stock) 

Entering Vendor Return Information (to create the Return to Vendor negative PO and 
return the goods from stock) 

Entering Customer Return Information to create Returned Goods documents 

Entering CRS Serial Lot Numbers 
1 Click Sales Orders>Returns>Customer Returns Entry. 

2 Create a new return or enter the return number. 

3 Click Add and enter the item number. 

4 The Customer Returns Line Entry program is displayed. 

5 Specify the past invoice number, if any, for the return. 

6 Specify the Received and Authorized quantities. 

7 When the system asks: Specify serial/lot number?, click Yes. 

8 For serial/lot items, the CRS Serial/Lot Number Entry screen is displayed. 

9 Click Add. 

10 Specify the Serial/Lot number. 

11 Specify the quantity for the return. 

12 You can add or edit additional serial/lot items as needed to distribute the received 
quantity. 

13 Click Save.  

14 Click Done to return to the Customer Returns Line Entry screen to complete processing 
the return. Complete the remaining fields as needed to produce the following: Returned 
Goods Document, Return to Vendor PO, Vendor Replacement PO, and/or Customer 
Replacement Order. Refer to the step-by-step procedures for creating each kind of 
document to complete this process. 
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Entering Temporary Items in CRS 
1 Click Sales Orders>Returns>Customer Returns Entry. 

2 Specify the customer or return number. 

3 Specify the temporary item number for the return. 

4 When the system asks: Is this a temporary item?, click Yes. (Optional--Note that you can 
select Quick Add to access Default Item Entry, where you can specify an item to use for 
the temporary item's default values.) 

5 The system displays the Customer Returns Line Entry screen, with the temporary item 
number and description: TEMPORARY displayed. 

6 In the Temporary Items section, specify the vendor, item class, unit of measure, and 
(optional) weight per unit. 

7 Specify the past invoice number, if any, for the return. 

8 Specify the Received and Authorized quantities. 

9 Specify the Return Action: W - Return to Warehouse, R - Return to Vendor for 
Replacement, C - Return to Vendor for Credit, S – Scrap, P – Repair. 

10 Specify how Replace to Customer: W – From Warehouse (default), D-Direct Ship from 
Vendor, or N – No.  
For temporary items, the D – Direct Ship from Vendor option is not available for the R - 
Return to Vendor for Replacement Return Action. 

11 Specify the Reason Code and the Returns Code. 

12 (Optional) If Return Action you selected is R, C or P, indicate whether to Wait for 
Vendor Action/Repair. 

13 Complete the remaining fields as needed to produce the following: Returned Goods 
Document, Return to Vendor PO, and/or Customer Replacement Order. Refer to step 6 
of the step-by-step procedures below for creating each kind of document to complete this 
process. 

Entering Customer Replacement Information to create the Customer Replacement order 

Entering Vendor Return Information (to create the Return to Vendor negative PO and 
return the goods from stock) 

Entering Vendor Replacement Information (to create the Vendor Replacement PO and 
will return the goods to stock) 

Entering Customer Return Information to create Returned Goods documents  

Entering Customer Replacement Information to create the 
Customer Replacement order 
1 Click Sales Orders>Returns>Customer Returns Entry. 

2 Create a new return or enter the return number. 
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3 Click Add and enter the item number. 

4 The Customer Returns Line Entry program is displayed. 

5 Specify the customer return line item information. (Refer to the Entering customer return 
line item information for step-by-step instructions.) 

6 In the Customer Replacement Information section, specify the customer return 
warehouse. This value defaults to the return warehouse’s Authorized Replenishment 
Path. If the replenish path is ‘From Vendor’ then this value defaults to the return 
warehouse. If the Replace to Customer setting is Direct Ship from Vendor then this field 
is disabled. 

7 Specify the Vendor. If the Replace to Customer setting is not Direct Ship from Vendor 
then this field is disabled. See the setting for “wait for vendor action/repair” in Vendor F/M 
(APF910). 

8 Indicate whether to Update Usage. This check box is only enabled if Replace to 
Customer is W. 

9 Specify the replacement information, including cost and price (press F1 to use the values 
from the past invoice), discount, ship to, order priority shipping, freight and tax 
information. 

10 The system displays the SO/Line# and SO Line Status. You can edit the SO/Line# 
values. 

11 Click OK to display the Customer Returns Entry screen. 

12 Refer to the Completing customer returns procedure to perform the CRS ending routine. 

Entering Customer Return Information (Creating Returned 
Goods documents) 
1 Click Sales Orders>Returns>Customer Returns Entry. 

2 Specify the return number. 

3 Specify the item number for the return. 

4 The system displays the Customer Returns Line Entry screen.  

5 Specify the customer return line item information. (Refer to the Entering customer return 
line item information for step-by-step instructions.) If the Return Action specified is Scrap, 
an allowance credit memo will be created; if not a return credit memo will be created and 
the goods will be returned to stock. 

6 In the Customer Return Information section, specify the Return Warehouse where the 
items will be returned. 

7 Specify the Usage information. (Note that temporary items do not track usage.)  

8 Specify the credit information for the return, including discount, restocking fees, ship-to 
location, freight and tax information. 

9 Click OK to display the Customer Returns Entry screen. 
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10 Click Done to enter another returns document; click Done again to exit the program.  

11 Refer to the Completing customer returns procedure to perform the CRS ending routine. 

Entering Vendor Replacement Information (to create the 
Vendor Replacement PO and will return the goods to stock) 
Note: this action is only available if Return to Vendor is Replacement and is not available for 
temporary items. 

1 Click Sales Orders>Returns>Customer Returns Entry. 

2 Create a new return or enter the return number. 

3 Click Add and enter the item number 

4 The Customer Returns Line Entry program is displayed. 

5 Specify the customer return line item information. (Refer to the Entering customer return 
line item information for step-by-step instructions.) 

6 In the Vendor Replacement Information section, specify the receiving warehouse. 

7 The system displays the PO/Line# and PO Line Status. You can edit the PO/Line# value. 

8 Click OK to display the Customer Returns Entry screen. 

9 Refer to the Completing customer returns procedure to perform the CRS ending routine. 

Entering vendor returns (to create return-to-vendor, negative 
POs, and return goods from stock) 
Note this action is only available if Return to Vendor is Credit or Replacement. 

1 Click Sales Orders>Returns>Customer Returns Entry. 

2 Create a new return or specify the return number. 

3 Click Add and specify the item number 

4 The Customer Returns Line Entry program is displayed. 

5 Specify the customer return line item information. (Refer to the Entering customer return 
line item information for step-by-step instructions.) 

6 In the Vendor Return Information section, specify the Vendor for the return. If the vendor 
is no longer valid or no past invoice entered, this value defaults to item’s primary vendor 

7 The system displays the Consolidation warehouse of the vendor (or the return 
warehouse if consolidation warehouse is blank), the Transfer/Line# and Transfer line 
Status, Transfer To Warehouse (if created), PO/Line# and PO Line Status and PO 
Warehouse, if created. Note: For temporary items, returns may not have a consolidation 
warehouse that is different from the return warehouse. 
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8 (Optional) You can edit the Transfer/Line# and the PO/Line# values. 

9 Click OK to display the Customer Returns Entry screen. 

10 Refer to the Completing customer returns procedure to perform the CRS ending routine. 

Completing customer returns 
Use this ending routine after you have entered return information and are ready to create 
docs. 

1 When you are returned to the CRS Entry screen, check the Create Documents prompt in 
the grid to determine which lines will create credit memos and/or sales orders. For each 
line that can have a CM/SO created, a Y is displayed in this column, except for new 
lines. 
Note: For new lines which have not yet had acknowledgments printed, you must click 
Done to display a window to print a return merchandise authorization (RMA) is displayed 
for new lines.  

2 (Optional) Click Create Docs. 

3 The Select CRS Lines (SOC840) screen is displayed so you can select the CRS line to 
process for sales order and /or credit memo creation. 

4 Check the specific Sales Order and/or Credit Memo check boxes for each CRS line, or 
click All to select all lines or None to not select any lines to process for sales order and 
/or credit memo creation. 

5 Click OK. 

6 On the Credit Memo Creation (SOC825) screen, specify the requested information. For 
credit memos, you can associate an AR Invoice, add the credit memo to the invoice-
ready-to-print file, and add a document memo. For sales orders, you can add the sales 
order to the bill-of-lading-print file, and add a document memo. 

7 Click OK to display the CRS Creation Status (SOC814) screen, which indicates the 
process status for the CRS and the associated documents that are created. 

8 Check the Print Status info check box and specify a printer to optionally print this 
information and click OK. 

9 Click Done to enter another returns document; press Done again to exit the program. 

10 Specify the requested information. For credit memos, you can associate an AR Invoice, 
add the credit memo to the invoice-ready-to-print file, and add a document memo. For 
sales orders, you can add the sales order to the bill-of-lading-print file, and add a 
document memo. 

11 Click Done to enter another returns document; press Done again to exit the program. 

Completing CRS documents 
Use the Edit>Complete Line menu option after you have entered a return. 
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1 Click Sales orders> Customer Returns>Customer Returns Entry.  

2 Specify the return document number. 

3 Click Edit>Complete>Document. 

4 Click OK when the message: Do you want assign all lines' status as complete? is 
displayed. 

5 All of the lines now display Y in the Comp field in the grid. 

6 Click Done to enter another returns document; press Done again to exit the program. 

Completing CRS lines 
Use the Edit>Complete Line menu option after you have entered a return. 

1 Click Sales orders> Customer Returns>Customer Returns Entry.  

2 Specify the return document number. 

3 In the grid, highlight the line you want to complete. 

4 Click Edit>Complete>Line. 

5 Click OK when the message: Do you want assign this line's status as complete? is 
displayed. 

6 The line now displays Y in the Comp field in the grid. 

7 Click Done to enter another returns document; press Done again to exit the program. 

Receiving CRS documents 
Use the Edit>Receive menu option after you have entered a return. 

1 Click Sales orders> Customer Returns>Customer Returns Entry.  

2 Specify the return document number. 

3 Click Edit>Receive>Document. 

4 Click OK when the message: Do you want assign all lines' zero receive quantity equal to 
their authorized quantities? is displayed. 

5 All of the lines' authorized quantities now displays in the Rec Qty fields in the grid. 

Click Done to enter another returns document; press Done again to exit the program. 

Receiving CRS lines 
Use the Edit>Receive Line menu option after you have entered a return and want to assign 
the authorized quantity as the received quantity. 
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1 Click Sales orders> Customer Returns>Customer Returns Entry.  

2 Specify the return document number. 

3 In the grid, highlight the line you want to complete. 

4 Click Edit>Receive>Line. 

5 Click OK when the message: Do you want assign this line's received quantity as 
authorized quantity? is displayed. 

6 The authorized quantity now displays in the Rec Qty field in the grid. 

7 Click Done to enter another returns document; press Done again to exit the program. 

Manually advancing CRS line status  
Use this menu option to manually advance the status of a CRS line. Note that some options 
may not display in the Vendor Return and Replacement drop boxes until other drop boxes 
have their status advanced. For example, the 'complete' option may not for the waiting for 
vendor status until a prior vendor status is 'complete'. Depending on the return actions for the 
CRS line not all sections of this screen are available. 

1 Click Sales orders> Customer Returns>Customer Returns Entry. 

2 Specify the return document number. 

3 In the grid, highlight the CRS line for the manual status advance. 

4 Click Edit>Manual Status Adv. 

5 The Manual Status Advance for CRS (SOC860) screen is displayed for the line selected. 

6 (Optional) In the Returned Credit Memo section, click 2-Complete in the Goods drop box 
to advance the status. Then click the appropriate option in the Credit drop box to 
advance the status. 

7 (Optional) In the Vendor Return section, click the appropriate status in the Return drop 
box.  

8 (Optional) In the Replacement section, click the appropriate status in the Vendor drop 
box and Customer drop boxes to advance the status.  

9 You have these options. Click 
Reset to change all drop box statuses back to the initial statuses of the line selected 
Complete to change all statuses to their complete status. 
Cancel to abort all status changes and return you to Customer Returns Entry. 
Save to save your status changes immediately and return you to Customer Returns 
Entry. Statuses which are complete when the new window displays cannot be changed. 
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Inquiries procedures 

Viewing customer information 
1 Click Sales Orders>Inquiries> Customer Inquiry. 

2 Specify the customer for which you want to view information in the Customer field. 
Optionally, click Change Filters if you want to limit the records that display by 
warehouse, item type, ship-to or customer return.  
Optionally, click Search. You can use the Starts With field to enter the beginning 
characters for the customer code. If the Start From field in the lower portion of the 
screen, you can select to display documents by document number or reference number. 

3 Select a view. 
Choose a view from the View menu option or select a view from the view bar. 

Quotes Displays quote information including quote number, quote date, 
expiration date, warehouse, sales order number (if converted to a 
sale), the customer for whom the quote was made, who gave the quote 
and the quote total.  

Getting more information on a quote: 

In the view area, select the line and click Line Detail or double click on 
the icon at the beginning of that line. 

  

Sales  
Orders 

Displays sales order information including document number, 
document type (work order, invoice, credit memo, counter sale, etc.), 
document status (work order entered but not printed, work order 
printed, confirmed invoice, receipted invoice, deleted sales order, 
voided invoice), document origin, invoice date, warehouse, amount, 
ship-to and reference number.  

Sorting open sales orders: 

Orders sort by document number by default. Click on the Reference 
number column header to sort by reference number. Click on the 
Document number column header to sort by document number. You 
can also click on any other column header to sort by that information. 

If the document is on hold, *HOLD* appears in the column after the 
reference number. Documents on hold cannot be printed or confirmed. 
Any non-deleted or non-voided document may be selected for detail 
inquiry. 

Getting more information on an order: 

In the view area, select the line and click Line Detail or double click on 
the icon at the beginning of that line. On the Line Detail screen for Past 
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Invoices view of SO Document Inquiry, the AR Detail button is 
available to view the AR document associated with the invoice if it is 
still on file.  

  

Past Invoices Displays past invoices including SO document number, AR invoice 
number, document type (work order, invoice, credit memo, counter 
sale, etc.), document origin, invoice date, warehouse, amount, ship-to 
and reference number.  

Sorting past invoices: 

Click on the Invoice column header to sort by past invoice number or 
click on the Reference number column header to sort by reference 
number. You can also click on any of the other column headers to sort 
by that information. 

Getting more information on a past invoice: 

In the view area, select the line and choose the Line Detail button or 
double click on the icon at the beginning of that line. In the Line Detail 
Past Invoices view of Customer Inquiry, there are 2 special buttons 
available above the line item browser. The GL Posting button is 
enabled when the transaction highlighted in the browser is one that 
allows for drill back from the source document to the GL posting that 
was created by the register. If the GL posting records can be found, 
then Journal Inquiry will display defaulting to showing transactions for 
this document only. The AR Detail button is available to view the AR 
document associated with the invoice if it is still on file. 

  

Past Sales Displays past sales information for each item number and description. 
Listed information consists of invoice number and date, document 
origin, quantity sold and the corresponding unit of measure, price and 
the pricing unit of measure.  

Filtering past sales information by item type: 

Click Options>Filter Views from the menu bar.  

  

Pricing Displays customer pricing information on items. Listed information 
consists of item number, item description, the customer’s default price, 
pricing unit of measure and item type.  

Highlight a line and click:  

Orders to display the on order information for existing purchase orders, 
warehouse transfers or manufacturing tickets for the selected customer 
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and item. Specify the display code: S-sales orders, T-warehouse 
transfers, M-manufacturing tickets. The display for each document 
includes: order number, type, status, ordered quantity, received 
quantity, back-ordered quantity, unit of measure for the quantities, cost 
and its corresponding unit of measure, the promised date and vendor 
number for all warehouses. 

Whse Qtys to display the warehouse quantity information. For the 
specified item, you can view the available, on-hand, and on-order 
quantities as well as long- and sort-term surplus and average lead 
time, in each warehouse. 

Line Detail to access level pricing, contracts, and past sales 
information for the customer/item combination.  
The Level Prices detail window shows the item’s standard pricing for 
the customer selected, as well as any price levels or quantity breaks 
that exist for this customer. 
The Contracts detail window shows the Contract Entry (SOE560) 
screen in view-only mode. The Past Sales detail window shows past 
sales information for the customer/item combination.  

Ship-to 
Addresses 

Displays alternate ship-to information from the created in the Ship-To 
F/M for this customer. This view lists the alternate ship-to numbers, 
location names, contact 1, and phone number 1.  

Getting more information on alternate ship-to addresses: 

In the view area, select the line and click Line Detail or double click on 
the icon at the beginning of that line. The detail window displays the 
alternate location’s mailing address, both phone numbers and contact 
names if provided, salesperson/territory, default ship via code, UPS 
zone, route code if routes are used in your system, tax code and tax 
rate as well as any user defined fields entered on the User Defined tab 
of Ship-To F/M (ARF920). 

  

Press Enter to view detail on the next alternate ship-to for the customer 
selected. Press F4 to backup to the main inquiry screen.  

Customer 
Returns 

Displays information on the returns documents for the selected 
customer. 

Filtering Customer Returns: 

Click Change Filters to select: All Returns, Open Returns, Completed 
Returns, Returns Waiting on Vendor Action, or Returns Waiting on the 
Goods for the display. You can also narrow the display by warehouse, 
item type and ship-to location. 
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Blanket Sales 
Orders 

Displays information on blanket sales orders including document 
number, hold status, warehouse, entry date, expiration date, 
completion date, ship-to number and reference number.  

Sorting blanket sales orders: 

Orders sort by document number by default. Click on the Reference 
number column header to resort by reference number. Click on the 
Document number column header to resort by document number. You 
can also click on any other column header to sort by that information. 

If the document is on hold, *HOLD* appears to the right of the 
reference number. Documents on hold cannot be released or 
distributed.  

Getting more information on blanket sales orders: 

In the view area, select the line and click Line Detail or double click on 
the icon at the beginning of that line. 

  

MSDS Displays information on Material Safety Data Sheets (MSDS) that were 
sent to this customer. The information in the view consists of the 
MSDS ID and ID description, ship-to, date last sent, MSDS revision 
date and the invoice numbers with which the MSDS sheets were sent. 

Filtering MSDS information by ship-to addresses: 

Click Options>Filter Views from the menu. 

Press F2 to search existing ship-to addresses. Press F3 to select all 
ship-to addresses for this customer. 

Customer Notes Displays customer notes information. 

Lost Sales Displays lost sales information for each item for the specified 
customer. Listed information consists of item number and description, 
Ship-to locations, salesperson information, order entry date and user, 
and edit date and user. 

Proposals  Displays service proposals entered in the Service & Repair module for 
the specified customer. Information in the browser includes the 
proposal number, effective and expiration dates, contact, total amount 
and reference information. The Line Detail button displays the Service 
Proposal Inquiry with details for the highlighted line item. 

Contracts Displays service contracts entered in the Service and Repair module 
for the specified customer. Information in the browser includes the 
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contract number, effective and expiration dates, contact, total amount 
and reference information. The Line Detail button displays the Service 
Contract Inquiry with details for the highlighted line item. 

Doc Routing  Displays routing information for documents entered in the Service and 
Repair module for the specified customer. Information in the browser 
includes the account number, document type, doc description, routes, 
fax number, and email address. 

  

User-Defined  

The data that appears on the User-Defined view of Customer Inquiry 
comes from the User-Defined view of Customer F/M (ARF910). Many 
users have a few pieces of information about customers, vendors, and 
items that are unique to their business that they would like to enter into 
FACTS for reference purposes. The User-Defined view displays user-
defined fields entered the major file maintenances and makes them 
available in FACTS Inquiry programs for information only. There are 5 
user-defined fields that can be entered on the User-Defined screen of 
Customer F/M). There user-defined field must first be configured by a 
user that has administrator privileges for User-defined Fields setting on 
the Security tab of User Code F/M (SMF410).  

  

Credit History Displays tabs for Aging, Payment history and Sales history. • Payment 
history includes last payment date and grace period. Information also 
includes both invoices and weighted dollars. Invoice Payment Statistics 
include the total number of invoices paid, the average number of days 
to pay, the dollars paid, and the weighted average days to pay are also 
displayed in accumulated periods. The accumulation of data into 
periods displays the “Last 03 Periods” , the “Last 06 Periods” and “Last 
12 Periods” as the accumulation of data from the current period 
through the specified periods back from the current period. • Sales 
history includes the account opening date, last sale date, highest 
balance date and highest balance. Information also includes sales, 
cost and gross margin percentage for month-to-date, year-to-date, and 
prior year. • Aging displays credit history in three categories: Current 
date for balances due, Total aging and Disputed.  

Check History Displays accounts receivable document information by check number. 
The number of periods check history is kept is dependent on the 
Check History setting on in AR Static F/M. The Check History view 
displays check numbers for the highlighted customer along with the 
check date, check amount, and check memo.  
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Ledgercards  Displays all ledgercard information for the selected customer from 
newest to oldest by default. Information displayed includes entry date, 
debit amount, credit amount, balance, transaction (register) type, 
document number and register number of each ledgercard on file for 
this customer. Click View Doc at the bottom of the screen to display 
additional document detail information. The system checks to see if 
detail info exists for currently highlighted ledgercard line for its 
transaction type.  

Open docs Displays the open documents for the customer including the document 
number, type, ship-to number, register number, entry period, date 
entered, due date, the original amount and the current amount. If the 
open document was created from SO, the SO document number that 
the open document applies to is also displayed.  

Paid Doc 
History   

Displays document number, reference number, ship-to number, 
original amount, original discount amount, entry period, entry register 
number and removal register number. The documents initially appear 
in document number order.  

Standard Order Displays ship-to locations that have standard orders for the specified 
customer. Highlight a line and click Line Detail to access standard 
order lines for the specified ship-to/customer combination. 

 

7 When you are finished reviewing information for customers, close the Customer Inquiry 
program. 

Viewing document information 
1 Click Sales Orders>Inquiries>Document Inquiry. 

2 This program displays sales order documents by sales order document number as the 
default.  
When you first access Document Inquiry, the upper portion of the screen contains a 
Whse field, which is used to locate specify the warehouse used in the inquiry. The 
system defaults to the initiating warehouse for the user. You can also use the drop-down 
list to select open documents or past invoices, or quotes.  
 
In the Document (Or Invoice) Number field, enter the document/invoice number to 
display. Entering a valid sales order document/invoice number displays the document as 
it would be in the corresponding entry program (Quote Entry for quotes, Direct Invoice 
Entry for invoices, Credit Memo Entry for credit memos, etc.), and denotes the type (BO - 
backorder, IN - invoice, WO - open order, CS - counter sale or CM - credit memo) 
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(except for quotes) in the center top of the screen. If the document is on hold, *HOLD* is 
displayed in the header next to the ship-to number. Documents on hold may not be 
printed or confirmed. 

3 You can search for and display sales order documents, quotes and past invoices in this 
program.  
 
Past Invoice View Details  
In the Past Invoices view of SO Document Inquiry, the GL Posting button is enabled 
when the transaction highlighted in the browser is one that allows for drill back from the 
source document to the GL posting that was created by the register. If the GL posting 
records can be found, then Journal Inquiry will display defaulting to showing transactions 
for this document only. The AR Detail button is available to view the AR document 
associated with the invoice if it is still on file.  
From the Past Invoice view, you can also select the File>Print Invoices option to print 
past invoices. 

4 (Optional) You can select from the following: 

Invoices to display the invoice numbers for this document (only valid for open sales 
orders). The system displays a list of invoices for this order. You can then choose an 
invoice to display or return to the main screen. For past documents, notes are only 
available to view/edit (based on your user security access) from the Invoice view 
(accessed by the Invoice button) of Document Inquiry.  
 
Dep/Payment to display Deposit/Payment entry information. The system displays 
the Deposit/Payment Entry (SOC718) in display-only mode.  
 
Footer to display the footer memo for the document. 
 
Header to display the Header Detail Window for the document. Refer to the Order 
Entry Header Detail Window topic for details. 
 
Highlight a line item and click Line Detail to access the Line detail screen for the 
document. Refer to the Document Inquiry Line Number Detail topic for details. 
 
For open quotes and open sales order documents and past invoices, access Note 
Entry (SME710) for the sales order header or line record specified in the program.   

For Past Invoices and Past Documents, click Open Doc to access the open 
document ties to the past invoice line or past document line.  

For Blanket Sales Orders, click Rel Req button to access the Blanket Order Entry 
Release Request Screen (SOE711) in display-only mode.  

5 When you are finished reviewing information for documents, click Done to exit the 
Document Inquiry program. 
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End of period procedures  

End-of-period checklist - Sales Orders  
The end-of-period procedures are critical to the proper functioning of the system. Certain 
programs must be run in a specific order to close the Sales Orders Module accurately. 

It is suggested that copies of the checklist be made and used for each period close-out to be 
filed for future reference. 

Period ___ Year _____  

User  Date  Menu    Description  

________  ________  Recurring  1.  Post Recurring Documents through 
last day of period  

________  ________  Invoices  2.  Print/update last Daily Sales Register  

________  ________  EOP  3.  Print/update Period Sales Register  

________  ________  EOP  4.  Run End-of-Period Update  

End-of-Period Checklist Explanation for Sales Orders 
1. Post Recurring Documents through last day of period. If Recurring Documents are 
used, in order to close the current period, this procedure must be complete. The End-of-
Period Update checks to make sure that the last day posted is the last day of the month. The 
reason for this check is to ensure that the user posts all recurring documents in the correct 
period.  

2. Complete all invoicing and print/update last Daily Sales Register. All invoices for the 
period should be entered and printed and the last Daily Sales Register printed and updated. 
If these procedures are not complete, the sales figures will not be an accurate accounting of 
the period in AR, IC, SO, SA and GL.  

3. Print/update Period Sales Register. This report allows the user to obtain a listing of all 
sales (by each Daily Sales Register printed) for the period. After the register prints, the user 
should remove the records just printed to clear the file. If records are not removed, they 
appear on next period’s register. All Period Sales Registers should be kept as an audit trail.  

4. Run End-of-Period Update. This is the last step to closing the sales orders current period 
and should only be run after all of the above procedures have been completed. The program 
clears month-to-date Daily Sales Register recap figures and closes the current period. If it is 
the last period of the year, year-to-date figures are also cleared. When this program is 
complete, the user may begin daily procedures in Sales Orders in the new (current) period.  

A detailed account is provided of the purpose of each program on the checklist. 
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Creating a SO to GL distribution table 
1 Begin by selecting the type of GL distribution, which determines how transactions 

processed by the Daily Sales Register post into the Journal File in General Ledger 
(example: print only, print and post). See the GL Distribution input for options.  

2 Then indicate to which General Ledger Journal file the distribution should post, such as 
Sales Journal. 

3 Select a basis. The basis tells the system whether to use the default GL number set in 
this program, or GL numbers that exist in various GL Table file maintenances located in 
other modules.  
For instance, Accounts Receivable entry in this program gives you the option of posting 
to the default GL number or the customer’s GL number. If you look in the Customer F/M 
program, it contains a field in which you can assign an AR GL Table to each customer. 
By selecting the customer basis, you are telling FACTS that you want the DSR to post to 
the Accounts Receivable GL number associated with the table assigned to that customer 
— not to the GL number entered here.  
In many cases, the other basis options — such as customer, item, tax code, ship via and 
returns code — enable you to create a much more accurate and detailed accounting 
system than you could be simply posting to default GLs. 

4 Indicate whether you want the department and/or branch numbers embedded within the 
GL account number (if applicable). If you use departments and branches and select this 
option, the system looks at the department and branch number on the invoices and 
inserts this information into the GL number.  
For example, if the G/L number to post is 415-00-00 (department is fourth and fifth digits, 
branch is sixth and seventh digits), the department is 01 and the branch is 02, then the 
system posts to 415-01-0The system inserts the department and/or branch in the proper 
place within the GL account number.  

5 If the Department Position flag in the Company Control Record is 0, the department 
inputs are disabled. If the Branch Position flag in the Company Control Record is 0, the 
branch inputs are disabled. By default, these inputs are deselected. 

6 Enter default GL numbers for each of the accounts listed in this program regardless of 
whether you intend to use the default basis or not. In some cases, the system can only 
post to a default GL entered in this program.  

Remote Order Entry procedures 

Signing onto the ROE system 
1 From the Sign-On Screen, follow these steps to sign on to the system and access the 

Remote Order Entry Menu. 

2 Enter your user code or press F4-Exit to exit the system. If an incorrect entry is made, 
press Enter to reenter the code. 
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3 Enter your password or press F4-Backup/Exit to backup/exit the system. The password 
will not display on screen. If a remote user makes an incorrect entry, press Enter to 
reenter the password. 

Note: If at any time during the sign-on process you see the message Contact the system 
administrator - code XX, please make note of the code number and contact your 
distributor. 

Signing off of the ROE system 
From the menu system, type "OFF" and press Enter.  

Entering a remote order 
1 From the ROE main menu, select Remote Order Entry. 

2 Press Enter for the system to assign the next available document number. 

3 Enter the required header information. 

4 Enter the line-item detail and memo line information. 

5 Complete the ending routine.  

6 Enter another return, or return to the ROE main menu. 

Editing a remote order 
1 From the ROE main menu, click Remote Order Entry. 

2 Specify the document number to edit. The order number will not be accessible if it has 
been reviewed by the distributor. *HOLD* will display on screen, if the order is on hold. 
Contact the system administrator for further assistance. 

3 Make all required changes to the header by pressing F2-Change Header, or enter the 
line number of the line-item/memo line to change. 

4 Press F3-End to access the ending routine. 

5 Enter another return to edit, or return to the ROE main menu. 

Deleting a remote order 
1 From the ROE main menu, click Remote Order Entry. 

2 Specify the document number to delete. If the order number will not be accessible if it 
has been reviewed by the distributor. Call your system administrator for further 
assistance.  
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3 Specify D-Delete and press Enter to continue. 

4 The system prompts "Are you sure you want to delete the entire document (y/n)?  

5 Answer YES. The system will remove each line item and the entire order from the 
system.  

Editing a Customer Item Number in ROE 
1 From the ROE main menu, click Customer Item F/M. 

2 Specify the customer’s item number to modify. 

3 Specify the line number to change. The system prompts "OK to Change (Y/N)?", 
answer Yes to add or No to change or delete the entry. 

4 Specify another association to modify or press F4-End.  

Entering a Customer Item Number in ROE 
1 From the ROE main menu, click Customer Item F/M. 

2 Specify the customer’s item number, system item number, (optionally) customer 
description, and the default selling unit of measure. 

3 The system prompts "OK to Add (Y/N)?", answer Yes to add or No to change or delete 
the entry. 

4 Specify another association or press F4-End.  

Deleting a Customer Item Number in ROE 
1 From the ROE main menu, click Customer Item F/M. 

2 Specify the customer’s item number. 

3 Click Delete.  

4 The system prompts "Are you sure you want to delete this record (N/YES)? Answer 
YES. The system will remove the record. 

Sending a message in ROE 
1 From the ROE main menu, click General Message Entry. 

2 The current user code displays in the From field; enter the subject of the message in the 
Regarding prompt. Indicate Yes or No if a Reply (is) Required? 

3 Specify the body of the message. Press Enter to complete each line and F3-End to end. 



Sales Orders Transaction Procedures  

222 | Infor Distribution FACTS Sales Orders User Guide 

4 Make any necessary adjustments to the message. Press F3-End and F3-Send. 

5 Indicate whether to send the message to an Employee or Group of employees. Use F2-
Search to display a list of employees or available groups.  

6 From the To Employee/Group prompt, press F2-Display Receivers to display a list of 
message recipients. Delete any entries from the list by entering the line number which 
corresponds to the name to delete. When done, press F4-Backup and F3-Send. 
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